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Objectives 

In this course, you will learn the following: 

• Start and Exit SiteManager 

• Navigate in SiteManager 

• Open and control the display of multiple SiteManager components 

• Close SiteManager components 

• Change your password 

• Identify update and inquiry display 

• Use Open, New, and ‘Choose Keys’ 

• Use, Sort, Find, and Filter 

• View System Attachments 

• Identify Support Resources 

• Use Online Help 

• View the User Manual 

• Access Reports 

• Run a Process 

• Access TDOT Custom Reports 

• View an active Contract 

• Identify time charge types 

• View Contract Items 

• View TDOT Variable Add-on Items 

• Identify Add-on Items 

• View Contract Funding 
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• View Subcontracts 

• Update Contract Master List 

• Grant Contract Authority to Field Staff 

• Understand TDOT Region/Office Staff Contract Initialization Activities 

• Schedule Projected Dates for Key Dates 

• Update Actual Dates for Key Dates 

• Schedule Projected Dates for Checklist Events 

• Add and Start a Milestone 

• Record the Actual Date of a Checklist Scheduled Event 

• Add Stockpile Materials 

• Replenish a Stockpile 

• Close a Stockpile 

• Understand the Pipeline Process in SiteManager 

• Download Data from the Server 

• Understand the Basic Concepts of Daily Work Reports 

• Enter Basic Daily Work Report Information  

• Enter Contractor Activity 

• Enter Contractor Equipment Activity 

• Enter Daily Staff Activity 

• Select and Record Work Items 

• Record Work on a DWR Template 

• Copy a Daily Work Report 

• Modify a Daily Work Report  

• Upload Data to the Server 

• View Pipeline Information 
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• Create a new Diary 

• Preview a Daily Work Report 

• Authorize a Daily Work Report 

• Create a Charge Day 

• View the Unauthorized DWR Report 

• View the Installed Work Report 

• Unauthorize and Correct a DWR Work Item Entry 

• View the History of Daily Work Reports 

• View the Installed Work Items Report 

• View the DWR Template Report 

• View the Item Quantity Report 

• TDOT Progress Estimate Generation Workflow 

• View the Unauthorized DWR Report 

• View the Installed Work Report 

• Generate a Progress Estimate 

• View the Estimate Summary  

• Resolve Estimate Discrepancies 

• Enter Material Test Reports for the Estimate Period 

• Add Price and Pay Adjustments for the Estimate Period 

• TDOT Estimate Review and Approve Workflow 

• View the Estimate Item Detail 

• View the Estimate Item Paybook 

• Generate the Summary To Contractor Report 

• Approve an Estimate 

• Track an Estimate 
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• View the Estimate History 

• Correct Quantities for Approved Progress Estimates 

• View Quantity Adjustment DWRs 

• Understand the Rules and Life Cycle of Change Orders 

• Create a Change Order Header 

• Navigate to Change Order functions from the Change Order Header 

• Apply a Time Adjustment to a Change Order 

• Modify existing Contract Items on a Change Order 

• Add New Contract Items to a Change Order 

• Apply Explanations 

• Calculate a Change Order 

• Forward a Change Order for Review 

• View the Custom Change Order  

• View the Change Order Report 

• Send a Change Order for Approval 

• Approve a Change Order 

• Track a Change Order 

• Overview of the Contract Finalization Process 

• Update Key Dates 

• Create a Document Submission of the Final Estimate 

• Review and Resolve Estimate Discrepancies 

• View a Change Order 

• Generate the Final Estimate 

• Approve a Final Estimate 

• TDOT Supplemental Estimate Workflow 
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• Create a Document Submission of the Supplemental Estimate 

• View Document Submission Recommendations 

• Generate a Supplemental Estimate 
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 1 

Learning Module 

 Section 1  Getting Started 
 for Field and Office Documentation 

 

By the end of this module, you will be able to: 

• Start and Exit SiteManager 

• Navigate in SiteManager 

• Open and control the display of multiple SiteManager 

components 

• Close SiteManager components 

• Change your password 

• Identify update and inquiry display 

• Use Open, New, and ‘Choose Keys’ 

• Use, Sort, Find, and Filter 

• View System Attachments 

• Identify Support Resources 

• Use Online Help 

• View the User Manual 

• Access Reports 

• Run a Process 

• Access TDOT Custom Reports 
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Using the Student Guide 

The student guides are divided into sections — learning modules. Each learning 
module consists of: 

• Objectives 

• Multiple Topics and Instructor-Led Exercises 

• Review 

• Summary Exercise 

Each section will begin with the objectives for the module. The module will be 
divided into topics roughly corresponding to the objectives of the module. Each 
topic will have a short description of the SiteManager function, one or more 
general procedures about how to perform an action in SiteManager, and an 
instructor-led exercise for the topic. Instructor-led exercises are easy to spot on 
each page. Instructor-led exercises are identified by the Bulldozer graphic 
illustrated below and are numbered sequentially. Instructor-led exercises are 
very explicit and detail the specific steps and data to be used in performing the 
action. 

 Exercise 5-2 
Instructor-led Exercises are identified by the Bulldozer graphic. 

Figure 1-1 

Each module will end with a review and a summary exercise. The review will 
summarize the main points and all of the SiteManager functionality covered in 
the module. The review pages may serve as an excellent reference for the 
summary exercise that follows the review. It may also server as a work aid for 
use back at the office. 

The summary exercise gives you the opportunity to practice the skills you 
learned in the learning module. The summary exercise instructions will provide 
you with the data to be used and general instructions. Remember that the module 
review on the pages immediately preceding the summary exercise is composed 
of the general procedures covered in the module. The review will serve as a 
good reference as you perform the summary exercise. 
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SiteManager Procedures, the steps you follow to access a component of 
SiteManager, vary depending on whether you have just entered the system or 
have been in some other component and have already selected a common 
variable. 

For instance, if you enter the application and navigate directly to the Contractor 
Payments component, the Estimate Summary window requires the selection of 
the desired Contract and Estimate. However, if you have been working in the 
Contract Records component, already have a Contact selected, and then navigate 
to the Contractor Payments component, the Estimate Summary window displays 
the Estimates for the Contract previously selected in Contract Records. 

The procedures in this manual describe how to access components of 
SiteManager as if you just entered the application. 

 

In TDOT, there are three Student Guides: 

• SiteManager for Office Documentation 

• SiteManager for Field Documentation 

• SiteManager for Management Personnel 

 

This is a very 
important 
concept. 
Stress it 
throughout 
the class. 
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Starting AASHTO SiteManager 
The AASHTO SiteManager Construction Management System will run on several 
different windows graphical User interfaces. For your operating system, you will 
start AASHTO SiteManager the same way you would any program on your 
computer. 

 
SiteManager Desktop Icon 

Figure 1-2 

 

The SiteManager Logon Dialog Box 

Figure 1-3 

 
The Group Dialog Box 

Figure 1-4 

Note. The only RTF template that TDOT uses is The Summary to Contractor Report, 
which is not needed in Standalone mode; therefore, the Download RTF Template check 
box should never be selected. 

 
 

This box 
only appears 
for Users in 
more than 
one group. 
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 Exercise 1-1 
In the following exercise, you will log on to SiteManager. 

User ID: jj05753 Group: PJSUPS Contract: CNB022C 
1. Click the Start button. 
2. Click the All Programs choice. 
3. Click the SiteManager Training choice. 
4. Click the SiteManager choice. SiteManager displays the 

SiteManager Logon dialog box. 
5. In the User ID field, type jj05753. 
6. Press the Tab key. 
7. In the Password field, type pass. 
8. Press Enter. SiteManager opens with the SiteManager Panel displayed. 

Shift-tab if user ID 
not highlighted. 
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Main Panel Folder Tab of SiteManager Panel 

After starting the SiteManager application, the Main Panel tab will display the 
components of the system as icons. The central functionality of SiteManager is 
divided into ten icons: Contract Administration, Daily Work Reports, Pipeline, 
Contractor Payments, Change Orders, Civil Rights, Materials Management, 
Accessories, System Administration, and Manuals. 

 

SiteManager Panel Window’s Main Panel Tab 

Figure 1-5 

 

The SiteManager Status Bar 

The SiteManager Status Bar at the bottom of the SiteManager window indicates 
your mode, connection, database region, logon group and individual ID. 

 
Status Bar 

Figure 1-6 

 

Available 
icons are 
specific to 
your security 
group. 

Everything is tracked by 
ID and Password.  
DON’T SHARE!  

Discuss training program. 
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Navigating in SiteManager Using the Main Panel 

The SiteManager Panel is used to navigate to the components of the 
SiteManager application. The highest level is the Main Panel tab that contains 
the different functional groups, with each group individually represented by an 
icon. Double-clicking the icon of a functional group brings up another folder tab 
consisting of the sub-groups or the actual windows contained within that 
functional group. As icons are selected, the next level’s folder tab appears next 
to the previous level. 

 

Navigating in SiteManager 

Figure 1-7 
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 Exercise 1-2 
In the following exercise, you will browse some of the components of SiteManager. 

User ID: jj05753 Group: PJSUPS Contract: CNB022C 

 
1. View the icons on the Main Panel. 
2. On the Main Panel, double-click the Contract Administration icon. 
3. On the Contract Administration panel, double-click the Contract Records 

panel. SiteManager displays the Contract Records panel. 
4. Take note of the icons available from the panel. 

Now, let’s browse another panel. 
5. To go up a level, click the Contract Administration tab. 
6. Double-click the Contractor Management icon. SiteManager displays the 

Contractor Management panel. 
7. Take note of the icons available from the panel. 

Now, let’s browse another panel. 
8. To go up two levels, click the Main Panel tab. 
9. Double-click the Daily Work Reports icon. SiteManager displays the Daily 

Work Reports panel. 
10. Take note of the icons available from the panel. 

Now, let’s browse another panel. 
11. To go up a level, click the Main Panel tab. 
12. Double-click the Pipeline icon. SiteManager displays the Pipeline panel. 
13. Take note of the icons available from the panel. 

Now, let’s browse another panel. 
14. To go up a level, click the Main Panel tab. 
15. Double-click the Contractor Payments icon. SiteManager displays the 

Contractor Payments panel. 
16. On the Contractor Payments panel, double-click the Estimate icon. 

SiteManager displays the Estimate panel. 
17. Take note of the icons available from the panel. 

Now, let’s browse another panel. 
18. To go up a level, click the Main Panel tab. 
19. Double-click the Change Orders icon. SiteManager displays the Change 

Orders panel. 
20. On the Change Orders panel, double-click the Change Order Maintenance 

panel.  

Note some of 
the icons 
contained on 
each panel. 
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21. Take note of the icons available from the panel. 

Now, let’s browse another panel. 
22. To go up a level, click the Main Panel tab. 
23. Double-click the Accessories icon. SiteManager displays the Accessories panel. 
24. Take note of the icons available from the panel. 

Now, let’s browse another panel. 
25. To go up a level, click the Main Panel tab. 
26. Double-click the Manuals icon. SiteManager displays the Manuals panel. 
27. Take note of the icons available from the panel. 

Now, to prepare for the next exercise, let’s navigate to the Contract Records panel. 
28. To go up a level, click the Main Panel tab. 
29. Double-click the Contract Administration icon. 
30. Double-click the Contract Records icon. SiteManager displays the Contract 

Records panel. 
31. In the Contract Records panel, double-click the Contracts icon. SiteManager 

displays the Select Contract window. 
32. In the Contract ID list box, scroll to and double-click CNB022C. SiteManager 

displays the Contracts window. 

TDOT Contract number naming convention: 

CN - required for finance system 

B - letting year  

 2003=B 

 2006=E 

 2007=F 

Example: CNE037=Contract 37 from 2006 letting.  

A, B, C on end is merely for training to create 
“snapshots” of contract in various stages of 
lifecycle. 
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 Exercise 1-3 
In the following exercise, you will identify the components of the toolbar. Place 
the mouse over the button and use the tool tip to identify each component. Then 
you will activate the “show text” option. Write the toolbar component name next 
to the appropriate letter below.  

User ID: jj05753 Group: PJSUPS Contract: CNB022C 

 

The SiteManager Toolbar 

Figure 1-8 

A  H  

B  I  

C  J  

D  K  

E  L  

F  M  

G    

 
1. Place the mouse pointer on the toolbar. 
2. Use the right-click button to click the toolbar.  
3. In the Object menu, click Show Text. 

 

SiteManager Panel 

Close 

Delete

Save

Remarks

Toolbar 

Exit SiteManager 

Help Contents 

New 

Remarks are 
unlimited. 
Use a word 
processor for 
spelling. 

If the 
Remarks icon 
has lines 
across it 
(shown), that 
means there 
are remarks. 

Icons are grey 
when they are 
not available 
to select. 

 

Some buttons 
are available 
from all 
windows; 
others are 
window-
specific. 

Open 

Address

Generic Fields

Attachments
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Controlling the Display of Multiple 
SiteManager Components 

In many instances, you will be working in a 
SiteManager component and need to leave it 
temporarily to open another component. Having 
opened more than one component of SiteManager 
you may then need to control the display. 

 
The File Menu 

Figure 1-9 

Opening Multiple SiteManager Components 

While being in one SiteManager component, you may need to go to another 
component without closing the current one. 

 Exercise 1-4 
In the following exercise, you will open one component, while another component of 
SiteManager is open. 

User ID: jj05753 Group: PJSUPS Contract: CNB022C 

Now, let’s open another SiteManager component. 
1. Click the SiteManager Panel button.  
2. Double-click the Projects icon. SiteManager displays the Projects window. 
3. In the Project Number list box, scroll to and double-click 55019-

3220-94. 

Discuss Hot 
Navigation. 
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Using the Window Menu to Control the Display of Multiple 
SiteManager Components 
Having opened more than one SiteManager component, you can now use a variety 
of standard Windows methods to control the display of the components and your 
movement between them.  

CONTROLLING THE WINDOW DISPLAY USING TILE 
Tiling divides the screen into the number of SiteManager components that you 
have active. Typically, tiling is used to display two SiteManager components side 
by side horizontally to compare the entries in each or to return a single component 
to full screen once you have closed the other component. With three components 
of SiteManager active, tiling would give each component only one third of the 
screen. Unless you have a very large display, tiling with more than two 
SiteManager components open may not be very useful. 

The Window Menu 

Figure 1-10 

 
Two SiteManager Components Tiled 

Figure 1-11 

 Exercise 1-5 
In the following exercise, you will tile the two current components of SiteManager. 

User ID: jj05753 Group: PJSUPS Contract: CNB022C 
1. Click the Window menu. 
2. Click the Tile choice. SiteManager tiles the windows. 
 

Stress to only have 
two components 
open when tiling. 
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CONTROLLING WINDOW DISPLAY USING CASCADE 
Cascading makes the number of SiteManager components that you have active 
an equal size and arrange each component in an overlapping offset window. 
Typically, cascading is used to display more than two open SiteManager 
components offset. When you have a need to navigate between more than two 
open SiteManager components, the Cascade choice may make it easier to move 
between them. 

 

Three SiteManager Components Cascaded 

Figure 1-12 
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 Exercise 1-6 
In the following exercise, you will open another SiteManager component, cascade the 
open components and navigate among the three. 

User ID: jj05753 Group: PJSUPS Contract: CNB022C 
1. Click the SiteManager Panel button. 
2. In the Contract Records panel, double-click the Categories icon. 

Now, let’s cascade the windows. 
4. Click the Window menu. 
5. Click the Cascade choice. SiteManager cascades the windows. 

Now, let’s navigate between the cascaded windows. 
6. Click the visible portion of the Projects window. 
7. Click the visible portion of the Contracts window. 
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CONTROLLING WINDOW DISPLAY USING LAYER 

Layering displays the SiteManager component that you have active in the most 
efficient full screen display. Typically, layering is used to give each active 
component a full window for display or to return a single active component to 
full display after you have closed the other components that were tiled or 
cascaded. 

 
The Window Menu with Three SiteManager Components Active 

Figure 1-13 

 Exercise 1-7 
In the following exercise, you will layer the three open components of SiteManager 
and move between them. 

User ID: jj05753 Group: PJSUPS Contract: CNB022C 
1. Click the Window menu. 
2. Click the Layer choice. SiteManager layers the windows. 

Now, let’s navigate to another window. 
3. Click the Window menu. 
4. Click the Categories choice. SiteManager displays the Categories window. 

Now, let’s navigate to another window. 
5. Click the Window menu. 
6. Click the Projects choice. SiteManager displays the Project window. 

Notice shows active 
windows allow to 
move back and forth 
between windows. 
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Closing Versus Exiting in SiteManager 
While SiteManager is not document oriented like other common Windows 
applications, the same principle of closing versus exiting still applies. When you 
are in a SiteManager component and you wish to end your work in it, but still 
continue to perform other SiteManager activities, you should close. As with other 
applications, you only exit SiteManager when you are through with your 
activities. 

 
The File Menu 

Figure 1-14 

The SiteManager Toolbar 

Figure 1-15 

 Exercise 1-8 
In the following exercise, you will close a component of SiteManager and then exit 
the application. 

User ID: jj05753 Group: PJSUPS Contract: CNB022C 
1. To close a window, click the Close button. 
2. To exit SiteManager, click the Exit SiteManager button or click the File menu 

followed by the Exit choice. 

 

Demonstrate 
closing and 
opening Main 
Panel. 

2+ ways to 
close/exit contrast 
to MS Word. 
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Changing Your SiteManager Password 
In addition to your network logon identity, SiteManager also has password 
protection. Your SiteManager ID determines what information you have access to 
and whether you can update the data or not. If you have any questions regarding 
your SiteManager security access, contact your SiteManager System 
Administrator. 

 
The Change Password Dialog Box 

Figure 1-16 

 

Electronic Signature Law: Millennium 
Digital Commerce Act of 2000, digital 
technology is legally binding, 6-30-00, 
signed by Clinton.  If a statute, 
regulation, or other rule of law 
requires documentation in original 
form, an electronic record satisfies the 
rule. 
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IMPORTANT TIPS REGARDING YOUR USER ID: 

1. In TDOT, when a User ID is first assigned to a User, the default 
password is PASSWORD (all caps). The User must change the 
password before logging on to SiteManager.  

2. SiteManager User IDs for TDOT Criteria: 

• Seven characters in length.  

• The first two characters will be jj (in lowercase), followed by a 
randomly assigned 5-digit number. 

IMPORTANT TIPS REGARDING YOUR SITEMANAGER PASSWORD 
AND LOGON ATTEMPTS: 

1. It is important that you do not give out your password to anyone. 
SiteManager maintains a record of everything you do in 
SiteManager. These records are the same as your signature. 

2. If you have attempted to log on twice and have failed, close the 
SiteManager Logon window and start again. This will allow you to 
try to log on again without disabling your password. 

3. If you attempt to log on three times and fail, SiteManager will 
disable your password. Contact Regional Support if password is 
disabled. 

4. SiteManager Passwords for TDOT Criteria:  

• Four to eight characters in length 

• Case-sensitive - SiteManager can tell the difference between 
capital and lowercase letters. Type your ID and password 
precisely. 

• 90-day expiration 

• Cannot be the word “password” 

• Cannot contain symbols. 

 

Mention the 
importance of 
establishing an 
unbroken chain of 
custody when in a 
court of law. 

Everything is 
tracked by ID! 



Changing Your SiteManager Password Trns•port SiteManager® Learning Guide 
SiteManager Overview for TDOT for Field and Office Documentation 
 

 

 19 

 Exercise 1-9 
In the following exercise, you will log on to SiteManager using another ID and 
change the password.  

User ID: jj05750 Group: PJSUPS Contract: CNB022C 
1. Double-click the SiteManager Training program icon on your 

desktop. 
2. To select the user ID, hold down the Shift key and press the Tab 

key. 
3. In the User ID field, type jj05750. 
4. To move to the next field, press the Tab key. 
5. In the Password field, type PASSWORD. 
6. Click the Change Password button. SiteManager displays the 

Change Password dialog box. 

Now, let’s change the password. 
7. In the Old Password field, type PASSWORD. 
8. Press the Tab key. 
9. In the New Password field, type pass. 
10. Press the Tab key. 
11. In the Confirm Password field, type pass. 
12. Click OK.  
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Security Overview 
Depending on your SiteManager security privileges, you may have: 

• Update rights to all SiteManager windows and data, 

• Inquiry rights only and be able to access data and print reports, but 
not update information, 

• Update rights on some SiteManager windows, inquiry only on 
other windows, and/or no access to other windows,  

• Update rights on some SiteManager data, inquiry rights on other 
data, and/or no access to other data, 

• Access to SiteManager in only a network mode, or 

• Access to SiteManager in both a standalone and network mode. 
When you have access to the window and the data, the field will appear with a 
white background. When you only have inquiry access, the data will appear but 
the fields will have a gray background. 

 

A SiteManager Window in Inquiry Only Mode 

Figure 1-17 
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Inquiry 

 Exercise 1-10 
In the following exercise, you will access an inquiry only window in server mode as 
well as log into the application in standalone mode to view the difference in security 
options. 

User ID: jj05750 Group: PJSUPS Contract: CNB022C 
1. How many icons are displayed on the Main Panel? ________________ 
2. Double-click the Contract Administration icon. 
3. Double-click the Contract Records icon. 
4. How many icons are displayed on the Contract Records panel? 

_________________________________________________________ 
5. Double-click the Categories icon. 
6. Double-click Contract CNB022C. 
7. Double-click Project Number 55019-3220-94. 
8. Does the screen display in inquiry or update mode?  ________ 
9. Click the Exit SiteManager button. 

Now, let’s log on using a different user ID and see how the access rights for that user 
affect the icons available. 

User ID: jj05753 Group: PJSUPS Mode: Standalone 
10. Double-click the SiteManager Training program icon. 
11. To select the User ID, hold down the Shift key and press the Tab key. 
12. In the User ID field, type jj05753. 
13. In the Connect to drop-down list, click the expand arrow to the right of the 

current selection and click the Training Standalone choice. 
14. In the Password field, type pass. 
15. Click the Logon button. 
16. How many icons are on the Main Panel? _________________________ 
17. On the Main Panel, double-click Contract Administration.  
18. On the Contract Administration panel, double-click the Contract 

Records icon. 
19. How many icons are displayed on the Contract Records panel? _______ 
20. Click the File menu. 
21. Click the Exit choice.  

Have the class note 
the look of inquiry 
mode. 

Five

Connect to: 
Training 
Standalone. 

Tip: Select mode 
in Connect to field 
before entering 
password to avoid 
logging on to 
incorrect mode 
accidentally. 

Seven 

Eight 

Twelve 

Mention that this is 
one of several ways to 
Exit SiteManager.  
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Now, to prepare for the next exercise, let’s log on using a different user ID. 

User ID: jj05754 Group: OSTAFF Mode: Server 
22. Double-click the SiteManager Training program icon. 
23. Hold down the Shift key and press the Tab key. 
24. In the User ID field, type jj05754. 
25. Press the Tab key. 
26. In the Password field, type pass. 
27. Press Enter. 
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Entering a SiteManager Window – Open, New, and 
Choose Keys 

When you have the authority and update rights and first enter a SiteManager 
window, you can: 

• Open for an existing record , or 
• Create a new record for data entry, 
• Choose keys to create a new record. 

In some instances, SiteManager will not even let you into the window without 
choosing the keys first. Choosing the keys identifies the initial values for the 
new or existing record. 

 
 

Opening an Existing Record 

When opening an existing record, it is not necessary to use the Choose Keys 
option. For some windows, a selection list will be automatically displayed to 
allow the User to select the appropriate record. For other windows, the User may 
access records by selecting the Open button and choosing the appropriate record. 

 Exercise 1-11 
In the following exercise, you will access a window and open an existing record that 
needs multiple keys. 

User ID: jj05754 Group: OSTAFF Contract: CNB022H 
1. On the Main Panel tab, double-click the Daily Work Reports icon. 
2. On the Daily Work Reports tab, double-click the Daily Work 

Reports icon. 
3. What security mode are we in (inquiry or update)? ______________ 
4. What Contract ID is displayed? _____________________________ 
5. On the toolbar, click the Open button. 
6. In the Contract list box, scroll to and double-click contract ID 

CNB022H. 
7. In the Inspector list box, scroll to and double-click user ID jj05751. 
8. In the Date list box, scroll to and double-click DWR date 04/20/05. 
9. When informed that the DWR will be opened in read-only format, 

click the OK button. 
10. When you want to open an existing record, do you use Open, New, 

or Choose Keys? _________________________________________ 

We are teaching 
instincts about using 
SiteManager. 

DWRs are read only 
when you are not the 
creator and or 
Authorized or 
Locked. 

Discuss hot navigation. 

Update 

None 

Note Authorized and 
Locked 

Open 
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Creating a New Record 

When creating a new record, the User will navigate to the appropriate window. 
For some windows, the window will open in New mode. For other windows, the 
User may create a new record by selecting the New button. 

 Exercise 1-12 
In the following exercise, you will access a window and identify the new record 
mode. 

User ID: jj05754 Group: OSTAFF Contract: CNB022H 
1. On the toolbar, click the New button. 
2. Note that you are ready to create a record for Contract CNB022H. 
3. What is the Inspector’s Name? ____________________________ 
4. What is the DWR date? __________________________________ 
5. What is the Contract? ____________________________________ 
6. When you want to create a new record, do you use Open, New, or 

Choose Keys? __________________________________________ 

Smith, Pat 

00/00/00 

CNB022H, same as the one you opened. 

New 
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Choosing Keys 

The Choose Keys choice displays a list of key field(s) to be selected. In many 
instances in SiteManager, the Choose Keys choice must be selected before a 
new record can be created. 

 
Choosing Keys 

Figure 1-18 

 

 Exercise 1-13 
In the following exercise, you will access a window that requires keys to be chosen 
and identify the new record mode. 

User ID: jj05754 Group: OSTAFF Contract: CNB022C 
1. Click the Services menu. 
2. Click the Choose Keys choice. SiteManager displays the Contract 

ID window. 
3. In the Contract ID list box, scroll to and click the CNB022C choice. 
4. Click the OK button. 
5. Note that you are ready to create a record for Contract CNB022C. 
6. When you want to create a new record for a DIFFERENT Contract, 

do you use Open, New, or Choose Keys? ______________________ 
7. Click the Close button. 
8. Click the No button when prompted to save changes. 
9. Click the Main Panel folder tab. 
 

Having chosen the 
correct key, only 
now are you ready to 
create a new DWR 
for a contract. 

New, then Choose Keys 

Key =Contract ID
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Using the Object Menu for Data Manipulation and 
Retrieval 
To make data entry and retrieval easier, SiteManager provides a Search, Filter, 
Find, and Sort capability throughout the application. The Filter and Find 
functions also provide Users with the ability to limit the data retrieved from the 
SiteManager database by specifying criteria using relational operators. The Clear 
button removes the current data retrieval choice in effect. The Show Filter/Sort 
choice shows the current criteria in effect for these choices. 

To invoke the Object menu, using the right mouse button, click in a field. 

 
The Object Menu 

Figure 1-19 

 

Criteria Window Buttons: 

Insert:  Inserts a blank row before the currently selected row.   

Add:  Inserts a blank row after the last row. 

Remove:  Deletes the selected row.  Remove deletes only one row at a 
time. 

Clear: Deletes all rows.  All rows must be deleted to return to the 
complete, unfiltered list. 

Load: Opens saved filter list.  Saved filter allows for loading and 
deleting of saved (and default) filters. 

Save: Opens filter name window to allow filter to be saved.  The 
Default check box allows a filter to be automatically applied every time 
the window is accessed. 

Stress important 
distinction 
between Remove 
and Clear.  
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Criteria Window Conditions: 

Using the Equal (=) condition: 

• Requires the specified value to be exact.  

• Only matching whole words will be included 

• Only matching capitalization will be included 

Using the Like condition: 

• Allows specified value to be imprecise 

• Wildcard % allowed – A wildcard is a value that matches any value 
– like the wild card when playing Uno. 

• SiteManager assumes value% when the Like condition is selected, 
including all data that start with the entered value 

• %value% allows partial data matches to be included  

• Only matching capitalization will be included 

When creating multiple conditions, AND joins will be executed before OR 
joins. 

INSTRUCTOR NOTE: 

Filters that are not saved remain active until the user exits 
SiteManager. 

Filters that are saved as Default filters remain for the user ID on the 
computer until they are removed.  To remove a default filter: 

1. Right click a row 

2. Select the Filter choice 

3. Click the Load button 

4. Select the default filter 

5. Click the Delete button. 
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Sorting 

When the window displays as a list, the Sort feature allows you to sort the list, 
based on specified criteria. Each time the window displays, the default sort 
criterion is automatically applied. As with the Filter function, only one default 
sort criterion can be in effect for a window at any given time. 

 
The Sort Window 

Figure 1-20 
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 Exercise 1-14 
In the following exercise, you will sort the Work Items records for a DWR for 
Contract CNB022E. 

User ID: jj05754 Group: OSTAFF Contract: CNB022E 
1. In the Main Panel, double-click the Daily Work Reports icon. 
2. In the Daily Work Reports panel, double-click the Daily Work 

Reports icon.  
3. In the Daily Work Reports window, click the Open button on the 

toolbar. 
4. Click the No button in the Save Message. 
5. In the Contract ID list box, scroll to and double-click CNB022E. 
6. In the Inspector ID list box, scroll to and double-click jj05752, 

Sandy Gutierrez. 
7. In the DWR Date list box, scroll to and double-click 04/04/05. 
8. Click the OK button to the Read Only message. 
9. Click the Work Items folder tab. 

Now, let’s use the column headings to sort the Work Item list. 
10. Click the Description column heading. 
11. Click the Item Code column heading. 
12. Click the Instld column heading. 
13. Scroll to the bottom of the list to see the items that were reported 

installed on this DWR. 

Now, let’s use the Object Menu to sort. 
14. Position the pointer over the first record. 
15. Use the right-click button click the record.  
16. In the Object menu, click Sort. 
17. In the Sort Criteria window, click the Add button.  
18. In the Field drop-down list, click ProjectNumber 
19. Click the Add button, again. 
20. In the Field drop-down list, click Item Code. 
21. Click the OK button. 
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Finding 

When a window displays as a scrollable list, the Find choice allows the User to 
get to a specific row by selecting the appropriate value to find. 

 
The Find Criteria Window 

Figure 1-21 
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 Exercise 1-15 
In the following exercise, you will locate an item using the Find option.  

User ID: jj05754 Group: OSTAFF Contract: CNB022E 
1. Position the selection pointer over the first record in the list at the top 

of the window. 
2. Using the right mouse button, click the record. 
3. From the object menu, click the Find choice. SiteManager displays the 

Find Criteria window. 
4. On the Find Criteria window, click the Add button. 
5. In the Field drop-down list, click Item Code. 
6. In the Condition drop-down list, click =. 
7. In the Value field, type 712-06. 
8. Click the Add button. 
9. In the Field drop-down list, click ProjectNumber. 
10. In the Condition drop-down list, click =. 
11. In the Value field, type 55019-3220-94.  
12. Click the Find button.  

AND for 
different fields, 

OR for same 
field. 
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Filtering 

The Filter choice allows you to specify filtering criteria for SiteManager fields 
and their limiting values using relational operators. Each time a window 
displays, the filtering criteria, marked as default, is automatically applied, 
thereby limiting the amount of data retrieved. Only one default filter criterion 
can be in effect for a window at any given time. 

 
The Filter Criteria Window 

Figure 1-22 

“Like” will find 
the word LIME 
as a part of any 
phrase. 

Capitalization 
counts. 

If you move the 
mouse while 
right clicking, 
you will default 
to the Find 
window. 

% = wild card 
only available 
with ‘like.’ 
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 Exercise 1-16 
In the following exercise, you will learn how to filter to display only the records 
meeting your condition.  

User ID: jj05754 Group: OSTAFF Contract: CNB022E 

Now, let’s filter the contents of this list. 
1. Position the selection pointer over a record in the list at the top of the 

window.  
2. Using the right mouse button, click the record. 
3. From the object menu, click the Filter choice. SiteManager displays 

the Filter Criteria window. 
4. Click No to the Save Changes prompt. 
5. In the Filter Criteria window, click the Add button. 
6. In the Field drop-down list, click Description. 
7. In the Condition drop-down list, click Like. 
8. In the Value field, type %CONCRETE%. 
9. Click the OK button. 
10. When informed that the specified filter will return a number of rows, 

click the Ok button.  The Work Items window displays the filtered 
results. 

% characters 
are variables.  

This step may not 
be necessary. 
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Clearing the Current Criteria 

Remember that the current data retrieval choice will stay in effect until cleared. 
The Clear button removes the current data retrieval choice in effect by deleting 
all of the rows of criteria, which returns unfiltered results. 

 Exercise 1-17 
In the following exercise, you will clear the current filter. 

User ID: jj05754 Group: OSTAFF Contract: CNB022E 
1. Position the selection pointer over a record. 
2. Using the right mouse button, click the record. 
3. From the object menu, click the Filter choice. SiteManager displays 

the Filter Criteria window. 
4. In the Filter Criteria window, click the Clear button. 
5. Click the OK button. SiteManager displays a message. 
6. When informed that the specified filter will return a number of rows, 

click the OK button. The Work Items window displays all of the 
rows without filtering the results. 

7. Click Yes to the Filter Message. 
8. Click the Close button on the toolbar. 
9. Click the Main Panel folder tab. 

Always. 
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System Attachments 
The System Attachments window allows URL links, Plug-In applications, and OLE 
attachments to be attached the SiteManager system without being attached to 
specific records.  Plug in and OLE attachments are detailed in other sections of this 
training manual. 

 

The System Attachments Window  

Figure 1-23 

 
The CMS File Management System Attachment 

Figure 1-24 

 

 
In TDOT, URL links are included as System Attachments. 

The CMS Contract File Management attachment will open the File 
Management system.  The URL this attachment opens is as follows.  

\\jj00wf080\cms\ 

These are 
internet 
websites – you  
may need to 
connect to the 
internet to 
access them. 
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 Exercise 1-18 
In the following exercise, you will view System Attachments. 

User ID: jj05754 Group: OSTAFF 
1. On the Main Panel, double-click the Accessories icon.  
2. Double-click the System Attachments icon.  
3. In the System Attachments list box, scroll to and click CMS 

Contract File Management. 
 

The System Attachments are not set up for the training environment.   
 
4. Click the Close button.  
5. Click the Main Panel folder tab. 
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Support Resources 

The following Support Resources have been developed for AASHTO 
SiteManager. Contact your SiteManager System Administrator to verify your 
Transportation agency policies regarding the availability and distribution of this 
material. 

• User Manual (.pdf) 
• SiteManager On-line Help 
• Learning Guides 
• Training Database 
 

TDOT SiteManager Support Personnel 

Location Name Email Phone 

Region 1 Matt Douglas G.Matthew.Douglas@tn.gov (423) 907-7512 

Region 2 Gail Hollis Gail.Hollis@tn.gov (423) 949-9202 

Region 3 Gwen Ward Gwen.Ward@tn.gov (931) 684-0797 

Region 4 Dan Robinson Dan.Robinson@tn.gov (731) 935-0220 

HQ Chris Hampton Chris.Hampton@tn.gov (615) 741-3542 

 

In TDOT, electronic documentation and on-line training material can be 
obtained from Support Personnel or downloaded from 
www.tdot.state.tn.us/construction/SiteManager.htm. 

 

Printed 
Documentation  
and additional on-
line training 
material can be 
obtained from 
SiteManager 
Support 
Personnel as 
needed. 
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Using Help 

The Help menu will contain standard Help choices — Contents, Search for Help 
on, and Glossary and, when accessed while a window is open, will also provide 
one non-standard choice, Current Window. Help in SiteManager will work like 
any other Windows Help. 

Using Help by Contents 

The Help menu’s Contents choice or the Help button 
displays an alphabetized list of Help Topics that can 
be browsed for the subject on which you need help. 

 
Help Contents 

Figure 1-25 

 
Help Button 

Figure 1-26 
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 Exercise 1-19 
In the following exercise, you will access Help from the Help menu. 

User ID: jj05754 Group: OSTAFF  
1. On the Main Panel, click the Help menu. 
2. Click the Contents choice. SiteManager displays the AASHTO 

SiteManager Help window. 
3. On the Contents page, scroll to the Contracts Panel section and 

click the Contracts Description Folder Tab topic. 
4. Click the Status-Contract Description tab link. Help displays a 

pop-up window. 

Now, let’s exit online Help. 
5. To close the Help window, click the File menu and click the Exit 

choice. 
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Using Help by Searching 

The Search for Help on choice displays a lengthy, alphabetized list of Help 
Topics that can be browsed or searched for the subject on which you need help. 

 
The Help Search 

Figure 1-27 

 Exercise 1-20 
In the following exercise, you will search for a topic.  

User ID: jj05754 Group: OSTAFF 
1. Click the Help menu and click the Search for Help on choice.  
2. Click the Search button.  
3. Type stockpiled materials. 
4. Click the Stockpiled Materials Panel topic. 
5. Click the Display button. Help displays the requested topic. 
6. To close the help window, click the File menu and click the Exit choice. 

Search opens 
correctly in 
production. 
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Using the Current Window Help 

With any SiteManager window active, the Help menu’s Current Window choice 
will access context sensitive help that includes Help on fields. 

 
The Help on a SiteManager Window 

Figure 1-28 
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 Exercise 1-21 
In the following exercise, you will access Help on the current window. 

User ID: jj05754 Group: OSTAFF Contract: CNB022C 
1. On the Main Panel, double-click the Contract Administration 

icon. 
2. On the Contract Administration panel, double-click the Contract 

Records icon. 
3. On the Contract Records panel, double-click the Contracts icon.  

Now, let’s open another contract. 
4. Click the Open button. 
5. In the Contracts list box, scroll to and double-click Contract 

CNB022C. 
6. Click the Help menu and click the Current Window choice 
7. Click the Next Page (>>) button (right arrow at the bottom center of 

window). 
8. In the Contract Description tab Field Names and Descriptions 

section, click Contract ID – Contract Description tab. Help 
displays a pop-up window. 

Now, let’s exit online Help. 
9. Click the File menu and click the Exit choice. 

Now, let’s prepare for the next exercise. 
10. To close the Contracts window, click the Close button. 
11. Click the Main Panel folder tab. 

SM help is not 
TDOT specific. 

Read it or print 
it out. 

Ask – why did 
CNB022E open? 

Hot navigation 
since open ‘E’ 
DWR. 
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Viewing the User Manual 

The SiteManager User Reference Manual is a reference document for users of 
the AASHTO SiteManager application.  The user should refer to this manual 
only when a question cannot be answered by referring to the SiteManager online 
help system.  This manual describes all of the SiteManager components, 
including their purpose, functions, and how to use them. 

 
The User Reference Manual in PDF 

Figure 1-29 
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 Exercise 1-22 
In the following exercise, you will access the on-line User Reference Manual.  

User ID: jj05754 Group: OSTAFF  
1. On the Main Panel, double-click the Manuals icon. 
2. Double-click the User Manual icon. 
3. Click the Next Page button. (At the bottom, this looks like a triangle.) 
4. Click the page number field at the bottom of the screen. 
5. Type 25. 
6. Press Enter.  

Now, let’s search the reference manual. 
7. Click the Search button.  (In the toolbar, this looks like binoculars.) 
8. In the Search for field, type Temperature. 
9. Click the Search button. 
10. Click the first result. 
11. Click additional results to browse the topic. 

Now, let’s exit the application. 
12. Click the File menu. 
13. Click the Exit choice. 

Now, let’s prepare for the next exercise. 
14. Click the Main Panel folder tab. 

First result 
links to 
page 386.
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Standard SiteManager Reports 

Below is a list of the standard SiteManager Reports and the SiteManager panels 
they may be selected from. 

Contract Administration: 

• Contract Status  

• Item Quantity 

• Item Work Report 

• Subcontract Value 

• Contractor Current Status 

• Past History – Work Completion 

Contractor Payments:  

• Summary To Contractor  

• Installed Work 

• Work Suspend/Resume Times 

Change Orders:  

• Change Order Report 

• Unapproved Change Order Aging Report 

• Time Extension Granted  

• Change Order/Reason Code Breakdown 

 

TDOT has created several custom reports in Crystal Reports. The custom reports are run from a 
separate application accessed through the intranet. 

http://boe.tdot.state.tn.us/businessobjects/Enterprise115/InfoView/  

                                                      

  This is run from the Process List window. 
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General Reporting Concepts 
Most reports follow these procedures. The user initiates the report from the 
correct report window.  

 

The Installed Work Report 

Figure 1-30 

To view and print a displayed report: 
1. To view, click the Next Page or Prior Page icons. 
2. Click the Zoom button to reduce the Zoom. 
3. To print, click the Copies button, setting the desired number of 

copies to print. 
4. Click the File menu and click the Print choice. 

To Export a report: 
1. Run the report (saved reports may not be exported) 
2. Click the Services menu Export choice. 
3. In the File Name field, type the file name. 
4. In the Save as type drop-down list, select the type of file: Text, 

Excel, or Lotus 1-2-3. 
5. Click the Save button. 

A Report can be saved for later retrieval. SiteManager saves the report using a 
.PSR extension.  To save a report: 

1. On the toolbar, click the Save button. 
2. In the File Name field, type the name for the file. 
3. Change the drive and directory as desired. 
4. Click the Save button.  
5. In the message box, click the OK button. 
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The View Saved Reports icon can be used to open a saved report. To open a 
saved report: 

1. On the Reports panel, double-click the View Saved Reports (PSR) 
icon. 

2. Change the drive and directory as needed to select the PSR file. 
3. Click the OK button. 

 Exercise 1-23 
In the following exercise, you will access a standard report and save a copy of the 
report.  

User ID: jj05754 Group: OSTAFF Contract: CNB022K 
1. On the Main Panel, double-click the Contractor Payments icon. 
2. On the Contractor Payments panel, double-click the Reports icon. 
3. On the Reports panel, double-click the Installed Work icon. 

SiteManager displays the Report Criteria window. 
4. In the list box, scroll to and double-click the CNB022K choice. 
5. Review the Report.  

Now, let’s save the report to your computer. 
6. Click the Save button. 
7. In the C:\SMTRAINS directory, double-click the SMFILES folder. 
8. Type INWK_CNB022K20061025. 
9. Click the Save button. SiteManager displays a dialog box to inform 

you about exporting the file. 
10. In the dialog box, click the OK button. 
11. To close the Installed Work window, click the Close button. 

Now, let’s view the report you saved to your computer. 
12. On the Reports panel, double-click the View Saved Reports (PSR) 

icon. 
13. Double-click the INWK_CNB022K20061025.PSR file. 

SiteManager displays the View Saved Reports (PSR) window. 

Now, let’s prepare for the next exercise. 
14. Click the Close button. 
15. Click the Contractor Payments tab. 

This example 
demonstrates how 
users could save a 
copy of a SM 
standard report 
that updates in 
real time. If 
addressing a 
question, saving 
the report will 
provide the User 
with a reference 
of the data.

Do not click the 
Generate Off-line 
file or Generate 
Off-line Print 
check boxes.
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Running a Process 
The Process List window in the Contractor Payments panel includes the 
Summary to Contractor Report.  This is the only SiteManager Process that TDOT 
users will need to run. 

A process is run from the Process List window by clicking on the named process, 
and choosing Run Process from the Services menu, or by clicking the named 
process and clicking the Run Process button or by double-clicking the process. 

 

The Contractor Payments Process List window 

Figure 1-31 
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 Exercise 1-24 
In the following exercise, you will run a process. 

User ID: jj05754 Group: OSTAFF Contract: CNB022P 
1. On the Contractor Payments panel, double-click the Process List 

icon. 
2. In the Process List, double-click the Summary to Contractor 

report. SiteManager displays the Confirm Process Submission 
window. 

3. Click the Parameters button. SiteManager displays the Process 
Submission Parameters window. 

4. On the Process Submission Parameters window, click the Generate 
Online check box (ON). A warning will appear, noting that the latest 
RTF objects were not downloaded from the Object Store. 

5. On the warning message, click OK. 
6. On the Process Submission Parameters window, click OK. 

SiteManager closes the window. 
 

STOP. Do not submit the process in SiteManager Training.  
 
7. Click the Cancel Button 
8. Click the Close Button. 

 
A copy of the report is saved at C:\SMTRAINS\SMFILES to view during training.  
 
9. Right-click the Start button at the bottom left of the screen. 
10. Click the Explore choice. 
11. Navigate to the C:\SMTRAINS\SMFILES folder. 
12. Double-click Estimate Summary to Contractor CNB022P.htm. 
13. After viewing report, click the Close button to close the browser window. 
14. Click the Exit button to exit SiteManager. 

This tells SM to 
run on this 
machine rather 
than the Server.  
When this option 
is selected, the 
data is up to date 
as of the last Basic 
Contract Data 
download. 

The steps to 
run a process 
in production 
are in the 
Review. 
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Accessing TDOT Custom Reports 

When accessing the TDOT Custom reports, Office Staff users may pick from 
the available reports. 

 
TDOT Office Staff available reports window - page 1 

Figure 1-32 
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TDOT Office Staff available reports window - page 2 

Figure 1-33 

 

TDOT Custom Reports are accessed through the following web address: 

http://boe.tdot.state.tn.us/businessobjects/Enterprise115/InfoView/ 
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Review for Section 1 
To start SiteManager: 

1. Double-click the SiteManager desktop icon. 
Or 
1. Click the Start button, click the Program 

choice, click the SiteManager choice, and 
click the SiteManager choice.  

2. Type your logon identification name. 
3. Press the Tab key. 
4. Type your password. 
5. If appropriate in the Connect to drop-down 

list, click the expand arrow to the right of 
the current selection and click the desired 
database choice. 

6. Press Enter.  
7. If appropriate, in the Available Group for 

… dialog box, click the group ID. 

To select a main panel component of SiteManager: 

1. Double-click the component’s icon 

To select up or down a level in SiteManager: 

1. Click the level’s folder tab. 

To open more than one component of SiteManager: 

1. Open the first component of SiteManager. 
2. Click the SiteManager Panel button. 

Or 
Click the File menu and click the Main 
Panel choice. 

3. Open the other component of SiteManager. 

To tile: 

1. Open the number of SiteManager 
components that you want to tile. 

2. Click the Window menu. 
3. Click the Tile choice. 

To cascade: 

1. Open the number of SiteManager 
components that you want to cascade. 

2. Click the Window menu and click the 
Cascade choice. 

3. Click the visible portion of the window you 
want to display. 

To layer: 

1. Open the number of SiteManager 
components that you want to layer. 

2. Click the Window menu and click the 
Layer choice. 

To move between multiple layered SiteManager 
components: 

1. Click the Window menu. 
2. Click the name of the SiteManager 

component from the list. 

To close a SiteManager component: 

1. Click the Close button. 
Or 
1. Click the File menu and click the Close 

choice. 

To exit SiteManager: 

1. Click the Exit button. 
Or 
1. Click the File menu and click the Exit 

choice. 

To change your password: 

1. Start SiteManager. 
2. On the logon screen, type your existing 

password. 
3. Click the Change Password button. 
4. Type your old password. 
5. Press the Tab key. 
6. Type your new password. 
7. Press the Tab key. 
8. Type your new password, again. 
9. Click OK. 
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To open an existing record:  

1. Double-click the window’s icon. 
2. Click the Open button. 
3. Scroll to and click the desired record. 
4. Click OK  

To create a new record:  

1. Double-click the window’s icon. 
2. Click the New button. 

To choose keys after you enter a window:  

1. Click the Services menu and click the 
Choose Keys choice. 

2. In the list box, scroll to and double-click 
desired value. 

3. Repeat step 2 until all initial values are 
selected. 

To sort records: 

1. Click the desired sort field at the top of the 
list. 

Or 
1. Position the selection pointer over a record  
2. Using the right mouse button, click the 

record. 
3. From the object menu, click the Sort choice. 
4. Click the Add button. 
5. In the Field drop-down list, click the expand 

arrow to the right of the current selection 
and click the desired field. 

6. In the Order drop-down list, click the 
expand arrow to the right of the current 
selection and click the desired choice. 

7. To add additional sorts, click the Add 
button. 

8. Repeat steps 4-7 until you have selected all 
sorts. 

9. Click OK.  

To find specific records: 
1. Position the selection pointer over a record.  
2. Using the right mouse button, click the 

record. 
3. From the object menu, click the Find 

choice. 
4. Click the Add button. 
5. In the Field drop-down list, click the expand 

arrow to the right of the current selection 
and click the desired field. 

6. In the Condition drop-down list, click the 
expand arrow to the right of the current 
selection and click the desired choice. 

7. In the Value field, select the current entry 
and type the desired value. 

8. To add additional conditions, click the Add 
button. 

9. In the Join drop-down list, click the expand 
arrow to the right of the current selection 
and click the desired choice. 

10. Repeat steps 5-9 until you have selected all 
conditions. 

11. Click OK.  

To filter records: 

1. Position the selection pointer over a record  
2. Using the right mouse button, click the 

record. 
3. From the object menu, click the Filter 

choice. 
4. Click the Add button. 
5. In the Field drop-down list, click the expand 

arrow to the right of the current selection 
and click the desired field. 

6. In the Condition drop-down list, click the 
expand arrow to the right of the current 
selection and click the desired choice. 

7. In the Value field, select the current entry 
and type the desired value. 

8. To add additional conditions, click the Add 
button. 

9. In the Join drop-down list, click the expand 
arrow to the right of the current selection 
and click the desired choice. 

10. Repeat steps 5-9 until you have selected all 
conditions. 

11. Click OK.  
To clear a filter: 

1. Position the selection pointer over a record  
2. Using the right mouse button, click the 

record. 
3. From the object menu, click the Filter 

choice. 
4. Click the Clear button. 
5. Click OK.  
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To view System Attachments: 

1. Double click the Accessories icon. 
2. Double-click the System Attachments icon. 
3. Double-click the attachment you wish to 

run. 

To access Help by Contents: 

1. Click the Help menu and click the Contents 
choice. 
Or 
Click the Help button. 
Or 
In a SiteManager window, press the F1 key. 

2. In the topics list box, scroll to and click the 
desired topic. 

3. When finished, click the File menu and 
click the Exit choice. 

To access Help by searching: 

1. Click the Help menu and click the Search 
for Help on choice.  

2. Type the topic on which you need help. 
3. Click the topic. 
4. Click the Display button.  
5. When finished, click the File menu and 

click the Exit choice. 

To access Help on the current window: 

1. Display the SiteManager window for which 
you need help. 

2. Click the Help menu and click the Current 
Window choice. 

3. When finished, click the File menu and 
click the Exit choice. 

To access Help on a field: 

1. Display the SiteManager window that has 
the field for which you need help. 

2. Click the Help menu and click the Current 
Window choice. 

3. In the field list, scroll to and click the 
desired field. 

4. When finished, click the File menu and 
click the Exit choice. 

To access the User Manual documentation: 

1. On the Main Panel, double-click the 
Manuals icon.  

2. Double-click the User Manual icon. 

To generate any report: 

1. Double-click the desired report icon. 
2. Select the criteria. 
3. Click OK. 

To save a report: 

1. Click the Save button. 
2. Type the name for the file. 
3. Change the drive and directory as desired. 
4. Click Save. 
5. Click OK. 

To open a saved report: 

1. Double-click the View Saved Reports 
(PSR) icon on the Reports Tab. 

2. Change the drive and directory as needed. 
3. Select the PSR file. 
4. Click Open. 

To run a process: 

1. Navigate to the panel where the process is 
assigned. 

2. Double-click the Process List icon. 
3. In the process list, double-click the desired 

process. 
4. Click the Submit button. 

To access TDOT custom reports: 

1. Launch Internet Explorer.  
2. Access web address 

http://boe.tdot.state.tn.us/businessobjects/
Enterprise115/InfoView/  

3. Click the plus sign next to Public Folders.  
4. Click the plus sign next to SiteManager.  
5. Click the desired group name.  
6. Click the desired report name.  
7. Enter the desired prompt values.  
8. Click the OK button.  
9. Print or Save the report as appropriate.  
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Summary Exercise for Section 1 
In the following summary exercise, you will navigate through SiteManager. 

User ID: jj05754 Group: OSTAFF Contract: CNB022C 

1. Log into SiteManager as jj05754. 

2. Navigate to the Items window  
(Main Panel > Contract Administration > Contract Records > Items).  

3. Select the first project for Contract CNB022C, and then any of the available items. 

4. Are you in inquiry or update mode?  
___________________________________________________ 

5. Click the Close button to close the Items window.  

6. Navigate to the Item Master window  
(Main Panel > Contract Administration > Reference Tables > Item Master). 

7. Use the Find feature to find the Item Code 204-06 for Spec Year 2000.  

8. What is the Item Description? _____________________________ 

9. Filter for short description %CLEARING%. 

10. What is the first item retrieved? ____________________________ 

11. Clear the filter. 

12. Click the Close button to close the Item Master window.  

13. Navigate to the Milestones window (Contract Administration > Contract Records > Milestones). 

14. Access Help on the current window. 

15. Click the Close button to close the Milestones window. 

16. Navigate to the User Manual and find the Estimate Generation topic.  

17. Click the Close button to close the User Manual window.  

18. Navigate to the Contractor Payment Reports panel.   
(Main Panel > Contractor Payments > Reports) 

19. In Contractor Payment Reports, run an Installed Work Report for contract CNB022L. 

20. In Contractor Payments, navigate to the Process List. 

21. Exit SiteManager. 

INQUIRY 

BEDDING MATERIAL (PIPE) CLASS A 

201-01 Clearing and Grubbing 

Navigate means to close 
the window you are in 
and go to a different 
window 
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Learning Module 

 Section 2  Contract Activation 
for Office Documentation 

 

By the end of this module, you will be able to: 

VIEW A CONTRACT: 

• View an active Contract 

• Identify time charge types 

• View Contract Items 

• View TDOT Variable Add-on Items 

• Identify Add-on Items 

• View Contract Funding 

• View Subcontracts 

PREPARE A CONTRACT FOR THE FIELD: 

• Update Contract Master List 

• Grant Contract Authority to Field Staff 
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New Contracts 

This module describes the Contract information available to you through 
SiteManager’s windows and data entry fields. New Contracts are typically loaded 
electronically from the pre-construction system, PES and LAS, and given 
pending status by default.  

 

The Contract Records Panel 

Figure 2-1 

 

To begin tracking the progress of the Contract work in SiteManager, the 
Headquarters Finance Office will change the Contract’s status to active. 
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 Exercise 2-1 
In the following exercise, you will navigate to the Contracts window.  

User ID: jj05754  Group: OSTAFF Contract: CNB022C 

1. Double-click the SiteManager Training program icon on your desktop. 
2. In the User ID field, type jj05754. 
3. Press the Tab key. 
4. In the Password field, type pass. 
5. Press the Enter key. 
6. On the Main Panel folder tab, double-click the Contract 

Administration icon. 
7. On the Contract Administration folder tab, double-click the 

Contract Records icon. 
8. On the Contract Records panel, double-click the Contracts icon. 
9. In the Contract ID list box, scroll to and double-click Contract ID 

CNB022C. 

Shift-tab if user 
ID not 
highlighted. 
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Viewing a Contract  

The Description folder tab of the Contract window displays the basic Contract 
description data. This includes the Contract’s status, project number(s), 
administrative offices, and other descriptive information that determines how the 
system processes data for this Contract.  

Contract Time Charges 

In SiteManager, the three types of Time Charges for Contracts are: 

• Completion Date - Similar to TDOT “Calendar Days” contracts for non-
resurfacing and non-mowing contracts.  In SiteManager, TDOT Mowing, 
Litter Removal, and Sweeping & Drain cleaning contracts are Completion 
Date.    Time cannot be suspended on Completion Date Contracts. 

• Calendar Day - TDOT’s Resurfacing Contracts (Completion Date contracts 
with a working window) are Calendar Day in SiteManager, with a set 
number of bid days.  Time is started when the Notice to Proceed date is 
entered. Time cannot be suspended on Calendar Day Contracts. 

• Working Days (Available Days) - TDOT does not use at this time. 

 

The Description Folder Tab 

Figure 2-2 

In TDOT, Spec Yr 
field does NOT 
reference a spec 
book.  This field 
shows that the 
items are from the 
2000 Item Master. 
(2001 Item Master 
is Metric). 

Click the Remarks 
button for additional 
contract description 
information. 

In TDOT, all 
Contracts will 
show Federal in the 
Funding section. 

HQ Finance will 
activate if Fed 
Oversight 
Contract. Local 
Oversight will not 
be used.

All Contracts will 
show as Federal.  
This is NOT a 
true 
representation of 
the funding.  To 
view actual 
funding go to the 
Funding window. 
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In TDOT, most of the fields on the Contract window are loaded from PES 
and LAS and will not be modified in SiteManager except by the 
Headquarters Construction and Finance Offices. 

TDOT will primarily use the Completion Date Contract Time Charge type. 

 Exercise 2-2 
In the following exercise, you will view the description for Contract CNB022C.  

User ID: jj05754  Group: OSTAFF Contract: CNB022C 

1. What region and unit is this contract assigned to? 
_______________________________________________________ 

2. How is time calculated on this contract? ____________________________ 
3. What is the dollar value of this contract? ______________________ 

 

Region 4, Unit 042 

Completion Date 

$985.850.80 
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Viewing the Contract Location 

The Location folder tab displays the Contract location. Each Contract must have 
one county selected as the primary county.  

 

The Location Folder Tab 

Figure 2-3 

 Exercise 2-3 
In the following exercise, you will view the location for Contract CNB022C. 

User ID: jj05754  Group: OSTAFF Contract: CNB022C 

1. Click the Location folder tab. 
2. What is the Primary County of Contract CNB022C? 

_______________________________________________________ McNairy 
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Viewing Contract Payment Data 

The Payment Data folder tab can be used to automatically calculate common 
construction computations. 

 

The Payment Data Folder Tab 

Figure 2-4 

 

In TDOT, the functions of this window will not be used. 

 Exercise 2-4 
In the following exercise, you will view the payment data for Contract 
CNB022C.  

User ID: jj05754  Group: OSTAFF Contract: CNB022C 

1. Click the Payment Data folder tab. 

TDOT is not 
using Auto 
Liq. Dmg or 
any other 
function of 
this window. 
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Viewing Critical Dates 

The Critical Dates folder tab displays Critical Dates in the life of the contract. 
The Critical Date types were defined during system development and cannot be 
added or deleted. These dates are considered critical because SiteManager 
includes them in the standard Contract reports. When a new Contract is added 
from the pre-construction system, PES and LAS, SiteManager includes the 
Critical Date types defined in the Default Critical Date reference table. A few of 
the dates such as Letting Date come over from the pre-construction system.  

When an Actual Date is entered, the system can send notices to an individual 
recipient.  

In SiteManager, the Notice to Proceed Date is important because: 

• It must be entered before any Estimates may be generated 

• It starts charging time against the contract for Fixed Completion Date contracts 

Tip: The Notice to Proceed Date can only be entered when or after the 
Contract status is changed to active. Although the Notice to Proceed date is not 
required for Contract activation, it must be entered before any Estimates may be 
generated. 

 

The Critical Dates Folder Tab 

Figure 2-5 

In TDOT, the Critical Dates folder tab is updated by the Headquarters 
Construction and Finance Offices. 

In TDOT, the Notice to Proceed is updated by the Headquarters Finance 
Office when the Starting Notice Report is received from the Office Staff. 
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SiteManager  
Critical Date Name 

TDOT Term (if applicable) 
 

Accepted Date Final Inspection Date 

Adjusted Completion 
Date 

Prorata Date – The original completion date altered 
by a Change Order (Supplemental) plus time 
adjustment for item overruns/underruns. 

Assigned to FM Date N/A 

Award Date Award Date  

Checked Out to Field Date System populated when the contract is pipelined out 
to standalone. Changed back to zero when checked 
back in. 

Commissioner Approved 
Completion Date 

The original completion date altered by a Change 
Order (Supplemental). 

Contract Archived Date N/A 

Contractor Bankruptcy 
Date 

N/A 

Contractor Default Date N/A 

Contractor Final Release 
Date 

Claim Expiration Date (Advertisement Due Date) 

Execution Date Accepted Date  

Letting Date Letting Date 

Notice to Proceed Date Effective Date or Work Begin Date (whichever is 
earlier). Time charges start on this date.  For SP 
108B Resurfacing, this is the begin date or at least as 
early as the number of days required before the 
original completion date. 

Open to Traffic Date N/A 

Original Completion Date The completion date established by the contract. 

Price Adjustments Base 
Date 

Auto-populated with first day of letting’s month 
(even if no price adjustment exists) 

Physical Work Complete 
Date 

N/A 

Signed Date Signed Date 

Substantial Work 
complete date 

Date to Stop Charging Time (for Completion Date 
contracts) 

Work Begin Date Date Work Actually Began (Starting Notice) 

The TDOT Equivalents to Default Critical Dates 

Table 2-1 

Note Dates in 
bold text. 
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 Exercise 2-5 
In the following exercise, you will view the Actual Date of a Contract Critical 
Dates for Contract CNB022C.   

User ID: jj05754  Group: OSTAFF Contract: CNB022C 

1. Click the Critical Dates folder tab. 
2. In the Critical Date Description list box, scroll to and click Notice 

to Proceed Date. The data for the Notice to Proceed Date is 
displayed below the list. 

3. What is the Notice to Proceed date? ________________________ 
4. What is the Original Completion Date?______________________ 

Can do DWRs 
and Diaries 
without a 
Notice to 
Proceed Date, 
but you can’t 
generate an 
Estimate. 

09/15/05

04/15/05
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Viewing Contract Primary Personnel 

The Primary Personnel folder tab displays the Contract’s primary state personnel. 
Every Contract must have a Project Manager and a Project Engineer. When 
Users are designated as the Project Manager and Project Engineer on the 
Contract, SiteManager adds them to Contract Authority automatically. If primary 
personnel are later replaced, SiteManager starts Contract authority for the new 
personnel and ends Contract authority for the previous personnel. 

The terms Project Manager and Project Engineer are SiteManager terms and have 
no particular significance other than the fact that they are the first to receive 
Contract Authority. 

 

The Primary Personnel Folder Tab 

Figure 2-6 

 

At TDOT, the Headquarters Construction Office will enter the assigned 
Project Supervisor in both the Project Manager and Project Engineer field. 

 Exercise 2-6 
In the following exercise, you will view the Project Manager and Project 
Engineer assignments for Contract CNB022C.  

User ID: jj05754  Group: OSTAFF Contract: CNB022C 

1. Click the Primary Personnel folder tab. 
2. Who is the Project Supervisor for Contract CNB022C? 

_________________________________________________ 

When primary 
personnel are added 
or removed on this 
panel, the system 
adds or removes 
them on the 
Contract Authority 
panel automatically.

The User 
indicated here 
will receive 
system-
generated 
messages about 
the Contract. 

Tracy Johnson 

When a contract is 
Pending the 
Project Manager/ 
Engineer field 
would be blank or 
contain an “N”. 
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Viewing the Prime Contractor and Associates 

The Prime Contractor folder tab displays the Prime Contractor, the Prime 
Contacts, and the Prime Associates. At a minimum, SiteManager requires a 
Prime Contractor, Surety company, and Insurance company to be designated. 

 
The Prime Contractor Folder Tab 

Figure 2-7 

Since TDOT does not record an insurance company for the prime 
contractor, the placeholder value, SiteManager Generic Insurance, is 
substituted for a real value. TDOT will record actual associates for: 

• Bonding 
• Surety 

 Exercise 2-7 
In the following exercise, you will view the Prime Contractor’s surety and insurance 
companies for Contract CNB022C.  

User ID: jj05754  Group: OSTAFF Contract: CNB022C 

1. Click the Prime Contractor folder tab. 
2. Who is the Prime Contractor? _______________________ 
3. Who is the Bonding Company? 

_______________________________________________ 
4. Who is the Surety Company? 

_______________________________________________ American Casualty Co. of Reading, PA 

BB&T – Thornton & Harwell 
Consider showing 
the Address 
button.  

Volunteer Bridge Construction, Inc. 
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Viewing the DBE Commitment Goal 

The DBE Commit folder tab displays the DBE commitments for a Contract. If 
the Prime Contractor is a DBE, the User can also enter the DBE Work Class on 
this folder tab. The system calculates the DBE commitment amounts displayed 
on this folder tab using values entered on the Subcontracts panel.  

 

The DBE Commit Tab 

Figure 2-8 

 Exercise 2-8 
In the following exercise, you will view the DBE goal for Contract CNB022C.  

User ID: jj05754  Group: OSTAFF Contract: CNB022C 

1. Click the DBE Commit folder tab. 
2. What is the DBE Commitment Total Current Pct? ___________ 
3. Click the Close button. 

 

The Training Plan Folder Tab 

The Training Plan folder tab is grayed out because it is obsolete functionality 
deactivated by AASHTO. 

If the Contract has 
DBE commitments, 
this panel displays 
the Contract’s 
actual DBE 
commitment 
amounts, which are 
based on work 
done by 
Subcontractors.  

When you modify 
the DBE Goal 
Percent, the 
system 
recalculates the 
DBE Goal Value. 

2.97% 

There is not a 
DBE goal for 
this contract, 
but there is 
DBE 
participation 
as shown in 
the Total 
Current Pct 
field. 
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Viewing Contract Items 

The Items panel displays Items on the selected Contract and Project.  

 

The Items Window 

Figure 2-9 

In TDOT, items known as “add-on” items are added to the contract before it 
is assigned to the Region. These add-on items are the adjustment items 
appropriate for the items of that contract. Once the contract is activated, all 
additional items are added using the Change Order function, with the 
exception of the “add-on” items listed in the next section that are added by 
Headquarters Finance.  

Add-on Items will never have a Bid Quantity in the Contract Item window, 
because they are not bid on by the contractor. 

The Major Item Indicator will be checked for those items determined to be 
major items during the contract activation process.  

The Category field 
does not display 
properly in Inquiry 
mode. Since this is 
considered a minor 
issue, it will 
probably never be 
fixed. 

Does not represent 
“Spec Book Year.” 
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 Exercise 2-9 
In the following exercise, you will review an item.  

User ID: jj05754  Group: OSTAFF Contract: CNB022C 

1. On the Contract Records panel, double-click the Items icon. 
2. In the Project list box, scroll to and double-click PCN 55019-3220-

94. 
3. In the Contract Item list box, scroll to and double-click Category 

Nbr 0100, Line Nbr 0110, Item Code 307-01.01, Description 
Asphalt Concrete Mix (PG64-22). 

4. What is the Unit Price? ____________________________ 
5. What is the Bid Quantity? __________________________ 
6. Click the Open button.  
7. In the Contract Item list box, scroll to and double-click Category 

Nbr 0500, Line Nbr 0540, Item Code 620-03.10, Description 
Concrete Parapet. 

8. What is the Supplemental Description? 
________________________________________________ 

 
 

$39.00

546 

Leave window open 
for next exercise. 

(See Plans Description) 
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Viewing TDOT Variable Add-on Items per Specifications 

Referring to the tables below, if the Contract Item exists, then the corresponding 
item(s) listed below as Item(s) Automatically Added to Contract are added to the 
contract as “Add-on” items. The appropriate unit of measure and assigned unit 
price are also displayed for each item below. 

BID ITEM ON 
CONTRACT 

ITEM AUTOMATICALLY ADDED TO CONTRACT 
ITEM UNIT UNIT PRICE 

203-01 

203-01.03  ROAD & 
DRAINAGE ADD'L MATERIAL CUBIC YARD 203-01 PRICE X 150%  

203-05  UNDERCUTTING CUBIC YARD 203-01 PRICE X 150%  

204-02.01 

204-02.02  EXTRA DEPTH 
DRY EXCAVATION (A) CUBIC YARD 204-02.01 PRICE X 

150% 
204-02.03  EXTRA DEPTH 
DRY EXCAVATION (B) CUBIC YARD 204-02.01 PRICE X 

180% 

204-03.01 

204-03.02  EXTRA DEPTH 
WET EXCAVATION (A) CUBIC YARD 204-03.01 PRICE X 

150% 
204-03.03  EXTRA DEPTH 
WET EXCAVATION (B) CUBIC YARD 204-03.01 PRICE X 

180% 

204-04.01 

204-04.02  EXTRA DEPTH 
ROCK EXCAVATION (A) CUBIC YARD 204-04.01 PRICE X 

150% 
204-04.03  EXTRA DEPTH 
ROCK EXCAVATION (B) CUBIC YARD 204-04.01 PRICE X 

180% 

307 MIX ITEM 
307-03.20  PRICE 
ADJUSTMENT FOR AC 
CONTENT 

DOLLAR $1.00 

307 ASPHALT 
ITEM 

307-05.40  LIQUID ANTI-
STRIP AGENT PAYMENT DOLLAR $1.00 

307-05.41  HYDRATED LIME 
ANT-STRIP AGENT PAY DOLLAR $1.00 

307 OR 411 
ASPHALT 
ITEM 

407-07  DENSITY 
DEDUCTION DOLLAR $1.00 

407-09  A C CONTENT & 
GRADATION DEDECUTION DOLLAR $1.00 

411 MIX ITEM 
411-03.20  PRICE 
ADJUSTMENT FOR AC 
CONTENT 

DOLLAR $1.00 

411 ASPHALT 
ITEM 

411-03.40  MATERIAL 
VARIATION DEDUCTION DOLLAR $1.00 

411-05.40  LIQUID ANTI-
STRIP AGENT PAYMENT DOLLAR $1.00 

411-05.41  HYDRATED LIME 
ANT-STRIP AGENT PAY DOLLAR $1.00 

501 ITEM 501-05-03  PRICE ADJ FOR 
RIDEABILITY (CONCRETE) DOLLAR $1.00 

501-01.20, 
501-01.21 OR 

501-05-05  ADDL P'LAND 
CEMENT & CONC DOLLAR $1.00 

HQ adds these prior to 
Contract Activation. 

Only the items 
that apply to 
the contract 
items are added 
(all the items in 
this table are 
not 
automatically 
added if one of 
the items 
appears on the 
contract.  
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BID ITEM ON 
CONTRACT 

ITEM AUTOMATICALLY ADDED TO CONTRACT 
ITEM UNIT UNIT PRICE 

501-01.30 (ULTRATHIN) 

604-03.01 604-01.08  CLASS A CONC 
(FOUNDATION LEVELING)         CUBIC YARD 604-03.01 PRICE X  

40% 
CONCRETE 
ITEM 
(EXCLUDING 
501 ITEMS) 

604-22.50  DEFECTIVE 
CONCRETE  DOLLAR $1.00 

705-01.01 705-01.50  SHOP CURVED 
GRDRL @ BRIDGE ENDS LINEAR FEET 705-01.01 PRICE X 

125% 

705-12.02 705-01.51  SHOP CRV GRDRL 
@ BR END (LONG POST) LINEAR FEET 705-12.02 PRICE X 

125% 

705-02.02 705-02.50  SHOP CURVED 
GUARDRAIL LINEAR FEET 705-02.02 PRICE X 

150% 

705-02.03 705-02.51  SHOP CURVED 
GUARDRAIL (LONG POST) LINEAR FEET 705-02.03 PRICE X 

150% 
801-01 
WITHOUT 
801-02 

801-02  SEEDING WITHOUT 
MULCH UNIT 801-01 PRICE X 45% 

801-01 
WITHOUT 
801-06 

801-06  MULCH UNIT 801-01 PRICE X 60% 

TDOT Add-on Items per Specifications 

Table 2-2 
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TDOT Add-on Items (Before Contract is Activated) per Special Provisions 

The table below provides a list of “Add-on” items that may be added to a contract before 
the time of activation. 

Item Description Unit Measure 

105-02 FLAGGING ADJUSTMENT DOLLAR 

105-03 RAILROAD FLAGGING (DEDUCT) DOLLAR 

108-01.01 NO EXCUSE BONUS LUMP SUM 

108-07 LIQUIDATED DAMAGES DAY 

108-07.01 LIQUIDATED DAMAGES WEEK 

108-07.02 LIQUIDATED DAMAGES % 

108-08.01 LIQUIDATED DAMAGES (MOWING) DAY 

108-08.02 LIQUIDATED DAMAGES (LITTER) LINEAR MILE 

108-08.03 LIQUIDATED DAMAGES (SWEEPING) LINEAR MILE 

108-08.04 LIQUIDATED DAMAGES HOUR 

108-08.05 LIQUIDATED DAMAGES LANE 

108-08.06 LIQUIDATED DAMAGES WEEKEND 

108-08.07 LIQUIDATED DAMAGES 15 MINUTES 

108-08.08 LIQUIDATED DAMAGES 30 MINUTES 

108-08.09 LIQUIDATED DAMAGES EACH 

108-10.01 INCENTIVE PAYMENT DAY 

108-10.02 INCENTIVE PAYMENT DAY 

108-10.03 INCENTIVE PAYMENT DAY 

108-10.04 INCENTIVE PAYMENT DAY 

108-10.05 INCENTIVE PAYMENT DAY 

108-10.06 INCENTIVE PAYMENT DAY 

108-10.07 INCENTIVE PAYMENT DAY 

108-10.08 INCENTIVE PAYMENT DAY 

108-10.09 INCENTIVE PAYMENT DAY 

108-10.10 DISINCENTIVE PAYMENT DAY 

108-10.11 DISINCENTIVE PAYMENT DAY 

108-10.12 DISINCENTIVE PAYMENT DAY 

108-10.13 DISINCENTIVE PAYMENT DAY 

108-10.14 DISINCENTIVE PAYMENT DAY 

108-10.15 DISINCENTIVE PAYMENT DAY 

108-10.16 DISINCENTIVE PAYMENT DAY 

HQ adds 
these prior to 
Contract 
Activation. 
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Item Description Unit Measure 

108-10.17 DISINCENTIVE PAYMENT DAY 

108-10.18 DISINCENTIVE PAYMENT DAY 

108-10.19 DISINCENTIVE PAYMENT DAY 

108-10.20 DISINCENTIVE PAYMENT HOUR 

108-10.21 DISINCENTIVE PAYMENT HOUR 

108-10.22 DISINCENTIVE PAYMENT HOUR 

108-10.23 DISINCENTIVE PAYMENT HOUR 

108-10.24 DISINCENTIVE PAYMENT HOUR 

108-10.25 DISINCENTIVE PAYMENT HOUR 

108-10.26 DISINCENTIVE PAYMENT HOUR 

108-10.27 DISINCENTIVE PAYMENT HOUR 

108-10.28 DISINCENTIVE PAYMENT HOUR 

108-10.29 DISINCENTIVE PAYMENT HOUR 

108-10.30 INCENTIVE PAYMENT HOUR 

108-10.31 INCENTIVE PAYMENT HOUR 

108-10.32 INCENTIVE PAYMENT HOUR 

108-10.33 INCENTIVE PAYMENT HOUR 

108-10.34 INCENTIVE PAYMENT HOUR 

108-10.35 INCENTIVE PAYMENT HOUR 

108-10.36 INCENTIVE PAYMENT HOUR 

108-10.37 INCENTIVE PAYMENT HOUR 

108-10.38 INCENTIVE PAYMENT HOUR 

108-10.39 INCENTIVE PAYMENT HOUR 

108-10.40 INCENTIVE PAYMENT LUMP SUM 

108-10.41 INCENTIVE PAYMENT LUMP SUM 

108-10.42 INCENTIVE PAYMENT LUMP SUM 

108-10.43 INCENTIVE PAYMENT LUMP SUM 

108-10.44 INCENTIVE PAYMENT LUMP SUM 

108-10.45 INCENTIVE PAYMENT LUMP SUM 

108-10.46 INCENTIVE PAYMENT LUMP SUM 

108-10.47 INCENTIVE PAYMENT LUMP SUM 

108-10.48 INCENTIVE PAYMENT LUMP SUM 

108-10.49 INCENTIVE PAYMENT LUMP SUM 

108-10.50 INCENTIVE PAYMENT WEEKEND 
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Item Description Unit Measure 

108-10.51 INCENTIVE PAYMENT WEEKEND 

108-10.52 INCENTIVE PAYMENT WEEKEND 

108-10.53 INCENTIVE PAYMENT WEEKEND 

108-10.54 INCENTIVE PAYMENT WEEKEND 

108-10.55 INCENTIVE PAYMENT WEEKEND 

108-10.56 INCENTIVE PAYMENT WEEKEND 

108-10.57 INCENTIVE PAYMENT WEEKEND 

108-10.58 INCENTIVE PAYMENT WEEKEND 

108-10.59 INCENTIVE PAYMENT WEEKEND 

108-10.60 DISINCENTIVE PAYMENT WEEKEND 

108-10.61 DISINCENTIVE PAYMENT WEEKEND 

108-10.62 DISINCENTIVE PAYMENT WEEKEND 

108-10.63 DISINCENTIVE PAYMENT WEEKEND 

108-10.64 DISINCENTIVE PAYMENT WEEKEND 

108-10.65 DISINCENTIVE PAYMENT WEEKEND 

108-10.66 DISINCENTIVE PAYMENT WEEKEND 

108-10.67 DISINCENTIVE PAYMENT WEEKEND 

108-10.68 DISINCENTIVE PAYMENT WEEKEND 

108-10.69 DISINCENTIVE PAYMENT WEEKEND 

108-11 
ACCELERATED SCHEDULE INCENTIVE 
PAYMENT LUMP SUM 

109-01.01 PAYMENT ADJUSTMENT FOR FUEL DOLLAR 

109-01.02 
PAYMENT ADJUSTMENT FOR BITUMINOUS 
MATERIAL DOLLAR 

407-10 
ASPHALT CEMENT CONTENT & GRADATION 
DEDUCTION DOLLAR 

411-03.30 RIDEABILITY DEDUCTION DOLLAR 

411-03.32 RIDEABILITY (SPECIAL PROVISION 411B) DOLLAR 

602-04 STEEL INSPECTION COST DOLLAR 

604-22.50 DEFECTIVE CONCRETE DOLLAR 

604-23.01 RIDEABILITY DEDUCTION (BRIDGES) DOLLAR 

TDOT Add-on Items (Before Contract is Activated) per Special Provisions 

Table 2-3 
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TDOT Add-on Items (After Contract is Activated) per Specifications 

The table below provides a list of “Add-on” items that may be added to a contract after the 
contract is activated. 

Item Description Unit Measure 

108-09.01 DAMAGE TO STATE PROPERTY DOLLAR 

108-09-02 DAMAGE TO STATE PROPERTY DOLLAR 

108-09.03 DAMAGE TO STATE PROPERTY DOLLAR 

108-09.04 DAMAGE TO STATE PROPERTY DOLLAR 

108-09.05 DAMAGE TO STATE PROPERTY DOLLAR 

108-09.06 DAMAGE TO STATE PROPERTY DOLLAR 

108-09.07 DAMAGE TO STATE PROPERTY DOLLAR 

108-09.08 DAMAGE TO STATE PROPERTY DOLLAR 

108-09.09 DAMAGE TO STATE PROPERTY DOLLAR 

108-99 COST OF WORK DONE BY STATE FORCES DOLLAR 

109-05.01 ELIMINATED OR ALTERED ITEM DOLLAR 

109-05.02 ELIMINATED OR ALTERED ITEM DOLLAR 

109-05.03 ELIMINATED OR ALTERED ITEM DOLLAR 

109-05.04 ELIMINATED OR ALTERED ITEM DOLLAR 

109-05.05 ELIMINATED OR ALTERED ITEM DOLLAR 

109-05.06 ELIMINATED OR ALTERED ITEM DOLLAR 

109-05.07 ELIMINATED OR ALTERED ITEM DOLLAR 

109-05.08 ELIMINATED OR ALTERED ITEM DOLLAR 

109-05.09 ELIMINATED OR ALTERED ITEM DOLLAR 

501-05.01 
ADDITIONAL PORTLAND CEMENT CONCRETE 
(RAMP PAVING CUBIC YARD 

501-05.02 PRICE ADJUSTMENT FOR RIDEABILITY (%) SQUARE YARD 

501-05.04 THICKNESS DEFICIENCY (%) SQUARE YARD 

604-01.06 CLASS A CONCRETE ADJUSTMENT (INCREASE) CUBIC YARD 

604-01.07 CLASS A CONCRETE ADJUSTMENT (DECREASE) CUBIC YARD 

606-02.04 STEEL PILES (10 INCH)(CUT-OFFS) LINEAR FEET 

606-03.04 STEEL PILES (12 INCH)(CUT-OFFS) LINEAR FEET 

606-04.04 STEEL PILES (14 INCH)(CUT-OFFS) LINEAR FEET 

606-05.04 UNTREATED TIMBER PILES (SIZE 1)(CUT-OFFS) LINEAR FEET 

606-06.04 UNTREATED TIMBER PILES (SIZE 2)(CUT-OFFS) LINEAR FEET 

606-07.04 TREATED TIMBER PILES (SIZE 1)(CUT-OFFS) LINEAR FEET 

606-08.04 TREATED TIMBER PILES (SIZE 2)(CUT-OFFS) LINEAR FEET 

HQ adds 
these with 
Plug in 
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Item Description Unit Measure 

606-09.04 PRECAST CONCRETE PILES (SIZE 1)(CUT-OFFS) LINEAR FEET 

606-10.04 PRECAST CONCRETE PILES (SIZE 2)(CUT-OFFS) LINEAR FEET 

606-15.05 18" PRESTR CONC PILES (CUT-OFFS) LINEAR FEET 

606-16.04 STEEL PIPE PILES (10-INCH)(CUT-OFFS) LINEAR FEET 

606-17.04 STEEL PIPE PILES (12-INCH)(CUT-OFFS) LINEAR FEET 

606-18.04 STEEL PIPE PILES (14-INCH)(CUT-OFFS) LINEAR FEET 

606-19.04 STEEL PIPE PILES (16-INCH)(CUT-OFFS) LINEAR FEET 

606-20.04 STEEL PIPE PILES (18-INCH)(CUT-OFFS) LINEAR FEET 

606-20.40 STEEL PIPE PILES (CUT-OFFS) (SIZE) LINEAR FEET 

606-21.40 STEEL PIPE PILES (CUT-OFFS) (SIZE) LINEAR FEET 

606-23.02 STEEL PIPE PILES (24-INCH)(CUT-OFFS) LINEAR FEET 

619-01.02 
POLYMER MODIFIED CONC (VARIABLE DEPTH- 
TYPE 1) CUBIC YARD 

619-01.03 
POLYMER MODIFIED CONC (VARIABLE DEPTH- 
TYPE 3) CUBIC YARD 

TDOT Add-on Items (After Contract is Activated) Per Specifications 

Table 2-4 

 

In TDOT, Add-on items will be added by Headquarters Finance without a change 
order upon notification by Construction Field Office. 

In TDOT, the New Contract Change Order Item function is used to add new items not 
covered by standard specifications or special provisions. 

 Exercise 2-10 
In the following exercise, you will review an item.  

User ID: jj05754  Group: OSTAFF Contract: CNB022C 

1. Click the Open button on the toolbar. 
2. In the Contract Item list box, scroll to and double-click Category 

Nbr 0100, Line Nbr 9024, Item Code 109-01.01, Description PAY 
ADJUSTMENT FOR FUEL. 

3. What is the Unit Price? ____________________________ 
4. What is the Bid Quantity? __________________________ 
5. Click the Close button on the toolbar. 

$1.00

.000 
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Viewing Contract Funding 

The Contract Funding panel lets the User view funding for the whole Contract 
and for the Contract’s Projects, Categories, and Line Items. The Contract 
Funding panel lists the current funding specifications in the top datawindow. 
Data for the selected funding record is displayed in the bottom datawindow. If 
the User adds funding that does not match the funding selection on the Contract 
Description folder tab (i.e., Federal, State/Province, or Both), SiteManager 
automatically updates the Contract Description folder tab. 

Active Contracts must be fully funded. For any part of the Contract funded by 
multiple sources, the combined funding must equal 100%. If more than one 
priority level is assigned, the combined funding for each priority level must equal 
100%. In addition, each funding source can be assigned a Cap amount. When the 
highest priority funding source reaches its Cap amount, the funding source with 
the next highest priority continues the funding. If the lowest priority level fund 
has a Cap amount, the Cap amount will be ignored until a lower level fund is 
added. 

 

The Contract Funding Window 

Figure 2-10 

In TDOT, the Contract Funding window is loaded from PES and LAS.  

The Category Number identifies the funding source and must be given 
attention when recording work in a DWR. 

 

This screen 
shot shows a 
more complexly 
funded contract 
than the one we 
viewed in 
training. Direct 
students to look 
at this screen 
shot. 
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 Exercise 2-11 
In the following exercise, you will view the Contract Funding window for 
Contract CNB022E.  

User ID: jj05754  Group: OSTAFF Contract: CNB022C 

1. On the Contract Records panel, double-click the Contract 
Funding icon.  

2. Examine Figure 2-10 above. 
3. Click the Close button. 
4. Click the Main Panel folder tab.  
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Viewing a Subcontract 

The Subcontract panel lets the User add, modify, and delete Subcontracts and 
Subcontract data. The panel also displays calculated DBE commitment amounts. 
The User can define both parent Subcontracts and lower level Subcontracts. 

 

The Description Folder Tab 

Figure 2-11 

 

In TDOT, HQ Construction will load all Subcontracts into SiteManager and 
enter the approval date.  The field office will add the equipment and 
personnel to the subcontractor’s DWR Master List for the Contract. 

Subcontract Descriptions 

The User enters the Subcontractor and DBE commitments on the Description 
folder tab. To be selected as a Subcontractor, a Contractor must first be entered 
as a vendor in the Vendor reference tables. When a new Subcontract is saved, the 
system adds the Subcontract amount to the total amount of uncompleted work for 
the Subcontractor. This value is displayed on the Vendors panel in Reference 
Tables (CA). The Contract’s Prime Contractor cannot be selected as a 
Subcontractor on the Contract. 

The percentage of the Subcontract that can be counted towards the Contract’s 
DBE goal depends on the Subcontract’s level, the Subcontractor’s DBE status, 
and whether or not the Subcontract includes Items. A Parent Subcontract with a 
DBE Subcontractor and Items is always counted 100% towards the Contract’s 
DBE goal. If the Subcontract has no Items (i.e., the Subcontractor is a 
supplier/hauler), the User enters the percentage counted towards the DBE goal. 
For nested Subcontracts, if a higher-level DBE Subcontract is counted 100% 
towards the DBE goal, the percentage of the nested Subcontract is always zero. 

If a Subcontractor is 
not associated with 
contract items and 
approved, the 
Inspector will not be 
able to give the 
Subcontractor credit 
for installing work 
items on the Daily 
Work Report.  

Nested subcontracts 
happen when a 
subcontractor 
subcontracts part of 
the work to another 
subcontractor. 
Nested 
subcontractors are 
referred to as 2nd, 3rd, 
etc. Tier 
Subcontracts at 
TDOT. 

SiteManager 
defines 
“commitment” as 
DBE 
Commitment. 
Subcontracts that 
are not DBE are 
not included in 
the commitment 
data. 
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 Exercise 2-12 
In the following exercise, you will view a Subcontract description for contract 
CNB022C.  

User ID: jj05754  Group: OSTAFF Contract: CNB022C 

1. On the Main Panel, double-click the Contract Administration icon. 
2. On the Contract Administration panel, double-click the Contractor 

Management icon. 
3. On the Contractor Management panel, double-click the Subcontracts 

icon. 
4.  How many subcontracts are there for this contract? ________________ 
5.  How many subcontractors are DBE’s for this contract? _____________ 
6. In the Subcontract list box, scroll to and double-click Subcontract 

Number 01. 
7. What is the approval date for this subcontract? ____________________ 
8. Is this a “nested” subcontract? _________________________________ 

 

EIGHT 

04/15/05 

TWO 

No, because the parent subcontract field is blank. 
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Viewing Subcontract Items 

The Subcontract Items folder tab lets the User add, modify, and delete 
Subcontract Items. If the Subcontractor is a hauler or supplier only, the 
Subcontract will not have Items. If the Subcontract has no Items, the User must 
enter the Subcontract Amount manually. If the Subcontract has Items, the 
Subcontract Amount is the sum of all of the Item amounts and the User cannot 
modify it. 

 

The Items Folder Tab 

Figure 2-12 

 Exercise 2-13 
In the following exercise, you will view a Subcontract item for contract 
CNB022C.  

User ID: jj05754  Group: OSTAFF Contract: CNB022C 

1. Click the Items folder tab. 
2. How many items are on this subcontract? _____________________ 
3. What is the total quantity and dollar amount for Project 55019-3220-

94, Line Item 0110, Item Code 307-01.01, Short Description 
ASPHALT CONCRETE MIX (PG64-22). ___________________ 

 _______________________________________________________ 
4. Click the Close button. 

If a Subcontractor is 
associated with a 
contract but not 
qualified for the 
work item, the 
Inspector will not be 
able to give the 
Subcontractor credit 
for installing the 
work item on the 
Daily Work Report. 

Eight 

Qty: 546, Amount:  $19,847.10 
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Field Preparation Activities 

SiteManager has two modes – server and standalone. Standalone Users port 
contract data to their standalone database in order to perform field reporting 
using a function called Pipeline. All preliminary work that would affect their 
field reporting must be completed on the server before they pipeline the contract 
data to standalone. 

 

After the TDOT Headquarters Construction and Finance Offices have 
completed their contract activation activities and released the contract to 
the field office, the field office staff will perform two phases of activities to 
begin their use of the contract: 

• Field Preparation 

• Contract Initialization 

FIELD PREPARATION ACTIVITIES: 

These are the minimum activities that must occur to make it possible for the 
field office/inspection staff to complete field reporting. 

• Update Contract Master List 

• Grant Contract Authority to Field Staff, if necessary 

CONTRACT INITIALIZATION ACTIVITIES: 

Once the above activities have been performed, it is necessary for the field 
office staff to complete the additional contract initialization activities 
described in the next section of this training guide before the first estimate 
can be processed. 

These additional activities include: 

• Schedule Key Dates 

• Schedule Checklist Event Dates 

• Enter Work Start Date 
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Contract Master List 

The Contract Master List allows the active Equipment, Personnel Types, and 
Staff Members on the Vendor’s Master List to be associated to a specific 
Contract. The Vendor Master List data for the prime Contractor and any 
approved Subcontractors are available to associate with the Contract.  The 
Contract Master List controls the drop-down lists used in the DWR window to 
report daily Equipment, Personnel, and Staff presence at the Contract site. 

Contract Master Lists are created on the SiteManager server. For the content to 
be available in standalone, the Contract must be pipelined down before the data 
will be available in the drop-down lists for Equipment, Personnel Types, and 
TDOT Staff Members on the DWR. No change to Contract Master List content is 
permitted in standalone. 

TDOT will use the Contract Master List to associate the following for the 
Prime Contractor and Subcontractors on a Contract: 

• Equipment 

• Personnel 

• Staff Member (TDOT Staff) 

Equipment and Personnel will be associated for the Prime Contractor and 
all Subcontractors at the beginning of the project and for all additional 
subcontractors added throughout the life of the contract. 

Upon subcontract approval from HQ Construction an email notification will 
be sent to the designated Office Staff.  At this time equipment and personnel 
associations for the subcontractor shall be made. 

TDOT will not use the Supervisor Master List function. 

 

 Exercise 2-14 
In the following exercise, you will navigate to the Contract Master List.  

User ID: jj05754  Group: OSTAFF Contract: CNB022B 

1. Click the Main Panel folder tab. 
2. On the Main Panel, double-click the Daily Work Reports icon. 
3. On the Daily Work Reports panel, double-click the Reference Tables icon.  
4. On the Reference Tables panel, double-click the Contract Master List 

icon. 
5. On the Contract ID list box, scroll to and double-click CNB022B. 
6. On the Vendor list box, scroll to and double-click Volunteer Bridge 

Construction, Inc.  
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Associating Vendor Equipment with a Contract 

Only the active Equipment that has been added to the Vendor’s Master List may 
be associated with the Contract. 

 

The Equipment Window 

Figure 2-13 

 Exercise 2-15 
In the following exercise, you will associate a piece of equipment from a vendor’s 
master list to the Contract Master List.  

User ID: jj05754  Group: OSTAFF Contract: CNB022B 

1. Verify that the Equipment radio button has been selected.  
2. Click the Add All button to add all choices.   

Note all equipment options available from the Vendor Master List 
have been associated to the selected Vendor for the selected 
Contract. 

3. Click the Save button.  
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Associating Vendor Personnel Types with the Contract 

Only the active Personnel Types that have been added to the Vendor Master List 
may be associated with the Contract. 

 

The Personnel Window 

Figure 2-14 

 

In TDOT, Supervisor names will not be maintained in the Supervisor section 
of the Contract Master List function.  Instead, Supervisor types, such as 
Superintendent or Foreman, are included in the Personnel section.  

 Exercise 2-16 
In the following exercise, you will associate all personnel types from a Vendor 
Master List to the Contract Master List.  

User ID: jj05754  Group: OSTAFF Contract: CNB022B 

1. Click the Personnel radio button. 
2. Click the Add All button to add all choices.  Note all personnel types 

available from the Vendor Master List have been associated to the 
selected Vendor for the selected Contract. 

3. Click the Save button.  

Show students how to 
select a list of names 
to move by using the 
Shift key. 
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Associating Staff Members with the Contract 

Only the active Staff Members that have been added to the Vendor Master List 
may be associated with the Contract. 

 

The Staff Member Window  

Figure 2-15 

 

In TDOT, the SSN/ID field is an intelligent number. For example: 

• For a state employee, the SSN/ID would be similar to 4042000001 
if the employee is assigned to Region 4, Unit 42. (The first digit 
indicates the Region number and next three digits identify the Unit 
number.  The final digits are a sequence number.) 

• For a consultant, the SSN/ID would be similar to 6012000001. (The 
first digit indicates a consultant and the next three digits identify 
which consultant. The final digits are a sequence number.) 

Contact Regional Support to have staff members added to the list. 
 
Staff Members are associated to the contract only once during the life of 
the contract and may be associated to the Prime or an approved 
Subcontractor. 

 

To select multiple 
users in unit, click the 
first selection, hold 
down the Shift key 
and click the last 
desired user in the 
list, then click Add. 
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 Exercise 2-17 
In the following exercise, you will associate agency staff from a vendor’s master list 
to the Contract Master List.  

User ID: jj05754  Group: OSTAFF Contract: CNB022B 

1. Click the Staff Member radio button. 
2. On the left side of the window scroll in the Vender Master List and 

click 4042000001. 
3. Press and hold down the Shift key. 
4. Click 4042000016 (the last person for Unit 42 of Region 4). All of 

the people in Region 4, Unit 42 are highlighted. 
5. Click the Add button to add all selected choices from the Vendor list 

to the Contract Vendor list. 
6. Click the Save button.  



Trns•port SiteManager® Learning Guide Contract Master List 
Section 2  Contract Activation Contract Administration for Office Documentation 

 

 

90  

Contract Master List and Subcontractors 

In the Contract Master List, Equipment and Personnel types need to be added for 
each Subcontractor. 

Staff Members only need to be associated once and are added to the Prime 
Contractor’s Contract Master List. They are not added to the Subcontractor’s 
Contract Master List. 

 Exercise 2-18 
In the following exercise, you will add Equipment and Personnel types to the 
Contract Master List for a Subcontractor.  

User ID: jj05754  Group: OSTAFF Contract: CNB022C 

1. Click the Open button. 
2. Click the Contract ID button. 
3. Double click Contract ID CNB022C. 
4. On the Vendor list box, scroll to and double-click WMC 

Contracting Company, Inc. 
5. Click the Equipment radio button. 
4. Click the Add All button to add all choices. 
5. Click the Save button. 
6. Click the Personnel radio button. 
7. Click the Add All button to add all choices. 
8. Click the Save button. 
9. Click the Close button. 
10. Click the Main Panel folder tab. 

Because staff was 
already assigned for 
the contract, it is not 
necessary to repeat 
that association since 
it is not contractor 
specific. 
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Granting Contract Authority 

Contract Authority gives the User the authority to view or modify a specific 
Contract. Contract Authority works in conjunction with other security features. 
The User’s ability to add, modify, or delete Contract data also depends on the 
User’s group assignments, the office level assignment, and whether or not the 
User has global (Office-wide) Contract access. 

Adding Users to Contract Authority 

The Contract Authority window displays the Users, office-level assignments, 
global Contract access indicator, and group assignments for each individual User. 
When a Project Supervisor is added to the Contract, the system adds a row for 
each of the User’s group assignments to the Contract Authority window 
automatically. An authorized User can end Contract Authority for personnel no 
longer needed to work on the Contract by selecting the appropriate Contract 
Authority Assignment row for the User and then selecting End Contract 
Authority from the Services menu. 

 

The Contract Authority Window 

Figure 2-16 

 

In TDOT, all Unit staff members have office-wide access by default. Office-
Wide Access allows the user rights to all contracts in the assigned office. 
Contract authority may be given to Users in other Regions and Units as 
needed. 

Office-wide Contract authority can be removed by contacting Regional 
Support. Project Supervisors and Office Staff are able to assign and 
unassign contract authority.  

When granting 
Contract 
Authority to an 
Inspector, 
authority must be 
granted for both 
Inspector and 
Inspector –
Standalone 
groups. 
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Pipelining the Contract 

Master Lists and Contract Authority should ALWAYS precede Pipelining the 
Contract to Standalone mode. If field personnel inadvertently pipelined a contract 
before these two steps were done, they would have insufficient data in their 
SiteManager Standalone database to correctly perform their job on the work site. 

 Exercise 2-19 
In the following exercise, you will grant and end contract authority. 

User ID: jj05754  Group: OSTAFF Contract: CNB022C 

1. Double-click the Contract Administration icon.  
2. Double-click the Contract Records icon. 
3. Double-click the Contract Authority icon. The Contract Authority 

window opens. 
4. Scroll to and click the User ID jj05763, Miller, Chris.  
5. Click the New button. The New Contract Group Authority 

window opens. 
6. In the Group Description field, click the down arrow to the right of 

the field, and select INSP – Inspector. 
7. Right click in the Contract ID field to perform a search. 
8. Scroll to and click Contract CNB022C. 
9. Click OK. 
10. Click Save.  

Now, give this User ID authority in standalone for the same contract. 
11. Click the User ID jj05763, Miller, Chris. 
12. Click the New button. The New Contract Group Authority 

window opens. 
13. In the Group Description field, click the down arrow to the right of 

the field, and select INSPST – Inspector - Standalone. 
14. Right-click in the Contract ID field to perform a search. 
15. Scroll to and click CNB022C. 
16. Click OK. 
17. Click Save. 

Exercise will 
associate 
contract 
authority for an 
inspector that 
does not have 
office-wide 
contract 
authority. 
Presume this 
Inspector has 
office-wide 
access for a 
different office.

Stress 
importance! 
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Now, give another ID authority for a contract. 
18. Scroll to and click the User ID jj05764, Roberts, Jan. 
19. Click the New button. The New Contract Group Authority 

window opens. 
20. In the Group Description field, click the down arrow to the right of 

the field, and select INSP – Inspector. 
21. Right click in the Contract ID field to perform a search. 
22. Scroll to and click Contract CNB022C. 
23. Click OK. 
24. Click Save. 

Now, end contract authority for a user.  
25. Scroll to and click the User ID jj05764, Roberts, Jan. 
26. In the Contract Authority Assignment section, click Group 

Description Inspector for Contract ID CNB022C. 
27. Click the Services menu and then click End Contract Authority. 

The date and time that contract authority was ended is entered in the 
Authority End Dt field.  

28. Click the Close button. 

The remainder of 
this exercise is to 
demonstrate how to 
end contract 
authority. It can be 
skipped if need to 
maintain the time 
schedule.  
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Review for Section 2 
To open a contract from the Contracts window:  

1. On the Main Panel, double-click the 
Contract Administration icon. 

2. On the Contract Administration panel, 
double-click the Contract Records icon. 

3. On the Contract Records panel, double-
click the Contracts icon. The Contracts 
window opens. 

4. Click the Open button. The Select Contract 
list is displayed. 

5. In the Select Contract list box, scroll to and 
double-click the Contract ID or perform a 
Find. The Select Contract list closes and 
the Contracts window is displayed. 

To view a Contract’s description: 

1. Open a contract. 
2. On the Contracts window, click the 

Description folder tab. 

To view a Contract’s location: 

1. Open a contract. 
2. On the Contracts window, click the 

Location folder tab. 

To view a Contract’s payment data: 

1. Open a contract. 
2. On the Contracts window, click the 

Payment Data folder tab. 

To view the Actual Date of a Contract Critical Date: 

1. Open a contract. 
2. On the Contracts window, click the 

Critical Dates folder tab. 
3. In the Critical Date Description list box, 

scroll to and click the date. The data for the 
selected date is displayed in the area below 
the list. 

To view a Contract’s Primary Personnel: 

1. Open a contract. 
2. On the Contracts window, click the 

Primary Personnel folder tab. 

To view a Contract’s Prime Contractor: 

1. Open a contract. 
2. On the Contracts window, click the Prime 

Contractor folder tab. 

To view a Contract’s the DBE goal: 

1. Open a contract. 
2. On the Contracts window, click the DBE 

Commit folder tab. 

To view an Item on a Contract: 

1. On the Main Panel, double-click the 
Contract Administration icon. 

2. On the Contract Administration panel, 
double-click the Contract Records icon. 

3. On the Contract Records panel, double-
click the Items icon. The Items window 
opens. 

4. Click the Open button. 
5. In the Contract ID list box, scroll to and 

double-click the Contract. The Projects for 
the selected Contract are listed. 

6. In the Project list box, scroll to and click the 
Project. 

7. In the Contract Item list box, scroll to and 
click the Item. 

8. Click OK. The Items window opens and 
displays data for the selected Item. 

To view Contract Funding: 

1. On the Contract Records panel, double-
click the Funding icon.  

2. In the Contract ID list box, double-click the 
Contract.  

3. Click Ok.  

To view a Subcontract: 

1. On the Contractor Management panel, 
double-click the Subcontracts icon. The 
Subcontracts panel opens. 

2. Click the Open button. The Select Contract 
ID panel opens. 

3. In the Contract ID list box, scroll to and 
double-click the Contract. 

4. In the Subcontract list box, scroll to and 
click the Subcontract. 

5. Click OK. The panel displays data for the 
selected Subcontract.  
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To view an Item on a Subcontract: 

1. On the Contractor Management panel, 
double-click the Subcontracts icon. The 
Subcontracts panel opens. 

2. Click the Open button. The Select Contract 
ID panel opens. 

3. In the Contract ID list box, scroll to and 
double-click the Contract. 

4. In the Subcontract list box, scroll to and 
click the Subcontract. 

5. Click OK. The panel displays data for the 
selected Subcontract.  

6. Click the Items folder tab. 

To open the Contract Master List: 

1. On the Main Panel, double-click the Daily 
Work Reports icon. 

2. On the Daily Work Reports panel, double-
click the Reference Tables icon.  

3. On the Reference Tables panel, double-
click the Contract Master List icon. The 
Select Contract Vendor window appears. 

4. On the Contract ID list box, scroll to and 
double-click the desired Contract. 

5. On the Vendor list box, scroll to and 
double-click the desired Vendor. The 
Contract Master List window appears. 

To associate Vendor Master List Equipment to a 
Contract: 

1. Open the Contract Master List window. 
2. Click the Equipment radio button. 
3. Click the Add All button to add all of the 

Vendor Master List data. 
 
Or 
 
Click the desired choice and click the Add 
button to add that single choice. 

4. Click the Save button. 
5. Click the Close button. 

To associate Vendor Master List Personnel Types to a 
Contract: 

1. Open the Contract Master List window. 
2. Click the Personnel radio button. 
3. Click the Add All button to add all of the 

Vendor Master List data. 
 
Or 
 
Click the desired choice and click the Add 
button to add that single choice. 

4. Click the Save button. 
5. Click the Close button. 

To associate Staff Members to a Contract: 

1. Open the Contract Master List window. 
2. Click the Staff Member radio button. 
3. Click the Add All button to add all of the 

Vendor master list data. 
4. Click the Save button. 
5. Click the Close button. 

To add a User to Contract Authority: 

1. On the Main Panel, double-click the 
Contract Administration icon. 

2. On the Contract Administration panel, 
double-click the Contract Records icon.  

3. On the Contract Records panel, double-
click the Contract Authority icon. The 
Contract Authority window opens. 

4. Select the desired User ID. 
5. Click the New button. The New Contract 

Group Authority window opens. 
6. In the Group Description field, click the 

down arrow to the right of the field, and 
select the desired group.  

7. Type the Contract ID or use the Search 
function to select a specific Contract. 

8. Click the Save button. 

To end Contract Authority for a user: 

1. On the Main Panel, double-click the 
Contract Administration icon. 

2. On the Contract Administration panel, 
double-click the Contract Records icon.  

3. On the Contract Records panel, double-
click the Contract Authority icon. The 
Contract Authority window opens. 

4. Select the desired User ID. 
5. Select the desired contract authority 

assignment  
6. Click the Services menu and then click End 

Contract Authority.
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Summary Exercise for Section 2 
In the following exercise, you will view and prepare Contract CNB022D for the field.  

User ID: jj05754  Group: OSTAFF Contract: CNB022D 

1. Navigate to Contracts window. 

2. Open Contract ID CNB022D. 

3. What Region and Unit is the contract assigned to? ____________________________________ 

4. What is the Execution Date of the contract? _________________________________________ 

5. What is the bonding company? ___________________________________________________ 

6. Navigate to the Contract Item window. 

7. Open Contract CNB022D, Project 55019-3220-94, Category Nbr 0500, Line Nbr 0540, Item 
Code 620-03.10 Description CONCRETE PARAPET. 

8. Is the item an Add-on Item? _____________________________________________________ 

9. How can you tell? _____________________________________________________________ 

10. Navigate to the Contractor Management panel. 

11. Open the Subcontracts window.  For contract CNB022D, open Subcontract 07.  
• Who is the Subcontractor? ______________________________________________________ 
• Is the subcontractor a DBE? _______________________________________________ 
• Could the Subcontractor begin working? _____________________________________ 

12. Navigate to the Main Panel. 

13. Navigate to the Daily Work Reports panel and to the Reference Tables (DWR+) panel and 
open the Contract Master List window.  

14. For the prime contractor of Contract CNB022D, Volunteer Bridge, associate all the equipment, 
all the personnel, and the staff members for Region 4, Unit 42. 

15. For a subcontractor of your choice for Contract CNB022D, associate equipment and personnel. 

16. Navigate to the Contract Authority window. 

17. Give Jackie Warren and Sandy Gutierrez contract authority for both of their Group IDs 
(Inspector and Inspector Standalone) for Contract CNB022D. 

18. Navigate to the Contract Records panel. 

 

 

Region 4 Unit 042 

03/25/05 

BB&T – Thornton & Harwell 

No 

It has a Bid Quantity. An Add-on Item will never have a Bid Quantity. 

YES
NO- BLANK APPROVAL DATE 

LI Smith & Assoc. 
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Learning Module 

Section 3  Contract Initialization 
for Office Documentation 

 

By the end of this module, you will be able to: 

• Understand TDOT Region/Office Staff Contract Initialization 

Activities 

• Schedule Projected Dates for Key Dates 

• Update Actual Dates for Key Dates 

• Schedule Projected Dates for Checklist Events 

• Start a Milestone 
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Region/Office Staff Contract Initialization Activities 

After the TDOT Field Office Staff has completed its Field Preparation 
activities and released the contract to its field inspection staff so that field 
reporting can begin, additional contract initialization activities need to be 
performed before the first estimate can be processed. 

These activities are described in this section of this training guide. These 
activities include: 

• Schedule Key Dates 

• Schedule Checklist Event Dates 

• Enter the Work Start Key Date.   
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Dates in SiteManager 

Since dates are very important in the life of a highway construction contract, they 
are important in SiteManager.  Four of the most important types of dates in 
SiteManager are: 

• Critical Dates (of the Contract window) 

• Key Dates 

• Checklist Event Dates 

• Milestone Dates  

The first three, Critical Dates, Key Dates, and Checklist Events are very powerful 
because they can send SiteManager Inbox messages as reminders to an individual 
Recipient. 

 

The Standard Date Addressing and Message Objects of SiteManager 

Figure 3-1 

 
Date Type When the Message Is Sent Who the Message Is Sent To 
Critical Dates 
(Single 
Occurrence) 

When a value is entered in the 
Actual Date Field by a 
Headquarters user. 

In-box of the Recipient 
indicated. 

Key Date 
(Single 
Occurrence) 

When the Projected Date of 
the Key Date is reached before 
the Actual Date is entered. 

In-box of the user whose User 
ID is identified in the Project 
Manager field on the Primary 
Personnel folder tab of the 
Contract window. 

When a value is entered in the 
Actual Date Field by a User. 

In-box of Recipient indicated. 

Checklist Event 
Dates 
(May be used 
for multiple 
occurrences) 

When the Projected Date of 
the Checklist Event is reached 
before the Actual Date is 
entered. 

In-box of the Recipient 
indicated. 

Milestone When the Scheduled 
Completion Date is reached 
before the Actual Completion 
Date entered. 

Message appears in the 
Estimate Discrepancy 
window after estimate is 
generated for the period in 
which the milestone was 
missed. 

SiteManager Dates 

Table 3-1 

Critical Dates are 
not updated by 
field personnel. 

TDOT uses 
Recipients only 
and not 
Distribution Lists. 
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Key Dates and Checklist Events 

Key Dates and Checklist Events are the SiteManager components that let you 
establish and monitor a series of key dates and scheduled events. Key Dates and 
Checklist Events, although similar in functionality, are independent events.  

Key Dates are dates that are important when they occur and when they do not 
occur. Therefore, either a single recipient or the members of a distribution list are 
notified when a Key Date is accomplished and the Project Manager is notified 
when a Key Date is not accomplished by the projected date. A Key Date can be 
set up to be required either when the Contract is activated or when it is finalized. 
The User creates the Key Date schedule and records the actual occurrences of 
Key Dates on the Key Dates panel. 

Checklist Events are actions that are important when they do not occur. For 
Checklist Events that occur more than once or at regular intervals (e.g., monthly 
or weekly), the system tracks each occurrence. A Checklist Event can be set up to 
be required when the Contract is activated or finalized, or to cause a discrepancy 
when Estimates are generated. The user creates the Checklist Event schedule on 
the Checklist Scheduled Events panel. 

The Checklist Event Dates panel lets the user view the Checklist Event 
schedule, including multiple occurrences of each event, and provides a 
chronological history of the events. The user records the actual occurrences of 
the Checklist Events on this panel or, if the event is a document submitted by an 
external source, records the actual occurrences on the Document Submission 
panel. 

Notified when 
entered and if not 
entered. 

Notified if not 
entered by 
Projected Date

Two places for 
Checklist Events: 
1. You schedule 
2. You enter date 
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Scheduling Key Dates 

The Key Dates panel lists the Key Dates for the selected Contract in the top 
window. The data for the selected Key Date is displayed in the bottom window. 
The Key Date Types are pre-defined in the system code tables. SiteManager adds 
a set of default Key Dates automatically to each new Contract. The User creates 
the Key Date schedule and records the actual occurrence of Key Dates on this 
panel. The User can add, modify, and delete the Key Dates.  

 

 

The Key Dates Window 

Figure 3-2 

In TDOT, the Key Dates window is used by Office Staff to schedule 
projected dates and enter Actual Dates for Key Dates. 

All default Key Dates will appear for the Contract when the Contract is 
loaded into SiteManager.  As part of the Contract Activation process, the 
Office Staff personnel will perform the following functions:  

 Delete Key Dates that do not apply to the Contract 

 Enter the Projected Date for each Key Date 

 Enter the Actual Date for the Starting Notice Key Date 
 
In TDOT, the Notice to Proceed Date and Work Begin Date are updated by 
the Headquarters Finance Office upon receipt of the Starting Notice Report.  
Office Staff will enter the Starting Notice Key Date in SiteManager prior to 
generating this report. 

Until the Notice to Proceed Date is entered, field data collection can begin, 
but estimates cannot be generated. 
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Key Date Recipient Fed/ 
State 

Enters Date Comment 

Starting Notice Project 
Supervisor  
designee 

Both Office Staff Projected Date = Effective Date. Used to 
generate the Starting Notice report which 
notifies HQ Finance to fill in the Notice to 
Proceed and Work Begin Dates (from 
Critical Dates) 

Final Inspection 
Request 

Regional 
Construction 
Supervisor 

Both Office Staff Projected Date = Adjusted Completion Date 
(from Critical Dates). 
Contract ready for final inspection. 

Final Inspection Project 
Supervisor  
designee 

Both Office Staff Projected Date = Adjusted Completion Date 
(from Critical Dates). 
Final Inspection completed this date as 
inspected and Accepted Date. 

CC-3 Project 
Supervisor  
designee 

Fed Office Staff Projected Date = Adjusted Completion Date 
(from Critical Dates) 
All CC-3’s have been received. 

Notice of 
Termination 

Project 
Supervisor  
designee 

Both Office Staff Projected Date = Adjusted Completion Date 
(from Critical Dates). 
NOT form complete.  
Submit Field Office Completion Notice 
Report. 

Completion 
Notice (Date 
Time Stopped) 

Project 
Supervisor 

Both Office Staff Projected Date = Adjusted Completion Date 
(from Critical Dates) 
Time charges have been stopped.  The final 
inspection and all exceptions are complete.  

Final Records 
Submittal 

Project 
Supervisor  
designee 

Both Office Staff Projected Date = Adjusted Completion Date 
(from Critical Dates) 
Project Records have been submitted to 
Final Records.  

DT1696 
Materials and 
Tests 
Certification 

Project 
Supervisor  
designee 

Both Office Staff Projected Date = Adjusted Completion Date 
(from Critical Dates). 
DT1696 Materials and Tests certification 
submitted to Regional Materials and Tests. 

TDOT Default Key Dates 

Table 3-2 
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 Exercise 3-1 

In the following exercise, you will delete an unnecessary key date record and 
schedule the Key Dates for contract CNB022C.  

User ID: jj05754  Group: OSTAFF Contract: CNB022C 

1. On the Contract Records panel, double-click the Key Dates icon. 
2. In the Contract ID list box, scroll to and double-click contract 

CNB0022C. 
Now, let’s first delete an unnecessary key date record. 

3. In the Key Date Type list, click CC-3. 
4. On the toolbar, click the Delete button. SiteManager prompts you to 

confirm the deletion. 
5. In the message, click the Yes button. 

Now, let’s update another key date record. 
6. In the Key Date Type list, click Starting Notice. 
7. In the Projected Date field, type 041505. 
8. In the Actual Date field, type 040105. 
9. In the Recipient field, perform a Search and double-click jj05753 

Johnson, Tracy.  
10. Click the Save button. 

Now, let’s update another key date record. 
11. In the Key Date Type list, click Completion Notice (Date Time 

Stopped). 
12. In the Projected Date field, type 111505. 
13. In the Recipient field, perform a Search and double-click jj05753 

Johnson, Tracy. 
14. Click the Save button. 
15. Why are we entering a Projected Date for this Event? 

______________________________________________________ 
______________________________________________________ 

16. Click the Save button. 
17. Click the Close button. 

So that a notice will go to the Project Supervisor if the Actual Date is not entered on 
or before 11/16/05. 
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Schedule Checklist Event Projected Dates 

The Checklist Scheduled Events panel lists the scheduled events for the selected 
Contract. The data for the event selected in the top window is displayed in the 
bottom window. The Event Types are pre-defined in the system code tables. 
SiteManager adds a set of default Checklist Events automatically to each new 
Contract. The User creates the Checklist Event schedule on this panel. The User 
can add, modify, and delete the Checklist Events. For example:  

• A checklist event can be added when the event type needed is not listed.  

• An unneeded checklist event can be deleted.  

• An existing checklist event can be changed, for example, the frequency 
of the event could be modified. 

When an event is scheduled on this panel, a subsequent batch process creates a 
record for each projected date. After the batch process runs, the User can record 
the Actual Date of each occurrence of an event on either the Checklist Event 
Dates panel or the Document Submission panel, depending on the event. The 
batch process and/or an Estimate discrepancy may notify the recipient(s) when a 
Checklist Event is overdue. 

 

The Checklist Scheduled Events Window 

Figure 3-3 

Recipients are 
notified when a 
Scheduled Event 
does not occur on 
time. 

To stop exceptions 
on jobs after work 
is complete, but 
before the final 
estimate has been 
run, refer to 
“Reviewing and 
Resolving Estimate 
Discrepancies” of 
Section 13, 
“Contract 
Finalization.” 
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In TDOT, the Checklist Scheduled Events window is used by Office Staff to create the checklist event 
schedule. 

All default checklist events will appear for the Contract when the Contract is loaded into SiteManager.  
During Contract Activation process, the Office Staff personnel will perform the following functions: 

• Delete Checklist Event Dates that do not apply for the Contract.  
• Enter the Next Projected Date for every event. If nothing is entered, SiteManager will enter the 

next logical date after the Notice to Proceed Date. A Next Projected Date should be entered for all 
Checklist events.  

• Enter the Number of Occurrences as 999 for monthly and quarterly. 
• Enter the appropriate recipient.  

A night process that runs automatically, the Contract Status Monitor process, will automatically populate 
the correct number of Checklist Events, but it needs a starting point – the Next Projected Date.  

 

Checklist 
Event 

Event Group 
Type 

Frequency Recipient Who 
Enters 

Next Date 

Comment 

Attestation for 
Illegal 
Immigrants 

Contractor 
Management 

Semi-
Annually 

Project 
Supervisor 
designee 

Office Staff Next Projected Date = First day of the 
applicable event month (January 01 or 
July 01) 

Contractor’s 
Employee 
Interview 

Civil Rights Monthly Project 
Supervisor 
designee 

Office Staff Next Projected Date = First day of the 
month of the Effective Date 

Contractor’s 
Payrolls 

Contractor 
Management 

Monthly Project 
Supervisor 
designee 

Office Staff Next Projected Date = First day of the 
month of the Effective Date 

Contractor 
ESHP Cert – CL 
107-01.01 

Contractor 
Management 

One Time 
Only 

Project 
Supervisor 
designee 

Office Staff Next Projected Date = Effective Date of 
the Contract 

Contractor 
Performance 
Evaluation 

Contractor 
Management 

Annually Project 
Supervisor 
designee 

Office Staff Next Projected Date = First day of the 
applicable event month (end of year or 
completion of project) 

Critical Path 
Method SP105A 

Contractor 
Management 

90 Days Project 
Supervisor 
designee 

Office Staff Next Projected Date = Effective Date 

DBE Signed 
Subcontract(s) 
on File 

Civil Rights One Time 
Only 
 

Project 
Supervisor 
designee 

Office Staff Next Projected Date = Effective Date 
Change the “Frequency Type” field from 
“One Time Only” to anything else (e.g. 
Weekly). Enter “1” in the “Number of 
Occurrences” field, change the 
“Frequency Type” to “One Time Only,” 
and proceed.  

On the Job 
Training 

Civil Rights One Time 
Only 

Project 
Supervisor 
designee 

Office Staff Next Projected Date = Effective Date 

Prompt Payment 
to 
Subcontractors 

Contractor 
Management 

Monthly Project 
Supervisor 
designee 

Office Staff Next Projected Date = First day of the 
second month following the Effective 
Date 
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Checklist 
Event 

Event Group 
Type 

Frequency Recipient Who 
Enters 

Next Date 

Comment 

Storm Water 
Inspection 
Certification 

Environmental Quarterly Project 
Supervisor 
designee 

Inspector Next Projected Date = First day of the 
applicable event month (January 01, April 
01, July 01, or October 01) 

Traffic Control 
Checklist 

Safety Monthly Project 
Supervisor 
designee 

Inspector Next Projected Date = First day of the 
month following the Effective Date 

The TDOT Default Checklist Events 

Table 3-3 

 Exercise 3-2 

In the following exercise, you will schedule the Checklist Events for contract 
CNB022C.  

User ID: jj05754  Group: OSTAFF Contract: CNB022C 

1. On the Contract Records panel, double-click the Checklist 
Scheduled Events icon. 

2. In the Checklist Scheduled Events window, in the Event Type 
column, click DBE Signed Subcontract(s) on File. 

3. In the Next Proj Date field, type 050105.  
4. In the Frequency Type drop-down list, click the expand arrow and 

click Quarterly. 
5. In the Number of Occurrences field, type 1. 
6. In the Frequency Type drop-down list, click the expand arrow and 

click One Time Only. 
7. Using the right mouse button, click the Recipient field. 
8. From the object menu, click the Search choice. 
9. In the list box, scroll to and click jj05753 Johnson, Tracy. 
10. Click the OK button. 
11. Click the Save button. 

Now let’s schedule an additional checklist event. 
12. In the Checklist Scheduled Events window, in the Event Type 

column, scroll to and click Contractor Employee Interview. 
13. In the Next Proj Date field, type 050105. 
14. In the Number of Occurrences field, type 999. 
15. Using the right mouse button, click the Recipient field. 
16. From the object menu, click the Search choice. 

Steps 4-6 demonstrate the 
work around for One Time 
Only Checklist Events.  

If Nbr of Occurrences field is 
grey, change the Frequency 
Type to another value, 
modify the Number of 
Occurrences and then change 
the Frequency Type back to 
its original value.  
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17. In the list box, scroll to and click jj05753 Johnson, Tracy. 
18. Click the OK button. 
19. Click the Save button. 

Now let’s schedule an additional checklist event. 
20. In the Checklist Scheduled Events window, in the Event Type 

column, scroll to and click Prompt Payment to Subcontractors. 
21. In the Next Proj Date field, type 050105. 
22. In the Number of Occurrences field, type 999. 
23. Using the right mouse button, click the Recipient field. 
24. From the object menu, click the Search choice. 
25. In the list box, scroll to and click jj05753 Johnson, Tracy. 
26. Click the OK button. 
27. Click the Save button. 

Now let’s schedule an additional checklist event. 
28. In the Checklist Scheduled Events window, in the Event Type 

column, scroll to and click Storm Water Inspection Report. 
29. In the Next Proj Date field, type 050105. 
30. In the Number of Occurrences field, type 999. 
31. Using the right mouse button, click the Recipient field. 
32. From the object menu, click the Search choice. 
33. In the list box, scroll to and click jj05753 Johnson, Tracy. 
34. Click the OK button. 
35. Click the Save button. 

Now let’s schedule an additional checklist event. 
36. In the Checklist Scheduled Events window, in the Event Type 

column, scroll to and click Traffic Control Checklist. 
37. In the Next Proj Date field, type 050105. 
38. In the Number of Occurrences field, type 999. 
39. Using the right mouse button, click the Recipient field. 
40. From the object menu, click the Search choice. 
41. In the list box, scroll to and click jj05753 Johnson, Tracy. 
42. Click the OK button. 
43. Click the Save button. 
44. Click the Close button. 
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Starting a Milestone 

The Milestones window lets the User modify and delete Contract Milestones. 
Office Staff also enters the dates the milestone work was started and completed. 

TDOT is using this window as a record keeping of days charged for 
milestones. Liquidated Damages are to be assessed under the 
appropriate pay item. 

 

Milestone Time Charges 

In SiteManager, the three types of Milestone Time Charges for Contracts are: 

• Calendar Day and/or Completion Date Milestone:  These types of 
Milestones require the “Work Start” date and “Actual Completion” date 
be entered.  There will be no charge on the Diary Window Charge Tab 
for these types of Milestones. 

• Working Days (Available Days) –These types of Milestones require the 
“Work Start” date and “Actual Completion” date be entered.  It will also 
require days to be charged on the Diary Window Charge Tab for these 
types of Milestones.   
 
(Mowing Cycles will be the only Milestones using milestone “type” 
Working Days.) 
 
 

 

The Milestones Window 

Figure 3-4

TDOT calls these ‘incentives,’ 
‘goals,’ or ‘phased 
construction.’ 
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In TDOT, HQ Finance will create Milestones. Original Completion Date 
only applies to litter cycle milestones.  Office Staff will start Milestones by 
entering the Milestone Work Start Date.  Milestones are used for such things 
as phased construction and mowing and litter cycle. 

TDOT will not auto generate disincentives or incentives.  These are applied 
with pay items.  The Milestones window is used as supporting 
documentation for these pay items. 

 Exercise 3-3 
In the following exercise, you will create and start Milestones for contract 
CNB022C.  

User ID: jj05754  Group: OSTAFF  Contract: CNB022C 

1. On the Contract Records panel, double-click the Milestones icon. 
The Milestones window opens. 

 
For Office Staff to start milestones, HQ Finance must first create the milestones. 
In this version of training, please perform the following steps to create 
milestones as HQ Finance would. 
 
Now, let’s create milestones.  

2. In the Description field, type Bridge over Lick Creek Reopen for 
Traffic. 

3. In the Time Charges drop-down list, click the expand arrow and 
click Completion Date. 

4. In the Rate Time Period drop-down list, click the expand arrow and 
click Days. 

5. In the Original Milestone Compl Date field, type 10/15/05. 
6. Click the Save button. The system enters the next sequential 

Milestone Number for the new Milestone. 
7. Click the New button. An empty row is inserted in the Milestone list 

box. 
8. In the Description field, type Bridge over Little Owl Creek 

Reopen for Traffic. 
9. In the Time Charges drop-down list, click the expand arrow and 

click Completion Date. 
10. In the Rate Time Period drop-down list, click the expand arrow and 

click Days. 
11. In the Original Milestone Compl Date field, type 10/15/05. 
12. Click the Save button. The system enters the next sequential 

Milestone Number for the new Milestone. 

Tab to the 
Description field to 
type data. 

Steps 2-12 will be 
completed by HQ 
Finance in 
production, but 
Office Staff must 
complete in 
training. 
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Now, let’s start the Milestones. 
13. Click Milestone 01. 
14. In the Work Start field for Milestone 01, type 041505. 
15. Click Milestone 02. 
16. In the Work Start field for Milestone 02, type 041505. 
17. Click the Save button. 
18. Click the Close button. 
19. Click the Contract Administration folder tab. 
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Review for Section 3 
To schedule a Checklist Event: 

1. On the Contract Records panel, double-
click the Checklist Scheduled Events icon. 

2. In the Event Group Type drop-down list, 
click the event group type. 

3. In the Frequency Type drop-down list, 
click the frequency type. If the frequency 
type is either monthly, weekly, or bi-weekly, 
the Event Day field is enabled. 

4. If the Event Day field is enabled, type the 
corresponding day of the week (2-6) or day 
of the month (1-31). 

5. In the Milestone No. drop-down list, click 
the milestone to associate with this 
scheduled event. 

6. In the Next Proj Date field, type the next 
date this scheduled event is expected to 
occur. 

7. If the event must occur before the Contract 
status can be changed to Active, click the 
Required to Activate check box (ON).  

8. In the Nbr of Occurrences field, type 
number of times this scheduled event will 
occur. 

9. To generate a discrepancy if the event has 
not occurred by the time of Estimate 
generation, click the Discrepancy check box 
(ON). 

10. If the event is a document, in the Required 
Doc Type drop-down list, click the required 
document type. 

11. If the required document is expected from 
an external source, click the External 
Indicator check box (ON). 

OR 

12. Press the Tab key. 

13. In the Message Text field, type a short 
message that is sent to the Distribution List 
or Recipient when the scheduled event 
Actual Date is not completed by the Next 
Projected Date. 

14. Click the Save button. 

To schedule a Key Date: 

1. On the Contract Records panel, double-
click the Key Dates icon. 

2. Click the desired Key Date Type.  

3. In the Projected Date field, type the date 
the key date event is expected to be 
completed. 

4. If this Key Date must occur before the 
Contract status can be changed to Active, 
click the Required to Activate check box 
(ON). 

5. If this Key Date is to be part of the Contract 
finalization process, click the Required to 
Finalize check box (ON). 

OR 

6. In the Message field, type a short notice that 
will be sent to the Distribution List or 
Recipient when the Actual Date is entered. 

7. Click the Save button. 
 

To delete a Key Date: 

1. On the Contract Records panel, double-
click the Key Dates icon. 

2. Click the desired Key Date Type.  

3. Click the Delete button.  

4. Click the Yes button.  

5. Click Save.  

 

To start a Milestone: 

1. On the Contract Records panel, double-
click the Milestones icon. The Milestone 
panel opens and the Select Contract 
window is displayed. 

2. In the Contract ID list box, scroll to and 
double-click the Contract. The Milestones 
for the selected Contract are displayed. 

3. In the Milestone list box, scroll to and 
double click the Milestone. 

4. In the Work Start field, type the date the 
Milestone work began. 

5. Click the Save button.
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Summary Exercise for Section 3 
In the following exercise, you will perform Contract initialization activities on Contract CNB022D.  

User ID: jj05754  Group: OSTAFF Contract: CNB022D 

1. Navigate to the Contract Records panel. 

2. Navigate to the Key Dates window and enter the following for Contract CNB022D: 

• For Starting Notice Date Type, enter a projected date of 04/15/05.  
• For Starting Notice Date Type, enter an actual date of 04/01/05.  
• For the Starting Notice’s Recipient, search and select jj05753 Johnson, Tracy.   

3. Navigate to the Checklist Scheduled Events window for Contract CNB022D.  

• Select the DBE Signed Subcontract(s).  
• Enter 04/15/05 as the Next Projected Date.  
• Select jj05753 Johnson, Tracy. 

4. Open the Milestones window and enter the following for Contract CNB022D: 

• For Milestone 01, enter a Start Date of 04/15/05.  
• For Milestone 02, enter a Start Date of 04/15/05.  

5. Navigate to the Main Panel.  
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Learning Module 

Section 4  Maintaining Contracts 
for Office Documentation 

 

By the end of this module, you will be able to: 
• Record the Actual Date of a Checklist Scheduled Event 

• Add Stockpile Materials 

• Replenish a Stockpile 

• Close a Stockpile 
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Recording Checklist Event Dates 
The Checklist Event Dates panel lists the scheduled events for the selected 
Contract. The data for the event selected in the top datawindow is displayed in 
the bottom datawindow. The data shows a chronological history of each 
occurrence of a repetitive scheduled event, and the Actual Date recorded by the 
User for each occurrence. This panel lets the User record the actual dates of the 
Checklist Scheduled Events, and add or delete Checklist Event Date records.  
 

 
The Checklist Event Dates Window 

Figure 4-1 
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  Exercise 4-1 
In the following exercise, you will record the Actual Date of a Checklist Event 
for contract CNB022E.  

User ID: jj05754  Group: OSTAFF Contract: CNB022E 

1. On the Main Panel, double-click the Contract Administration icon. 
2. On the Contract Administration panel, double-click the Contract 

Records icon. 
3. On the Contract Records panel, double-click the Checklist Event 

Dates icon.  
4. In the Checklist Event Dates window, click the Open button. 
5. In the Contract ID list box, scroll to and double-click Contract 

CNB022E. SiteManager displays the Checklist Event Dates window. 
Now, let’s change an actual date. 

6. In the Event Type column, scroll to and click Contractor Employee 
Interview. 

7. Click the Projected Date/Actual Date area. 
8. Click in the Actual Date field, type 050105. 
9. Click the Save button. 

Now, let’s change another actual date. 

10. In the Event Type column, scroll to and click Prompt Payment to 
Subcontractors. 

11. In the bottom datawindow, click the Actual Date field and type 050105. 
12. Click the Save button. 
13. Click the Close button. 

Warning: If 
Projected 
Date modified, 
record may 
not be saved. 
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Adding Stockpiled Materials 
The Stockpiled Materials window lets the User select materials to be stockpiled 
for the Contract, and enter invoice data for the materials. The panel displays 
Contract Line Item data in the top window and stockpiled material data in the 
bottom window. This data is used during estimate generation to determine the 
amount to be paid for the Items installed. The estimate process enters the 
installed quantity and the amount paid to date on the Stockpiled Materials panel. 
The estimate process also closes out the stockpiled material balance when the 
remaining quantity is zero, or the User can close out the balance manually. 
 

 
The Stockpiled Materials Window 

Figure 4-2 

 
In TDOT, the Project Supervisor and Office Staff will use the Stockpiled 
Materials window in SiteManager to track stockpiled materials.  

Stockpiled material reductions or additions to the pay amount in the 
estimate are calculated and applied automatically through SiteManager. 
Details regarding stockpiled materials that have been applied to an estimate 
can be seen on the Line Item Adjustment window. 

As a TDOT practice, it is recommended that you include the item number 
and description of material in the Stockpiled Description field.  THIS WILL 
MAKE IT EASIER TO IDENTIFY THE STOCKPILE.  

When an initial stockpiled material payment consists of multiple invoices, 
the first invoice is entered under the New option and the remaining invoices 
for that same material are entered as replenishes to the stockpiled material.  
All other additional invoices received for the same material after the initial 
payment are also entered as replenishes to the stockpiled material. 
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Before Adding a Stockpile 
SiteManager calculates payments for Stockpiled Materials based on the quantity 
of Material used per Contract Item. SiteManager does not automatically apply 
portions of the invoiced Material quantity and payment amount to different 
Contract Items. This means that the User must decide how to allocate the 
invoiced amounts for a Stockpiled Material. Before adding invoice data to 
SiteManager, the User must determine the following: 

• Which Contract Items include the invoiced Material 
• How much of the total invoiced Material to allocate to each Contract 

Item 
• If an initial payment amount is due, which Contract Items pay this 

amount 
• How many units of material are included in one unit of the pay item (the 

conversion factor).   
From these numbers, the User can calculate the values to enter in the fields of the 
Stockpiled Materials panel. 
 

In TDOT the Initial Invoice Payment field should always be the same as the 
Invoice Amount field that is automatically calculated for you by 
SiteManager.   

See appropriate Specification and/or Circular Letter for determining Unit 
Price and Initial Invoice Payment. 

Each invoice must be added individually and on the correct project number 
line item number. The Initial Invoice Amount is the amount that is paid for 
the Stockpile on the next estimate. 

NOTE:  Setting up the proper conversion factor is very important.  If the 
conversion factor is something other than one to one and you need assistance 
determining how many units of material are in one unit for the pay item, 
contact your Regional Support. 

Stress this! 
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 Exercise 4-2 
In the following exercise, you will create a stockpiled material record. 

User ID: jj05754  Group: OSTAFF Contract: CNB022C 

1. On the Contract Records panel, double-click the Stockpiled 
Materials icon. 

2. Click the Services menu. 
3. Click the Choose Keys choice. 
4. In the Selection datawindow, click the Contract ID button. 
5. In the Contract ID list box, scroll to and to and double-click 

CNB022C. 
6. In the Projects list box, scroll to and double-click Project 55019-

3220-94 (Bridge & Approaches Over Lick Creek). 
7. In the Contract Items list box, scroll to and double-click Item Code 

604.04.01 for Line Number 0480 in Category Nbr 0500 – Applied 
Texture Finish (New Structures). 

8. In the Stockpiled Desc field, type 604-04.01 Applied Texture 
Finish.   

9. Press the Tab key. 
10. In the Invoice Date field, type 041005. 
11. Press the Tab key. 
12. In the Invoice Number field, type 28545. 
13. Press the Tab key. 
14. In the Quantity field, type 45. 
15. Press the Tab key. 
16. Click in the Units drop-down list, and press the letter G on the 

keyboard. 
17. Click the Gallon choice. 
18. Press the Tab key. 
19. In the Unit Price field, type 128.00. 
20. Press the Tab key. 
21. In the Conv Factor field, type 0.20. 
22. Press the Tab key. 
23. What is the system calculated Invoice Amount? ______________ 
24. In the Initial Invoice Payment field, type 5760.00. 
25. Click the Save button. 
26. Click the Open button. 
27. Note that by including the item number and item description in the 

Stockpiled Description field it is easy to identify the correct 
stockpile.  

28. Leave the Select window open for the next exercise. 

                                                      
  As a TDOT practice, it is recommended that you include the item number and item description in the 

Stockpiled Description field.  THIS WILL MAKE IT EASIER TO IDENTIFY THE STOCKPILE. 

Press ‘G’ to jump 
to ‘Gallon’ choice. 
The list can be 
long. 

Spec book indicates 
that 1 gallon covers 45 
square feet =  
1 gallon = 45 S feet 
45 square feet / 9 = 5 
square yards 
1 gallon / 5 sy = .2 gal 
per sy 

$5760.00 
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Replenishing a Stockpile 
The Stockpiled Materials window also allows you to add to an existing stockpile 
by replenishing it. After opening the existing stockpile, you use the Services 
menu’s Replenish Stockpile choice to add to the existing stockpile.  The menu 
selection only blanks out the Quantity field, so care should be taken to modify 
the other fields appropriately, particularly the Initial Invoice Payment field 
because this is the value that is paid on the next estimate. 
 

 
The Stockpiled Materials Window 

Figure 4-3 

 
In TDOT the Initial Invoice Payment field should always be the same as the 
Invoice Amount field that is automatically calculated for you by 
SiteManager.  The Initial Invoice Amount is the amount that is paid for the 
Stockpile on the next estimate. 

See appropriate Specification and/or Circular Letter for determining Unit 
Price and Initial Invoice Payment. 

When replenishing a stockpile, each invoice must be added individually and 
on the correct project line item number.  
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 Exercise 4-3 
In the following exercise, you will replenish a stockpiled material record. 

User ID: jj05754  Group: OSTAFF Contract: CNB022E 

1. In the Stockpiled Material Select window, click the Contract ID 
button.  

2. In the Contract ID list box, scroll to and double-click CNB022E. 
3. In the Stockpiled Materials list box, scroll to and double-click the 

stockpile for Project Number 55019-3220-94, Category Number 
0500, Line Item 0480 Applied Texture Finish (New Structures), 
Invoice Number 28545, Entered Date 03/14/06. SiteManager 
displays the Stockpiled Materials window. 

Now, let’s replenish the stockpile. 
4. Click the Services menu. 
5. Click the Replenish Material choice.  
6. In the Invoice Date field, type 061505. 
7. Press the Tab key. 
8. In the Invoice Number field, type 35878. 
9. Press the Tab key. 
10. In the Quantity field, type 40.   
11. Press the Tab key twice. 
12. In the Unit Price field, type 128.00  
13. Press the Tab twice. 
14. In the Initial Invoice Payment field, type 5120.00. 
15. Click the Save button. 

Remind class 
that in TDOT, 
the initial 
invoice 
payment 
SHOULD equal 
the total invoice 
amount, but 
could be less 
based on 
SiteManager 
calculation and 
how user sets 
up. 
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Closing out a stockpile balance 
The Stockpiled Materials window also allows you to close an existing stockpile. 
After opening the existing stockpile, you use the Services menu’s Close Out 
Balance choice to remove remaining quantity in the existing stockpile.  
SiteManager will create a deduction on the next estimate for the remaining 
quantity times the unit price of the material that remained in the stockpile prior to 
closing it out. 

 Exercise 4-4 
In the following exercise, you will close out a stockpiled material balance. 

User ID: jj05754  Group: OSTAFF Contract: CNB022E 

1. Click the Services menu. 
2. Click the Close Out Balance choice.  
3. Click the Save button. 
4. Click the Close button. 
5. Click the Main Panel folder tab. 
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Review for Section 4 
To record the Actual Date of a Checklist Scheduled 
Event: 

1. On the Contract Records panel, double-
click the Checklist Event Dates icon. 

2. In the Checklist Event Dates list box, scroll 
to and click the Checklist Event. 

3. In the Actual Date field, type the date that 
the event occurred. 

4. Press the Tab key. 
5. In the Comments field, type comments to 

add to the record. 
6. Click the Save button. 

To add a Stockpiled Material:  

1. On the Contract Records panel, double-
click the Stockpiled Materials icon.  

2. Click the Services menu, and click Choose 
Keys. 

3. In the Contract ID list, scroll to and double-
click a Contract. 

4. In the PCN list, scroll to and double-click a 
Project number. 

5. In the Contract Items list, scroll to and 
double-click an item. 

6. In the Stockpiled Desc field, type the 
description. 

7. In the Invoice Date field, type the date. 
8. In the Invoice Number field, type the 

invoice number. 
9. In the Quantity field, type the quantity. 
10. In the Units drop-down list, select the 

appropriate unit. 
11. In the Units Price field, type the unit price. 
12. In the Conv Factor field, type the 

conversion factor. 
13. In the Initial Invoice Payment field, type 

the initial invoice payment amount. 
14. Click the Save button on the toolbar. 

To replenish a stockpiled material: 

1. On the Contract Records panel, double-
click the Stockpiled Materials icon. The 
Stockpiled Materials panel opens. 

2. Click the Open button. 
3. In the Contract ID list box, scroll to and 

double-click the Contract. 
4. In the Stockpile Materials list box, scroll to 

and double-click the correct stockpile. 
5. Click the Services menu and click the 

Replenish Material choice. 
6. Click OK. The Stockpiled Materials panel  
7. In the Quantity field, type a previously 

determined quantity of the stockpiled 
material to be applied to this Item and this 
Contract. 

8. Change the other fields as appropriate. 
9. If the invoice requires only an initial 

payment, in the Initial Invoice Payment 
field, type the previously determined dollar 
amount of the initial payment to be applied 
to this Item and this Contract. 

10. Click the Save button. 

To close out the balance of a stockpiled material: 

1. On the Contract Records panel, double-
click the Stockpiled Materials icon. The 
Stockpiled Materials panel opens. 

2. Click the Open button. 
3. In the Contract ID list box, scroll to and 

double-click the Contract. 
4. In the Stockpile Materials list box, scroll to 

and double-click the correct stockpile. 
5. Click the Services menu and click the Close 

Our Balance choice. 
6. Click the Save button. 
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Summary Exercise for Section 4 
In the following exercise, you will Perform Contract Maintenance activities. 

User ID: jj05754  Group: OSTAFF Contract: CNB022F 

1. Navigate to the Checklist Event Dates window.  

2. Enter the actual date 042905 for both the Labor Interviews and Prompt Payment to 
Subcontractors Checklist Event Types for Contract CNB022F. 

3. Navigate to the Stockpiled Materials window 

4. Open a stockpile for Contract CNB022F. 

• Material 307-01.01 Gr ‘A’ Mix - Aggregate for line item number 0110. 

5. Replenish the Stockpile using the following Invoice information: 
• Invoice date is 05/20/05. 
• Invoice Number is 52789. 
• Quantity is 200 Tons. 
• Unit Price is 39.00. 
• Change the Initial Invoice Payment to match the auto calculated value. 

6. Exit SiteManager. 
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Learning Module 

 Section 5  From Server to PM 
for Field and Office Documentation 

 

By the end of this module, you will be able to: 

• Understand the Pipeline Process in SiteManager 

• Download Data from the Server 
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Overview 

Pipeline is the process that automates the transfer of data. SiteManager provides 
the Pipeline processes because Contract data must be downloaded and uploaded 
often during the life of a Contract. In general, the data downloaded from the 
Server is the Contract plan data, which is primarily the Contract specifications. 
The data uploaded to the Server is the Contract activity data, which is the work 
done on the Contract. Pipeline automates the data flow from the: 

• Server to Standalone Mode (PM) 

• Standalone Mode (PM) to Server 

 

Pipeline The pipeline process transfers data files from one database to 
another. In SiteManager, the User uses the pipeline process to 
download data directly from the server’s database to the 
standalone workstation’s database, and to upload data directly 
from the standalone workstation’s database to the server’s 
database.  

 

PM = Standalone 
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The following table shows how the Pipeline panels are used to transfer data.  

Step Activity Process Pipeline Panel 

1 Download 
Basic Contract 
Data from the 
Server 

The User selects and downloads basic 
contract data from the server’s 
database to the standalone 
workstation’s database using the 
Server to PM Pipeline panel. The 
Pipeline process loads the data directly 
into the User’s standalone database. 
Before DWRs can be generated in 
Standalone mode, the User must 
download Basic Contract Data from 
the Server. 

Server to PM Pipeline panel 

2 Create Daily 
Work Reports 

The User creates and modifies DWRs 
on the contract to report the usage of 
Labor, Equipment, and Items on the 
Contract. 

As DWRs are created, they are 
listed on the DWR Select 
folder tab in the PM to Server 
window. 

3 Upload Daily 
Work Reports 
to the Server 

The User selects and uploads DWRs 
from the standalone workstation to the 
Server. 

PM to Server Pipeline panel 

4 View Pipeline 
History 

The User can view a history of 
Pipeline activity. 

Pipeline Information panel 

5 Download 
Basic Contract 
Data and Daily 
Work Reports, 
as needed. 

New data is added to the Contract on 
the Server only. The User downloads 
new Contract data as it becomes 
available. The new data updates the 
standalone database. The User can also 
download Daily Work Reports. 

Download Basic Contract Data 
and Daily Work Reports as 
needed. 

NOTE: Basic Contract Data 
includes all Change Order 
information. 

6 Release the 
Contract 

When the Contract work is done, the 
User uses Pipeline to release the 
Contract back to the Server. On the 
Pipeline Summary panel, select the 
Basic Contract Data check box. 

PM to Server Pipeline panel 

The Pipeline Process Table 

Table 5-1 

 

In TDOT, the Inspector must always check out Basic Contract Data when 
pipelining a contract to Standalone mode on his/her computer for the first 
time.  It is required that the Basic Contract Data be pipelined to Standalone 
mode a minimum of twice a week to ensure that the Standalone database 
has the most current contract information. 
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The Pipeline Panel 

When logging on to SiteManager, the User connects to either the standalone 
database or the server database, depending on which Pipeline function will be 
used. 

 

The Pipeline Panel 

Figure 5-1 
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Check Out — Downloading Data from the Server — PM 

The Server to PM Pipeline panel lets the User download (check out) data from 
the server’s database to the standalone workstation’s database. To download 
Contract data from the Server, the User must first select a Contract. 

To download Basic Contract Data, the User must check the Basic Contract Data 
box on the Server to PM Pipeline panel.  Basic Contract Data includes all Change 
Order information.  After the User has selected the data to download, the pipeline 
process is triggered by selecting the Pipeline Data menu option on the Services 
menu. For the data to download, the Contract must be in active status. 

Server to PM Pipeline Summary 

On the Server to PM Pipeline window’s Pipeline Summary folder tab, the user 
can view the number of Daily Work Reports, Diaries, Change Orders, Force 
Accounts, and Users selected. To see which ones are selected, the User clicks the 
appropriate folder tab. 

 

The Pipeline Summary Folder Tab 

Figure 5-2 

 
Note: TDOT will not use the Diary Select, Change Order Select, Force Account Select, or 
Users Select folder tabs.

The Basic Contract 
Data includes all 
Change Orders. 

The pipeline 
process loads the 
Contract  directly 
from the server 
database to the 
User’s standalone 
database. 

 

Contract work 
cannot be recorded 
in the field until the 
Basic Contract 
Data is 
downloaded. 

 

The standalone 
workstations 
depend on periodic 
downloads from the 
Server for current 
data such as the 
results of estimates. 

The Pipeline Status 
field shows the 
activity and 
complete status of 
the pipeline process.
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 Exercise 5-1 

In the following exercise, you will select Contract CNB022I, browse the Server 
to PM Pipeline panels, and download the basic contract data.  

User ID: jj05751 Group: INSP  Contract: CNB022I 

1. Double-click the SiteManager Training program icon on your 
desktop. 

2. In the User ID field, type jj05751. 
3. Press the Tab key. 
4. In the Password field, type pass. 
5. Press the Enter key. 

Now, let’s browse to the Pipeline panel and open a contract. 
6. On the Main Panel, double-click the Pipeline icon. 
7. On the Pipeline panel, double-click the Server to PM Pipeline icon. 

SiteManager displays the Server to PM Pipeline window. 
8. Click the Open button.  
9. In the Contract list box, scroll to and double-click Contract 

CNB022I. 
10. Click the DWR Select tab. 
11. Click the Change Order Select tab. 
12. Click the Pipeline Summary tab. 
13. On the Pipeline Summary tab, click the Basic Contract Data check 

box (ON). 
14. Click the Services menu and click Pipeline Data. The progress of the 

download is shown in the Pipeline Status field. A message confirms 
that the data is downloaded. 

15. Click the Close button. 

 

Basic Contract 
Data downloads 
all Change 
Orders and any 
other updates to 
the contract. 

Shift-tab if user 
ID not 
highlighted. 
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Selecting Daily Work Reports 

When the User clicks the DWR Select folder tab on the Server to PM Pipeline 
panel, the panel displays a list of DWRs for the selected Contract. The User 
selects one or more DWRs to download. 

 

The DWR Select Folder Tab 

Figure 5-3 

 

In TDOT, Inspectors may select DWRs from the DWR Select folder tab to 
download to Standalone mode for modification or review.  DWRs must be 
pipelined back up to the server as soon as modifications have been 
completed. 

Users who checkout an unauthorized DWR created by another user to 
his/her Standalone database must immediately check in the DWR so that it 
is available to the owner for modification, if necessary, or for inclusion in a 
Diary.  A “view only” copy of the checked out DWR will remain in the 
Standalone database. 
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Daily Work Report Applicability 

Daily Work Report data is transferred using the Pipeline function. To begin 
working on a Contract, the User must first download Basic Contract Data from 
the Server. ‘Basic Contract Data’ includes all of the Contract data required to 
process the DWRs, including Change Orders.  After Contract work is underway, 
the DWRs are uploaded to the Server.  

Pipeline is used to: 

• Download Basic Contract Data from the Server 

• Upload Daily Work Reports to the Server 

 



Review for Section 5 Trns•port SiteManager® Learning Guide 
Field Reporting Section 5  From Server to PM 

 

 

 133 

Review for Section 5 
To download data from the server: 

1. When logging on to SiteManager, connect 
to the server database. 

2. On the SiteManager main panel, double-
click the Pipeline icon. 

3. On the Pipeline panel, double-click the 
Server to PM Pipeline icon. The Pipeline 
Summary folder tab is displayed. 

4. To select a Contract, click the Open button. 
5. In the Contract ID list box, scroll to and 

double-click the Contract. 
6. To download Basic Contract Data, click the 

Basic Contract Data check box (ON). 
7. To select Daily Work Reports, click the 

DWR Select folder tab. 
8. In the DWR list box, shift-click each Daily 

Work Report to be downloaded. 
9. Click the Add button. The selected Daily 

Work Reports are added to the Selected 
DWRs list. 

10. Click the Pipeline Summary folder tab. 
The panel displays the total number of 
Change Orders, Force Accounts, Diaries, 
Daily Work Reports, and Users selected. 

11. To download the selected data from the 
Server, click the Services menu and click 
the Pipeline Data choice. The progress of 
the download is shown in the Pipeline 
Status field. 
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Summary Exercise for Section 5 

In the following exercise, you will pipeline data from Contract CNB022K to 
Standalone mode.  

User ID: jj05751 Group: INSP Contract: CNB022K 

1. For Contract CNB022K, download the Basic Contract Data from the 
Server. 

2. Exit SiteManager. 
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Learning Module 

 Section 6  Daily Work Reports I 
for Field and Office Documentation 

 

By the end of this module, you will be able to: 

• Understand the Basic Concepts of Daily Work Reports 

• Enter Basic Daily Work Report Information  

• Enter Contractor Activity 

• Enter Contractor Equipment Activity 

• Enter Daily Staff Activity 

• Select and Record Work Items 

• Record Work on a DWR Template 
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Daily Work Reports I 

The User creates daily records of construction activity in Daily Work Reports.  
SiteManager lets the User create DWRs on the workstation in the field.  Before 
the Inspector can create the first DWR for a Contract in standalone mode, the 
Basic Contract Data must be downloaded from the SiteManager Server database 
to the User’s workstation.  After the User pipelines the Basic Contract Data onto 
the workstation’s local database, the User can begin creating DWRs in 
standalone.  Typically, for each Contract, each User submits one DWR per day. 
Only the User who creates the DWR may modify it. 

The Daily Work Report Select panel lets the User open a DWR.  The panel lists 
all of the DWRs stored on the workstation for the selected Contract and the 
selected User ID.  The User can only access the DWRs stored in the local 
database.  The User can open any DWR in the database, but the User cannot 
modify a report the User did not create.  The DWR opens as Read Only if the 
system finds one of the following:  

• The Daily Work Report has been transferred to the server or standalone 
database  

• The Daily Work Report has been authorized 

• The Daily Work Report was authored by another User 

 

 

Choose Keys 

When the User first enters the Daily Work Report window to create a new DWR, 
the User must first select Choose Keys from the Services menu. By selecting 
Choose Keys, the User is given a list of Contracts for which to create DWRs. If a 
User enters the Daily Work Report window to open an existing record, he or she 
must click the Open button and select the existing DWR. To create a new DWR 
for the same Contract as the existing DWR, the User must click the New button. 
To create a new DWR on a different Contract, the User must click the New 
button and then select Choose Keys from the Services menu to choose a 
Contract. 

SiteManager will 
not allow two 
DWRs to be created 
by the same User 
for the same 
contract on the 
same day. 
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The DWR Info Folder Tab 

Figure 6-1 

 

In TDOT, the Lead Inspector will complete a DWR for every day during 
the life of a project including weekends and holidays.   Other inspectors 
will create DWRs for any day they are on-site or reporting work.  DWRs 
may also be created by Office staff.  

DWRs created by Inspectors will be created in Standalone Mode and 
DWRs created by Office Staff will be created in Server Mode. 

Note: Inspectors should make sure the network cable is unplugged from the 
laptop when creating a DWR in Standalone Mode. 
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The Daily Work Reports window has the following folder tabs: 

DWR Info 

The DWR Info folder tab lets the User create a new DWR and collect 
information about the day for which the report was created. 

Contractors 

The Contractors folder tab lets the User enter daily data about the Prime and 
Subcontractor(s), Supervisor(s), and variable labor (by personnel type).  TDOT 
will not use the Supervisor section of the window. 

Contractors Equip 

The Contractor Equip folder tab lets the User document the daily presence and 
use of equipment on the job site for a selected Contractor. 

Daily Staff 

The Daily Staff folder tab lets the User enter daily information on state 
employees and consultants.  Each entry shows how many hours the staff member 
worked. 

Work Items 

The Work Items folder tab lets the User view and add daily usage data for 
installed Work Items. 

Force Accounts 

TDOT will not use this feature. 

 

Contractors folder tab 
includes the 
Contractor’s 
Supervisors/Foreman by 
name, which will not be 
used by TDOT.  

Personnel Type is not an 
employee name, but 
rather a job title - 
Electrician, Driver or 
Heavy Equipment 
Operator. TDOT will 
record 
superintendent/foreman 
as personnel types. 
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 Exercise 6-1 
In the following exercise, you will log on in Standalone mode as the Lead 
Inspector and navigate to the Daily Work Reports window.   

User ID: jj05751 Group: INSPST Mode: Standalone  Contract: CNB022I 

1. Double-click the SiteManager Training program icon on your 
desktop. 

2. In the User ID field, type jj05751.  
3. Press the Tab key. 
4. In the Connect To drop-down list, click the expand arrow to the 

right of the current selection and click Training Standalone. 
5. In the Password field, type pass. 
6. Press Enter. 
7. On the Main Panel, double-click the Daily Work Reports icon. 
8. On the Daily Work Reports panel, double-click the Daily Work 

Reports icon.  
 

 

Jackie Warren 
(jj05751) is the Lead 
Inspector for all 
DWR/Diary exercises. 

Shift-tab if the user 
ID is not 
highlighted. 
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Entering Basic Daily Work Report Information 

The DWR Info folder tab lets the User create a new DWR and collect 
information about the day for which the DWR was created.  For example, the 
User enters the weather conditions and high and low temperatures for the day 
here.  The name of the author of this report is displayed in the Inspector field.  
The date covered by this report is displayed in the DWR Date field.  The Locked 
and Authorized fields indicate the state of the DWR.  A locked DWR has been 
transferred via pipeline to a standalone database and has not been transferred 
back to the server.  An authorized DWR has been approved for payment.  If 
either the Locked or Authorized field displays Yes, the User cannot modify the 
DWR. 

This folder tab has three check boxes — No Work Items Installed, No 
Contractors On Site, and No Daily Staff On Site — that indicate there is no data 
for the subject.  These boxes are checked by default.  When the User enters data 
for the subject on another folder tab, the corresponding check box is cleared 
automatically. 

General remarks are also recorded on this folder tab.  To record a remark, the 
User must first select a remark type.  If a remark has already been entered for the 
selected type, as indicated by a check mark next to the type, the remark appears 
in the Remarks field.  A remark does not have a size limit, and can be pasted to 
and from a word processor.   

 

The DWR Info Folder Tab  

Figure 6-2 

Emphasize that 
they do not have to 
click these off if 
they enter data on 
the folder tabs. 

Locked = piped 

DWRs paid on an 
estimate cannot 
be changed, 
although 
locked indicator 
will be N. 

Authorized = 
approved in Diary 
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In TDOT, field users are required to complete the DWR Date, 
Temperature, Weather Conditions, and appropriate Remarks (“Work 
Performed” at a minimum) on the project for the date of the DWR.  

For the Remarks type “Work Performed”, the field user should enter the 
contractor’s name, details regarding the item work progress, and the 
location where the work is performed. 

 

 Exercise 6-2 
In the following exercise, you will create a new DWR and complete the DWR Info 
folder tab for April 11, 2005 on Contract CNB022I.  

User ID: jj05751 Group: INSPST Mode: Standalone Contract: CNB022I 

1. While on the DWR Info. folder tab, click the Services menu. 
2. Click the Choose Keys choice. 
3. In the Contract ID list box, scroll to and double-click Contract CNB022I. 
4. In the DWR Date field, type 041105. 
5. Press the Tab key.  

Now, let’s add the temperatures and conditions. 
6. In the High Temperature field, type 68 degrees. 
7. In the Low Temperature field, type 46 degrees. 
8. In the A.M. field, click the expand arrow to the right of the current selection and 

click Partially Cloudy.  
9. In the P.M. field, click the expand arrow to the right of the current selection and 

click Sunny. 

Now, let’s add a few remarks. 
10. In the Remarks Type list box, scroll to and click -Work Performed-.   
11. In the Remarks text box, type Volunteer Bridge Construction, Inc. - Clearing 

and Grubbing. 
12. In the Remarks text box, type International Traffic Systems, Inc. - Installed 

Construction Signs from BOP to EOP. 
13. In the Remarks Type list box, scroll to and click Visitor. 
14. In the Remarks text box, type Regional Director arrived on project at 10:00 

AM and advised installation of additional series signs at station 25+50 
intersection of Walnut Grove Rd. 

15. Click the Save button. 

If 
temperatures 
are not 
entered 
correctly, the 
high 
temperature 
will display in 
both fields. 

Same as now, 
equipment and 
personnel on next 
tabs. 
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Entering Contractor Activity 

The Contractors folder tab in DWR lets the User enter daily data on the 
Contractor and variable labor (by personnel type).  Equipment usage is recorded 
on the Contractors Equipment folder tab.  The User can select the Contractor 
from a drop-down list of Contractors and Subcontractors who are authorized to 
work on the Contract.  The Prime Contractor is always at the top of the drop-
down list. The User must select a Contractor before recording installed work 
items.  A minimum DWR that will impact an Estimate has a Contractor on-site 
and records installed work items. 

After the User selects a Contractor, the User can select Personnel Types 
associated with the selected Contractor from the drop-down lists in the Personnel 
Type area.  The records that appear on the drop-down lists are stored on the 
Contract’s Master Lists. To add a record (supervisor, equipment, etc.) that does 
not appear on a drop-down list, a User must first add it to the Contract Master 
List from the Vendor Master List. 

 
The Contractors Folder Tab 

Figure 6-3 

Only 
Subcontractors 
associated with 
the Contract and 
approved for 
specific work 
items are 
accessible from 
the Contractor 
drop-down list. 

This is a 
three-focus 
window. 

TDOT does not use 
the Supervisor/ 
Foreman Name 
section on the 
Contractor’s tab. 
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The Prime Contractor and Subcontractors 
The Contractor drop-down list will contain the Prime Contractor and any 
qualified Subcontractors.  The Prime Contractor will be the first contractor in the 
drop-down list. 

Subcontractors are qualified for specific work items in the Subcontract window 
of the Contract Administration component of SiteManager.  The Subcontractor is 
not available to select on a DWR prior to that subcontractor’s approval date for 
the contract. 
 

In TDOT, all Contractors (Prime Contractors and Subcontractors) on site 
should be indicated on the Contractors folder tab of the DWR window. If 
the Subcontractor is on site, the User must indicate the Subcontractor in 
the Contractor area of the Contractors folder tab. If the Subcontractor is 
not on the drop-down list for this Contract, contact the Field Office so it 
may be added. 

 Exercise 6-3 
In the following exercise, you will add a Prime Contractor and a Subcontractor to the 
DWR on April 11, 2005 for Contract CNB022I.   

User ID: jj05751 Group: INSPST Mode: Standalone Contract: CNB022I 

1. Click the Contractors folder tab 
2. On the Contractors folder tab, click the Contractor area. 
3. Click the New button. An empty row is added to the list. 
4. In the Contractor drop-down list, click the expand arrow to the right of the 

current selection and click Volunteer Bridge Construction, Inc 
5. Click the Save button. 
6. Click the New button. An empty row is added to the list. 
7. In the Contractor drop-down list, click the expand arrow to the right of the 

current selection and click International Traffic Systems, Inc. 
8. Click the Save button. 

Do not edit 
values in the 
Nbr of 
Supervisors 
or Nbr of 
Workers 
fields.  

If the 
Subcontractor 
does not have 
an approval 
date, it will 
not display.  



Trns•port SiteManager® Learning Guide Entering Contractor Activity 
Section 6  Daily Work Reports I Field Reporting  

 

 

144  

The Contractor Supervisor 
In TDOT, you will NOT use the Supervisor/Foreman section of the 
window.  Instead all Supervisor/Foreman information will be recorded for 
each Contractor in the Personnel Type section of the Contractor folder tab. 
 
 
The Contractor Personnel  

The personnel drop-down list will contain personnel types added to the Contract 
Master List. 

In TDOT, the User will record all Personnel Types on site for each 
Contractor indicated on the Contractor list. The Hours Worked field is not 
a required field and should remain blank. If any additional details are 
required, the User will enter the information in the Remarks field. 

If the required Personnel Type is not on the drop-down list, contact the 
Field Office so it may be added to the DWR Master List. 
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 Exercise 6-4 
In the following exercise, you will add a personnel type to the contractor on site for 
the DWR on April 11, 2005 for Contract CNB022I.   

User ID: jj05751 Group: INSPST Mode: Standalone Contract: CNB022I 

1. On the Contractors folder tab, click the International Traffic Systems, 
Inc. contractor. 

2. On the Contractors folder tab, click the Personnel Type area. 
3. Click the New button. An empty row is added to the list. 
4. In the Personnel Type drop-down list, click the expand arrow to the 

right of the current selection and click Superintendent. 
5. In the Nbr of Persons field, type 1. 
6. Click the New button. An empty row is added to the list. 
7. In the Personnel Type drop-down list, click the expand arrow to the 

right of the current selection and click Foreman. 
8. In the Nbr of Persons field, type 1. 
9. Click the New button. An empty row is added to the list. 
10. In the Personnel Type drop-down list, click the expand arrow to the 

right of the current selection and click Truck Driver (2 axles). 
11. In the Nbr of Persons field, type 1. 
12. Click the New button. An empty row is added to the list. 
13. In the Personnel Type drop-down list, click the expand arrow to the 

right of the current selection and click Unskilled Laborer. 
14. In the Nbr of Persons field, type 3. 
15. Click the Save button. 

Now let’s add personnel for another contractor. 
16. On the Contractors folder tab, click the contractor Volunteer Bridge 

Construction, Inc. 
17. Click the Personnel Type area. 
18. Click the New button. An empty row is added to the list. 
19. In the Personnel Type drop-down list, click the expand arrow to the 

right of the current selection and click Foreman. 
20. In the Nbr of Persons field, type 1. 
21. Click the Save button. 

You would typically add more personnel and equipment for Volunteer 
Bridge at this point, but we will continue through the DWR for training 
purposes. 
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Modifying Personnel Type Master List 

The Master List of personnel types is maintained for each Contractor on each 
Contract. The Master Lists are maintained by HQ Construction Office, while the 
Contract Master List is maintained by the Field Office.   

As Subcontracts are added to the Contract, the Subcontractors personnel and 
equipment must be added to the master list to allow reporting of these in the 
DWR.  This process is included in the Contract Activation chapter of the Office 
Documentation Course. 
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Entering Contractor Equipment Activity 

The Contractor Equip folder tab lets the User document the presence and use of 
equipment on the job site for the selected Contractor.  The user enters the number 
of pieces of each equipment type on the site on this date and the number of pieces 
used. User must select a Contractor before entering equipment information for 
the Contractor.  

After the User selects a Contractor, the User can select Equipment IDs from the 
drop-down list in the Equipment ID - Description field.  The records that appear 
on the drop-down list are stored in the Contractor’s Contract Master List.  To add 
a record that does not appear on the drop-down list, the User must first add it to 
the Contract Equipment Master List from the Vendor Master List. 

 
The Contractor Equipment Folder Tab 

Figure 6-4 

 

In TDOT, the User will record the type of equipment, number of pieces, 
and number of pieces used.  TDOT will not use the “Hours Used” field. 

If an equipment selection is not available, contact the Field Office so it may 
be added to the DWR Master List. 

Do not edit 
values in the Nbr 
of Supervisors or 
Nbr of Workers 
fields. These 
fields are 
automatically 
populated. 
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 Exercise 6-5 
In the following exercise, you will add equipment to the contractor on site for the 
DWR on April 11, 2005 for Contract CNB022I.   

User ID: jj05751 Group: INSPST Mode: Standalone Contract: CNB022I 

1. On the Daily Work Reports window, click the Contractor Equipment folder 
tab.  

2. On the Contractors Equipment folder tab, click the International Traffic 
Systems, Inc.  

3. Click the Equipment ID-Description area.  
4. Click the New button. An empty row is added to the list. 
5. In the Equipment ID-Description drop-down list, click the expand arrow to the 

right of the current selection and click Pickup Truck. 
6. In the Nbr. of Pieces field, type 2. 
7. In the Nbr Used field, type 2. 
8. Click the New button. An empty row is added to the list. 
9. In the Equipment ID drop-down list, click the expand arrow to the right of the 

current selection and click Haul Truck. 
10. In the Nbr. of Pieces field, type 1. 
11. In the Nbr Used field, type 1. 
12. Click the Save button. 

Now let’s add equipment for another contractor. 
13. On the Contractors Equipment folder tab, click the Volunteer Bridge 

Construction, Inc. 
14. Click the Equipment ID-Description area.  
15. Click the New button. An empty row is added to the list. 
16. In the Equipment ID-Description drop-down list, click the expand arrow to the 

right of the current selection and click Pickup Truck. 
17. In the Nbr. of Pieces field, type 1. 
18. In the Nbr Used field, type 1. 
19. Click the Save button. 

 

May need to 
click in the 
Nbr of Pieces 
field first to 
activate drop-
down list. 
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Modifying the Equipment Master List 

A Master List of equipment is maintained for each Contractor on each Contract.  
The Master List is maintained by HQ Construction Office, while the Contract 
Master List is maintained by the field office. 

As Subcontracts are added to the Contract, the Subcontractors personnel and 
equipment must be added to the master list to allow reporting of these in the 
DWR.  This process is included in the Contract Activation chapter of the Office 
Documentation Course. 
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Entering Daily Staff Activity 

The Daily Staff folder tab lets the User enter daily information on state 
employees and consultants. Each entry shows how many hours the staff member 
worked. The User selects staff members from the drop-down list in the Staff 
Member field. The User may also enter remarks for each line of Daily Staff 
recorded. The Staff Members that appear on the drop-down list are stored in the 
Contract Master List.  Staff Members that do not appear on the drop-down list 
must first be added to the Contract Master List. 

 
The Daily Staff Folder Tab 

Figure 6-5 

 

In TDOT, the Project Supervisor will determine which user will record the 
name of the TDOT staff members on site, as well as the total number of 
hours each staff member was at the project site.  The total number of 
regular and overtime hours will be entered in the Reg. Hours column.  All 
other fields should be left blank.   

Users not designated by the Project Supervisor should not complete this 
folder tab. 

 

In TDOT, 
these five fields 
remain blank. 

Staff Hours 
Custom Report will 
show TDOT Staff 
and hours so you 
can transfer the 
data to the time 
card. Information 
regarding 
consultants can be 
viewed by running 
the Consultant 
Hours Custom 
Report. 
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 Exercise 6-6 
In the following exercise, you will add TDOT Daily Staff to the DWR on April 11, 
2005 for Contract CNB022I.   

User ID: jj05751 Group: INSPST Mode: Standalone Contract: CNB022I 

1. On the Daily Work Reports window, click the Daily Staff folder tab.  
2. Click the New button. An empty row is added to the list. 
3. In the Staff Member drop-down list, click the expand arrow to the right of the 

current selection and click Warren, Jackie. 
4. In the Reg. Hours field, type 7.5. 
5. Click the New button. An empty row is added to the list. 
6. In the Staff Member drop-down list, click the expand arrow to the right of the 

current selection and click Johnson, Terry. 
7. In the Reg. Hours field, type 7.5. 
8. Click the Save button. 
9. Click the Work Items folder tab. 
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Selecting and Recording Work Items 

The Work Items folder tab lets the User view and add daily usage data for 
installed Work Items. Before entering Work Item data, the Contractor responsible 
for the Work Item must be entered on the Contractors folder tab.  When the User 
first selects the Work Items folder tab, the Select Work Item list is displayed.  
The Record Work Item and Selects Work Item buttons let the User toggle between 
two different versions of the Work Items folder tab.  To enter usage data, the 
User first selects the Work Item and then selects the Record Work Item button (or 
the Record Work Item option on the Edit menu).  This displays the Record Work 
Items folder tab on which the User can view and add daily usage data. 

 
The Record Work Item and Selects Work Item Buttons 

Figure 6-6 

The User can toggle between two different versions of the Work Items folder tab.  
When the User first selects the Work Items folder tab, or when the Selects Work 
Item button is clicked, the Select Work Items folder tab lists Work Items for the 
selected Contract.  The Work Items are listed in ascending order by Project 
Number then Item Code.  The User can find, filter, and sort the list.  If an Item 
has installed quantities for the selected DWR, the Installed (Instld) check box is 
checked (ON).  

 
The Select Work Items Folder Tab  

Figure 6-7 

Contractor 
must be 
entered first. 

Since this 
training 
software was 
developed in 
an earlier 
version of 
SiteManager, 
this screen 
may look 
slightly 
different when 
you are 
actually 
working in the 
system.  For 
example, the 
Instld Column 
is now on the 
far left and 
there is a new 
Category 
Description 
column. 
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When the Record Work Item button is clicked, the Record Work Items window 
displays usage information on the selected Item for the DWR. The Record Work 
Items window allows the User to view existing data for the Work Item or add 
new usage data.  

 
The Record Work Items Folder Tab  

Figure 6-8 

The Record Work Items window displays the following Item information: 

• Qty Reported to Date – Total quantity reported on DWRs. 

• Qty Authorized to Date – Total quantity reported on DWRs that were 
authorized in Diaries. 

• Units Type - The unit of measure for the pay item. 

• Qty Installed to Date – Total quantity reported on DWRs that were 
authorized in Diaries and included in approved and pending estimates. 

• Qty Paid to Date – Total quantity reported on DWRs that were 
authorized in Diaries and included in an estimate of any status. This 
value will always be the same as the Qty Installed to Date for TDOT 
when all estimates are approved. 

• Current Contract Qty - Current contract quantity of the Contract line item 
including any Change Orders. Current Quantity is calculated by the sum 
of Bid Quantity and the net Change Order quantity. 

TDOT is not 
using Pay To 
Plan Qty. 

Again, this 
screen may 
look slightly 
different when 
you get back 
to your office.  
An As Built 
Qty field is 
now directly 
below Placed 
Qty which 
TDOT does 
not plan to 
use.  Also the 
Measured 
Indicator is 
displayed 
different. 
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In TDOT, it is important to select the appropriate Category when documenting installed quantities on 
an item if that item exists in more than one Category.  The table below defines the various Categories 
used by TDOT.  Participating Categories are those paid by the normal funding source for the project.  
Non-Participating Categories are those paid by other funding sources than the normal funding source 
for the project.  Descriptions of the funding sources can be found in the Contract Funding window 
located at Main Panel>Contract Administration>Contract Records>Contract Funding.  If there are any 
questions concerning funding or if a Category needs to be added, please contact the Headquarters 
Finance Office. 

In TDOT, on the Record Work Items folder tab, the Placed Quantity, Contractor and Location are 
required information for each location sequence number.  TDOT will NOT use the As Built Qty field.  
Only the Prime Contractor and subcontractors approved to work on the work item can be selected as 
the Contractor.  If more than one contractor (prime or sub) performs work on the same Placed 
Quantity, the contractor performing most of the work should be selected.  While subcontractors may 
perform work on Add-On Items (non-bid items added with a quantity of zero and a line item number 
of 9000-9499), these must be recorded against the Prime Contractor because they will not appear as 
subcontracted items.  If the Placed Qty is not editable, a DWR template is required.  The Station 
Number fields should be used (if appropriate) for that item. 

In TDOT, installed work items from the DWRs authorized in the Diary window are used by the 
Contractor Payments component of SiteManager as the basis for paying the Contractor in an 
Estimate.   

A minimum TDOT DWR in SiteManager that reports installed quantities must include: 

• The weather conditions 

• The Work Performed remark, including the name of the contractor performing the work 

• The Contractor reported on the site, including personnel and equipment 

• The quantities at the item level that were installed 

• The location where the items were installed 

 

 

Item Types Participating 
Categories 

Non-Participating 
Categories 

Roadway Items 0100 0110 - 0190 

Box Bridge Items 0300 0310 - 0390 

Bridge Items 0500 0510 - 0590 

Maintenance & Other Items 0700 0710 - 0790 

Utility Items 0900 0900 - 0990 

Alternate Bid Items >1100 

TDOT Categories 

Table 6-1 
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 Exercise 6-7 

In the following exercise, you will record the details of a work item for the Prime 
Contractor for the DWR on April 11, 2005 for Contract CNB022I.   

User ID: jj05751 Group: INSPST Mode: Standalone  Contract: CNB022J 

1. Scroll to and select Project Nbr 55019-3220-94, Line Item Number 0020, 
Category Number 0100, Item Code 201-01, Description CLEARING AND 
GRUBBING. 

2. Click the Record Work Item button. SiteManager displays the info on the 
Work Items panel. 

Now, let’s enter the information about that work item. 
3. Click the New button.  
4. In the Placed Qty field, type 0.20 
5. In the Contractor drop-down list, click the expand arrow and click Volunteer 

Bridge Construction, Inc.  
6. In the Location field, type Grey Road.  
7. Click the Save button.  
8. Click the Selects Work Item button to return to the contract item list. 
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Selecting and Recording to a DWR Template 

DWR Templates are used to record contract activity data that cannot be entered 
on standard SiteManager panels. DWR Templates can also calculate values for 
work items and those values can be returned to populate the Placed Qty field of 
the Daily Work Report. If an item has an associated template for the contract that 
returns a value, then the Placed Qty field can only be populated by that return 
value and recording data to DWR Templates. The list of DWR templates 
available for the item may be accessed with the DWR Template button. 

Any DWR Templates associated to the selected Item are available from the DWR 
Template window for viewing or entering data.  The DWR Template panel is 
accessed with the DWR Template button.  If the item requires the use of a 
template, the DWR Template panel automatically displays when the work item 
location and contractor data is saved. 

 
The DWR Template Button 

Figure 6-9 

The DWR Templates panel displays a list of the DWR Templates available for 
use with this Work Item. The user chooses which DWR Template associated to 
the selected Item to view or record data to. Once the DWR Template has been 
chosen the User can enter data into the template. 

 

The DWR Template Panel  

Figure 6-10 

This screen does not 
match the data in 
the training exercise, 
but does reflect the 
use of the SM01 
template. 
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The DWR Template 

Figure 6-11 

 

TDOT has developed a number of SiteManager DWR Templates similar to 
the forms currently used for calculating and recording item quantities. 
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 Exercise 6-8 
In the following exercise, you will use a DWR template to record a placed 
quantity to the DWR on April 11, 2005 for Contract CNB022I.   

User ID: jj05751 Group: INSPST Mode: Standalone  Contract: CNB022J 

1. Scroll to and select Project Nbr 55019-3220-94, Line Item Number 0310, 
Category Number 0100, Item Code 712-06, Description SIGNS 
(CONSTRUCTION). 

2. Click the Record Work Item button. SiteManager displays the info on the 
Work Items panel. 

Now, let’s enter the information about the work item. 
3. Click the New button.  
4. Why is the Placed Qty field gray and un-editable for this item?  

_____________________________________________________________ 
5. In the Contractor drop-down list, click the expand arrow and click 

International Traffic 
6. In the Location field, type BOP to EOP.  
7. Click the Save button. SiteManager displays the DWR Template window. 
8. What is the title of the window that displayed when the save button was clicked?  

_______________________________________________________________ 
9. Double-click Template ID 22A - Aluminum Signs. 
10. In the Sign Schedule field, type 12B. 
11. In the Legend field, type General Robert R Neyland Bridge 
12. In the Size field, type 24” x 60”. 
13. In the Area of Each Sign field, type 10.00. 
14. In the # of Signs field, type 40. 
15. Press the Tab key. 
16. What is displayed in the Pay Quantity field? ______________ 
17. Click the Save button. 
18. Click the Close button. 
19. Click the Remarks button. 
20. In the Remarks box, type this is an example Remark. 
21. Click the Remark button to close the Remarks window. 
22. Click the Save button. 
23. Click the Selects Work Item button to return to the contract item list. 

DWR Template Required 

DWR Template  

400.0

Point out the lines 
displayed on the 
Remarks button.  

Template 22A has 
been revised since 
this training was 
originally developed.  
There are actual 
fields on this 
template now for 
remarks. 

This step 
demonstrates the 
Select Work Item 
button. 
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 Exercise 6-9 

In the following exercise, you will record the details of a work item for the Prime 
Contractor for the DWR on April 18, 2005 for Contract CNB022J.   

User ID: jj05751 Group: INSPST Mode: Standalone Contract: CNB022J 

First, let’s open an existing a DWR. 
1. On the Daily Work Reports window, click the DWR Info folder 

tab. 
2. Click the Open button. 
3. In the Contract ID select box, click the Contract ID button to 

change the focus of the window. 
4. From the Contract ID select list, double-click Contract ID 

CNB022J. 
5. From the Inspector select list, double-click User ID jj05751 

(Warren, Jackie). 
6. From the Date select list, double-click DWR Date 04/18/05. 
7. The DWR will open.  Review the details on the DWR Info folder 

tab.   

Now, let’s add a remark. 
8. In the Remarks Type list box, scroll to and click Work Performed.   
9. In the Remarks text box, type Volunteer Bridge Construction, 

Inc. -  Test pile driven at 2:30 PM. 
10. Click the Save button. 

Now, let’s review some more of the information on this DWR. 
11. Click the Contractors folder tab.  Was the Prime Contractor on-site? 

______________________________________________________ 
12. Click the Contractor Equip. folder tab.  How many pieces of 

equipment are listed on this DWR? ________________________  
13. Click the Daily Staff folder tab.  How many agency staff members 

were on site _____________________________________________ 

Exercise setup: It is one 
week later, and users are 
opening a DWR that was 
created earlier in the day 
to record placed quantity 
totals. 

Yes - Volunteer Bridge Construction, Inc 

Five types (7 total pieces) 

Five 

Note: changing  
to contract J 
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Now, let’s record a new work item. 
14. Click the Work Items folder tab. 

15. Scroll to and select Project Nbr 55019-3220-94, Line Item Number 
0500, Category Number 0500, Item Code 606-09.01, Description 
TEST PILES (PRECAST CONCRETE, SIZE 1). 

16. Click the Record Work Item button. SiteManager displays the info 
on the Work Items panel. 

Now, let’s enter the information about that work item. 
17. Click the New button.  
18. Why is the Placed Qty field gray and un-editable for this item?  

________________________________________________________ 
19. In the Plan Page Nbr. field, type 6. 
20. In the Contractor drop-down list, click the expand arrow and click 

Volunteer Bridge Construction, Inc.  
21. In the Location field, type Abutment #1, Column B, Footing A.  
22. In the Station From fields, type 5 + 25 LT 45. 
23. In the Station To fields, type 5+ 50 RT 45. 
24. Click the Save button. SiteManager displays the DWR Template 

window. 
25. What is the title of the window that displayed when the save button 

was clicked?  
________________________________________________________ 

26. In the DWR Template list box, scroll to and click Template ID SM05, 
05-TEST PILING (ENGLISH). 

27. Click the Record Template Data button.   

Now, let’s enter the structure information. 
28. In the Structure Type field, click the drop-down arrow and click 

Bridge. 
29. In the Bridge Number field, type 1. 
30. In the Substructure Type field, click the drop-down arrow and click 

Abutment. 
31. In the Abutment Number field, type 1. 
32. In the Station/Position field, type 5+35 / RT CL.  
33. What is automatically populated in the Location field?  

________________________________________________________ 

We need to save 
this information, 
but be prepared; 
clicking Save will 
open the DWR 
Template window. 

DWR Template  

DWR Template Required 

If using any of 
the station fields, 
the others may 
not be left blank. 

Provide enough detail 
in the Location field 
so that it is easy for 
others to interpret. 

Bridge 1 - Abutment  

The purpose of this 
exercise is to show 
a multi-line 
template as 
opposed to a 
regular template 
used in the 
previous exercise. 
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Now, let’s enter the survey information 
34. In the BM field, type 380.000. 
35. In the RR field, type 9.9. 
36. In the PCO field, type 381.50. 
37. Notice the Survey Info fields HI, RRGR, and OP fields were 

automatically populated. 

Now, let’s enter the pile information. 
38. In the Pile Number field, type 8.  
39. In the Initial Length (ft) field, type 55.0. 
40. In the Added Length (ft) field, type 0. 
41. Note the Pay Quantity field is automatically populated. 
42. In the Heat Number (Steel) field, type N/A – Concrete Pile. 
43. In the Load field, type 100. 
44. In the Required Bearing field, type 150. 
45. In the Remarks field, type #8 driven to 1.5 times req bearing. 
46. Click the Save button. 

Now, let’s record the pile penetration below P. C. O. as 0 feet 0 inches to 24 feet 
0 inches.  

47. Under the (ft) label, verify 0. 
48. Under the (in) to label, verify 0. 
49. Under the (ft) label, type 24. 
50. Under the (in) label, verify 0. 
51. In the Refusal? field, verify the No radio button is selected (ON). 
52. Click in the Hammer Type field and click P+H/Pre-Drilled P+H. 
53. Click the Save button. 

Remaining portion of 
template exercise is in 
detail section of the 
template.  Remind 
students to be careful of 
place holder zeros.  

Users MUST TYPE THE 
ZEROS like in the 
number ten even if it 
appears that the zeros are 
there already.   

Remind users to 
press the Tab key to 
move between fields. 

Users need to click 
the New button each 
time they enter a 
new data set. 
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Now, let’s continue the driving log: 
54. Click the New button. 
55. In the (ft) field, type 24. 
56. In the (in) to field, verify 0. 
57. In the (ft) field, type 25. 
58. In the (in) field, verify 0. 
59. In the Refusal? field, verify the No radio button is selected (ON). 
60. In the Hammer Type field, click the expand arrow and click Single Action. 
61. In the Hammer Weight, W (lbs) field, type 3800. 
62. In the Hammer Stroke, H (ft) field, type 7.5.  
63. Press the Tab key. 
64. What is automatically populated in the Penetration (in) field? ______________ 
65. In the Number of Blows column, type 100. 
66. What is automatically populated in the Bearing (tons) field? ________________  
67. Click the Save button. 
68. What is the Pay Quantity? ___________________________________________ 

Now, let’s view the results of using the template. 
69. Click the Close button. 
70. What has been populated in the Placed Quantity field? _________________  
71. Click the Save button. 
72. Click the DWR Info. tab. 
73. To prepare for the summary exercise, click the New button. Set up for 

summary 
exercise: to 
prevent students 
from getting the 
“copy” message. 

129.545 

12.000 

55.0 

55.0 
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Review for Section 6 
To access the Daily Work Report window: 

1. On the SiteManager main panel, double-
click the Daily Work Reports icon. 

2. On the Daily Work Reports panel, double-
click the Daily Work Reports icon. 

To enter basic DWR Info folder tab: 

1. On the SiteManager main panel, double-
click the Daily Work Reports icon. 

2. On the Daily Work Reports panel, double-
click the Daily Work Reports icon.  

3. Open an existing unauthorized, unlocked 
DWR created by you or create a new DWR. 

4. In the High Temperature field, click the 
spin button to advance to or type the correct 
temperature. 

5. Press the Tab key. 
6. In the Low Temperature field, click the 

spin button to advance to or type the correct 
temperature. 

7. Press the Tab key. 
8. In the A.M. field, type the prevailing 

weather conditions for the A.M. hours of the 
work period. 

9. Press the Tab key. 
10. In the P.M. field, type the prevailing 

weather condition for the P.M. hours of the 
work period. 

11. To enter a remark, in the Remark Type list 
box, scroll to and click the desired remark 
type. Then type the remark in the Remarks 
field. 

12. Click the Save button. 

To enter Contractor activity: 

1. On the SiteManager main panel, double-
click the Daily Work Reports icon. 

2. On the Daily Work Reports panel, double-
click the Daily Work Reports icon.  

3. Open an existing unauthorized, unlocked 
DWR created by you or create a new DWR. 

4. Enter or modify basic DWR Info. 
5. Click the Save button. 
6. Click the Contractors folder tab. 
7. Modify the Contractor data appropriately. 
8. Click the Save button. 

To add a personnel type to a Daily Work Report: 

1. On the SiteManager main panel, double-
click the Daily Work Reports icon. 

2. On the Daily Work Reports panel, double-
click the Daily Work Reports icon.  

3. Open an existing unauthorized, unlocked 
DWR created by you or create a new DWR. 

4. Enter or modify basic DWR Info. 
5. Click the Save button. 
6. Click the Contractors folder tab. 
7. If there is more than one Contractor listed, 

click the Contractor who employs the 
worker. 

8. Click the Personnel Type field and click 
the New button. An empty row is added to 
the list. 

9. In the Personnel Type drop-down list, click 
the expand arrow and click the desired 
personnel type. 

10. Press the Tab key. 
11. In the Nbr of Persons field, type the 

number of workers of this Personnel Type 
who worked on this date. 

12. Click the Save button. 
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To add equipment to a Daily Work Report: 

1. On the SiteManager main panel, double-
click the Daily Work Reports icon. 

2. On the Daily Work Reports panel, double-
click the Daily Work Reports icon.  

3. Open an existing unauthorized, unlocked 
DWR created by you or create a new DWR. 

4. Enter or modify basic DWR Info. 
5. Click the Save button. 
6. Click the Contractors folder tab. 
7. Add the contractor who supplied the 

equipment. 
8. Click the Save button. 
9. Click the Contractor Equipment folder 

tab.  
10. If there is more than one Contractor listed, 

click the Contractor who supplied the 
equipment. 

11. Click the Equipment ID field and click the 
New button. An empty row is added to the 
list. 

12. In the Equipment ID drop-down list, click 
the expand arrow and click the desired 
equipment ID. 

13. Press the Tab key. 
14. In the Nbr of Pieces field, type the number 

of pieces of this equipment present on this 
date. 

15. Press the Tab key. 
16. In the Nbr Used field, type the number of 

pieces of this equipment used on this date. 
17. Click the Save button. 

To add Daily Staff to a Daily Work Report. 

1. On the SiteManager main panel, double-
click the Daily Work Reports icon. 

2. On the Daily Work Reports panel, double-
click the Daily Work Reports icon.  

3. Open an existing unauthorized, unlocked 
DWR created by you or create a new DWR. 

4. Click the Daily Staff folder tab. 
5. Click the New button on the toolbar. 
6. In the Staff Member drop-down box, click 

the name of the staff member you want to 
add.  

7. In the Reg. Hours field, type the number of 
hours the staff member worked.  

8. Click the Save button. 
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To select and record a Work Item: 

1. On the SiteManager main panel, double-
click the Daily Work Reports icon. 

2. On the Daily Work Reports panel, double-
click the Daily Work Reports icon.  

3. Open an existing unauthorized, unlocked 
DWR created by you or create a new DWR. 

4. Enter or modify basic DWR Info. 
5. Click the Save button. 
6. Click the Contractors folder tab. 
7. Add the contractor who installed the work 

item(s). 
8. Click the Save button. 
9. Click the Work Items folder tab.  
10. In the Work Item list box, scroll to and 

click the work item whose installation needs 
to be recorded. 

11. Click the Record Work Item button.  
12. Click the Location Installed field and click 

the New button.  An empty row is inserted 
on the Record Work Item List.   

13. In the Placed Qty field, type the quantity of 
the item installed at this location. 

14. Press the Tab key. 
15. In the Plan Page Nbr field, type the page 

number of a reference to the installed item. 
16. In the Contractor drop-down list, click the 

expand arrow and click the name of the 
Contractor responsible for the installed item. 

17. Press the Tab key. 
18. In the Location field, type the location 

where the item was installed. 
19. In the From Station field, type the Station 

ID that identifies where the installation of 
this Work Item starts. 

20. Press the Tab key. 
21. In the From Station Offset field, type the 

offset from the Station ID that identifies 
where the installation of this Work Item 
starts. 

22. Press the Tab key. 
23. In the From Station Distance field, type the 

offset distance from the Station ID that 
identifies where the installation of this Work 
Item starts. 

24. Press the Tab key. 
25. In the To Station field, type the Station ID 

that identifies where the installation of this 
Work Item ends. 

26. Press the Tab key. 
27. In the To Station Offset field, type the 

offset from the Station ID that identifies 
where the installation of this Work Item 
ends. 

28. Press the Tab key. 
29. In the To Station Distance field, type the 

offset distance from the Station ID that 
identifies where the installation of this Work 
Item ends. 

30. Click the Save button. 
31. Repeat steps 12-31 for additional locations 

where the work item was installed on this 
workday. 

32. When complete, click the Select Work 
Item button to select additional items for 
recording or return to the current DWR. 

To Record Work Item Data to DWR Templates: 

1. To invoke the DWR Template window click 
on the DWR Template button or select 
Edit/View Work Item Template Data 
from the Services menu. 

2. The DWR Template ID window displays the 
Templates available for use with the 
selected Work Item. Choose a DWR 
Template to record data to and click the 
Record Template Data button or choose 
Record Template Data from the Services 
menu. The DWR Template is displayed. 

3. Enter the appropriate data into the fields of 
the DWR Template. 

4. Click the Save button or select Save from 
the File menu when the data is fully entered 
into the Template. 

5. Click the Close button or select Close from 
the File menu to return to the Record Work 
Item window. The Placed Qty field is now 
populated with the value from the DWR 
Template and the Templt Used box is 
checked. 

 

 

 

Key to recording DWR data is 
accuracy.  The placed quantity 
recorded in a DWR is the 
quantity that will be paid on an 
estimate, barring any test report 
or other adjustments. 

“Garbage in = garbage out” 
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10.6 

Summary Exercise for Section 6 
In the following exercise, you will create a DWR for April 19, 2005 for Contract CNB022J using 
the information provided below. 

User ID: jj05751 Group: INSPST Mode: Standalone  Contract: CNB022J 

Weather conditions: 
• High - 70 degrees 
• Low - 49 degrees 

• AM -Partially Cloudy  
• PM - Partially Cloudy 

Remarks: 
• Work Performed: Volunteer Bridge installed 18” RCP at station 16+75 RT 

Centerline. 
Personnel:   

• Foreman – 1 
• Class “B” Operator – 2 

• Class “D” Operator – 1 
• Truck Driver (3/4 axels) – 2 

Equipment (on site and used)  
• Backhoe/Hydraulic Excav - 1 
• Pickup Truck – 3 
• Bull Dozer – 1 

• Bobcat – 1 
• Haul Truck – 2 

Daily Staff  
• Warren, Jackie – 7.5 hours • Johnson, Terry – 7.5 hours 

Items: 
1. Item Code 204-07, BEDDING MATERIAL (PIPE) CLASS B (Project 55021-3214-94, 

Line Item Nbr 0643, Category Number 0100): 
• Plan Page Nbr: 4A 
• Contractor: Volunteer Bridge 

Construction, Inc. 
• Location: Station 16+75 RT 

Centerline 
• Template SM10E 

• Culvert Type: Concrete Pipe 
• Pipe Diameter (in): 18 
• Length (ft): 50.000 

What is the pay quantity for this 
item?__________________________________________________ 

2. Item Code 607-39.02, 18” PIPE CULVERT (Project 55019-3220-94, Line Item Nbr 
0200, Category Number 0100): 

• Contractor: Volunteer Bridge 
Construction, Inc. 

• Location: Station 16+75 RT 
Centerline 

• Placed Quantity: 50 

When complete, navigate to the Daily Work Reports panel. 
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Learning Module 

 Section 7  Daily Work Reports II 
for Field and Office Documentation 

 

By the end of this module, you will be able to: 

• Copy a Daily Work Report 

• Modify a Daily Work Report  
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Copying a Daily Work Report 

After creating the first Daily Work Report for a new Contract, it is easier to copy 
an existing DWR rather than creating a new one from scratch.  A copied Daily 
Work Report copies the following data to a new Daily Work Report. 

• Contractor 

• Personnel (Including number of persons) 

• Equipment (Including number of pieces and number used) 

• Daily Staff (Including hours) 

A copied DWR will not include the following data from the original Daily Work 
Report: 

• Basic DWR Info 

• Installed Work Items and Templates 

To copy a DWR, the user simply changes the date on any existing DWR. This 
prompts the user to confirm the contractor data should be copied to the new 
DWR date.  You may use the calendar to indicate the new DWR date, or you 
may type the new date over the existing date in the date field. 

Tip: The User copying it must have authored the DWR being copied. 

The DWR Info Folder Tab  

Figure 7-1 

In TDOT, the following must be entered on the DWR Info folder tab on a 
copied DWR: 

• Date 
• Temperature 
• Weather Conditions  

• Work Performed Remarks, 
including contractor name 

• Appropriate Remarks 

To copy a 
DWR, the user 
simply changes 
the date on any 
existing DWR. 
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 Exercise 7-1 
In the following exercise, you will copy an existing DWR for April 18, 2005 to create 
a new DWR for April 20, 2005 on Contract CNB022J. 

User ID: jj05751 Group: INSPST Mode: Standalone Contract: CNB022J 

First, open the DWR you wish to copy from (4/18/05): 

1. On the Daily Work Reports panel, double-click the Daily Work Reports icon. 
2. Click the Open button. SiteManager displays the Contract ID window. 
3. In the Inspector list box, scroll to and double-click jj05751. 
4. In the Date list box, scroll to and double-click the DWR Date 04/18/05. 

SiteManager displays the Daily Work Reports window. 

Now, let’s copy the contractor information from the 4/18/05 DWR to a new DWR for 
4/20/05.  

5. In the DWR Date field, type 042005. 
6. On the keyboard, press the Tab key. SiteManager displays a message prompting 

you to confirm your desire to copy the contractor information. 
7. In the message, click the Yes button. 
8. Click the Save button. 

Now, let’s enter the temperatures and conditions for 4/20/05. 
9. In the High Temperature field, type 71. 
10. In the Low Temperature field, type 52. 
11. In the A.M. drop-down list, click the expand arrow to the right of the current 

selection and click Sunny. 
12. In the P.M. drop-down list, click the expand arrow to the right of the current 

selection and click Sunny. 

Now, let’s enter a remark for 4/20/05. 
13. In the Remarks Type list box, scroll to and click Work Performed. 
14. In the Work Performed text box, type Volunteer Bridge driving Production 

Piling. 
15. Click the Save button. 
 

Users may 
also use the 
calendar to 
pick a date. 

Stress this! 

To be 
prompted 
to copy 
contractor  
info, after 
typing or 
choosing 
the new 
date, Tab 
out of the 
DWR Date 
field, save  
or click into 
another 
field. 
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Modifying a Copied Daily Work Report 

Once a Daily Work Report is copied, the User may modify the Contractors, and 
Personnel Types, Equipment, and Daily Staff on the new DWR to reflect the 
activities of the day.  

The Contractors Folder Tab 

The Contractors (Prime and Sub), and Personnel Types as well as the number of 
workers may be modified on the Contractors folder tab.  

 

The Contractors Folder Tab 

Figure 7-2 

Auto 
populated – 
DON’T 
ENTER. 
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 Exercise 7-2 
In the following exercise, you will modify the contractors, supervisors, and personnel 
types for a copied DWR on April 20, 2005 for Contract CNB022J.  

User ID: jj05751 Group: INSPST Mode: Standalone Contract: CNB022J 

1. On the Daily Work Reports window, click the Contractors folder 
tab.   

2. Click the Contractor Volunteer Bridge Construction, Inc.  

3. Click the Personnel Type area select the Unskilled Laborer 
personnel type. 

4. In the Nbr of Persons field, type 5 (overwriting  the 4). 

5. Click the Save button.  

Now, let’s add a subcontractor. 

6. Click the Contractor area. 

7. Click the New button.  An empty row is added to the list. 

8. In the Contractor drop-down list, click the expand arrow to the right 
of the current selection and click WMC Contracting Company, Inc.  

9. Click the Save button.  

Now, let’s add personnel type for that subcontractor. 

10. Click the Personnel Type area. 

11. Click the New button. An empty row is added to the list. 

12. In the Personnel Type drop-down list, click the expand arrow to the 
right of the current selection and click Class “D” Operators. 

13. For the Class “D” Operators personnel type, in the Nbr of Persons 
field, type 1. 

14. Click the Save button.  

Now, let’s add another personnel type for that subcontractor. 

15. Click the New button. An empty row is added to the list. 

16. In the Personnel Type drop-down list, click the expand arrow to the 
right of the current selection and click Foreman. 

17. For the Foreman personnel type, in the Nbr of Persons field, type 1. 

18. Click the Save button.  

Users are 
modifying the 
number of 
Laborers on 
the DWR. 
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Now, let’s add another personnel type for that subcontractor. 

19. Click the New button. An empty row is added to the list. 

20. In the Personnel Type drop-down list, click the expand arrow to the 
right of the current selection and click Unskilled Laborer. 

21. For the Unskilled Laborer personnel type, in the Nbr of Persons 
field, type 4. 

22. Click the Save button.  

Now, let’s add another personnel type for that subcontractor. 

23. Click the New button. An empty row is added to the list. 

24. In the Personnel Type drop-down list, click the expand arrow to the 
right of the current selection and click Truck Driver (2 axles). 

25. For the Truck Driver (2 axles) personnel type, in the Nbr of Persons 
field, type 1. 

26. Click the Save button. 
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The Contractor Equip. Folder Tab 

The contractor’s equipment, number of pieces and the number of pieces used 
may be modified on the Contractor Equipment folder tab. 

 

The Contractor Equip Folder Tab 

Figure 7-3 
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 Exercise 7-3 
In the following exercise, you will modify a Contractor’s equipment list for a copied 
DWR on April 20, 2005 for Contract CNB022J.  

User ID: jj05751 Group: INSPST Mode: Standalone  Contract: CNB022J 

1. On the Daily Work Reports window, click the Contractor Equip 
folder tab.   

2. In the Contractor area, click WMC Contracting Company, Inc.  
3. Click the Equipment ID-Description area. 
4. Click the Save button.  

Now, let’s add an equipment type for that subcontractor. 
5. Click the New button.  An empty row is added to the list. 
6. In the Equipment ID-Description drop-down list, click the expand 

arrow to the right of the current selection and click Farm Tractor.  
7. In the Nbr of Pieces field, type 1.  
8. In the Nbr Used field, type 1. 
9. Click the Save button.  

Now, let’s add another equipment type for that subcontractor. 
10. Click the New button.  An empty row is added to the list. 
11. In the Equipment ID-Description drop-down list, click the expand 

arrow to the right of the current selection and click Haul Truck.  
12. In the Nbr of Pieces field, type 1.  
13. In the Nbr Used field, type 1. 
14. Click the Save button. 

Now, let’s add another equipment type for that subcontractor. 
15. Click the New button.  An empty row is added to the list. 
16. In the Equipment ID-Description drop-down list, click the expand 

arrow to the right of the current selection and click Pickup Truck.  
17. In the Nbr of Pieces field, type 2.  
18. In the Nbr Used field, type 2.  
19. Click the Save button. 
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Now, let’s delete a piece of equipment type for the Prime Contractor. 
20. In the Contractor area, click Volunteer Bridge Construction, Inc. 
21. In the Equipment ID-Description list, click the Crane.  
22. Click the Delete button. 
23. Click Yes to the delete message. 
24. Click the Save button. 
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The Daily Staff Folder Tab 

The Daily Staff and the hours on site may be modified on the Daily Staff folder 
tab.  

 

The Daily Staff Folder Tab 
Figure 7-4 

 Exercise 7-4 
In the following exercise, you will modify the Daily Staff for a copied DWR on April 
20, 2005 for Contract CNB022J.  

User ID: jj05751 Group: INSPST Mode: Standalone  Contract: CNB022J 

1. On the Daily Work Reports window, click the Daily Staff folder 
tab.   

2. In the Staff Member area, click Miller, Chris.  
3. Click the Delete button. SiteManager displays a message to confirm 

deletion. 
4. In the message, click the Yes button. 
5. In the Staff Member area, click Roberts, Jan.  
6. Click the Delete button. SiteManager displays a message to confirm 

deletion. 
7. In the message, click the Yes button. 

Now, let’s modify the hours for the daily staff. 
8. In the Staff Member area, click Johnson, Terry. 
9. In the Reg Hours field, type 7.5. 
10. In the Staff Member area, click Warren, Jackie. 
11. In the Reg Hours field, type 9. 
12. Click the Save button. 
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The Work Items Folder Tab 

Work Item details do not copy from one DWR to another.  Work item details for 
the new Daily Work Report may be recorded on the Work Items folder tab.  

The Work Items Folder Tab 

Figure 7-5 

 Exercise 7-5 
In the following exercise, you will record work item details for a copied DWR on 
April 20, 2005 for Contract CNB022J.  
User ID: jj05751 Group: INSPST Mode: Standalone  Contract: CNB022J 

1. On the Daily Work Reports window, click the Work Items folder 
tab. 

2. Scroll to and select Project Number 55019-3220-94, Line Item 
Number 0520, Category Number 0500, Item Code 606-09.03, 
Description PRECAST CONCRETE PILES (SIZE 1). 

3. On the toolbar, click the Record Work Item button. 
4. Click the New button. 

Now, let’s record the details about the work item. 
5. In the Plan Page Nbr field, type 9. 
6. In the Contractor drop-down list, click the expand arrow and click 

Volunteer Bridge Construction, Inc. 
7. In the Location field, type Bent to 10+90 Column A, Footing D. 

Now, let’s choose a template. 
8. Click the Save button. SiteManager displays the DWR Template list 

box. 

This exercise will 
demonstrate the use 
of a detail multi-line 
template to record 
pile driving data and 
determine the placed 
quantity of the item. 

Again, this 
screen may 
look slightly 
different when 
you get back 
to your office.  
An As Built 
Qty field is 
now directly 
below Placed 
Qty which 
TDOT does 
not plan to 
use.  Also the 
Measured 
Indicator is 
displayed 
different. 
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9. In the DWR Template list box, click SM07 - 07 CONCRETE/ 
TIMBER PRODUCTION PILING (ENGLISH). SiteManager 
displays a DWR Template window. 

10. Click the Record Template Data button. 
Now, let’s enter the structure data. 

11. In the Structure Type drop-down list, click the expand arrow and 
click Bridge. 

12. In the Bridge Number field, type 1. 
13. Click in the Substructure Type drop-down list and click Bent. 
14. In the Bent Number field, type 2. 
15. Note that the Location field is automatically populated. 
16. In the Station/Position field, type 10+90 Column A, Footing D.   
17. In the Length Set field, type 35.0. 
18. In the Required Bearing field, type 90.0. 
19. Click the Save button. 

Now let’s enter the pile information. 
20. In the Pile Number field, type 1. 
21. In the Initial Length (ft) field, type 35.0. 
22. In the Pile Stripped for Seismic? (-2’) field, click the Yes radio button 

(ON). 
23. In the Cut-Off (ft) field, type 4.0. 
24. In the Refusal? field, select the Yes option. 
25. Click the Save button. 
26. What is the Total Pay Quantity? ______________________________   

Now, let’s review the results. 
27. Click the Close button. 
28. Note the Placed Qty field has been populated. 
29. What was the total placed quantity? ___________________________ 

Remaining 
portion of 
template exercise 
is in detail section 
of the template.  
Remind students 
to be careful of 
place holder 
zeros. 

29.0 

29.0 
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Creating and Using Attachments 
The Attachment functionality of SiteManager allows URL links, Plug-In 
applications, and OLE attachments to be attached to certain SiteManager records.  

Attachments are activated by clicking the attachment button, then double-
clicking the attachment. 

Creating an OLE Attachment 

The Microsoft Windows’ Object Linking and Embedding standard (OLE) allows 
Windows programs like SiteManager to access the functionality of other OLE-
compliant Windows applications.  The Attachments feature choice will work 
with any properly-installed, OLE-compliant Windows application.   

When you use the OLE functionality to create a new attachment, you are actually 
embedding the data and the connection to the application’s functionality in the 
SiteManager database.  Even though the OLE object is assigned a name, the data 
does not actually exist as an external file on your network or workstation hard 
drive.  It only exists as a named object in the SiteManager database.  Anyone 
with access to the record can assess the embedded data if the application that 
created the data is installed on their workstation. 

 

Insert Object Dialog Invoked by the New OLE button 

Figure 7-6 
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TDOT field Office Staff will use the Plug-In Attachment function in the Contracts 
window to run the plug-ins that adjust the estimate.  

TDOT will use the URL Attachment function in the System Attachment window to 
access additional resources such as the TDOT File Management system.  

TDOT field Office Staff and Inspectors will use the OLE Attachment function in the 
DWR window to attach an Excel or Word document to a recorded work item.  An 
example would be when work has begun on an item before the Change Order 
adding that item has been approved in the system.  In this case, work will be 
tracked using the SiteManager Loose Leaf Forms stored in File Management 
(accessible via a URL link in the System Attachments window). Once the Change 
Order item has been added to the contract, a “catch-up” quantity should be placed 
on the item and all supporting SiteManager Loose Leaf Forms should be attached to 
the quantity.   

The OLE Attachment function should not be used to attach .jpg, .bmp or other 
picture file types.  These should be saved in the File Management System.   

When selecting security groups for attachments, it is recommended to choose “Add 
All” to add all security groups to the attachment.   

Entering a Remark such as “View Attachment” will indicate to users when viewing 
reports that an attachment exists.  
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 Exercise 7-6 
In the following exercise, you will create an attachment on a DWR Work Item on 
DWR date 4/20/05 on Contract CNB002J.  

User ID: jj05751       Group: INSP      Mode: Standalone  Contract: CNB022J 

1. Click the Attachments button on the toolbar.   
2. Click the New OLE button on the toolbar.   
3. Click the Create From File folder tab.   
4. Click the Browse button.   
5. Select the file to be attached: 

C:\SMTRAINS\SMFILES\Attachment.xls 
6. Click the Open button.   
7. Click the OK button.   
8. In the Name field, type Example. 
9. In the Description field, type Calculations. 
10. In the Attachment Security box, click the Add All button.   
11. Click the Add button.   
12. Click the Attachments button.  
13. Click the Save button. 
14. Click the Remarks button.  
15. In the Remarks field, type View Attachment. 
16. Click the Remarks button to close the Remarks window. 
17. Click the Save button. 
18. Click the Attachments button. 
19. Click the Run Attachment button.  
20. In the Excel worksheet, click the Exit button to close the attached 

document and program. 
21. Click the Save button. 

Now, let’s prepare for the Summary Exercise. 
22. Click the DWR Info folder tab. 

The Excel file may 
be minimized at the 
bottom of your 
computer, on the 
task bar. 

The Description 
field is important 
for identifying the 
contents of the 
attachments. 
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Review for Section 7 
To create a new Daily Work Report using the copy 
function: 

1. On the SiteManager main panel, double-
click the Daily Work Reports icon. 

2. On the Daily Work Reports panel, double-
click the Daily Work Reports icon. 

3. Click the Open button. 
4. In the Contract ID list box, scroll to and 

double-click desired Contract. 
5. On the Inspector list box, scroll to and 

double-click your User ID.   
6. On the Date list box, scroll to and double-

click desired DWR Date.  It may not be a 
locked or authorized DWR. 

7. Double-click the Date field.  The calendar 
appears. 

8. Advance to the correct month and click the 
correct date for the new Daily Work Report. 

9. Click Ok.   
10. Click the Yes button for the message box 

asking if Contractor information should be 
copied. 

11. Click the Save button. 
12. Click the desired folder tab. 
13. Modify the data appropriately. 
14. Click the Save button. 
 

To attach a file to a record: 

1. Click the Attachment button. 
2. Click the New OLE button. 
3. Click the Create from File folder tab. 
4. Click the Browse button. 
5. Select the drive and file name for the file to 

be attached. 
6. Click the Open button. 
7. Click Ok.   
8. In the Name field, type the name for the 

document. 
9. In the Attachment Security box, click the 

Add All button to add all groups to the 
Access box. 

10. Click the Add button. 
11. Click the Attachment button.. 
12. Click the Save button. 
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Summary Exercise for Section 7 
In the following exercise, you will modify a copied DWR for Contract CNB022L. 
User ID: jj05751 Group: INSPST Mode: Standalone  Contract: CNB022L 

Use the Daily Work Report from Jackie Warren (jj05751) for Contract CNB022L on 11/21/05 to 
copy and create a new DWR for 11/22/05.  Be sure to copy the Contractor information for use in the 
following steps. 

Temperature and Weather conditions: 
• High - 59 degrees 
• Low - 36 degrees 

• AM -Partially Cloudy  
• PM - Clear 

Remarks: 
• Work Performed: International Traffic Systems, Inc Installed permanent 

signs. 
Personnel for Prime Contractor, Volunteer Bridge Construction, Inc. (update the record as 
necessary):   

• Class “A” Operators – 1 
• Unskilled Laborer – 4 

• Sweeping Machine (Vacuum) – 1 
• Truck Driver (3/4 axles) – 1 

 
Personnel for Subcontractor, International Traffic Systems, Inc. (update the record as 
necessary):   

• Foreman – 1 
• Unskilled Laborer – 4 

• Skilled Laborers – 3 
• Truck Driver (2 axles) – 1 

 
Equipment for Volunteer Bridge Construction, Inc. (update the record as necessary):   

• Pickup Truck – 2 
• Backhoe – 1 

• Haul Truck – 1 
• Sweeping Machine – 1 

 
Equipment for International Traffic Systems, Inc. (update the record as necessary):   

• Pickup Truck – 2 • Haul Truck – 1

Exercise continues on the next page. 
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Daily Staff  
• Warren, Jackie – 9 hours • Johnson, Terry – 9 hours

Items: Record the following information for Line Item Nbr 0310 Project 55019-3220-94, Item 
Code 712-06:

• Plan Page Number: 16 
• Contractor: International 

Traffic Systems, Inc. 

• Location: BOP to EOP 
• Template: SM22A 

Record the following information for template SM22A:
• Sign Schedule #: 12B 
• Legend: General Robert 

R. Neyland Bridge 

• Size: 24” x 60” 
• Area of Each Sign: 10.0 
• # of Signs: 4

What is the placed qty for this item at this location? ___________________ 

Exit SiteManager.  
 

40.0 
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Learning Module 

 Section 8  From PM to Server 
for Field and Office Documentation 

 

By the end of this module, you will be able to: 

• Upload Data to the Server 

• View Pipeline Information 
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Overview 

Pipeline is the process that automates the transfer of data. SiteManager provides 
the Pipeline processes because Contract data must be downloaded and uploaded 
often during the life of a Contract. In general, the data downloaded from the 
Server is the Basic Contract Data, which is primarily the Contract specifications. 
The data uploaded to the Server is the Contract activity data, which is the work 
done on the Contract. Pipeline automates the data flow from the: 

• Server to Standalone Mode (PM) 

• Standalone Mode (PM) to Server 

 

Pipeline The pipeline process transfers data files from one database to 
another. In SiteManager, the User uses the pipeline process to 
download data directly from the server’s database to the standalone 
workstation’s database, and to upload data directly from the 
standalone workstation’s database to the server’s database.  

 

The Pipeline Panel 

When logging on to SiteManager to Pipeline data, the User connects to the server 
database. 

 

The Pipeline Panel 

Figure 8-1 

PM = Standalone 

Think of PM as 
Personal Machine 

Upload contract data 
on a regular basis to 
avoid problems if 
somebody leaves near 
the end of a contract. 
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The following table shows how the Pipeline panels are used to transfer data.  

Step Activity Process Pipeline Panel 

1 Download 
Basic Contract 
Data from the 
Server 

The User selects and downloads basic 
contract data from the server’s database to 
the standalone workstation’s database using 
the Server to PM Pipeline panel. The 
Pipeline process loads the data directly into 
the User’s standalone database. Before 
DWRs can be generated in Standalone mode, 
the User must download Basic Contract Data 
from the Server. 

Server to PM Pipeline panel

2 Create Daily 
Work Reports 

The User creates and modifies DWRs on the 
contract to report the usage of Labor, 
Equipment, and Items on the Contract. 

As DWRs are created, they 
are listed on the DWR 
Select folder tab in the PM 
to Server window. 

3 Upload Daily 
Work Reports 
to the Server 

The User selects and uploads DWRs from 
the standalone workstation to the Server. 

PM to Server Pipeline panel

4 View Pipeline 
History 

The User can view a history of Pipeline 
activity. 

Pipeline Information panel 

5 Download 
Basic Contract 
Data and Daily 
Work Reports, 
as needed. 

New data is added to the Contract on the 
Server only. The User downloads new 
Contract data as it becomes available. The 
new data updates the standalone database. 
The User can also download Daily Work 
Reports. 

Download Basic Contract 
Data and Daily Work 
Reports as needed. 

NOTE: Basic Contract Data 
includes all Change Order 
information. 

6 Release the 
Contract 

When the Contract work is done, the User 
uses Pipeline to release the Contract back to 
the Server. 

PM to Server Pipeline panel

The Pipeline Process Table 

Table 8-1 

 

In TDOT, the Inspector must always check out Basic Contract Data when 
pipelining a contract to Standalone mode on his/her computer for the first 
time.  It is required that the Basic Contract Data be pipelined to Standalone 
mode a minimum of twice a week to ensure that the Standalone database has 
the most current contract information. 
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Check In — Uploading Data from PM to the Server  

The PM to Server Pipeline panel lets the User upload (check in) data from the 
standalone database to the server. When logging on to SiteManager, the User 
must connect to the server database. The pipeline process transfers the selected 
data directly from the User’s standalone database to the server database. 

To upload Contract data to the server, the User must first select a Contract and 
then select the Daily Work Reports to upload.  

To release the Contract when the Contract work is completed, and all DWRs 
have been pipelined to the server, the User checks the Basic Contract Data box. 
After the User selects the data to upload, the pipeline process is triggered by 
selecting the Services menu Pipeline Data option. 

PM to Server Pipeline Summary 

The PM to Server Pipeline Summary folder tab shows the number of Daily Work 
Reports selected. When the User selects the Services menu Pipeline Data option, 
the selected data is extracted from the standalone workstation. 

 

The Pipeline Summary Folder Tab 

Figure 8-2 

In TDOT, the User should pipeline DWRs to the server as soon as possible 
or as needed for an estimate. It is required that the Daily Work Report 
Data be pipelined to Server mode a minimum of  twice a week to ensure 
that the Server database has the most current contract information. 
In TDOT, at the end of the contract, the User should pipeline the  
Basic Contract Data from the standalone database back to the Server. 

The pipeline process 
loads the data directly 
from the User’s 
standalone database to 
the server database. 

 

To include current 
data in an estimate, 
make sure all DWRs 
have been uploaded 
before generating the 
estimate.  

The Basic Contract 
Data check box 
releases the 
contract when all 
work is done. 

The DWR folder 
tab is identical to 
the one in the 
Server to PM 
Pipeline window.

The Check In Status 
field displays the 
activity and complete 
status of the pipeline 
process. 

Why do you Pipeline 
Basic Contract Data? 
To keep the Contract 
Select list small. 
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 Exercise 8-1 
In the following exercise, you will navigate  to Server Pipeline panel and select 
Contract CNB022N. 

User ID: jj05751 Group: INSP  Mode: Server  Contract: CNB022N 
1. Double-click the SiteManager Training program icon on the desktop. 
2. In the User ID field, type jj05751. 
3. In the Password field, type pass. 
4. Click the Logon button. 

Now, let’s open the Pipeline panel and select a contract. 
5. On the Main Panel, double-click the Pipeline icon. 
6. On the Pipeline panel, double-click the PM to Server Pipeline icon. 

SiteManager displays the PM to Server Pipeline window. 
7. On the toolbar, click the Open button. 
8. In the Contract ID list box, scroll to and double-click Contract CNB022N. 
9. Click the DWR Select folder tab.  

Shift-tab if user 
ID not 
highlighted. 
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Selecting Daily Work Reports 

When the User clicks the DWR Select folder tab on the PM to Server Pipeline 
panel, the panel displays a list of Daily Work Reports that have not been 
uploaded to the server. The User selects the Daily Work Reports to upload.  

 

The DWR Select Folder Tab 

Figure 8-3 

 
In TDOT, completed Daily Work Reports should be pipelined from 
Standalone mode to Server mode as soon as possible or as needed for an 
Estimate.  It is required that the Daily Work Report Data be pipelined to 
Server mode a minimum of  twice a week to ensure that the Server 
database has the most current contract information. 
Diaries will always be created in Server mode and do not need to be 
pipelined. 
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 Exercise 8-2 

In the following exercise, you will upload data from Contract CNB022N to the 
server.  

User ID: jj05751 Group: INSP  Mode: Server  Contract: CNB022N 
1. In the DWRs list box, click the DWR created by Warren, Jackie on 

04/18/05.  
2. Click the Add button. 
3. In the DWRs list box, click the DWR created by Warren, Jackie on 

04/19/05. 
4. Click the Add button. 
5. In the DWRs list box, click the DWR created by Warren, Jackie on 

04/20/05. 
6. Click the Add button. 
7. Click the Pipeline Summary folder tab. Note that you have selected 

3 DWRs. 
8. Click the Services menu. 
9. Click the Pipeline Data choice. The SiteManager training 

application displays an SQL error. In the error message, click the 
Continue button. 

10. The Check In Status field message confirms that check-in is 
complete. Note that the DWRs field now shows 0. This confirms that 
the DWRs have been pipelined. 

11. Click the Close button. 

This is due to 
the training 
database. 
This does not 
occur in 
production. 
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Viewing Pipeline Information 

The Pipeline Information panel lets the User view Pipeline information about 
Daily Work Reports (DWRs). The Pipeline Information panel shows a history of 
Pipeline activity, such as when the data was downloaded and uploaded, and who 
downloaded or uploaded the data.  

The Pipeline Information panel displays information that applies to the selected 
Contract. When the User is connected to the server, the panel shows information 
on data uploaded and downloaded to and from the server. When the User is 
connected to the standalone database, the panel shows information on data 
uploaded and downloaded to and from the workstation. 

 

The Contract Folder Tab 

Figure 8-4 

 

In TDOT, the Pipeline Information panel can be used by the Project 
Supervisor to check the frequency of pipelining activities to ensure 
standalone contract data is pipelined up regularly.  It may also be used to 
verify that checked out DWRs have been pipelined to the server prior to 
generating an estimate. 

 

Check Out Date/Check 
Out Time refers to 
transferring data from 
the Server to PM.  

Check In Date/Check In 
Time refers to 
transferring data from 
PM to Server.  
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 Exercise 8-3 

In the following exercise, you will view a history of Pipeline activity on Contract 
CNB022N.  

User ID: jj05751 Group: INSP  Mode: Server  Contract: CNB022N 
1. On the Pipeline panel, double-click the Pipeline Information icon. 
2. Click the Contract folder tab. 
3. When was Contract CNB022N checked out by User jj05751? 

_______________________________________________________ 
4. Click the DWRs folder tab. 
5. How many DWRs has jj05751 (Jackie Warren) checked in? 

_______________________________________________________ 
6. Click the Close button. 

04/08/05 

3 

Project 
Supervisors 
will use this 
to see how 
often 
Inspectors 
are 
uploading. 
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Daily Work Report Applicability 

Daily Work Report data is transferred using the Pipeline function. To begin 
working on a Contract, the User must first download Basic Contract Data from 
the Server. ‘Basic Contract Data’ includes all of the Contract data required to 
process the Daily Work Reports, including Change Orders, Subcontracts, and 
Master Lists. Daily Work Reports can be downloaded from the Server and edited 
only if they are unauthorized and not included on a paid Estimate.  

Pipeline is used to: 

• Download Basic Contract Data, which includes Change Orders and Subcontracts, from the Server at 
least twice a week 

• Upload Daily Work Reports to the Server at least twice a week 

• Upload the Contract when work is done 
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Review for Section 8 
To upload data to the server: 

1. When logging on to SiteManager, connect 
to the server database. 

2. On the SiteManager main panel, double-
click the Pipeline icon. 

3. On the Pipeline panel, double-click the PM 
to Server Pipeline icon. The Pipeline 
Summary folder tab is displayed. 

4. To select a Contract, click the Open button. 
5. In the Contract ID list box, scroll to and 

double-click the Contract. 
6. To release the Contract, click the Basic 

Contract Data check box (ON). 
7. To select Daily Work Reports, click the 

DWR Select folder tab. 
8. In the DWR list box, shift-click each Daily 

Work Report to be uploaded. 
9. Click the Add button. The selected Daily 

Work Reports are added to the Selected 
DWRs list. 

10. Click the Pipeline Summary folder tab. 
The panel displays the total number of 
Diaries, Daily Work Reports, and Samples 
selected. 

11. To upload the selected data to the Server, 
click the Services menu and click the 
Pipeline Data choice. 

To view a history of Pipeline  activity: 

1. When logging on to SiteManager, to view 
information on data transferred to and from 
the server, connect to the server database. 
To view information on data transferred to 
and from the workstation, connect to the 
standalone database. 

2. On the SiteManager main panel, double-
click the Pipeline icon. 

3. On the Pipeline panel, double-click the 
Pipeline Information icon. The Samples 
folder tab is displayed. 

4. To select a Contract, click the Open button. 
5. In the Contract ID list box, scroll to and 

double-click the Contract. 
6. To view Pipeline information for the 

selected Contract, click the Contract folder 
tab. 

7. To view Pipeline information on Daily 
Work Reports for the selected Contract, 
click the DWRs folder tab. 

8. To view Pipeline information on Change 
Orders for the selected Contract, click the 
Change Orders folder tab. 
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Summary Exercise for Section 8 

In the following exercise, you will pipeline data to the Server on Contract CNB022N.  

User ID: jj05751         Group: INSP           Mode: Server           Contract: CNB022N 

1. For Contract ID CNB022N, upload the following DWRs for Warren, Jackie to the Server: 
DWR Dates:  

• 04/12/05 
• 04/13/05 
• 04/14/05 
• 04/15/05 
• 04/16/05 
• 04/17/05. 

2. Navigate to the Pipeline Information window. 

3. What date/time/user is shown as checking out the DWR created by jj05751 on 4/12/05 on 
Contract CNB022N? 
_________________________________________________________________________ 

4. What date/time/user is shown as checking in the DWR created by jj05751 on 4/12/05 on 
Contract CNB022N? 
_________________________________________________________________________ 

5. Exit SiteManager. 

NONE 

jj05751 - just now 
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Learning Module 

 Section 9  Diary 
for Field and Office Documentation 

 

By the end of this module, you will be able to: 

• Create a new Diary 

• Preview a Daily Work Report 

• Authorize a Daily Work Report 

• Create a Charge Day 

• View the Unauthorized DWR Report 

• View the Installed Work Report 

• Unauthorize and Correct a DWR Work Item Entry 

• View the History of Daily Work Reports 

• View the Installed Work Items Report 

• View the Item Quantity Report 
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Diary Overview 

Each Diary is a daily collection of the authorized Daily Work Reports submitted 
by all personnel working on the Contract.  Only one Diary can be created per day 
per Contract.  Diaries can also be created for days when no Daily Work Reports 
are collected.  The Diary panel has two folder tabs:  

• Authorize (approving for payment) 

• Charge 

The User uses the Diary window to perform five functions: 

• Create a new or open an existing Diary for a specific contract 
and day 

• Preview Daily Work Reports for a specific contract and day 

• Authorize Daily Work Reports (or not) 

• Apply Time Charges for a specific contract and day (as well as 
milestones, if applicable) 

• Make Remarks 

The Authorize Folder Tab of the Diary Window 
Figure 9-1 

 

In TDOT, the Lead Inspector or Project Supervisor will create a Diary for 
each day during the life of a contract, including weekends and holidays.  
The Lead Inspector or Project Supervisor will review and authorize all 
applicable DWRs associated with the Diary. 

Diaries will only be created in Server Mode. 
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 Exercise 9-1 
In the following exercise, you will view the Diary window.  

User ID: jj05753 Group: PJSUPS Mode: Server  Contract: CNB022M 
1. Double-click the SiteManager Training program icon on the 

desktop. 
2. In the User ID field, type jj05753. 
3. In the Password field, type pass. 
4. Click the Logon button.  
5. On the Main Panel, double-click the Daily Work Reports icon. 
6. On the Daily Work Reports panel, double-click the Diary icon. 

Shift-tab if user 
ID not 
highlighted. 
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Creating a New Diary 

The Diary Authorize folder tab lets the User create a Diary.  The User can create 
a Diary with or without Daily Work Reports.  Typically, the User creates a Diary 
from the Daily Work Reports that have been submitted by the Inspectors.  To 
create a Diary, the User selects a Contract first, and then enters the Diary’s date 
on the Diary Authorize panel.  By entering the date, the User is also selecting the 
Daily Work Reports with this date and creating a Diary with this date.  The User 
can enter a date by selecting it from a calendar.  If the User double-clicks the 
Diary Date field, a calendar is displayed on which the User can select the date. 

 
The Calendar 

Figure 9-2 

Tip: The User cannot enter a date that is after the current system data. 

After the User selects a date, the Diary Authorize folder tab lists the Daily Work 
Reports submitted for the selected date.  The reports are listed alphabetically by 
the name of the Inspector who submitted the report. 

If Diary already 
exists for entered 
date, it will 
automatically 
open. 
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 Exercise 9-2 
In the following exercise, you will create a new Diary on April 18, 2005 for Contract 
CNB022M.  

User ID: jj05753 Group: PJSUPS Mode: Server  Contract: CNB022M 
1. On the Diary window, click the Services menu and click Choose 

Keys. 
2. In the Contract ID list box, scroll to and double-click Contract 

CNB022M. 
3. In the Diary Date field, type 041805.  
4. Press the Enter key. The Diary window displays the list of DWRs 

submitted for the current date. 
5. Click the Save button. 

Have 
students type 
the date. 
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Previewing Daily Work Reports 

The Preview option on the Diary panel lets the User view and print a summary of 
a Daily Work Report without leaving the Diary panel. 

The Preview button option may be accessed by either the Preview DWR button 
on the toolbar or through the Services menu. 

 
The Preview DWR Button 

Figure 9-3 

 

The Daily Work Report Preview 

Figure 9-4 

In TDOT, before authorizing a DWR, the Lead Inspector or Project 
Supervisor should review the DWR for any errors or omissions.  
Additionally, the Lead Inspector or Project Supervisor should document 
remarks as necessary within the appropriate Remark Type field. 

It is important for the Project Supervisor to look at the DWRs since the 
Inspectors can approve their own DWRs.  Project Supervisors are still 
accountable for DWRs in their office. 
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 Exercise 9-3 
In the following exercise, you will preview a DWR on April 18, 2005 for contract 
CNB022M from the Diary window.  

User ID: jj05753 Group: PJSUPS Mode: Server  Contract: CNB022M 
1. In the Inspector list box, click the DWR for Warren, Jackie. 
2. Click the Preview DWR button.  Review the DWR. 
3. Did the contractor drive test piles that day?    ______ 
4. What was the location of the line item placement?   

 ____________________________________________________ 
5. Click the Close button.  

YES 

Abutment #1, Column B, Footing A 
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Authorizing Daily Work Reports 

The Diary Authorize folder tab lets the User authorize or unauthorize Daily Work 
Reports.  A Daily Work Report with a check in the Authorized check box is 
considered authorized.  When a Daily Work Report is marked as authorized, the 
system enters the current date in the Authorized Date field.  The User can remove 
authorization (and the authorized date) by removing the check from the 
Authorized check box, unless an estimate has been generated or approved. 

By authorizing a Daily Work Report, the User is flagging that DWR for use by 
the Contractor Payments component of SiteManager in the Estimate Generation 
process.  Authorization approves the installed work reported by the DWR to be 
included in the next Estimate for payment. 

Once an authorized Daily Work Report has been uploaded to the server and has 
been used in an approved Estimate to pay a Contractor for the installed work 
reported by it, it cannot be unauthorized or changed in any way. 

In TDOT, DWRS should be authorized if all of the Placed Quantities 
reported in the DWR are accurate.  If payment for the items installed needs 
to be adjusted due to test reports, this will be done by the Office Staff during 
estimate preparation using plug-in programs designed for this purpose. 

 

 Exercise 9-4 
In the following exercise, you will authorize the DWR for April 18, 2005 on Contract 
CNB022M.  

User ID: jj05753 Group: PJSUPS Mode: Server  Contract: CNB022M 
1. In the Inspector list box, click the DWR for Warren, Jackie. 
2. Click the Authorized check box (ON).  
3. Click the Save button. 
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Creating Charge Days and No Charge Days 

The Diary Charge folder tab lets the User record charge or credit information for 
the day and enter remarks. The User reviews the Daily Work Reports in the 
Diary to determine if work was performed on the Contract. If work was 
performed, a Full Day charge can be applied to the Contract end date. A No 
Charge (credit) day is a day on which no work was performed on the Contract. 
For No Charge days, no time is applied towards the Contract end date.  For No 
Charge days, the User must enter a credit reason to explain why a credit was 
given.  The User can also apply charge or credit information to milestones for the 
Contract.  For No Charge days applied to a milestone, the User must also enter a 
credit reason. 

The Charge Folder Tab 

Figure 9-5 

In TDOT, the majority of contracts will have a Fixed Completion Date and 
therefore it will not be necessary to indicate a charge day on the Charge 
folder tab. Consequently, the Charge Day folder tab has no impact on 
Fixed Completion Date contracts. 

Charging of days will only be done for working day milestones for phased 
construction and mowing contracts. Charge days for milestones must be 
entered for each charge day for each milestone. 

TDOT will not use half-day charges. 
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 Exercise 9-5 
In the following exercise, you will review the Diary Charge Days folder tab for 
Contract CNB022M on April 18, 2005.   

User ID: jj05753 Group: PJSUPS Mode: Server  Contract: CNB022M 
1. On the Diary window, click the Charge folder tab. 
2. To apply the charge to a milestone, click the Milestone field and click the New 

button. An empty row is inserted. 
3. In the Milestone drop-down list, select Milestone 01, Bridge over Little Owl 

Creek Reopen for Traffic. 
4. In the Charge Amount drop-down list, click the expand arrow and click Full 

Day. 
5. Click the Save button. 
6. Click the Close button. 

The Charge Days 
folder tab has no 
impact on Fixed 
Completion Date 
contracts. 

Select 
Milestones 
when the 
Milestones are 
not set up with 
Completion 
Date type time 
charges. 
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Viewing the Unauthorized DWR Report 

The unauthorized DWR report is a TDOT custom report that shows all the 
DWRs for a project that remain Unauthorized. 

 

Unauthorized DWR Report - Parameters window 

Figure 9-6 

We cannot view 
TDOT custom 
reports in the 
training 
environment. 
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Unauthorized DWR Report 

Figure 9-7 

 

In TDOT, the Unauthorized DWR Report is used to print a list of all DWR 
reports on the server that are unauthorized for the time period.  This will 
allow staff to ensure unauthorized DWRs can be included in the estimate, 
as appropriate. 

Installed Work 
Report (next topic) 
is also a tool for 
Identifying 
Unauthorized 
DWRs. 
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Viewing the Installed Work Report 

The Installed Work Report displays all the items of work recorded on Daily 
Work Reports that have not been included on an estimate.  There is an indicator 
for each item entry to indicate whether the displayed Installed Quantity has been 
authorized for payment on a Diary. 

The Installed Work Report 

Figure 9-8 

In TDOT, the Installed Work Report may be used to review quantities 
recorded in DWRs that have not yet been included in an estimate.  
Discrepancies in placed quantity totals may be apparent and therefore 
addressed prior to estimate generation. 

Any “Auth” box that shows an “X” is authorized for payment and will be 
included in the next estimate. 

 

Report may be 
sorted using the 
Item Code, 
Description, and 
Installed Quantity 
column headings. 

Once the estimate 
is generated, 
authorized DWRs 
will not be 
included in the 
report. 
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Yes 

 Exercise 9-6 
In the following exercise, you will view the Installed Work Report for Contract 
CNB022M.  

User ID: jj05753 Group: PJSUPS Mode: Server  Contract: CNB022M 
1. Click the Main Panel folder tab. 
2. On the Main Panel, double-click the Contractor Payments icon. 
3. On the Contractor Payments panel, double-click the Reports icon. 
4. On the Reports panel, double-click the Installed Work icon. 
5. On the Report Criteria selection panel, double-click Contract 

CNB022M. 
6. What is the Quantity Reported to Date for Category Nbr 0500, LIN 

0500, Item Code 606-09.01?   ___________________ 
7. Is that quantity authorized for payment on the next estimate?   
8. Click the Close button. 

55.00
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Unauthorizing and Correcting a DWR Work Item Error 

A Daily Work Report may be unauthorized on the Diary window if the DWR has 
not been included in a generated estimate.  A User with the appropriate security 
rights may access the Diary window, and deselect the Authorize indicator (OFF).  
Once unauthorized, the Daily Work Report will no longer be locked for 
modification and the author of the DWR can update the record with the necessary 
changes.  Once the record has been modified, a User with the appropriate 
security rights can access the Diary window, preview the DWR to verify the 
changes, and select the Authorize indicator (ON).  The authorized DWR will be 
included in the next estimate generated. 

Note: A DWR that has been included on a generated estimate that has not been 
approved at the final approval level can still be modified if necessary.  The 
estimate may be deleted from the application and the outlined process for 
correcting a DWR may be executed. 

The Diary window with the DWR Authorized 

Figure 9-9 

In TDOT, if an inaccuracy is discovered for a DWR that has been 
authorized on a Diary but not included on an estimate, the DWR should be 
unauthorized and the creator of the DWR notified of the necessary 
changes.  If the DWR author is an Inspector, the DWR should be pipelined 
to standalone mode, modified as appropriate, and pipelined back to the 
server. The Project Supervisor or Lead Inspector will then re-authorize the 
updated DWR in the Diary window. 

Office Staff will create and correct DWRs in server mode. 

Every attempt should be made to uncover inaccuracies PRIOR to 
generating an estimate. 

Note: Diaries are managed in server mode only. 

TDOT policy is 
to correct 
Inspector DWRs 
in standalone to 
keep standalone 
and server in 
sync. 
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 Exercise 9-7 
In the following exercise, you will unauthorize a DWR on the Diary for 4/17/2005; 
adjust the placed quantity on the DWR and then re-authorize the DWR for payment 
for Contract CNB022M.  

User ID: jj05753 Group: PJSUPS Mode: Server    Contract: CNB022M 
1. Click the Main Panel folder tab. 
2. On the Main panel, double-click the Daily Work Reports icon. 
3. On the Daily Work Reports panel, double-click the Diary icon. 
4. Click the Open button. SiteManager displays the Contract ID 

window. 

Now, let’s choose a contract and Diary. 
5. From the Date selection list, double-click 04/17/2005.  
6. In the Inspector list box, click to select the DWR for Warren, 

Jackie. 

Now, let’s unauthorize a DWR. 
7. Click the Authorized check box (OFF).  
8. Click the Save button. 
9. Click the Close button. 
10. Exit SiteManager. 

Now, let’s log on as an Inspector to pipeline the DWR to standalone mode 
11. On the desktop, double-click the SiteManager Training program 

icon. 
12. In the User ID field, type jj05751. 
13. In the Password field, type pass. 
14. Click the Logon button. 
15. On the Main Panel, double-click the Pipeline icon. 
16. On the Pipeline panel, double-click the Server to PM Pipeline icon. 

SiteManager displays the Server to PM Pipeline window. 
17. Click the Open button.  
18. In the Contract list box, scroll to and double-click Contract 

CNB022M. 
19. Click the DWR Select tab. 
20. In the DWRs list box, click the DWR created by Warren, Jackie on 

04/17/05. 
21. Click the Add button. 
22. Click the Pipeline Summary tab. 

In server mode 
to pipeline the 
DWR to 
standalone so 
that you may 
correct it.  
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23. On the Pipeline Summary tab, click the Basic Contract Data check 
box (ON). 

24. Click the Services menu and click Pipeline Data. The progress of 
the download is shown in the Pipeline Status field. A message 
confirms that the data is downloaded. 

25. Click the Exit button. 

Now, let’s log on as an Inspector to correct the DWR in standalone mode.  
26. On the desktop, double-click the SiteManager Training program 

icon. 
27. In the User ID field, type jj05751. 
28. In the Password field, type pass. 
29. In the Connect To drop-down list, click the expand arrow to the 

right of the current selection and click Training Standalone. 
30. Click the Logon button. 

Now, let’s open the DWR that we are correcting. 
31. On the Main Panel, double-click the Daily Work Reports icon. 
32. On the Daily Work Reports panel, double-click the Daily Work 

Reports icon. 
33. Click the Open button. SiteManager displays the Contract ID 

window. 
34. From the Contract ID selection list, double-click Contract 

CNB022M. 
35. In the Inspector list box, double-click User ID for Warren, Jackie 
36. From the Date list box, double-click 04/17/05. SiteManager displays 

the info for that DWR in Daily Work Reports window. 

Now, let’s select the work item to correct. 
37. Click the Work Items folder tab. 
38. Scroll to and select Project 55021-3214-94, Line Item Number 0643, 

Category Number 0100, Item Code 204-07, Description BEDDING 
MATERIAL (PIPE) CLASS B. 

39. On the toolbar, click the Record Work Item button. 

Now, let’s choose a template to use for the correction. 
40. On the toolbar, click the DWR Template button. SiteManager 

displays the DWR Template window. 
41. From the Template ID column, double-click Template ID SM10E. 
42. In the Length (ft) field, type 50.00. Press Tab to calculate. 
43. On the template, click the Save button. 
44. On the Item Recording window, click the Close button. 
45. On the toolbar, click the Save button. 
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46. Click the Close button. 
47. Exit SiteManager. 

Now, let’s log on as an Inspector to pipeline the DWR to server mode. 
48. On the desktop, double-click the SiteManager Training program 

icon. 
49. In the User ID field, type jj05751. 
50. In the Password field, type pass. 
51. Click the Logon button. 
52. On the Main Panel, double-click the Pipeline icon. 
53. On the Pipeline panel, double-click the PM to Server Pipeline icon. 

SiteManager displays the PM to Server Pipeline window. 
54. Click the Open button.  
55. In the Contract list box, scroll to and double-click Contract 

CNB022M. 
56. Click the DWR Select tab. 
57. In the DWRs list box, click the DWR created by Warren, Jackie on 

04/17/05. 
58. Click the Add button. 
59. Click the Pipeline Summary tab. 
60. Click the Services menu and click Pipeline Data. The progress of 

the download is shown in the Pipeline Status field. A message 
confirms that the data is downloaded. 

61. Click the Exit button. 

Now let’s log on again as the Project Supervisor or the Lead Inspector. 
62. Double-click the SiteManager Training program icon on the 

desktop. 
63. In the User ID field, type jj05753. 
64. In the Password field, type pass. 
65. Click the Logon button. 

Now, let’s authorize the DWR in the Diary. 
66. On the Main Panel, double-click the Daily Work Reports icon. 
67. On the Daily Work Reports panel, double-click the Diary icon. 
68. On the toolbar, click the Open button. SiteManager displays the 

Contract ID window. 
69. From the Contract ID selection list, double-click Contract 

CNB022M. 
70. From the Date selection list, double-click 04/17/2005. 
71. In the Inspector list box, click the DWR for Warren, Jackie. 
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72. Click the Preview DWR button. 
73. Review the DWR. 
74. Click the Close button to close the DWR Preview. 
75. Click the Authorized check box (ON). 
76. Click the Save button. 
77. Click the Close button. 
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Viewing the History of Daily Work Reports 

The Daily Work Reports History window displays Daily Work Report records 
for the selected Contract.  To run history reports, the User must select a Contract 
when the History panel first opens and displays a selection list of contracts.  The 
history reports display all Daily Work Report records for the selected Contract. 
The User can view the reports on-line or print the reports.  The History panel has 
the following folder tabs: 

• DWR History 

• Work Item History 

• Contractor History 

DWR History 

The DWR History folder tab displays a history of all of the Daily Work Reports 
available to the current User.  This report groups all the Daily Work Reports by 
date and inspector, in ascending order.  Weather conditions, temperatures, and 
work suspended times are examples of the information shown on this report.  The 
User can view the report on-line or print the report. 

The DWR History Folder Tab 

Figure 9-10 

Reports are 
sorted by DWR 
“Dates” only. 
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 Exercise 9-8 
In the following exercise, you will view the History of the DWRs for Contract 
CNB022M.  

User ID: jj05753 Group: PJSUPS Mode: Server  Contract: CNB022M 
1. On the Daily Work Reports panel, double-click the History icon.  
2. Click the Down Arrow button to view the DWRs for Contract 

CNB022M. 
3. What were the high temperature and morning weather conditions as 

recorded by jj05751 on 04/20/05? 
_______________________________________________________ 71 DEGREES AND SUNNY 
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Work Item History 

The Work Item History report displays a history of all work items recorded in the 
Daily Work Reports for the selected Contract.  The contract must be selected 
from the contract selection list that appears when the History icon is clicked. The 
User can view the report on-line or print it. 

The Work Item History Folder Tab 

Figure 9-11 

 Exercise 9-9 
In the following exercise, you will view the history of work items for Contract 
CNB022M.  

User ID: jj05753 Group: PJSUPS Mode: Server  Contract: CNB022M 
1. On the History window, click the Work Item History folder tab. 
2. Click the Down Arrow button to view the work items for Contract 

CNB022M. 
3. What quantity reported to date did jj05751 record for Line Item 

Number 0520 on 04/20/05? 
_______________________________________________________ 114.0 
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Contractor History 

The Contractor History folder tab displays three separate reports:  

• Equipment History 

• Supervisor History 

• Variable Labor History 

Each type of report can be selected using the appropriate toolbar button or by 
choices under the Services menu. 

 
Equipment History, Supervisor History, and Variable Labor History Buttons 

The Contractor History Toolbar Buttons 

Figure 9-12 
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Equipment History Report 

 

The Contractor Equipment History Report 

Figure 9-13 

 

Supervisor History Report 

 

The Contractor Supervisor History Report 

Figure 9-14 
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Variable Labor History Report 

 

The Contractor Variable Labor History Report 

Figure 9-15 

 Exercise 9-10 
In the following exercise, you will select and view Contractor History Reports for 
Contact CNB022M.  

User ID: jj05753 Group: PJSUPS Mode: Server  Contract: CNB022M 
1. On the History window, click the Contractor History folder tab. 
2. The Equipment History report displays automatically. 
3. What piece(s) of equipment and the number used did jj05752 record 

for WMC CONTRACTING CO., INC. on the DWR Date of 
04/20/05?        ______ 

4. Click the Variable Labor History button.  
5. What Personnel Types did jj05752 record onsite for WMC 

CONTRACTING CO., INC. on 04/20/05?     
          

6. Click the Close button.   

One Farm Tractor, One Haul Truck, and Two Pickup Trucks 

Class “D” Operators, Foreman,  
Truck Driver (2 axels), and Unskilled Laborer 
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Viewing the Inspector’s Report of Installed Work Items 
The Inspector’s Report of Installed Work Items is a TDOT custom report that 
shows the Dates Locations, and Quantities for work items installed on a contract.  

 
Inspectors Report of Installed Work Items – Parameters window 

Figure 9-16 

 

 
Inspectors Report of Installed Work Items 

 Figure 9-17  

We cannot view 
TDOT custom 
reports in the 
training 
environment. 
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Viewing the DWR Template Report 

The DWR Template Report is a TDOT custom report that shows all of the DWR 
Templates used for a contract. In TDOT, the DWR Template Report is used to 
print a list of all DWR Templates for the items and time period chosen.  This will 
allow staff to view the DWR template entries for multiple items and time periods 
at the same time. 

 
DWR Template Report – Parameters window 

Figure 9-18 

 
DWR Template Report 

Figure 9-19 

Under the 
report line 
after the DWR 
information, 
the DWR 
Template data 
is listed in 
standard 
columns from 
left to right 
regardless of 
how it is laid 
out on the real 
DWR 
Template.  This 
standard layout 
allows all DWR 
Templates to be 
displayed on 
the same 
report. 

Accessed from 
the SM-Inspector 
folder. 
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Viewing the Item Quantity Report 

The Item Quantity Report lists all Contract Item quantities that are found in the 
database based on user-selected criteria.  This report can be generated on all 
Contract Items (this is, Original, Change Order, Current, Installed, Paid, and 
Final).  The Items are grouped by Item Code and Project Number.  An Item cost 
summary is displayed for each group.  The User can view the report on-line or 
print the report. 

The Item Quantity Report 

Figure 9-20 

 

This report is 
sortable by most 
of the column 
headings. 
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 Exercise 9-11 
In the following exercise, you will view the Item Quantity Report for Contract 
CNB022M.  

User ID: jj05753 Group: PJSUPS Mode: Server  Contract: CNB022M 
1. Click the Main Panel folder tab. 
2. On the Main Panel, double-click the Contract Administration 

icon. 
3. On the Contract Administration panel, double-click the Reports 

(CA+) icon.  
4. On the Reports (CA+) panel, double-click the Item Quantity icon.  
5. Using the right mouse button, click the Contract ID field 
6. In the object menu, click Search. 
7. In the list box, scroll to and double-click CNB022M. 
8. Click the All Item Status check box (ON). 
9. Click the OK button. 
10. Click the Close button. 
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Review for Section 9 
To create a new Diary: 

1. On the Daily Work Reports panel, double-
click the Diary icon.  

2. Click the Services menu and click the 
Choose Keys choice. 

3. In the Contract list box, scroll to and click 
the desired Contract. 

4. Click Ok.  The Diary Authorize folder tab 
lists the Daily Work Reports submitted for 
the current date.   

5. To change the date, double-click the Diary 
Date field.  This opens a calendar on which 
a date prior to the current date can be 
selected.  To select a prior month, click the 
left arrow.  To enter the selected date, click 
Ok.   

6. To enter a remark, in the Remark Type list 
box, scroll to and click the remark type. 
Then, type the remark in the Remarks field. 

7. Click the Save button. 
8. Click Ok. 

To preview a Daily Work Report: 

1. On the Daily Work Reports panel, double-
click the Diary icon.   

2. Click the Open button. 
3. In the Contract list box, scroll to and 

double-click the desired Contract. 
4. In the Diary list box, scroll to and click the 

DWR Date of the Diary. (The DWR Date 
represents both the Daily Work Report Date 
and the Diary Date.) 

5. Click Ok.     
6. In the Inspector list box, scroll to and click 

the Inspector who submitted the Daily Work 
Report to be previewed. 

7. Click the Preview DWR button.     
8. To close the print preview window, click the 

Close button. 

To authorize a Daily Work Report: 

1. On the Daily Work Reports panel, double-
click the Diary icon.  

2. Create a new Diary or open an existing 
Diary. 

3. In the Inspector list box, scroll to the Daily 
Work Report to be authorized. 

4. Click the Authorized check box (ON).   
5. Click the Save button. 

To unauthorize a Daily Work Report: 

1. On the Daily Work Reports panel, double-
click the Diary icon.  

2. Open an existing Diary. 
3. In the Inspector list box, scroll to the Daily 

Work Report to be authorized. 
4. Click the Authorized check box (O).   
5. Click the Save button. 

To create charge or no charge day: 

1. On the Daily Work Reports panel, double-
click the Diary icon. 

2. Create a new Diary or open an existing 
Diary. 

3. Click the Charge folder tab. 
4. In the Charge Type field, click the radio 

button of the charge type to apply to the day 
for the Contract. 

5. If the charge type is No Charge, in the 
Credit Reason drop-down list, click the 
expand arrow and click the reason for not 
charging all or part of the day. 

6. To apply all or part of the charge or credit to 
a milestone, click the Milestone field and 
click the New button. An empty row is 
inserted. 

7. In the Milestone drop-down list, click the 
expand arrow and click the milestone to 
apply the charge or credit to. 

8. In the Charge Amount drop-down list, 
click the expand arrow and click Full Day or 
No Charge. 

9. If No Charge is entered as the Charge 
Amount for the milestone, in the Credit 
Reason drop-down list, click the expand 
arrow and click the reason for a credit. 

10. Click the Save button.  
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To access TDOT custom reports: 

1. Launch Internet Explorer.  
2. Access web address 

http://boe.tdot.state.tn.us/businessobjects/
Enterprise115/InfoView/  

3. Click the plus sign next to Public Folders.  
4. Click the plus sign next to SiteManager.  
5. Click the desired group name.  
6. Click the desired report name.  
7. Enter the desired prompt values.  
8. Click the OK button.  
9. Print or Save the report as appropriate.  

To view the History of Daily Work Reports: 

1. On the Daily Work Reports panel, double-
click the History icon. The Select Contract 
panel opens.   

2. In the Contract list box, scroll to and click 
the Contract ID. 

3. Click Ok.  The DWR History folder tab is 
displayed.   

4. Click the Down Arrow button to view the 
DWRs. 

To run the Installed Work Report: 

1. On the Main Panel, double-click the 
Contractor Payments icon. 

2. On the Contractor Payments panel, 
double-click the Reports icon. 

3. On the Reports panel, double-click the 
Installed Work icon. 

4. In the list box, select the appropriate 
contract. 

5. Click the OK button. 
6. To close the report, click the Close button. 

To view Item Quantity Report: 

1. On the Contract Administration panel, 
double-click the Reports icon.  

2. On the Reports panel, double-click the 
Item Quantity icon.  

3. Using the right mouse button, click the 
Contract ID field. In the object menu, click 
Search. 

4. In the list box, scroll to and double-click 
desired contract. 

5. In the Item Status drop-down list, click the 
All item status checkbox. 

6. Click the OK button to generate the 
contract.  
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Summary Exercise for Section 9 

In the following exercise, you will create a Diary and review activities on Contracts CNB022L. 

User ID: jj05753 Group: PJSUPS Mode: Server  Contract: CNB022L 

1. Create a new Diary for Contract CNB022L on 04/18/05. 

2. Preview Jackie Warren’s Daily Work Report for 04/18/05. 

3. Authorize Jackie Warren’s Daily Work Report for 04/18/05. 

4. Open the Diary Date 11/15/05 for Contract CNB022L.  Unauthorize the DWR created by User 
ID jj05752 (Gutierrez, Sandy). 

5. Log on in Server mode as jj05752. 

6. Pipeline DWR date 11/15/05 on Contract CNB022L for jj05752 (Gutierrez, Sandy) to 
Standalone mode. 

7. Exit SiteManager. 

8. Log on in Standalone mode as jj05752. 

9. Correct the reporting error for Contract CNB022L on DWR Date 11/15/05 for Item Code 712-
06, SIGNS (CONSTRUCTION), Project Number 55019-3220-94, Line Item Nbr 0310 on 
template SM22A.  Change the # of Signs value to 4. 

10. Exit SiteManager. 

11. Log on in Server mode as jj05752. 

12. Pipeline DWR date 11/15/05 for jj05752 back to Server mode. 

13. Exit SiteManager. 

14. Log on in Server mode as User ID jj05753. 

15. Authorize the corrected DWR. 

16. Preview the DWR History, Work Item History, and Contractor History for CNB022L. 

17. View the Item Quantity Report for CNB022L. 

18. View the Installed Work Report for CNB022L. 

19. Exit SiteManager.  
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Learning Module 

 Section 10  Estimate Basics and 
Progress Estimates 

for Office Documentation 
 

By the end of this module, you will be able to: 

• TDOT Progress Estimate Generation Workflow 

• View the Unauthorized DWR Report 

• View the Installed Work Report 

• Generate a Progress Estimate 

• View the Estimate Summary  

• Resolve Estimate Discrepancies 

• Enter Material Test Reports for the Estimate Period 

• Add Price and Pay Adjustments for the Estimate Period 

• TDOT Estimate Review and Approve Workflow 

• View the Estimate Item Detail 

• View the Estimate Item Paybook 

• Generate the Summary To Contractor Report 

• Approve an Estimate 

• Track an Estimate 

• View the Estimate History 

• Correct Quantities for Approved Progress Estimates 

• View Quantity Adjustment DWRs 
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SiteManager Estimates Overview 
The Estimate Generation process manages the Estimate functionality from the 
generation of an Estimate through the creation of the extract file for the 
transportation agency’s financial system. The functionality is divided into the 
following areas: 

• Generation of the Estimate 

• Review of Estimate information 

• Resolution of Estimate discrepancies 

• Review of Estimate item details 

• Approval of Estimate 

• Tracking of Estimate status 

 
The Estimate Panel 

Figure 10-1 
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TDOT Progress Estimate Generation Workflow 
INSPECTION STAFF 
The Inspection staff will complete the following pre-estimate planning and 
verification tasks prior to estimate generation: 

Progress Estimate Planning and Verification Tasks Functional Navigation 

Lead Inspector/Inspector will check-in (Pipeline) all DWRs to the server through 
the ending DWR date as outlined in the PM to Server chapter. 

Pipeline > PM to Server 
Pipeline 

If the contract is a Maintenance Contract the inspector will access the 
Adjustments Plug-In to see if there are any missing MMS Templates.   

Contract Administration 
> Contract Records > 
Contracts > Plug-In > 
Adj. Plug-In 

Lead Inspector will run the Unauthorized DWR Report to find the applicable 
DWRs that have not been authorized. 

TDOT Custom SM 
Report  

Accessories > System 
Attachments 

As needed, Lead Inspector will run and review the Installed Work Report to help 
determine which unauthorized DWRs should be authorized for the estimate.  
Lead Inspector may also need to review the DWRs and other reports to help with 
this determination. 

Contractor Payments > 
Reports > Installed Work 

As needed, Lead Inspector will create any missing Diaries for the estimate period 
and authorize all applicable DWRs that have not been authorized to date.  In 
TDOT, a Diary is to be created for each day of the period covered by the 
estimate for the life of the Contract. 

Daily Work Reports > 
Daily Work Reports or 
Diary 

Lead Inspector notifies Office Staff that all DWRs have been checked in and are 
ready to be included in an estimate 

External 

The TDOT Progress Estimate Generation Workflow – Inspection Staff 

Table 10-1 
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OFFICE STAFF  
The Office Staff will complete the following pre-estimate planning and verification 
tasks prior to estimate generation: 

Progress Estimate Planning and Verification Tasks Functional Navigation 

Office Staff will create DWRs for office recorded work items such as 
Mobilization and Ticketed Items. 

Daily Work Reports > 
Daily Work Reports 

If the contract is a Maintenance Contract the Office Staff will access the 
Adjustments Plug-In to see if there are any missing MMS Templates. 

Contract Administration 
> Contract Records > 
Contracts > Plug-In > 
Adj. Plug-In 

Office Staff will use the Diary window to authorize DWRs created by Office 
Staff.   

Daily Work Reports > 
Diary 

Office Staff will run the Unauthorized DWR Report to find the applicable DWRs 
that have not been authorized.  If the report displays Inspector DWRs that should 
be authorized, contact the Lead Inspector / Project Supervisor.  All applicable 
DWRs for the estimate period must be authorized prior to generating an estimate. 

TDOT Custom SM 
Report  

Accessories > System 
Attachments 

As needed, Office Staff will run and review the Installed Work Report to help 
determine which unauthorized DWRs should be authorized for the estimate.  
Office Staff may also need to review the DWRs and other reports to help with 
this determination. 

Contractor Payments > 
Reports > Installed Work 

Office Staff will create any missing Diaries for the estimate period and authorize 
all applicable Office Staff created DWRs that have not been authorized to date.  
In TDOT, a Diary is to be created for each day of the period covered by the 
estimate for the life of the Contract.  The Office Staff should not authorize 
Inspector DWRs.  Inspector DWRs should be authorized by a Lead Inspector or 
Project Supervisor. 

Daily Work Report > 
Daily Work Reports or 
Diary 

The TDOT Progress Estimate Planning and Verification Workflow – Office Staff 

Table 10-2 

PROJECT SUPERVISOR  
When authorizing DWRs for Lead Inspectors and/or Office Staff, Project 
Supervisors will complete the following pre-estimate planning and verification 
tasks prior to estimate generation: 

Progress Estimate Planning and Verification Tasks Functional Navigation 

Project Supervisor will run the Unauthorized DWR Report to find the applicable 
DWRs that have not been authorized by the Lead Inspector or Office Staff. 

TDOT Custom SM 
Report  

Accessories > System 
Attachments 

Project Supervisor will run and review the Installed Work Report to help 
determine which unauthorized DWRs should be authorized for the estimate.  
Project Supervisor may also need to review the DWRs and other reports to help 
with this determination. 

Contractor Payments > 
Reports > Installed Work 
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Progress Estimate Planning and Verification Tasks Functional Navigation 

Project Supervisor will create any missing Diaries for the estimate period and 
authorize all applicable DWRs that have not been authorized to date.  In TDOT, 
a Diary is to be created for each day of the period covered by the estimate for the 
life of the contract. 

Daily Work Reports > 
Daily Work Reports or 
Diary 

Project Supervisor notifies Office Staff that all applicable DWRs have been 
reviewed and authorized and that the estimate is ready for generation. 

External 

The TDOT Progress Estimate Generation Workflow – Project Supervisor Staff 

Table 10-3 

OFFICE STAFF 
The Office staff will complete the following tasks as part of the estimate 
generation and review process: 

Progress Estimate Workflow Tasks Functional Navigation 

Office Staff will generate the estimate. It may be necessary to generate the same 
estimate multiple times if corrections or adjustments are necessary. 

Contractor Payments > 
Estimate > Generate 
Estimate 

Office Staff will review the Summary to Contractor report and the Estimate 
Summary and Estimate Discrepancy windows.  The Office Staff will resolve 
those discrepancies that can be addressed, and override with remarks those that 
cannot be resolved at the present time. 

Contractor Payments > 
Process List > Summary 
to Contractor 

Contractor Payments > 
Estimate > Estimate 
Summary, Estimate 
Discrepancy 

Office Staff will access the Test Report plug-in to enter any remaining test 
reports and to review, resolve (if able) and balance shortages. 

Note:  The Test Report plug-in may be run at any time to enter test reports.  

Contract Administration 
> Contract Records > 
Contract > Attachments > 
Test Reports plug-in 

Office Staff will access the Adjustments plug-in and calculate all Fuel, 
Bituminous Material, AC Content, and Anti-Strip adjustments necessary for the 
estimate period.  If applicable, all Adjustment Calculation Messages must be 
resolved before adjustments can be applied. 

Contract Administration 
> Contract Records > 
Contract > Attachments > 
Adjustments plug-in 

If changes are required to the estimate, the Office Staff will follow the Estimate 
Correction Procedure detailed in The TDOT Progress Estimate Correction 
Workflow Table 10-6 of this chapter. 

Note: If any corrections must be made to an item, the estimate will need to be 
generated again.  Additionally, the Test Reports plug-in and Adjustments plug-in 
must be run again for the newly generated estimate. 

Contractor Payments > 
Process List > Summary 
to Contractor 

Office Staff will notify the Project Supervisor to begin his/her review of the 
estimate (see TDOT Estimate Review and Approve Workflow Table 10-9) 

External 

The TDOT Progress Estimate Generation Workflow – Office Staff 

Table 10-4 
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TDOT Estimate Generation Schedule 
In TDOT, all Progress Estimates are generated by the Office Staff of the Unit 
assigned the contract.  Before the Estimate Generation and Reconciliation Cycle 
can begin, the Inspection staff must pipeline all DWRs through the DWR Ending 
Date for their region to the server.  The following table outlines the Estimate 
Generation schedule for each of the Regions. 

 
Region 

 
First DWR Date 

Ending DWR Date (Estimate End Date) First Day Office Staff Can 
Generate Estimate 

Region 1 21st day of the 
previous month 

Through 20th day of the current month 21st day of the current month 

Region 2 1st day of the 
previous month 

Through the last day of the previous 
month 

1st day of the current month 

Region 3 1st day of the 
previous month 

Through the last day of the previous 
month 

1st day of the current month 

Region 4 16th day of the 
previous month 

Through the 15th day of the current 
month 

16th day of the current month 

The TDOT Progress Estimate Generation Schedule 

Table 10-5 
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Viewing the TDOT Unauthorized DWR Report 
The Unauthorized DWR report is a custom report developed by TDOT.  When 
generated, the report will display a list of DWRs, as well as the User ID and name 
of the person who created the DWR, that have not been authorized for the 
specified time period on the selected contract. 

 
The Unauthorized DWR Report Parameters window 

Figure 10-2 

 
The Unauthorized DWR Report 

Figure 10-3 
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Viewing the Installed Work Report 
The Installed Work Report displays all the items of work recorded on Daily Work 
Reports that have not been included on an estimate.  There is an indicator for each 
item entry to indicate whether or not the displayed Installed Quantity has been 
authorized on a Diary for payment. 

 
The Installed Work Report 

Figure 10-4 

 

In TDOT, the Installed Work Report may be used to review quantities 
recorded in DWRs that have not yet been included in an estimate.  
Discrepancies in placed quantity totals may be apparent and therefore 
addressed prior to estimate generation. 

Any “Auth” box that does not show an “X” is NOT authorized for payment 
and will not be included in the next estimate. 

 

Items paid on a 
previous 
estimate will 
not be listed on 
this report. 

Report may be 
sorted using the 
Item Code, 
Description, and 
installed Quantity 
column headings.
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 Exercise 10-1 
In the following exercise, you will access the Installed Work report for contract 
CNB022K.  

User ID: jj05754 Group: OSTAFF Contract: CNB022K 
1. Double-click the SiteManager program icon on your desktop.  
2. In the User ID field, type jj05754. 
3. In the Password field, type pass. 
4. Click the Logon button. 
5. On the Main Panel, double-click the Contractor Payments icon. 
6. On the Contractor Payments panel, double-click the Reports icon. 
7. On the Reports panel, double-click the Installed Work icon. SiteManager 

displays the Report Criteria window. 
8. In the Contract ID column, scroll to and click CNB022K.  SiteManager displays 

the Installed Work window. 
9. What is the quantity reported for Category Number 0500, LIN 0500, Item Code 

606-09.01 for DWR date 04/18/05? ___________________________________ 
10. Is this quantity authorized for payment on the next estimate? _______________ 
11. To close the report window, click the Close button. 
12. To prepare for the next exercise, click the Contractor Payments tab. 

55.00 
YES 
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Generating a Progress Estimate 
The Generate Estimate window can be accessed within the Contractor Payments 
component of SiteManager.  

The first and all subsequent Estimates leading up to the Final Estimate are Progress 
Estimates. The Progress Estimate is the system default (standard choice). 

To generate an estimate, the user may select either the Generate Estimate choice from 
the Services Menu or the Generate Estimate button from the Toolbar.  With either of 
the Estimate Generation methods, the Estimate will be generated immediately. 

 
The Generate Estimate 

Button 

Figure 10-5 

When Generate Estimate is initiated by clicking the Generate button, SiteManager 
will verify that a prior Estimate does not exist for an overlapping period of time 
(only one Estimate is valid for a period of time). If one does exist, the User is 
prompted with a window to confirm the deletion of the prior Estimate. If the 
deletion is confirmed, the generation process will delete the prior Estimate and 
initiate the generation of the new Estimate as a background process. Otherwise, the 
generation is halted leaving the prior Estimate intact. 

Once the Estimate has been submitted, an In-Box message will confirm whether or 
not the Estimate generated successfully. 

Estimate Activities 
The Estimate generation process allows the user to generate an Estimate for the 
Contract. The user selects to generate a progress or a final Estimate from the 
Contractor Payments component. The system then performs a background process 
which performs the following activities: 

• Delete pending Estimate. This activity deletes any previous pending 
Estimate which has been calculated but not approved. The deletion will 
remove only details tied to the previous pending Estimate. 

• Determine quantities for payment. This activity will determine the 
quantity to be paid for each line item on the Contract which has items 
installed for the Estimate period. 

• Calculate stockpiled materials. This activity will determine if an installed 
item has stockpiled materials. If it does, the process will use a stockpiled 
materials conversion factor to add a new line item adjustment to adjust the 
amount of payment which is to be made for the line item. 

• Identify discrepancies. This activity checks for and reports 'discrepancies' 
for the work being performed by defined rules and conditions, e.g., 
overruns, Checklist Events and physical completion dates for milestones 
with projected end dates during the Estimate period. This activity provides a 
window with discrepancy details for the Project Supervisor so that proactive 
steps can be taken for various project issues. The edits performed during the 
progress Estimate are a subset of the edits performed during the final 
Estimate. 
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• Determine Funding Amounts. This activity will calculate the funding 
amount for the different funding sources based upon the funding given for 
the Contract, project, category or item. 

Types of Estimates 
• Progress (first and all intermediate) 

• Final 

• Supplemental (This is used only when Final Estimate has been fully 
approved and paid. This can be verified in the Estimate Tracking window.) 

 
The Generate Estimate Window 

Figure 10-6 

 

TDOT will not use the Delay Generation box. 

 

Tip: If the contract you wish to generate an Estimate for is not on the contract 
pick-list or you receive the message, “You do not have Authority to Generate an 
Estimate” ensure that the contract status is ‘Active’ and that the contract Notice 
to Proceed critical date has been populated. The Notice to Proceed Date is the 
“Begin” date of any contract’s first Estimate period. 

Delay Generation 
will keep the 
estimate from 
generating. 
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 Exercise 10-2 
In the following exercise, you will generate a Progress Estimate for Contract 
CNB022P and view the In-Box.  

User ID: jj05754 Group: OSTAFF Contract: CNB022P 
1. On the Contractor Payments panel, double-click the Estimate icon. 
2. On the Estimate panel, double-click the Generate Estimate icon. 

SiteManager displays the Contracts window. 
3. In the Contract list box, scroll to and double-click CNB022P. 
4. In the End field, type 051505. 
5. Click the Generate Estimate button. A message says that an Estimate 

exists for the generation period, and asks the User to confirm deletion. 
6. Click the Yes button. SiteManager displays a message stating that the 

process has been submitted. 
7. In the message, click the OK button. SiteManager displays a message 

stating that the process has been completed.  
8. In the message, click the OK button.  
9. To close the Generate Estimate window, click the Close button. 

Now, let’s open the In-Box. 
10. Click the Main Panel tab. 
11. On the Main Panel, double-click the Accessories icon. 
12. On the Accessories panel, double-click the In-Box icon. SiteManager 

displays the In-Box window. 
13. Double-click the message titled Est Nbr = 0001 for CNB022P 

finished successfully.  

Client Job 
Monitor message 
will appear when 
SM does not find 
a server.  It is 
followed by a 
prompt to 
reconnect to 
servers.  In 
training you 
must ALWAYS 
click NO to this 
message. 

The In-box 
should be viewed 
1-2 times daily 
for estimate and 
change order 
review/approval 
notices.  
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Viewing the Estimate Summary 
The Estimate Summary window allows the User to view calculated Estimate 
summary information. It may be accessed from the Estimate panel or from the In-
Box. The window shows three sets of totals:  

• Previous Estimate(s) - Combined totals for previous Estimate(s) 

• This Estimate – totals for the current Estimate 

• Total to Date – combined totals for all Estimates 

 

The Estimate Summary Window 

Figure 10-7 

 Exercise 10-3 
In the following exercise, you will view the Estimate Summary window for contract 
CNB022P. 

User ID: jj05754 Group: OSTAFF Contract: CNB022P 
1. What is the amount paid to the contractor on this estimate? 

_______________________________________________________ 
2. Are there discrepancies on this estimate? ______________________ 
3. To close the Estimate Summary window, click the Close button. 
4. To close the In-Box window, click the Close button. 
5. Click the Main Panel folder tab. 

 

$100,510.05 
YES – Item Navigates back 

to the In-Box 
window. 
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Resolving Estimate Discrepancies 
SiteManager identifies the discrepancies associated with an Estimate and displays 
them in the Estimate Discrepancy window. The discrepancies are of two levels: 
discrepancies at the Estimate level and discrepancies at the item level. For 
instance, if a Checklist Event Date is not met, the discrepancy is associated to the 
Estimate. If an item overrun is displayed, the discrepancy is associated with the 
specific line item.  

Estimate discrepancies are listed at the top of the Estimate Discrepancy window, 
and the item discrepancies are listed after them. The Status field value is either 
‘Unresolved’ or ‘Override.’ When the Recalculate Discrepancies function is 
selected from the Services menu, or if the Estimate is regenerated, the 
discrepancies are re-determined. 

 

The Estimate Discrepancies Window 

Figure 10-8 

 

 
The Navigate Button 

Figure 10-9 

 

Two options with 
discrepancies: 

• Override with 
comment 

• Resolve and 
recalculate 
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TDOT Discrepancy Types 
There are four types of discrepancies utilized at TDOT. Each is identified using different criteria.  

Overrun Discrepancy – Occurs if a major item is overrun by 10% or more and a minor item 
overrun by 999.99% or more. 

Milestone Completion Date Missed Discrepancy – Occurs if a milestone has not been completed 
within the time frame specified on the Milestones window. 

Contract Completion Date Missed Discrepancy – Occurs if work is recorded on a DWR beyond 
the Contract Completion Date specified on the Contracts window/Critical Dates folder tab. 

Checklist Event Completion Date Missed Discrepancy – Occurs if the Actual Date of the 
Checklist Event has not been entered on the Checklist Event Dates window within the time frame 
specified on the Checklist Scheduled Events window. 

 

In TDOT, the Office staff needs to investigate all discrepancies to ensure 
the accuracy of item quantities and recorded dates within the application.  
The Project Supervisor will review discrepancies and determine whether 
an action needs to take place - override, correct DWR, or initiate change 
order.  

 

 Exercise 10-4 
In the following exercise, you will resolve an Estimate Discrepancy on Estimate 
0001 for contract CNB022P.  

User ID: jj05754 Group: OSTAFF Contract: CNB022P 
1. Double-click the Contractor Payments icon. 
2. On the Contractor Payments panel, double-click the Estimate icon. 
3. On the Estimate panel, double-click the Estimate Discrepancy 

icon. SiteManager displays the Estimate Discrepancies window. 
4. Click the discrepancy that says Event Storm Water Inspection 

Report for date (05/01/2005) has not occurred. 
5. Click the Navigation button. SiteManager displays the Checklist 

Event Dates window. 
6. In the Event Type list box, click the checklist event for Storm 

Water Inspection Report. 
7. In the Actual Date field, and type 051005. 
8. On the toolbar, click the Save button. 
9. To close the Checklist Event Dates window, click the Close button. 

Navigates back 
to the Estimate 
Discrepancies 
window. 
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Recalculating Estimate Discrepancies 
Using the Services Menu to Recalculate Discrepancies in the Estimate 
Discrepancy window will cause any resolved discrepancies to be removed from 
the Estimate but will not affect unresolved discrepancies. 

 
In TDOT, the Office Staff will recalculate discrepancies after completing 
all possible Estimate discrepancy resolutions. This will need to be done 
before any discrepancies are overridden with remarks. 

 Exercise 10-5 
In the following exercise, you will recalculate an Estimate Discrepancy on 
Estimate 0001 for contract CNB022P. 

User ID: jj05754 Group: OSTAFF Contract: CNB022P 
1. Click the Services menu. 
2. Click the Recalculate Discrepancies choice. SiteManager displays a 

message to inform you that this function may take several minutes to 
perform.  

3. In the message, click the Yes button. SiteManager displays a 
message to inform you that the refresh is complete.  

4. In the message, click the OK button. SiteManager removes the 
discrepancy that you resolved. 

5. On the toolbar, click the Save button. 
The resolved 
discrepancy is no 
longer on the list. 
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Overriding Estimate Discrepancies 
Overriding an Estimate Discrepancy in the Estimate Discrepancy window will 
cause the discrepancy to be ignored by SiteManager for the specified Estimate 
only.  

TDOT Estimate Discrepancy Procedures 
Overrun Discrepancy – The Office Staff / Project Supervisor should check the 
overrun quantity to verify if it is correct.  The discrepancy may be overridden. 

Milestone Completion Date Missed Discrepancy – The Office Staff / Project 
Supervisor will verify the discrepancy.  The discrepancy may be overridden until a 
change order can be prepared and approved. 

Contract Completion Date Missed Discrepancy – The Office Staff / Project 
Supervisor should verify the discrepancy, and if applicable, initiate a change order 
to correct it.  The discrepancy may be overridden until the change order can be 
prepared and approved. 

Checklist Event Completion Date Missed Discrepancy – The Office Staff / 
Project Supervisor will verify the discrepancy. This type of discrepancy must be 
resolved and never overridden. 

 
The Estimate Discrepancies Window 

Figure 10-10 

 

In TDOT, if an estimate discrepancy on a Progress Estimate cannot be resolved, the discrepancy must 
be overridden with an explanation with the exception of a Checklist Event. When overriding a 
discrepancy, click outside of the Remarks box and save after each override explanation. Do not use the 
TAB key. 
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 Exercise 10-6 
In the following exercise, you will override a discrepancy on Estimate 0001 for 
Contract CNB022P. 

User ID: jj05754 Group: OSTAFF Contract: CNB022P 
1. Click the discrepancy that says Major Item 55019-3220-94/0120 exceeds 

Overrun Limits. 
2. In the Status drop-down list, click the expand arrow to the right of the current 

selection and click the Override choice. SiteManager displays a Remarks 
window. 

3. In the Remarks window, type Change Order to increase the quantity is 
pending.  

4. To close the Remarks window, on the toolbar, click the Remarks button. 
5. Click the Save button. 
6. To close the Estimate Discrepancies window, click the Close button. 
7. To prepare for the next exercise, click the Main Panel folder tab. 
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TDOT Progress Estimate Correction Workflow 
If a discrepancy is displaying due to an error recorded on a DWR, the Office staff 
will not override the discrepancy.  Instead, the Office Staff and Inspection Staff 
will complete the following tasks as part of the estimate correction process to 
update the DWR error prior to running the plug-ins to adjust the estimate: 

 

TDOT Progress Estimate Correction Workflow Tasks Functional Navigation 

1. Office Staff will delete the pending estimate if a 
correction must be made to a DWR/Diary for the 
estimate period.  If an adjustment has been made to 
the estimate, the adjustment plug-in must be used 
to place the estimate back in pending status prior to 
deleting the estimate. 

Contractor Payments 
> Estimate > 
Estimate History 

2. Office Staff / Lead Inspector will unauthorize the 
DWRs that need to be corrected.  Note: DWRs 
created by Office Staff should be unauthorized by 
the Office Staff; DWRs created by Inspection Staff 
should be unauthorized by the Lead Inspector. 

Daily Work Reports 
> Diary 

3. DWR Creator (Inspectors only) will pipeline the 
DWR to standalone mode to correct the DWR. 
Note: Office Staff DWRs are created and corrected 
in Server mode.  Inspection Staff DWRs are 
created and corrected in Standalone mode. 

Pipeline > Server to 
PM 

4. DWR Creator corrects the DWR.   Daily Work Reports 
> DWR 

5. DWR Creator (Inspectors only) will pipeline the 
DWR to server mode after correcting the DWR. 

Pipeline > PM to 
Server  

6. Office Staff / Lead Inspector will authorize the 
corrected DWR.  Note: DWRs corrected by Office 
Staff should be authorized by the Office Staff; 
DWRs corrected by Inspection staff should be 
authorized by the Lead Inspector. 

Daily Work Reports 
> Diary 

7. Office Staff will generate the Estimate and repeat 
the Progress Estimate Generation Workflow. 

Contractor Payments 
> Estimates > 
Generate Estimate 

The TDOT Progress Estimate Correction Workflow 

Table 10-6 

In TDOT, every effort should be made to correct the estimate prior to 
running the adjustment plug-ins following the workflow above.  Only after 
being satisfied that the item quantities are correct should the Office Staff 
run the adjustment plug ins to adjust the pay amount of the estimate. 
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Entering TDOT Progress Estimate Adjustments 
TDOT Progress Estimate Adjustment Workflow 
The Office Staff will complete the tasks outlined in the table below as part of the 
estimate adjustment process to complete insufficient test reports adjustments as 
well as Fuel, Bituminous Material, AC Content and Anti-Strip Adjustments.  All 
installed quantities should be corrected, uploaded and included on an estimate 
before the Test Reports plug-in or Adjustments plug-in are run.   

The Test Reports plug-in MUST be completed prior to completing the 
Adjustments plug-in. 

 

Progress Estimate Adjustment Workflow Tasks Functional Navigation 

1. Office Staff will access the Test Reports plug-in, 
enter any remaining test reports for the estimate 
period, and balance shortages. 

Contract Administration > Contract 
Records > Contract > Attachments > 
Test Reports plug-in 

2. Office Staff may access the Line Item Adjustments 
window to view the line item adjustments created by 
the Test Report plug-in. 

Contractor Payments > Contract 
Adjustments > Line Item 
Adjustments 

3. Office Staff will access the Adjustments plug-in and 
calculate all Fuel, Bituminous Material, AC Content, 
and Anti-Strip adjustments necessary for the estimate 
period. If applicable, all Adjustment calculation 
messages must be resolved before Adjustment can be 
applied. 

Contract Administration > Contract 
Records > Contract > Attachments > 
Adjustments plug-in 

4. Office Staff may access the Line Item Adjustments 
created by the Adjustments plug-in. 

Contractor Payments > Contract 
Adjustments > Line Item 
Adjustments 

The TDOT Progress Estimate Adjustment Workflow 

Table 10-7 

IMPORTANT: If an adjustment has been made to the estimate by the Adjustment 
plug-in, the Adjustment plug-in must be used to place the estimate back in 
pending status prior to deleting the estimate. 

In TDOT, only Users assigned to the Office Staff security group (OSTAFF) are able to 
update the Test Reports plug-in and Adjustments plug-in. 

It is critical that the appropriate workflow is followed so that the plug-ins will calculate 
adjustments properly.   

Always generate the pending estimate and address all issues prior to calculating test report 
shortage adjustments in the Test Reports plug-in.   

Always complete the test report shortage calculations before running the Adjustments 
plug-in.  If an estimate must be deleted and generated again, always use the Adjustments 
plug-in to put the estimate back in pending status.   
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Entering Test Reports in SiteManager 
Material Test Reports are entered into SiteManager using a TDOT developed 
plug-in accessible from the SiteManager Contract window Attachment 
functionality.   

The Test Reports plug-in will apply deductions to item payment when test report 
shortages exist.  It is divided into four folder tabs: Tests, Materials, Test Report 
Payment Adjustment, and Shortage Calculation Setup. 

The steps to use the Test Reports plug-in are as follows and are detailed on the 
following pages.  

1.  Access the Test Reports plug-in (Main Panel > Contract 
Administration > Contracts > select Contract > click Attachments button 
> double-click Test Reports) 

2.  Set up the Test Reports plug-in before the first estimate by indicating 
No for every Contract Item that should not have test report adjustments 
applied using the Shortage Calculation Setup folder tab within the Test 
Reports plug-in. 

3.  Enter test reports as they are completed using the Test Reports folder 
tab within the Test Reports plug-in.  This may be done at any time. 

4.  Apply test report adjustments to an estimate after the estimate has been 
generated (but before it has been approved) using the Balance Shortages 
button on the Payment Adjustment folder tab of the Test Reports plug-
in. 

5.  Indicate materials used in an item using the Materials folder tab of the 
Test Reports plug-in. This may be done at any time. 

 Exercise 10-7 
In the following exercise, you will navigate to the Test Reports plug-in for contract 
CNB022P.  

User ID: jj05754 Group: OSTAFF Contract: CNB022P 
1. Double-click the Contract Administration icon. 
2. On the Contract Administration panel, double-click the Contract 

Records icon. 
3. On the Contract Records panel, double-click the Contracts icon. 

SiteManager displays the Contracts window. 
4. Click the Payment Data tab. Notice that the Price Adjmnt Ind check 

box has been deselected and made unavailable. When the contract is 
created, this automatic price adjustment functionality is disabled to 
bypass SiteManager and use the plug-in adjustments only. 

5. On the toolbar, click the Attachments button. 
6. Double-click the Test Reports attachment. SiteManager displays the 

Test Reports window.  

Test Report 
shortages must be 
balanced before 
adjustments can be 
calculated unless 
TR calc shortages 
was set to NO. 
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Test Reports Plug-in, Shortage Calculation Setup Folder Tab 
When the contract is loaded, one material is assigned to every item and the 
calculate shortage indicator is set to Yes for every item on the Shortage 
Calculation Setup folder tab of the Test Reports plug-in.   

The Office Staff will access the Shortage Calculation Setup folder tab to indicate 
No for every item that should not have test report adjustments.  For example, a 
liquidated damage item should not have a test, so the indicator should be changed 
to No for this item.  

Office Staff Users should also address the items added by change orders. When 
additional items are added to the contract by change order, one material is 
assigned to each change order item and the calculate shortage indicator is set to 
Yes as well.  All items that should not have test report adjustments should be 
toggled to NO.   

 
The Tests Reports Plug-in – Shortage Calculation Setup Folder Tab 

Figure 10-11 

 

Office Staff should change the Calculate Shortage indicator to NO for every 
item/material for which test reports adjustments should not be calculated. 

All items will default 
to Yes causing the 
system to calculate a 
shortage if test 
reports are not 
entered.  Office Staff 
will toggle this to No 
for items that do not 
require test reports. 
The settings will be 
saved. 

Defaults to Yes for 
every item. 
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 Exercise 10-8 
In the following exercise, you will modify the Shortage Calculation Setup for a 
material on the Test Reports Program for contract CNB022P.  

User ID: jj05754 Group: OSTAFF Contract: CNB022P 
1. In the Test Reports Program window, click the Shortage Calculation 

Setup folder tab. 
2. Click the row for Project 55019-3220-94, Catg 0100, Line Item Nbr 

0310, Item Cd 712-06, Material SIGNS (CONSTRUCTION). 
3. In the Calculate Shortage? column, verify that the indicator has been 

toggled to YES.  
This lets you know that the Test Reports plug-in will calculate the 
shortage for this item. 

4. Click the row for Project 55019-3220-94, Catg 0100, Line Item Nbr 
0623, Item Cd 407-07, Material 407-07 DENSITY DEDUCTION. 

5. In the Calculate Shortage? column, click the YES to change it to NO.   
This tells the plug-in not to calculate test report shortages for this 
material/item. 

6. Click the row for Project 55021-3214-94, Catg 0100, Line Item Nbr 
0614, Item Cd 407-07, Material 407-07 DENSITY DEDUCTION. 

7. In the Calculate Shortage? column, click the YES to change it to NO.   
This tells the plug-in not to calculate test report shortages for this 
material/item. 
 
You would typically continue to change the Calculate Shortage indicator 
to NO for all the items that are not tested.  For training purposes, we are 
continuing to the next step. 

 

Clicking YES or 
NO in the Calculate 
Shortage column 
toggles the 
indicator. This is 
not a drop-down 
list.  
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Test Reports Plug-in, Test Reports Folder Tab 
The Test Reports folder tab allows the user to view, add, modify, or delete 
material test reports for items on one or more projects for the selected contract.   

Office Staff Users record test reports for specific project item materials by first 
selecting an Item Code/Description, then the project number, and finally the 
material associated with that item.  The window displays all previously entered 
test reports for the selected material.   

For contracts with multiple projects, the option to select “No Project Number” is 
available.  This feature is for documentation purposes only.  Test report quantities 
must be assigned to the appropriate project before the plug-in can apply them to 
the proper item for payment. 

To add a new test report record for a selected item/material: 

1. Click the New button on the Test Reports window toolbar after selecting 
the item/material.  
The Add New Test Report window opens with fields for reporting the date, 
report number, report quantity, and remarks.   

2. Type a date, report number, report quantity, and remarks. 

3. Click the Save button to save the test report entry.   
The Add New Test Report window remains open to allow another test 
report entry.   

4. To close the Add New Test Report window, click the Close button on the 
window. 

To delete a test report record for a selected item/material: 

1. Select the row for the test report record to be deleted. 

2. Click the Delete button in the toolbar.   
The Confirm Delete Test Report window opens. 

3. Click the Delete button in the toolbar.   
The Confirm Delete Test Report window closes. 

To edit a test report record for a selected item/material: 

1. Select the row for the test report record to be edited. 

2. Click the Open button in the toolbar.   
The Edit Test Report window opens. 

3. Edit the test report as desired. 

4. Click the Save button in the toolbar 

5. Click the Close button in the toolbar.   
The Edit Test Report window closes. 
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The Tests Reports Plug-in – Test Reports Folder Tab Window 

Figure 10-12 

 

 
The Tests Reports Plug-in – Test Reports Panel – Add New Test Report Window 

Figure 10-13 
 

If the project has 
only one line item 
number related to 
that item code, and 
that line item 
number has only 
one category 
number, the 
dropdowns are pre-
populated. 
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 Exercise 10-9 
In the following exercise, you will add a test report for an item using the Test Reports 
plug-in for Estimate 0001 for contract CNB022P.  

User ID: jj05754 Group: OSTAFF Contract: CNB022P 
1. Click the Test Reports folder tab. 
2. In the Item Cd/Desc drop-down list, select item 712-06 SIGNS 

(CONSTRUCTION).  
3. In the Prj Nbr drop down-list, select 55019-3220-94.   

Because this item is listed on this project only once, the Line Item 
Number and Category Number are automatically selected. 

4. Click the New button.  
SiteManager displays the Add New Test Report window. 

5. In the Report Date field, type 051405. 
6. In the Report # field, type T2. 
7. In the Report Quantity field, type 23.0. 
8. Click the Save button. 
9. To close the Add New Test Report window, click the Close button.  

The Test Reports folder displays the new entry. 
Now let’s add test reports for another item/material. 

10. In the Item Cd/Desc drop-down list, select item 307-01.01 
ASPHALT CONCRETE MIX (PG64-22) (BPMB-HM) 
GRADING A.  

11. In the Prj Nbr drop down-list, select 55019-3220-94.   
Because this item is listed on this project only once, the Line Item 
Number and Category Number are automatically selected. 

12. Click the New button.  
SiteManager displays the Add New Test Report window. 

13. In the Report Date field, type 051405. 
14. In the Report # field, type 1. 
15. In the Report Quantity field, type 1400.0. 
16. Click the Save button. 
17. To close the Add New Test Report window, click the Close button.  

The Test Reports folder displays the new entry. 
 

Stays open for 
multiple entries.

Stays open for 
multiple entries.
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Test Reports Plug-in, Test Report Payment Adjustment Folder Tab 
The Test Report Payment Adjustment folder tab displays the materials associated 
with a contract item that either have a material test shortage or a balance to adjust 
(or both) based on the current estimate period.  If the estimate is not in pending 
status, then the user may view the list of material test shortage adjustments made 
for the current estimate period. 

When the user clicks the Balance Shortages button, the Test Reports plug-in will 
calculate the adjustment that should be made for the estimate and enter that value 
in the Line Item Adj This Est field.  After the balancing adjustments have been 
calculated, the user may manually override the calculated line item adjustments by 
entering the overriding value in the Override Line Item Adj This Est field. 

Line Item Adjustments made by the Test Reports plug-in will automatically be 
removed from the pending estimate when it is deleted or regenerated. 

To apply line item deductions to an estimate due to a shortage of test reports: 

1. Generate the estimate and resolve or override all discrepancies. 

2. Access the Test Report plug-in and set up the materials on the Shortage 
Calculation Setup folder tab. 

3. Enter the Test Reports received. 

4. Examine the Test Report Payment Adjustment folder tab of the Test 
Report plug-in. 

5. Click the Balance Shortages button on the Test Report Payment 
Adjustment folder tab of the Test Report plug-in.   

6. Override the Line Item Adjustment as desired. 

 

Review example in 
text to make sure 
participants 
understand 
relationship 
between the two 
plug-ins. 

You can add TR's 
after balancing 
shortages but you 
will need to "re-
balance" for them to 
pick up the changes. 

Shortages are 
balanced once per 
estimate unless the 
estimate is deleted, 
regenerated, or 
rebalanced.  
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The Tests Reports Plug-in – Test Report Payment Adjustment Folder Tab Window  

(Before Balancing Shortage) 

Figure 10-14 

 
The Tests Reports Plug-in – Test Report Payment Adjustment Folder Tab Window  

(After Balancing Shortage) 

Figure 10-15 

 

This panel 
shows all of 
the items 
marked with 
the YES 
indicator on 
the Shortage 
Calculation 
Setup panel 
that have 
shortages. 
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 Exercise 10-10 
In the following exercise, you will enter a test report payment adjustment using the 
Test Reports plug-in for Pending Estimate 0001 for contract CNB022P. 

User ID: jj05754 Group: OSTAFF Contract: CNB022P 
1. Click the Test Report Payment Adjustment folder tab. 
2. Click the row for Project 55019-3220-94, Catg 0100, Line Item Nbr 

0110, Item Cd 307-01.01, Material Asphalt Concrete Mix. 
3. What is the value in the Shortage field for this item? ___________ 
4. Click the row for Project 55019-3220-94, Catg 0100, Line Item Nbr 

0310, Item Cd 712-06, Material SIGNS (CONSTRUCTION). 
5. What is the value in the Line Item Adj. This Estimate column for 

this item? ______________________________________________ 
 
While the reported quantity on the previous exercise reduced the amount 
of the quantity still needed for testing, it was not enough. An adjustment 
will have to be made. 
 
6. On the toolbar, click the Balance Shortage button. This button will 

balance the shortage and create the Test Report Payment Adjustment 
(TRPA).  The plug-in makes the Balance Shortage button 
unavailable and displays the adjustment value made for this estimate 
in the Line Item Adj This Est field. 

7. What value appears in the Line Item Adj This Est field for Item 
Code 712-06? _________ 

8. What value appears in the Line Item Adj This Est field for Item 
Code 307-01.01? _________ 

 
 
 

This panel 
shows all of 
the items 
marked with 
the YES 
indicator on 
the Shortage 
Calculation 
Setup panel 
that have 
shortages. 

- 1.000 

-13.000 

0.00 

 -13.000 
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Test Reports Plug-in, Materials Folder Tab 
The Materials folder tab allows the user to view, add, or delete materials on one or 
more projects for the associated contract.  When the User clicks the New button to 
add a new material, the Add New material field becomes available for the User to 
type in a new material(s).  Users may cancel the request and return to the 
Materials panel without saving the new material. 

For those materials that apply to the same item on multiple projects, the option of 
selecting No Project Number is available.  This indication will allow the material 
to be associated with all instances of the selected item on the contract.  
Additionally, the option of selecting No Item Code is available.  This indication 
will allow the material to be associated with all items on the contract. 

Users cannot delete default materials created by the Test Reports plug-in. 

Note: Adding materials here does not effect the Test Report Payment Adjustment 
features of this plug-in.  It is merely a record keeping mechanism for noting 
additional materials used in an item.  Test Reports may not be reported to 
materials added on this folder tab. 

To add materials to an item: 

1. Access the Test Reports plug-in. 

2. On the Materials folder tab, select the Item Cd/Desc and the Prj Nbr 
for the item materials will be added to. 

3. Click the New button. 

4. In the Add New Material field, type a material name. 

5. In the Matl Units drop-down, select the material unit of measure. 

6. Click the Save button. 

 
The Tests Reports Plug-in – Materials Folder Tab Window 

Figure 10-16 

Stress that 
adding 
materials does 
not affect the 
Test Report 
Payment 
Adjustment 
features.  

Remember 
the Materials 
panel is for 
record 
keeping only.  
To record an 
actual test 
report that is 
to be 
associated to 
the item for 
payment, use 
the Test 
Reports panel. 
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 Exercise 10-11 
In the following exercise, you will view the area of the plug-in that you may use 
to record the materials included in an item.  

User ID: jj05754 Group: OSTAFF Contract: CNB022P 
1. Click the Materials tab. 
2. In the Item Cd/Desc drop-down list, select the 801-01 SEEDING 

(WITH MULCH). 
3. In the Prj Nbr field, select 55019-3220-94. 
4. Click the New button. 
5. In the Add New Material field, type LIME. 
6. In the Matl Units field, select UNIT. 
7. Click the Save button. 
8. Select the Test Reports tab. 

9. In the Item Cd/Desc drop-down list, select 801-01 SEEDING (WITH MULCH). 

10. In the Material drop-down list, select Lime. 

11. Click New. 

12. In the Report Date field, type 051405. 

13. In the Report # field, type report number if applicable. 

14. In the Report Quantity field, type 60. 

15. Enter Remarks if needed. 

16. Click Save and close the Add New Test window. 
17. To close the Test Reports plug-in, click the Exit button.   

The Test Reports plug-in will close, and SiteManager’s Contracts 
window will still be open in the background. 

The added 
material 
doesn’t count 
toward 
shortage 
calculations. 

Leave 
Contracts 
window open  - 
will use panel 
button for the 
next exercise. 
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Viewing Line Item Adjustments 
The Contract Line Item Adjustments window displays line item adjustments that 
are reflected in the final payable amount for the Estimate. The top datawindow 
displays all the Line Items for which an adjustment is present. The bottom 
datawindow displays associated adjustment information. System-generated 
adjustments cannot be modified by a User. 

 

 
The Line Item Adjustments Window (After Using the Test Reports Plug-in) 

Figure 10-17 

 

In TDOT, the Line Item Adjustments window is accessed to view the line 
item adjustments entered by the system. 

Line Item Adjustments displayed will be: 

1. Test Report Payment Adjustments 

2. Stockpiled Materials Initial Payment 

3. Stockpiled Materials Adjustments 

4. Adjustments – Fuel, Bituminous Material, 307 AC Content, 411 AC 
Content, and Anti-Strip 

5. The Remarks field will show any items that have been overridden by 
whom and how much. 

 

Note how the 
Test Reports 
plug-in made 
an 
adjustment 
after 
shortages 
were 
balanced. 
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 Exercise 10-12 
In the following exercise, you will view the line item adjustments resulting from the 
use of the Test Reports plug-in for Pending Estimate 0001 on contract CNB022P. 

User ID: jj05754 Group: OSTAFF Contract: CNB022P 
1. In SiteManager, on the toolbar, click the SiteManager Panel button. 
2. Click the Main Panel folder tab.  
3. Double-click the Contractor Payments icon. 
4. On the Contractor Payments panel, double-click the Contract 

Adjustments icon. 
5. On the Contract Adjustments panel, double-click the Line Item 

Adjustments icon.  
SiteManager displays the Line Item Adjustments window for Contract 
CNB022P Estimate Nbr 0001. 

6. Note that an adjustment appears for each row that appeared on the Test 
Report Payment Adjust folder tab of the Test Reports plug-in. 

7. Scroll to and click Prj Nbr 55019-3220-94, Catg Nbr 0100, Line Item 
Number 0310, Item Code 712-06, Description SIGNS 
(CONSTRUCTION). 

8. What is the amount of the adjustment for this item? ____________ 
9. Scroll to and click Prj Nbr 55019-3220-94, Catg Nbr 0100, Line Item 

Number 0110, Item Code 307-01.01, Description ASPHALT 
CONCRETE MIX (PG64-22) (BPMB-HM) GRADING A. 

10. What is the amount of the adjustment for this item? ____________ 
11. To close the Line Item Adjustments window, click the Close button.   

The Contracts window displays because the SiteManager Panel button 
was used to open the Line Item Adjustments window from the Contracts 
window in the first steps of this exercise. 

 

- 9.50 

-507 
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Entering Fuel, Bituminous Material, AC Content, and 
Anti-Strip Adjustments 
Fuel, Bituminous Material, AC Content, and Anti-Strip adjustments are entered 
into SiteManager using a TDOT developed plug-in accessible from the 
SiteManager Contract window Attachment functionality. 

The Adjustments plug-in will reference the estimate details and test report 
shortage adjustments to create the appropriate payment price adjustments for the 
current estimate period.  The adjustments will be recorded as a Line Item 
Adjustment and associated with one of the adjustment items listed in the table 
below.   

To delete the pay and price adjustments from the Adjustments plug-in, the 
estimate must be returned to Pending status. This is done by clicking the Services 
menu in the Adjustments plug in and selecting the choice Return Est Status to 
PEND.  Once the estimate has been returned to Pending status, it can be deleted 
using the Estimate History window. 

The Adjustments plug-in is divided into seven folder tabs: Adj. Process 
Submission, Fuel Adjustment Items, Bitm Adjustment Items, 307 A/C Adjustment 
Items, 411 A/C Adjustment Items, Liquid Anti-Strip, and Adjustment Setup. 

IMPORTANT: The user must first generate and resolve all discrepancies for a 
pending estimate through the standard SiteManager functionality, and then enter 
any remaining test reports and balance shortages, if applicable, in the Test Reports 
plug-in before accessing the Adjustments plug-in.   

 
The Attachments Window 

Figure 10-18 

If the estimate needs 
to be regenerated 
first use the 
Adjustments plug-in 
to return the 
Estimate Status to 
Pending (from the 
Adjustments plug in 
Services menu) 
before deleting the 
estimate from SM.  
It is the only way to 
remove the system 
generated Line Item 
Adjustments and 
prevent duplication 
of adjustments. 
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Item 
Code 

Spec 
Year 

Unit 
Sys 

Price Adjustment Pay Item Description Unit Of 
Measure 

109-01.01   2000 Eng PAY ADJUSTMENT FOR FUEL Dollar 

109-01.02   2000 Eng PAYMENT ADJUSTMENT FOR BITUMINOUS MATERIAL. Dollar 

307-03.20   2000 Eng PRICE ADJUSTMENT FOR AC CONTENT Dollar 

307-05.40 2000 Eng PAYMENT ADJUSTMENT FOR LIQUID ANTI-STRIP Dollar 

411-03.20   2000 Eng PRICE ADJUSTMENT FOR ASPHALT CEMENT CONTENT Dollar 

411-05.40 2000 Eng PAYMENT ADJUSTMENT FOR LIQUID ANTI-STRIP Dollar 

The TDOT Price Adjustment Pay Item List  

Table 10-8 

The steps to use the Adjustments plug-in are as follows and are detailed on the 
following pages.  

1.  Generate and review the estimate. 

2.  Resolve or override discrepancies. 

3. Test Report shortages must be balanced before Adjustments can be 
calculated. 

4.  Access the Adjustments plug in (Main Panel > Contract 
Administration > Contracts > select Contract > click Attachments button 
> double-click Adjustments for Fuel, Bit. Material, AC Content, and Anti-
strip) 

5.  Review messages for the estimate adjustments on the Adj. Process 
Submission folder tab of the Adjustments plug-in. 

6. When applicable, Enter monthly Asphalt Invoice Price, Mix Design and 
Recycled Asphalt percentages and dates for the pay items included in the 
estimate and listed on the Adjustment Setup folder tab of the Adjustments 
plug-in. 

7.  Confirm all messages have been satisfied for the estimate adjustments 
on the Adj. Process Submission folder tab of the Adjustments plug-in. 

8.  Click the Calc. button on the Adj. Process Submission folder tab of the 
Adjustments plug-in to generate adjustments to the estimate and provide 
1st level approval of the estimate. 

9.  View adjustments made by the system on the Fuel Adjustment Items, 
Bitm Adjustment Items, 307 A/C Adjustment Items, 411 A/C Adjustment 
Items, and Liquid Anti-Strip folder tabs of the Adjustments plug-in. 
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Adjustments Plug-in, Adj Process Submission Folder Tab 
The Adj. Process Submission folder tab is used to initiate the adjustment process 
by selecting the Calculation option or to delete a pending estimate adjustment.  
Users are able to select which estimate they would like to view the adjustments 
plug-in for from a drop-down menu in the top data window.  The top data window 
will display the selected estimate period begin and end dates as well as the status 
of the selected estimate.  The bottom datawindow displays pertinent processing 
messages for the adjustments process associated with the selected estimate.  These 
process messages include: 

• First message is always the pending estimate number if a pending estimate exists 
for the contract. 

• If the selected estimate is an approved estimate then a message stating that the 
Adjustment can not be made for this estimate will display.  

• If the selected estimate has 307/411 items placed during an estimate period in 
which an appropriate Mix Design (DA) percentage has not been entered, then a 
message stating what is needed and that Adjustments can not be made will 
display. 

• If the selected estimate has Fuel, Bituminous, or 307/411 items placed during the 
estimate period without the appropriate price adjustments then a message 
appears. 

• When applicable, if the User has not balanced the Test Report Shortages before 
running the Adjustment plug-in then a message stating Pending estimate has not 
had its Test Reports balanced and that Adjustments can not be made will display.  

 
The Adjustments Plug-in - Adj. Process Submission Folder Tab Window 

Figure 10-19 

The Asphalt Invoice 
Price will only be 
required on 
contracts let prior to 
2010. 
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 Exercise 10-13 
In the following exercise, you will access the Adj. Process Submission folder tab for 
Estimate 0001 for contract CNB022P.  

User ID: jj05754 Group: OSTAFF Contract: CNB022P 
1. On the toolbar, click the Attachments button. 
2. On the Attachments window, double-click the Adjustments 

attachment. SiteManager displays the TDOT Price Payment 
Adjustment window.  

3. In the Adjustment Calculation Messages area, notice the remaining 
issues to address. All valid discrepancies must be resolved before 
adjustments can be made.  

4. For what date has the invoice price for PG64-22 not been entered? 
_______________________________________________________ 

5. What are both the 307.01-01 and 307.01-08 items missing that is 
preventing adjustments from being made? 
_______________________________________________________ 

6. Click the Fuel Adjustment Items folder tab to see that no Fuel 
adjustments have been made on this estimate yet. 

7. Click the Bitm Adjustment Items folder tab to see that no 
Bituminous adjustments have been made on this estimate yet. 

8. Click the 307 A/C Adjustment Items folder tab to see that no 307 
A/C adjustments have been made on this estimate yet. 

9. Click the 411 A/C Adjustment Items folder tab to see that no 411 
A/C adjustments have been made on this estimate yet. 

10. Click the Liquid Anti-strip folder tab to see that no Liquid Anti-
strip adjustments have been made on this estimate yet. 

11. To prepare for the next exercise, click the Adjustment Setup tab. 
 

4/01/2005 

Mix Design Asphalt percentage 
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Adjustments Plug-in, Adjustment Setup Folder Tab 
The Adjustments Setup folder tab provides maintenance capabilities for item 
specific and contract level Mix Design (DA) and Recycled Asphalt (RA) Content 
performance grade asphalt invoice prices as well as liquid anti-strip prices.   

The plug-in automatically creates one DA/RA row for each applicable contract 
item that has a DWR work item recorded against that item.   

When the user accesses this folder tab, only the latest DA/RA values and PG 
Invoice dates are displayed.   

To update any values, select the row, select the Open option, and then select new. 
The system keeps a history of values entered in the adjustment setup folder tab. To 
access the history (all previously entered AC values), select the row, and then 
select open.  

 

The Adjustments Plug-in - Adjustment Setup Folder Tab Window 

Figure 10-20 

Note how the Adj 
Process Submission 
panel did not 
include messages 
for the items on 
55021-3214-94. 
This is because 
there were no 
installed quantities. 

The Asphalt Invoice 
Price will only be 
required on 
contracts let prior to 
2010. 

Only one Asphalt 
Invoice Price per 
month is allowed. 
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 Exercise 10-14 
In the following exercise, to complete the adjustments for contract CNB022P, you 
will enter the required information noted on the Adj Process Submission folder 
tab. 

User ID: jj05754 Group: OSTAFF Contract: CNB022P 
1. On the Adjustment Setup panel, in the Mix Design Asphalt 

Percentages area, select the row for Project 55019-3220-94, Item Cd 
307.01-01. 

2. On the toolbar, click the Open button. The Adjustments plug-in 
displays the Mix Design Percentage Setup window. 

3. In the Mix Design Percentage Setup window, click the New button. 
4. In the Mix Design (DA) Pct field, type 3.80. 
5. In the Recycled (RA) Pct field, type 0.45. 
6. In the Date field, type 040105. 
7. Click the Save button. The plug-in adds a new row with the 

information you entered into the lower area of the window. 
8. To close the Mix Design Percentage Setup window, click the Exit 

button. 
Now let’s enter another mix design asphalt percentage. 

9. Select the row for Project 55019-3220-94, Item Cd 307.01-08. 
10. On the toolbar, click the Open button. The Adjustments plug-in 

displays the Mix Design Percentage Setup window. 
11. In the Mix Design Percentage Setup window, click the New button. 
12. In the Mix Design (DA) Pct field, type 4.20. 
13. In the Recycled (RA) Pct field, type 0.00. 
14. In the Date field, type 040105. 
15. Click the Save button. The plug-in adds a new row with the 

information you entered into the lower area of the window. 
16. To close the Mix Design Percentage Setup window, click the Exit 

button. 
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Adjustments Plug-in, Adj Process Submission Folder Tab 
The Adj. Process Submission folder tab is used to initiate the adjustment process 
by clicking the Calc button on the toolbar after resolving all processing messages 
displayed in the window.  After calculating adjustment, the following message 
displays: 

• Initial approval given for Estimate 0001; returning estimate approval back to 
Pending also deletes estimate’s Price and Pay Adjustments if they exist. 

 
 

 
The Adjustments Plug-in - Adjustment Process Submission Folder Tab Window 

(After Clicking Calc Button) 

Figure 10-21 

 Exercise 10-15 
In the following exercise, to complete the adjustments for contract CNB022P, you 
will enter the required information noted on the Adj Process Submission folder 
tab. 

User ID: jj05754 Group: OSTAFF Contract: CNB022P 

First, let’s verify that we’ve satisfied all of the required Adjustment Calculation 
Messages. 

1. Click the Adj Process Submission tab.  
2. Have you addressed all required messages? _________________ 

Now let’s calculate the adjustments to the estimate. 
3. Click the Calc button in the toolbar. 
4. Click the Yes button.  

A Line Item Adjustment is created and included in Estimate #001 for 
Contract CNB022P. 
First Level approval is also given to the estimate. 

Now let’s confirm the adjustments were applied to the estimate. 
5. Is there an Adjustment calculation message indicate Initial Approval 

was given? ______________________________________________ 

YES 

YES 
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Adjustments Plug-in, Fuel Adjustment Items Folder Tab 
The Fuel Adjustment Items folder tab is a three focus window.   

 The top datawindow is populated automatically by the plug-in and 
displays the adjustment item details, the Bidding Fuel Price field to 
display the contract level price of fuel for bidding, and the Bidding Index 
field to display the value for the entry immediately preceding the 
Contract’s Price Adjustments Base Date. 

 The middle datawindow is also automatically populated by the plug-in 
and displays the item details for the specified line item for the selected 
adjustment type for each project/category the item is associated with on 
the contract.  The total adjustment amount for the project/category 
displays in the Dollar Amt/Placed Quantity field. 

 The bottom datawindow is also automatically populated by the plug-in 
and displays the pay adjustments for fuel created for those items 
designated as fuel adjustment items on the Price Adjustment 
Maintenance Reference Table in SiteManager and installed during the 
estimate period.  These adjustments will be recorded as a Line Item 
Adjustment. 

For test reports not included in an Adjustment to date:  

 If a TDOT negative Test Report Payment Adjustment (TRPA) has been 
made for an item listed in the bottom datawindow due to lack of tested 
quantity, the Shortage Paid Qty field will display a negative amount 
indicating that the quantity has not been adjusted because of a test 
quantity shortage.   

 If a positive TRPA has been made for an item listed in the bottom 
datawindow to make up for a previously shortage of material tests, the 
Shortage Paid Qty field will display a positive amount indicating the 
current material tested quantity covers a previous test shortage quantity. 
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The Adjustments Plug-in - Fuel Adjustment Items Folder Tab Window 

Figure 10-22 

 Exercise 10-16 
In the following exercise, you will view the fuel adjustment items for contract 
CNB022P.  

User ID: jj05754 Group: OSTAFF Contract: CNB022P 
1. Click the Fuel Adjustment Items tab.  
2. Were there any fuel adjustments made during this estimate period? _______ 
3. What is the adjustment amount for fuel on this estimate? _______________ 
4. To prepare for the next exercise, click the Bitm Adjustment Items tab. 

 

Yes 
$721.35 
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Adjustments Plug-in, Bitm Adjustment Items Folder Tab 
The Bitm Adjustment Items folder tab is a three focus window.   

 The top datawindow is populated automatically by the plug-in and 
displays the adjustment item details and the Base Index field to display 
the value for the entry immediately preceding the Contracts Price 
Adjustment Base Date.  

 The middle data window is also automatically populated by the plug-in 
and displays the item details for the specified line item for the selected 
adjustment type for each project/category the item is associated with on 
the contract.  The total adjustment amount for the project/category 
displays in the Dollar Amt/Placed Quantity field. 

 The bottom datawindow is also automatically populated by the plug-in 
and displays the pay adjustments for bituminous materials created for 
those items designated as bituminous adjustment items on the Price 
Adjustment Maintenance Reference Table in SiteManager and installed 
during the estimate period.  These adjustments will be recorded as a Line 
Item Adjustment. 

 

 
The Adjustments Plug-in - Bitm Adjustment Items Folder Tab Window  

Figure 10-23 
 

In TDOT, if an applicable item resulted in a ZERO payment adjustment 
amount because the mix design was not entered, asterisks will be placed in 
the applicable field and a message will be listed at the bottom stating why. 
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 Exercise 10-17 
In the following exercise, you will view the bituminous adjustment items for contract 
CNB022P.  

User ID: jj05754 Group: OSTAFF Contract: CNB022P 
1. Were there any Bituminous adjustments made during this estimate period? 

______________________________________________________________ 
2. What is the Adjustment amount for Bituminous materials on this estimate? 

______________________________________________________________ 
3. To prepare for the next exercise, click the 307 A/C Adjustment Items tab. 

$1486.53 

YES 
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Adjustments Plug-in, 307 A/C Adjustment Items Folder Tab 
The 307 A/C Adjustment Items folder tab is a three focus window.   

 The top datawindow is populated automatically by the plug-in and 
displays the adjustment item details. 

 The middle data window is also automatically populated by the plug-in 
and displays the item details for the specified line item for the selected 
adjustment type for each project/category the item is associated with on 
the contract. The total adjustment amount for the project/category displays 
in the Dollar Amt/Placed Quantity field. 

 The bottom datawindow is also automatically populated by the plug-in 
and displays the pay adjustments for A/C Content for those items 
designated as 307 Mix items on the Price Adjustment Maintenance 
Reference Table in SiteManager and installed during the estimate period.  
These adjustments will be recorded as a Line Item Adjustment. 

 

The Adjustments Plug-in - 307 A/C Adjustment Items Folder Tab Window  

Figure 10-24 

 

In TDOT, if an applicable item resulted in a ZERO payment adjustment amount 
because the mix design was not entered, asterisks will be placed in the applicable 
field and a message will be listed at the bottom stating why. 
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 Exercise 10-18 
In the following exercise, you will view the 307 asphalt content adjustment items for 
contract CNB022P.  

User ID: jj05754 Group: OSTAFF Contract: CNB022P 
1. Were there any 307 A/C adjustments made during this estimate period? 

_____________________________________________________________ 
2. What is the Adjustment amount for 307 A/C on this estimate? 

_____________________________________________________________ 

YES 

$-532.00 
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Adjustments Plug-in, 411 A/C Adjustment Items Folder Tab 
The 411 A/C Adjustment Items folder tab is a three focus window.  

 The top datawindow is populated automatically by the plug-in and 
displays the adjustment item details. 

 The middle data window is also automatically populated by the plug-in 
and displays the item details for the specified line item for the selected 
adjustment type for each project/category the item is associated with on 
the contract.  The total adjustment amount for the project/category 
displays in the Dollar Amt/Placed Quantity field. 

 The bottom datawindow is also automatically populated by the plug-in 
and displays the pay adjustments for A/C Content created for those items 
designated as 411 Mix adjustment items on the Price Adjustment 
Maintenance Reference Table in SiteManager and installed during the 
estimate period.  These adjustments will be recorded as a Line Item 
Adjustment. 

 

  

The Adjustments Plug-in - 411 A/C Adjustment Items Folder Tab Window  

Figure 10-25 

 

In TDOT, if an applicable item resulted in a ZERO payment adjustment 
amount because the mix design was not entered, asterisks will be placed in 
the applicable field and a message will be listed at the bottom stating why. 

 

Point out that 
the 411 data is 
similar to the 
data they will see 
when they look 
at these other 
tabs. 
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 Exercise 10-19 
In the following exercise, you will view the 411 asphalt content adjustment items for 
contract CNB022P.  

User ID: jj05754 Group: OSTAFF Contract: CNB022P 
1. Click the 411 A/C Adjustment Items folder tab. 
2. Were there any 411 A/C adjustments made during this estimate period? 

______________________________________________________________ 
3. To prepare for the next exercise, click the Liquid Anti-strip folder tab.  

NO 
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Adjustments Plug-in, Liquid Anti-Strip Folder Tab 
The Anti-Strip Adjustment Item folder tab is a three focus window for each anti-
strip adjustment item. 

 The top data window is populated automatically by the plug-in and 
displays the adjustment item details. 

 The middle data window is also automatically populated by the plug-in 
and displays the item details for the specified line item for the selected 
adjustment type for each project/category the item is associated with on 
the contract.  The total adjustment amount for the project/category 
displays in the Dollar Amt/Placed Qty field. 

 The bottom data window is also automatically populated by the plug-in 
and displays the pay adjustments for anti-strip created for those items 
where anti-strip quantities were entered in the Total Anti-Strip 
Gallons/Liters field within the SM39 DWR template.  

 

  

The Adjustments Plug-in – Liquid Anti-strip Folder Tab Window  

Figure 10-26 

 

In TDOT, if an applicable item resulted in a ZERO payment adjustment 
amount because the Invoice Price was not entered, asterisks' will be placed 
in the applicable field and a message will be listed at the bottom stating why. 
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 Exercise 10-20 
In the following exercise, you will view the Liquid Anti-strip adjustment items for 
contract CNB022P.  

User ID: jj05754 Group: OSTAFF Contract: CNB022P 
1. Were there any Liquid Anti-strip adjustments made during this estimate 

period? _______________________________________________________ 
2. To close the plug-in, click the Exit button. 

The Adjustments plug-in will close, and SiteManager’s Contracts window 
will still be open in the background. 

3. Click the Close button to close the Contract window. 
4. Click the Main Panel folder tab. 

NO 
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TDOT Estimate Review and Approve Workflow 
The Office staff will complete the following tasks as part of the estimate 
generation and review process. 

Estimate Review and Approve Workflow Tasks Functional Navigation 

1. Using the Adjustment Plug-In, Office Staff will approve the 
completed estimate which places it in the first level of 
approval and contact the Project Supervisor when the 
estimate is ready for the next approval level.”  NOTE:  Do 
not approve estimate if estimate is Less than $1000, contact 
HQ Finance. 

 
 
 

Contract Administration > Contract 
Records > Contracts > Plug-In > 
Adjustment Plug-In 

2. Project Supervisor will review the Summary to Contractor 
and Estimate Discrepancy windows to verify the estimate is 
correct. As needed, the Project Supervisor will run any 
reports or view any other windows necessary to review item 
quantities. 

Contractor Payments > Process List > 
Summary to Contractor  and Contractor 
Payments > Estimate Discrepancy, 
Various Contract Adjustments, Daily 
Work Reports, Contractor Payments, 
and Crystal Reports 

3. Project Supervisor will approve or stop the estimate based on 
their review. To stop the estimate, the Project Supervisor 
must notify the Office Staff person who generated the 
estimate. When stopped, an estimate will need to be 
evaluated and may need to be generated again. If changes are 
required, the Office Staff will follow the Estimate Correction 
Procedures detailed in the TDOT Progress Estimate 
Correction Workflow table 10-6 of this Chapter. 

Contractor Payments > Estimate > 
Estimate Approval 

4. Office Staff will run the Monthly Construction Report and 
send a copy to the Contractor and Surety Agency.  
Optionally, the Office Staff can send a copy of the Summary 
to Contractor Report with the Monthly Construction Report. 

External Crystal Report or Contractor 
Payments > Process List > Summary to 
Contractor 

5. Office Staff / Project Supervisor may track the status of the 
estimate.   

Contractor Payments > Estimate > 
Estimate Tracking 

6. Finance will approve or stop the estimate based on their 
review.  To stop the estimate, Finance must notify the Office 
Staff person who generated the estimate. When stopped, an 
estimate will need to be evaluated and may need to be 
generated again. 

Contractor Payments > Estimate > 
Estimate Approval 

7. Finance will post the approved Summary to Contractor report 
to the internet. 

Contractor Payments > Process List > 
Summary to Contractor 

The Estimate Review and Approval Workflow Table 

Table 10-9 

Office Staff may use 
Adjustment Plug-In to return 
the estimate to Pending status 
until HQ Finance office 
approves the estimate. 
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Viewing the Estimate Item Detail 
The Estimate Item Detail window displays the Item quantities from authorized 
Daily Work Reports.  

 
The Estimate Item Detail Window 

Figure 10-27 

In TDOT, the Office staff and Project Supervisor may view the Estimate 
Item Detail window to verify the item quantities for payment on the 
Estimate. 

If there is no Pending or Rejected estimate for the Contract, you will see 
cumulative totals for all items on estimates.  

These 
Discrepancy 
indicators only 
display when 
viewing ONE  
PENDING 
estimate, rather 
than All. 
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 Exercise 10-21 
In the following exercise, you will view the Estimate Item Detail for Estimate 0001 
for contract CNB022P.  

User ID: jj05754 Group: OSTAFF Contract: CNB022P 

1. On the Main Panel, double-click the Contractor Payments icon.  
2. On the Contractor Payments panel, double-click the Estimate icon. 
3. On the Estimate panel, double-click the Estimate Item Detail icon. 

SiteManager displays a message to inform you that no pending or 
rejected estimates exist for this contract.   

4. To see items for all estimates, click the Yes button. SiteManager 
displays the Estimate Item Detail window. 

5. In the list box, scroll to and click the record for Project Nbr 55021-
3214-94, Line Item Number 0643, Item Code 204-07, BEDDING 
MATERIAL.  

6. What quantity was installed on this estimate for this item? __________ 
7. What quantity was paid on this estimate for this item? _____________ 
8. In the list box, scroll to and click the record for Project Nbr 55019-

3220-94, Line Item Number 0310, Item Code 712-06, SIGNS 
(CONSTRUCTION). 

9. What quantity was installed on this estimate for this item? __________ 
10. What quantity was paid on this estimate for this item? _____________ 
11. In the list box, scroll to and click the record for Project Nbr 55021-

3220-94, Line Item Number 0110, Item Code 307-01.01, ASPHALT 
CONCRETE MIX. 

12. What quantity was installed on this estimate for this item? __________ 
13. What quantity was paid on this estimate for this item? _____________ 
14. To close the Estimate Item Detail window, click the Close button. 

19.000 

19.0  

24.00 

24.0 

1413 

1413 

The estimate 
is no longer in 
Pending status 
because the 
first level of 
approval was 
given by the 
plug in.  The 
estimate is 
now in INAP 
status. 
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Viewing the Estimate Item Paybook 
The Estimate Item Paybook is an inquiry only window showing the payment 
history for a Contract Item. The Item payment history displays in reverse 
chronological order meaning the current Estimate Item displays on the first row.  
Thus, it is possible that the first row is not yet paid.  Whether the first row is paid 
or not can be determined by the Approver User ID.  If the Approver User ID is the 
final reviewer "(HQ Finance), then the item has been paid. 

 
The Estimate Item Paybook Window 

Figure 10-28 

 

In TDOT, the Estimate Item Paybook may be used to check amounts paid 
on each Estimate for a particular item. 
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 Exercise 10-22 
In the following exercise, you will view the Estimate Item Paybook for Estimate 
0002 for contract CNB022P.  

User ID: jj05754 Group: OSTAFF Contract: CNB022P 
1. On the Estimate panel, double-click the Estimate Item Paybook 

icon. SiteManager displays the Select Contract and Line Item 
window. 

2. In the Contract list box, scroll to and double-click Contract ID 
CNB022P.  

3. In the Line Item list box, scroll to and double-click Ln Itm Nbr 0500 
for Project 55019-3220-94, Item Code 606-09.01 TEST PILES 
(PRECAST CONCRETE, SIZE 1). 

4. Has an adjustment been applied to this item? __________________ 
5. Click the Open button. 
6. In the Line Item list box, scroll to and double-click Ln Itm Nbr 0310 

for Project 55019-3220-94, Item Code 712-06 SIGNS 
(CONSTRUCTION). 

7. Has an adjustment been applied to this item? __________________ 
8. Click the Open button. 
9. In the Line Item list box, scroll to and double-click Ln Itm Nbr 0110 

for Project 55019-3220-94, Item Code 307-01.01 ASPHALT 
CONCRETE MIX. 

10. Has an adjustment been applied to this item? __________________ 
11. To close the Estimate Item Paybook window, click the Close button. 
12. To prepare for the next exercise, click the Contractor Payments 

folder tab. 

YES 

YES 

YES 
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Generating the Summary to Contractor Report 
The Summary to Contractor report displays the amounts to be paid to the 
Contractor based on the estimate.  The report summarizes previous payments 
made to the Contractor and the current status of the Contract when the estimate is 
generated. An itemized description of quantities and amounts on all items in every 
project contained in the estimate is also given. 

The report consists of two pages. The first page summarizes the Contract 
information.  The second page lists the quantities and amounts of all the items for 
each project in the Contract. 

 
The Estimate Summary to Contractor Report 

Figure 10-29 

Report needs 
to be printed 
in Landscape. 
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In TDOT, the Office Staff / Project Supervisor will review the Summary to 
Contractor report to ensure that the line item payment is correct and to 
ensure the item categories are correct.  If changes are required, the Office 
Staff will follow the Estimate Correction Procedure.  Reminder: If the 
estimate must be re-generated, the estimate must first be returned to 
Pending status in the Adjustments plug-in before the estimate is deleted 
and generated again. 

When generating the Summary to Contractor Report from the Process 
List, the option to change the parameters to “Generate Online” exists.  
When the report is generated online, only the data in the standalone 
database is included in the report.  If the “Generate Online” option is 
selected, the report will include the contract information that was current 
as of the last download of Basic Contract Data from the server. 

The Summary to Contractor Report should be printed in Landscape with 
the smallest font size. Refer to the Review in this section for steps to modify 
the font and print preference.  

 Exercise 10-23 
In the following exercise, you will generate the Summary to Contractor Report for 
Estimate 0001 for contract CNB022P.  

User ID: jj05754 Group: OSTAFF Contract: CNB022P 
1. On the Contractor Payments panel, double-click the Process List icon. 
2. In the Process List, click the Summary to Contractor.  
3. Click the Run Process button. 

STOP. Do not submit the process in SiteManager Training.  
4. Click the Cancel Button 
5. Click the Close Button. 

A copy of the report is saved at C:\SMTRAINS\SMFILES to view during 
training.  

6. Right-click the Start button at the bottom left of the screen. 
7. Click the Explore choice. 
8. Navigate to the C:\SMTRAINS\SMFILES folder. 
9. Double-click Estimate Summary to Contractor CNB022P.htm. 
10. After viewing report, click the Close button to close the browser window. 
11. Click the Exit button to exit SiteManager. 

See the Review 
for steps to run in 
Production. 
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Approving an Estimate 
The Estimate Approval window allows the authorized reviewers to approve all 
Estimate types—progress, final, or supplemental. The approval process provides 
an audit trail and prepares the Estimate for the creation of the extract file that is used 
by the Tennessee Department of Transportation’s financial system. The approval 
process is conducted by a chain of approvals established during SiteManager 
installation or at Contract setup. Each approval level corresponds to a User group 
within SiteManager.  

The Estimate is approved starting with the first level (Office Staff) and is completed 
with the last reviewer who indicates that the Estimate is ready for payment. Once 
the last approval level has approved the Estimate, a generic file layout is created 
which contains all payment information required by the Tennessee Department of 
Transportation’s financial system and available in SiteManager. 

 
The Estimate Approval Window 

Figure 10-30 

The Estimate creator 
must approve the 
Estimate before the 
users in the approval 
hierarchy can 
approve it.  
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In TDOT, the progress estimate is approved by the following personnel: 

• Office Staff (approval given in Adjustment plug-in) 

• Project Supervisor 

• Finance Staff 

In TDOT, the final estimate and supplemental estimates are approved 
by the following personnel: 

• Office Staff 

• Project Supervisor 

• Regional Director Rep 

• Finance Staff 

• Director of Construction 

 

The standard TDOT Estimate workflow is: 

1. Generate the estimate 

2.  Review the Estimate items 

3.  Resolve or Override estimate discrepancies 

4.  Run the Test Reports Program, and then 

5.  Run the Adjustments plug-in.   

6.  Review the Estimate 

7.  Approve the Estimate 

Since the calculation of adjustments in the Adjustments plug-in adds the 
first level of approval, Office Staff will never use the Estimate Approval 
window.  Other staff, (e.g., Project Supervisors) will use the Estimate 
Approval window. 

Once the estimate is in Approved status (having had the final level 
approval given), the Estimate may not be deleted or modified in any 
way. Ensure this is 

understood - once 
estimate is 
approved at final 
level of approval, it 
may not be deleted 
or modified. 
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 Exercise 10-24 
In the following exercise, you will log in as the second level approver of the estimate 
review the estimate amount, and approve Estimate 0001 for contract CNB022P. 

User ID: jj05753 Group: PJSUPS Contract : CNB022P 
1. Double-click the SiteManager program icon on your desktop.  
2. In the User ID field, type jj05753. 
3. In the Password field, type pass. 
4. Click the Logon button. 
5. On the Main Panel, double-click the Contractor Payments icon. 
6. On the Contractor Payments panel, double-click the Estimates icon. 
7. On the Estimate panel, double-click the Estimate Summary icon.  
8. In the Contract list box, scroll to and double-click the Contract CNB022P. 
9. In the Estimate area, double-click Estimate Nbr 0001.  
10. What amount will be paid to the contractor? _____________________ 
11. To close the Estimate Summary window, click the Close button. 

Now, let’s approve the estimate on the Project Supervisor level. 
12. On the Estimate panel, double-click the Estimate Approval icon. 

SiteManager displays the Select Contract/Estimate list box. 
13. In the Contract list box, scroll to and double-click the Contract CNB022P. 
14. For the Project Supervisor level, select the Approved check box (ON). 
15. Click the Save button.  
16. Click the Close button. SiteManager displays a message to inform you that a 

notification was sent to the next approval level. 
17. Click the Ok button. 

$59,274.38 

Shift-tab if user 
ID not 
highlighted. 
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Tracking Estimates 
The Estimate Tracking window is a view-only window that allows the tracking of 
Estimate generation, approval, and rejection.  A User can access the window to 
determine where the Estimate is in the approval process. 

 
The Estimate Tracking Window 

Figure 10-31 

 

In TDOT, Users may access this window to view the status of Estimates on 
the Contract. 
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 Exercise 10-25 
In the following exercise, you will track an Estimate. 

User ID: jj05753 Group: PJSUPS Contract: CNB022Q 
1. On the Estimate panel, double-click the Estimate Tracking icon.  
2. Click the Open button to display the Select Contract and Estimate window. 
3. Click the Contract button. 
4. In the Contract ID list box, scroll to and double-click Contract ID CNB022Q. 
5. In the Estimate area, double-click Estimate Number 0001. SiteManager displays 

the Estimate Tracking window. 
6. What date was the estimate generated? ______________________ 
7. Who generated the estimate? ______________________________ 

Now that you know who generated the estimate, if you wish to reject or stop the 
estimate, contact that person. 

8. To prepare for the next exercise, click the Exit button. 

10/29/06 
jj05754 

Note we are 
changing 
Contract IDs. 
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Viewing the Estimate History 
The Estimate History window allows the selection and display of all Estimates for 
a Contract.  Pending Estimates can be deleted.  Clicking the Open button displays 
the Estimate number or the period end date of the Estimate entered to define the 
starting row.  The Estimates will display from most recent to the oldest Estimate. 
The Estimate History window can also be used to navigate to the Estimate 
Summary and Estimate Discrepancy windows for an Estimate using the Services 
menu. 

The Estimate History Window 

Figure 10-32 

 
In TDOT, the Office Staff Personnel who generated the Estimate may 
delete a pending Estimate in the Estimate History window until the 
Adjustment plug-in has been used to apply adjustments. 
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 Exercise 10-26 
In the following exercise, you will log in and open the Estimate History window to 
view the status of Estimate 0001 for Contract CNB022Q that a Project Supervisor 
wishes to stop. 

User ID: jj05754 Group: OSTAFF  Contract: CNB022Q 
1. Double-click the SiteManager program icon on your desktop.  
2. In the User ID field, type jj05754. 
3. In the Password field, type pass. 
4. Click the Logon button. 

Now, let’s view the estimate history. 
5. On the Main Panel, double-click the Contractor Payments icon. 
6. On the Contractor Payments panel, double-click the Estimate icon. 
7. On the Estimate panel, double-click the Estimate History icon. SiteManager 

displays the Contracts window. 
8. In the Contract area, scroll to and double-click Contract ID CNB022Q. 

SiteManager displays the Estimate History window. 
9. What is the status of Estimate Nbr 0001? __________________ 
10. What is the net pay for Estimate Nbr 0001? _________________ 
11. Click the Close button.  

 

INAP – In Approval 

$1801.15 

Shift-tab if user 
ID not 
highlighted. 
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Using the Estimate History Window to Delete a Pending Estimate 
The Estimate History window also allows for the deletion of a pending estimate.   

 

It is critical that the appropriate workflow is followed so that the estimate plug-
ins will calculate adjustments properly.  Always generate the pending estimate 
and address all issues prior to running the plug-ins.   

If an estimate must be deleted and generated again after the plug-ins are run, 
always use the Return to Pending button in the Adjustments plug-in to return 
the estimate to pending and delete the adjustments BEFORE deleting the 
estimate. 

Once the estimate is in Approved status (having had the final level approval 
given), it may not be deleted or modified in any way. 

 

The next 
section will 
address how 
to adjust 
quantities on 
an Approved 
estimate. 
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 Exercise 10-27 
In the following exercise, you will remove Line Item Adjustments made by the 
Adjustments plug-in and delete Estimate 0001 for Contract CNB022Q. 

User ID: jj05754 Group: OSTAFF  Contract: CNB022Q 

First, let’s undo adjustments and return the estimate to pending. 
1. In the SiteManager Panel, click the Main Panel folder tab. 
2. On the Main Panel, double-click the Contract Administration 

icon. 
3. On the Contract Administration panel, double-click the Contract 

Records icon. 
4. On the Contract Records panel, double-click Contracts icon. 

SiteManager displays the Contracts window. 
5. On the toolbar, click the Attachments button. 
6. In the Attachments window, double-click the Adjustments plug-in. 

SiteManager displays the Adjustments plug-in window. 
7. On the toolbar, click the Return to PEND button. The Adjustments 

program displays a message to confirm that you wish to return the 
estimate status to pending. 

8. In the message, click the Yes button. The Adjustments program 
changes the estimate status to Pending and deletes the system-
generated adjustments. 

9. On the toolbar, click the Exit button. 
Now, let’s delete the estimate.  

10. Click the Close button. 
11. Click the Main Panel folder tab. 
12. On the Main Panel, double-click the Contractor Payments icon. 
13. On the Contractor Payments panel, double-click the Estimate icon. 
14. On the Estimate panel, double-click the Estimate History icon. 
15. Click to select Estimate Nbr 0001. 
16. What is the status of Estimate Nbr 0001? __________________ 
17. What is the net pay for Estimate Nbr 0001? _________________ 

Note that Net Pay has been reduced by the value of the deleted 
adjustment. 

18. On the toolbar, click the Delete button. SiteManager displays a 
message to confirm that you wish to delete the estimate. 

19. In the message, click the Yes button. 
At this time in the process, you may generate a replacement estimate, add 
additional DWRS, and make price and pay adjustments. 

20. Click the Exit button to exit SiteManager. 

PEND – Pending 

$1788.00 



Correcting Quantities for Approved Progress Estimates Trns•port SiteManager® Learning Guide 
Contractor Payments for Office Documentation Section 10  Estimate Basics and Progress Estimates 

 

 

 295 

Correcting Quantities for Approved Progress Estimates 
Use the Quantity Correction plug-in to adjust pay item quantities on Progress 
estimates that have reached final approval.  Note that quantities on Final Estimates 
may not be adjusted after the estimate is approved. 

The Quantity Correction Plug-In Window 

Figure 10-33 

The steps to use the Quantity Correction plug-in are as follows and are detailed on 
the following pages.  

1.  Run the Quantity Correction plug-in. (Main Panel > Contract 
Administration > Contracts > select Contract > click Attachments button 
> double-click Quantity Correction) 

2.  Select the DWR Date that included the quantity to be corrected. 

3.  Select the ITEM that included the quantity to be corrected. 

4.  In the Correct Quantity field, type the quantity that should have been 
recorded on the DWR. 

5.  Press the tab key to allow the program to calculate and display the 
quantity for the adjustment (Incorrect Quantity - Correct Quantity). 

6.  In the Remarks/Calculations field, type a remark to explain why the 
correction was needed. 

7.  Click the Save button. 

Only the originator of the DWR can modify any of the quantities on that DWR using the 
Quantity Correction plug-in. 

A DWR Quantity can only be corrected one time using the Quantity Correction Plug-In.  

The Quantity Correction Plug-In creates a system generated DWR.  This DWR must be 
authorized for before the correction is included on an estimate. 
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 Exercise 10-28 
In the following exercise, you will adjust an incorrect quantity on an approved DWR 
in the Quantity Correction plug-in for contract CNB022R.  

User ID: jj05752 Group: INSP  Contract: CNB022R 
1. Double-click the SiteManager program icon on your desktop  
2. In the User ID field, type jj05752. 
3. In the Password field, type pass. 
4. Click the Logon button. 

Now, let’s open the contract and Qty Correction plug-in. 
5. On the Main Panel, double-click the Contract Administration icon. 
6. On the Contract Administration panel, double-click the Contract 

Records icon. 
7. On the Contract Records panel, double-click the Contracts icon. 

SiteManager displays the Contracts window. 
8. In the Select Contract list box, scroll to and double-click CNB022R. 
9. Click the Attachments icon. 

 

The remaining steps cannot be completed in the training environment.  The following 
steps and screen shots demonstrate the process steps. 

10. Double-click the Qty Correction plug-in. SiteManager displays the 
Quantity Correction plug-in window.  The Contract and Inspector are 
automatically selected. 

 
 

11. In the DWR Date of Incorrect Qty field, select DWR Date 04/19/2005.  
The work items recorded on the DWR for the selected date are 
displayed. 

 

Shift-tab if user 
ID not 
highlighted. 

Note: we are 
changing 
Contract IDs. 
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12. Click to select the row for the DWR Item with the incorrect placed 
quantity: Project Number 55021-3214-94, Category Number 0100, 
Line Item Number 0643, Item Code 204-07, Description BEDDING 
MATERIAL (PIPE) CLASS B, Location Station16_75 RT. 
The Quantity Correction program displays an area to make the 
correction. 
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13. In the Correct Quantity field, type 29.000. 
14. Press the Tab key. The Quantity Correction plug-in shows the 

calculated adjustment in the Adjustment field. 
15. In the Remarks/Calculations field, type Corrected typo that 

resulted in an incorrect quantity being recorded. 
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16. Click the Save button. The Quantity Correction program displays a 
message to inform you that a quantity has been adjusted for that line 
item number. 
 

 
 

17. In the message, click the OK button. 
18. On the toolbar, click the Exit Application button. 
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Viewing QTY ADJ DWRs 
The Quantity Correction plug-in creates QTYADJ DWRs to adjust paid quantities 
on progress estimates that have already reached final approval. These may be 
viewed in the DWR window. 

The auto created QTY Adj DWRs are not authorized and will need to be 
authorized in the Diary window to be included in the next progress estimate. 

 

The Daily Work Reports Window 

Figure 10-34 
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 Exercise 10-29 
In the following exercise, you will view the DWR resulting from the Qty Correction 
plug-in. 

User ID: jj05752 Group: INSP Contract: CNB022R 
1. Click the Close button to close the Contracts window. 
2. Click the Main Panel folder tab. 
3. On the Main Panel, double-click the Daily Work Reports icon. 
4. On the Daily Work Reports panel, double-click the Daily Work 

Reports icon. SiteManager displays the Daily Work Reports window. 
5. On the toolbar, click the Open button.  
6. Click No in the save changes message.  SiteManager displays the 

Contract ID window. 
7. In the Inspector area, double-click QTYADJ01. 
8. In the Date area, double-click 04/19/05. SiteManager displays a 

message to inform you that the DWR will be opened in a read-only 
format. 

9. In the message, click the OK button. SiteManager displays the Daily 
Work Reports window. 

Now, let’s view the installed work item. 
10. Click the Work Items tab. 
11. Double-click the row for Project Number 55021-3214-94, Line Item 

Number 0643, Category Number 0100, Item Code 204-07, Description 
BEDDING MATERIAL (PIPE) CLASS B. 

12. What is the placed quantity? ____________ 
13. To prepare for the next exercise, click the Exit button. 

 

10.000 Exit to log in as 
a different user 
in Summary 
Exercise. 
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Review for Section 10 
To access Contractor Payment Reports: 

1. On the Contractor Payments panel, 
double-click the Reports icon. 

2. Double-click the icon for the desired report. 

To access and print the Installed Work report: 

1. On the Contractor Payments panel, 
double-click the Reports icon. 

2. On the Reports panel, double-click the 
Installed Work icon. 

3. In the Report Criteria list box, scroll to and 
double-click the desired record. 

4. Click the Print button. 
5. When complete, click the Close button. 

To generate a progress Estimate: 

1. On the Contractor Payments panel, 
double-click the Estimate icon. 

2. On the Estimate panel, double-click the 
Generate Estimate icon. 

3. Scroll to and click the desired Contract.  
4. Click OK.  
5. If desired, on the calendar, click the end 

date. 
6. Click the Generate Estimate button. 
7. If the estimate already exists for this 

generation period, and you want to delete it, 
click YES. 

8. Click OK. 
9. Click OK. 
10. When complete, click the Close button. 

To open an Estimate summary: 

1. On the Contractor Payments panel, 
double-click the Estimate icon. 

2. On the Estimate panel, double-click the 
Estimate Summary icon. 

3. On the Select Contract and Estimate 
window, in the Contract list box, scroll to 
and click the desired Contract. 

4. In the Estimate list box, scroll to and click 
the desired Estimate. 

5. Click OK.  
6. When complete, click the Close button. 

To view the Estimate discrepancies: 

1. On the Estimate panel, double-click the 
Estimate Discrepancy icon. 

2. On the Select Contract and Estimate 
window, in the list box, scroll to and double-
click the desired Contract. 

3. In the list box, scroll to and click the desired 
Estimate. 

4. Click OK. SiteManager displays the 
Estimate Discrepancies window. 

To navigate to the correct window to resolve the 
discrepancy: 

1. On the Estimate panel, double-click the 
Estimate Discrepancy icon. 

2. On the Select Contract and Estimate 
window, in the list box, scroll to and double-
click the desired Contract. 

3. In the list box, scroll to and click the desired 
Estimate. 

4. Click OK. 
5. Click the discrepancy to be resolved. 
6. Click the Navigation button. 
7. When you have completed resolving the 

discrepancy, click the Save button. 
8. When complete, click the Close button. 

To override Estimate discrepancies: 

1. On the Estimate Discrepancies window, 
click the discrepancy to be overridden. 

2. In the Status drop-down list, click the 
expand arrow to the right of the current 
selection and click the Override choice. 

3. Add remarks and click the Remarks button. 
4. Repeat steps 1-3 to override additional 

discrepancies. 
5. When complete, click the Save button. 

To recalculate Estimate discrepancies: 

1. Resolve the discrepancies of the Estimate. 
2. On the Estimate panel, double-click the 

Estimate Discrepancy icon. 
3. Open the Estimate to be recalculated. 
4. Click the Services menu and click the 

Recalculate Discrepancies choice. 
5. Click YES. 
6. Click OK. 
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To use the Test Reports plug-in:  

1. On the Main Panel, double-click the 
Contract Administration icon. 

2. Con the Contract Administration panel, 
double-click the Contracts Records icon. 

3. On the Contract Records panel, double-
click the Contracts icon. 

4. Select the Contract from the Select 
Contract window. 

5. Click the Attachments button on the 
toolbar. 

6. Double-click the Test Reports Program. 
7. Set up the plug-in before the first estimate 

by indicating No for every Contract Item 
that should not have Test Report 
adjustments applied using the Shortage 
Calculation Setup folder tab of the Test 
Reports plug-in. 

8. Enter test reports as they are completed 
using the Test Reports folder tab of the 
Test Reports plug-in. 

9. Apply adjustments to an estimate after the 
estimate has been generated using the 
Balance shortages button on the Payment 
Adjustment folder tab of the Test Reports 
plug-in. 

10. Indicate materials used in an item using the 
Materials folder tab of the test Reports 
plug-in.  This may be done at any time. 

To add a test report: 

1. On the Main Panel, double-click the 
Contract Administration icon. 

2. Con the Contract Administration panel, 
double-click the Contracts Records icon. 

3. On the Contract Records panel, double-
click the Contracts icon. 

4. Select the Contract from the Select 
Contract window. 

5. Click the Attachments button on the 
toolbar. 

6. Double-click the Test Reports Program. 
7. On the Test Reports folder tab, in the Item 

Cd/Desc drop-down list, click the desired 
item.  

8. In the Pjr Nbr drop-down list, click the 
desired project.  

9. In the Line Item Nbr drop-down list, click 
the desired line item number.  

10. In the Material drop-down list, click the 
desired material.  

11. Click the New button.  
12. In the Report Date field, type the desired 

value.   
13. In the Report # field, type the desired value.   
14. In the Report Quantity field, type the 

desired value.   
15. Click the Save button.  

To delete a test report: 

1. On the Main Panel, double-click the 
Contract Administration icon. 

2. Con the Contract Administration panel, 
double-click the Contracts Records icon. 

3. On the Contract Records panel, double-
click the Contracts icon. 

4. Select the Contract from the Select 
Contract window. 

5. Click the Attachments button on the 
toolbar. 

6. Double-click the Test Reports Program. 
7. Click the test report to be deleted.  
8. Click the Delete button.  
9. Click the Delete button in the Confirm 

Delete Test window.  
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To edit a test report: 

1. On the Main Panel, double-click the 
Contract Administration icon. 

2. Con the Contract Administration panel, 
double-click the Contracts Records icon. 

3. On the Contract Records panel, double-
click the Contracts icon. 

4. Select the Contract from the Select 
Contract window. 

5. Click the Attachments button on the 
toolbar. 

6. Double-click the Test Reports Program. 
7. Click the test report to be edited.  
8. Click the Open button.  
9. Edit the test report as desired.  
10. Click the Save button.  
11. Click the Close button.  

To add a material for an item: 

1. On the Main Panel, double-click the 
Contract Administration icon. 

2. Con the Contract Administration panel, 
double-click the Contracts Records icon. 

3. On the Contract Records panel, double-
click the Contracts icon. 

4. Select the Contract from the Select 
Contract window. 

5. Click the Attachments button on the 
toolbar. 

6. Double-click the Test Reports Program. 
7. Click the On the Main Panel, double-click 

the Contract Administration icon. 
8. Con the Contract Administration panel, 

double-click the Contracts Records icon. 
9. On the Contract Records panel, double-

click the Contracts icon. 
10. Select the Contract from the Select 

Contract window. 
11. Click the Attachments button on the 

toolbar. 
12. Double-click the Test Reports Program. 
13. tab. 
14. In the Item Cd/Desc drop-down list, select 

the desired item.  
15. In the Prj Nbr field, select the desired 

project. 
16. Click the New button. 
17. In the Add New Material field, type the 

desired material name. 
18. In the Matl Units field, select the desired 

unit. 
19. Click the Save button. 

To use the Adjustments plug-in 

1. On the Main Panel, double-click the 
Contract Administration icon. 

2. Con the Contract Administration panel, 
double-click the Contracts Records icon. 

3. On the Contract Records panel, double-
click the Contracts icon. 

4. Select the Contract from the Select 
Contract window. 

5. Click the Attachments button on the 
toolbar. 

6. Double-click the Adjustments for Fuel, 
Bit. Material, AC Content, and Anti-
strip. 

7. Review messages for the estimate 
adjustments on the Adj. Process 
Submission folder tab of the TDOT Price 
Adjustments window of the Adjustments 
plug-in. 

8. Enter Mix Design (DA) and Recycled 
Asphalt (RA) percentages and dates for the 
pay items included in the estimate and listed 
on the Adjustment Setup folder tab of the 
Adjustments plug-in. 

9. Confirm all messages have been satisfied for 
the estimate adjustments on the Adj. 
Process Submission folder tab of the TDOT 
Price Adjustments window of the 
Adjustments plug-in. 

10. Click the Calc. button on the Adj. Process 
Submission folder tab of the Adjustments 
plug-in to generate adjustments to the 
estimate and provide 1st level approve the 
estimate. 

11. View adjustments made by the system on 
the Fuel Adjustment Items, Bitm 
Adjustment Items, 307 A/C Adjustment 
Items, 411 A/C Adjustment Items and 
Liquid Anti-strip folder tabs of the 
Adjustments plug-in. 
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To view a Line Item Adjustment: 

1. On the Contractor Payments panel, 
double-click the Contract Adjustments 
icon. 

2. On the Contract Adjustments panel, 
double-click the Line Item Adjustments 
icon. 

3. On the Select Contract and Estimate 
window, in the list box, scroll to and double-
click the desired Contract. 

4. In the list box, scroll to and click the desired 
Estimate. 

5. Click OK.  
6. Click the New button.  

To view an Estimate item: 

1. On the Estimate panel, double-click the 
Estimate Item Detail icon. 

2. On the Contract window, in the Contract list 
box, scroll to and click the desired Contract. 

3. Click OK.  
4. Click the Services menu and click the View 

Estimate choice. 
5. When complete, click the Close button. 

To view the Estimate Item Paybook: 

1. On the Contractor Payments panel, 
double-click the Estimate icon. 

2. On the Estimate panel, double-click the 
Estimate Item Paybook icon. 

3. On the Select Contract and Line Item 
window, in the list box, scroll to and double-
click the desired Contract. 

4. In the list box, scroll to and double-click the 
desired Line Item. 

5. When complete, click the Close button 

To generate the Summary to Contractor Report: 

1. On the Contractor Payments panel, 
double-click the Process List icon. 

2. In the Process List, click the Summary to 
Contractor. 

3. Click the Run Process button. 
4. Double-click the desired contract ID.  
5. Double-click the desired estimate number.  
6. Click the Submit button. 
7. Click the OK button. 
8. Click the OK button. 
9. Click the Services menu.  
10. Double-click the desired process name.  
11. Double-click Output.html. 
12. Click the Page button.  
13. Click Text Size, and then click Smallest. 
14. Click the Page Setup button.  
15. Click the Landscape radio button.  
16. Click the Ok button.  
17. Once the report displays, close the browser 

window. 
18. Click the Close button. 
19. Click the Close button. 

To approve an Estimate: 

1. On the Estimate panel, Double-click the 
Estimate Approval icon. 

2. In the list box, scroll to and click the desired 
record. 

3. Click the Approved check box (ON) for 
your level. 

4. Click Ok.  
5. Click the Save button. 
6. When complete, click the Close button. 

To track an Estimate: 

1. On the Estimate panel, double-click the 
Estimate Tracking icon. 

2. Click the Open button. 
3. In the list box, scroll to and click the desired 

record. 
4. When complete, click the Close button. 
Add steps for qty correct plug in 

To open an Estimate history: 

1. On the Estimate panel, double-click the 
Estimate History icon. 

2. In the list box, scroll to and click the desired 
Contract and estimate number. 

3. Click OK.   
4. When through, click the Close button. 



Trns•port SiteManager® Learning Guide Review for Section 10 
Section 10  Estimate Basics and Progress Estimates Contractor Payments for Office Documentation 

 

 

306  

To put an estimate in pending status using the 
adjustment plug-in after the first level of approval: 

1. On the Main Panel, double-click the 
Contract Administration icon. 

2. On the Contract Administration panel, 
double-click the Contract Records icon. 

3. On the Contract Records panel, double-
click Contracts icon. 

4. In the list box, scroll to and click the desired 
Contract. 

5. On the toolbar, click the Attachments 
button. 

6. In the Attachments window, double-click 
the Adjustments plug-in. 

7. On the toolbar, click the Return to PEND 
button. The Adjustments program displays a 
message to confirm that you wish to return 
the estimate status to pending. 

8. In the message, click the Yes button. The 
Adjustments program changes the estimate 
status to Pending and deletes the system-
generated adjustments. 

To correct an item quantity on a paid estimate using the 
Quantity Correction program: 

1. On the Main Panel, double-click the 
Contract Administration icon. 

2. Con the Contract Administration panel, 
double-click the Contracts Records icon. 

3. On the Contract Records panel, double-
click the Contracts icon. 

4. Select the Contract from the Select 
Contract window. 

5. Click the Attachments button on the 
toolbar. 

6. Double-click the Quantity Correction 
Program. 

7. Select the DWR Date that included the 
quantity to be corrected. 

8. Select the ITEM that included the quantity 
to be corrected. 

9. In the Correct Quantity field, type the 
quantity that should have been recorded on 
the DWR. 

10. Press the tab key to allow the program to 
calculate and display the quantity for the 
adjustment (Incorrect Quantity - Correct 
Quantity). 

11. In the Remarks/Calculations field, type a 
remark to explain why the correction was 
needed. 

12. Click the Save button. 

To view a Quantity Correction DWR: 

1. On the Main Panel, double-click the Daily 
Work Reports icon. 

2. On the Daily Work Reports panel, double-
click the Daily Work Reports icon. 
SiteManager displays the Daily Work 
Reports window. 

3. On the toolbar, click the Open button. 
SiteManager displays the Contract ID 
window. 

4. In the Contract ID area, scroll to and 
double-click the Contract ID. 

5. In the Inspector area, double-click 
QTYADJ01. 

6. In the Date area, double-click the date. 
SiteManager displays a message to inform 
you that the DWR will be opened in a read-
only format. 

7. In the message, click the OK button. 
SiteManager displays the Daily Work 
Reports window. 

8. Click the Work Items tab. 
9. Double-click the row for the corrected item. 
10. Click the Close button.  
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Summary Exercise for Section 10 
In the following exercise, you will perform the Estimate process activities for 
contract CNB022O.   

User ID: jj05754 Group: OSTAFF Contract: CNB022O 

 

1. Open the saved Installed Work Report for Contract CNB022O (Main Panel > Contractor 
Payments > Reports > View Saved Reports > C:\SMTRAINS\SMFILES\ Installed Work Rpt 
before Est CNB022O.PSR) 

2. Does the Installed Work Report show any DWRs not authorized for inclusion on the next 
estimate? _____________________________________________________________________ 

3. Generate a Progress Estimate for Contract CNB022O with an end date of 05/15/05. (Confirm 
deletion of the existing Estimate.) 

4. Generate the Installed Work Report for Contract CNB022O. Does the Installed Work Report 
show any DWRs that were not included on the estimate? ________________________________ 

5. Navigate to the Estimate Summary  window. 

6. What are the Item Earnings for Estimate Nbr. 0001? ___________________________________ 

7. Are there discrepancies on Estimate Nbr. 0001? _______________________________________ 

8. Navigate to the Estimate Discrepancy window. 

9. What kind of discrepancies exist on this estimate? _____________________________________ 

10. From the Estimate Discrepancy window, navigate to Checklist Event Dates window and resolve 
the discrepancies caused by the missed Checklist Event.   

11. Enter 05/12/05 as the actual date for the Stormwater Inspection event type due on 05/01/05.  

12. Close the Checklist Event Dates window. 

13. Recalculate the Estimate Discrepancies. 

14. Navigate to the Test Reports plug-in on the Contracts window for Contract CNB022O.  Run 
the Test Reports plug-in.   
 
 
 
 
 
Summary exercise continues on next page. 

$96,760.05 

YES 

YES 

Since estimates are 
pre-generated in the 
training environment, 
a saved report must 
be viewed rather than 
the live report. 

YES 

OVERRUN AND CHECKLIST EVENT 
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15. On the Tests Reports folder tab, enter a new test report with the following information: 
• Item Cd/Desc: 604-03.02 STEEL BAR REINFORCEMENT (BRIDGES). 

• Prj Nbr: 55019-3220-94. 

• Date: 05/06/05. 

• Report #: T2. 

• Quantity: 1288.0. 

16. Calculate the Test Reports payment adjustment. What is the Line Item Adjustment on this 
estimate for Line Item 0450, on Project 55019-3220-94. _______________________________ 

17. On the Materials folder tab, enter a new material with the following information: 
• Item Cd/Desc: 801-01 SEEDING (WITH MULCH). 

• Prj Nbr: 55019-3220-94. 

• Material: FERTILIZER. 

• Unit: Unit. 

18. Navigate to the Line Item Adjustment window for Contract CNB022O, Estimate Nbr. 0001. 
How many adjustments have been applied to Estimate Nbr. 0001? _______________________ 

19. Navigate to the Price Adjustments Plug-in for Contract CNB022O. Run the Adjustment Plug-
in. 

20. Confirm RA, DA, and Asphalt Invoice Price have been entered on the Adjustment Set Up 
folder tab. 

21. Calculate the Price Adjustments. 

22. View the Price Adjustments. 

23. Navigate to the Estimate Item Details window. 

24. View Estimate Item Details for Item Code 606-09.03, Line Item Number 0520, PRECAST 
CONCRETE PILES. What quantity was installed on this date? ________________________ 

25. What are the two purposes of the Summary to Contractor Report? 
____________________________________________________________________________ 

26. Exit SiteManager. 
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SEND COPY OF ESTIMATE TO THE CONTRACTOR AND VERIFY CATEGORIES(FUNDING) ON THE CONTRACT 

9 
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Learning Module 

 

 

 

 

 Section 11  Change Order Basics I 
for Office Documentation 

 

By the end of this module, you will be able to: 

• Understand the Rules and Life Cycle of Change Orders 

• Create a Change Order Header 

• Navigate to Change Order functions from the Change Order 

Header 

• Apply a Time Adjustment to a Change Order 

• Modify existing Contract Items on a Change Order 

• Add New Contract Items to a Change Order 

• Apply Explanations 

• Calculate a Change Order 
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Change Order General Concepts 

The change order process allows legal changes to be made to a Contract by 
creating, approving, and tracking changes.   

Contract Change Orders may include: 

• Quantity adjustments for existing items (overrun/underruns) 

• Adding new items of work to the contract (extra work) 

• Time Extensions on milestones or revisions to Contract time or 
Contract completion date 

• Additions to the Contract not affecting time or item quantities 

Except for zero dollar change orders, users can specify more than one function to 
make up a change order.  Before a change order is saved, edits are performed to 
ensure that its components are reconciled with its selected functions.  Messages 
advise the User if information has not been entered for a selected function. 

Before the User can select a specific window in the Change Order (CO) function, 
a specific Contract must be selected from a pick list containing valid Contracts, 
and associated, existing COs.  A specific Contract must be selected from the pick 
list to create a new change order. 

Each CO must be 
associated with one 
Contract. 
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The Change Order Maintenance Panel  

Figure 11-1 

 Exercise 11-1 
In the following exercise, you will navigate to the Change Order Maintenance Panel.  

User ID: jj05754 Group: OSTAFF 
1. Double-click the SiteManager program icon on your desktop. 
2. In the User ID field, type jj05754. 
3. In the Password field, type pass. 
4. Click the Logon button. 
5. On the Main Panel, double-click the Change Orders icon. 
6. On the Change Orders panel, double-click the Change Order Maintenance 

icon. 

Shift-tab if user 
ID not 
highlighted. 
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Change Order Life Cycle 

The life cycle of contract change orders is reflected in the change order functions 
in SiteManager. 

1. Creating a New Change Order  

A CO can only be created by a User with specific authority to create new change 
orders.  A change order must be associated with an existing active Contract.  
Specific information about the change order must be recorded using the Change 
Order Header window, the Change Order Items window, the Time Adjustments 
window, and/or the Change Order Explanations window. 

2. Maintaining Change Orders 

Once a CO has been created, updates to the CO information may be required.  
Change Order header information, items, time frames, and explanations may be 
modified in update mode on the appropriate windows. 

3. Reviewing and Approving Change Orders 

After it is created, a draft CO can be forwarded via In-box notification for 
parallel review.  Parallel review is concurrent review by more than one reviewer 
at a time.   

The writer of the CO can also place the change order into Pending status and 
submit it for a hierarchical approval, skipping the review process.  

Users involved in reviewing a draft CO or approving a pending CO can record 
their decisions about proposed changes to the Contract on-line, using the 
Review/Approve window.  Reviewers/Approvers receive an In-Box message 
from the author requesting an action, review or approval for the CO.  The In-Box 
message specifies the Contract and change order number. 

When a Change Order that is in Pending status (in the approval process) is given 
the recommendation “Denied” in the Change Order Review/Approve window, it 
remains in Pending status.  The creator of the Change Order may choose to 
change the status of the Change Order to Draft in order to make modifications to 
the Change Order, then change it back to Pending to resubmit it for approval.  If 
the Change Order will never be approved, it may be changed to Denied status in 
the Header window.  Once a Change Order is in Denied Status, it may not be 
modified or submitted for review/approval. 

All change orders on a contract must be either Approved or Denied in order for 
the Physical Work Complete Date to be entered by Headquarters Finance as part 
of the Contract completion process.  (Change Orders may not be in a Draft or 
Pending status for the Contract completion process.)   

A CO can be kept in 
Draft and sent for 
review only or 
changed to Pending 
and sent for 
approval without a 
review. 

All COs must be 
approved or denied 
before Contract 
Completion can 
occur.   

A CO must be 
approved to report 
CO items installed 
in DWRs. 

Denied COs remain 
in Pending Status 
and must be 
changed to Draft or 
Denied in the 
Header window.  
COs in Denied status 
are inquiry only. 
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4. Tracking the Change Order 

At any time, the writer of the CO may view the status of a change order in the 
review or approval cycle by opening the Tracking window.  The Tracking 
window for a CO is a view-only window and displays: 

• The date a request for recommendation was sent to a reviewer or 
approver 

• The reviewer or approver’s name 

• The action requested - review or approve  

• The date the reviewer or approver makes a recommendation 

• The recommendation - Approved or Denied 

• Any Remarks the reviewer or approver has made 

Authorized users may also display details about current and historic Contract 
items on-line using the Item Summary window. 

5. Reports 

Once approved, change order data may be analyzed to help manage the change 
order process.  The Change Order Reports function allows users to produce 
reports that gather information about trends in Contract changes.   

In TDOT, a paper copy of the change order is still required for physical 
signatures.  SiteManager reflects electronic version. 

When an approver physically signs the Change Order, that approver 
should also indicate their approval of the Change Order in SiteManager. 
The Headquarters Finance Office will indicate approval of the Change 
Order on behalf of all applicable Headquarters approvers. 
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Change Order Conditions 

There are three conditions that affect how the Change Order process in 
SiteManager works.  These are the: 

• Type of Contract 

• Function(s) associated with the change order 

• Status of the change order 

Change Order Functions 

There are six types of change orders: 

• Overrun/Underrun 
• Extra Work 
• Time Adjustment 
• Zero Dollar 
• Force Account – TDOT will not use this function.  Force Account COs 

are “Extra Work” in TDOT. 

A change order may be a combination of types except for a Final Quantity CO, a 
singular change order required for contract completion, or a Zero Dollar. 

Users define the purpose of the change order by selecting among the different 
functions.  Except for Final Quantity and Zero Dollar, users can specify more 
than one function to make up a change order.  The functions available on a 
change order are: 

Overruns or Underruns:  Used when the quantities associated with the Contract 
items are either exceeded or not needed to complete the Contract or work item. 
Extra Work:  Used when additional work items are required to complete the 
Contract. 
Time Adjustments:  Used when the time frames need to be adjusted to reflect 
the completion period for a milestone or Contract. 
Zero Dollar:  Used only for contract adjustments that will not affect the dollar 
amount of the Contract (for example, adding permits or special provision to the 
contract). 
Force Account:  TDOT will not use this function. Force Account COs will 
require the “Extra Work” function to be selected. 
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Change Order Status  

The CO Status field displays the current status of the change order in the creation, 
review, and approval process.  The change order Status types are: 

Draft:  A change order is Draft status while it is being created, edited, or 
forwarded for review. 

Pending:  A change order is changed to Pending status when it needs to be 
submitted for the approval process.  While in Pending status, the change order 
cannot be modified except for its status. 

Denied:  Changing the status to Denied causes it to become inquiry-only for the 
life of the contract.  The Denied status is not available until the Change Order has 
been placed in Pending status. 

A change order in Pending status (under review) that received a recommendation of 
‘Denied’ may have its status changed back to Draft. With a Draft status, the change 
order may be edited (revised), have its status changed to Pending, and be resent 
through the approval process. 

Approved:  A change order is automatically placed in Approved status when the 
last approver completes the approval process – it is not a manual selection. When a 
change order has been approved by its final approval level, it cannot be altered.  
Adjustments can only be made by creating a new change order.   

All change orders must be in either Approved or Denied status for the contract 
completion process. 

In TDOT, if an approver selects “deny” in the review/approve window, the 
creator should change the status back to draft, make corrections, and 
change it to Pending in the Header window to submit it again. 

If an approver selects “denied” in the review/approve window and provides 
a remark indicating that the Change Order will never be approved and 
provides a reason, the creator should change the status of the Change Order 
to Denied in Header window. 

BEWARE:  A Change Order in Denied Status may not be changed to Draft. 

 

When the CO is 
approved it 
becomes read-
only and the 
items become 
available on 
DWRs.
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The TDOT Change Order Process  

In TDOT, all change orders will typically be created and maintained by the Office 
Staff.  There are three phases in the TDOT CO Process. They are as follows: 

Creation of a Change Order 
• Prepare any applicable paperwork  

• Create the change order on the Change Order Header window in SiteManager 

• Add item adjustments and/or new items to the change order on the Change 
Order Items window in SiteManager 

• Add time adjustments to the change order on the Change Order Time 
Adjustments window in SiteManager. 

• Add explanations to the change order on the Change Order Explanations 
window 

Maintaining & Reviewing a Change Order 
• Forward the change order for parallel review  

• Track the change order 

• Revise the change order as necessary 

• Generate applicable change order reports 

Change Order Approval Process 
• Change status to Pending 

• Forward the change order for approval 

• Track the change order 

• Change the Status to Draft to revise the change order as necessary 

• Generate applicable change order reports 

• Change the Status to Denied if an approver selects Denied on the Change 
Order review/approve window, provides a remark indicating that the Change 
Order will never be approved, and provides a reason for the never approving 
it. 
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Creating a Change Order Header 

The Change Order Header window allows an authorized User to: 

• Create a new change order by entering a new descriptive information for 
a change order, or  

• Maintain the current descriptive information about an existing change 
order as the status of the change order progresses from Draft through 
Pending to Approved or Denied.   

The CO Type field has TDOT-defined change order types of: 

• Category 1 

• Category 2 

• Category 3 

• Time Adjustments due to quantity increase 
 

As per Policy Number 355-01, change order categories are defined as follows: 
Major Change - Category 1 

A major change is defined as: 
• Any cumulative change to the working time/completion date of the contract in 

excess of 7.5% of the original contract time; 
• Or any change/addition that alters the total original contract amount by more than 

$250,000. 
Intermediate Change - Category 2 

An intermediate change is defined as: 
• Any cumulative change to the working time/completion date of the contract not in 

excess of 7.5% of the original contract time; 
• Any change/addition that alters the total original contract amount by more than 

$150,000 but less than or equal to $250,000; 
• Any change/addition that alters the total original contract amount by more than 

ten percent (10%)of the original contract; 
• Any change to a unit bid price: 
• Or any change to a special provision or contract provision. 

Minor Change - Category 3 
A minor change is defined as any changes/additions other than those specified under 
Major Change or Intermediate Change as shown above. 

In TDOT, the Reason Code and CO Type fields are used to control the custom Change 
Order Report and Force Account Approval Form.  All entries listed in the Reason Code 
picklist can be selected for Change Orders except for “Force Account.”  This should only 
be selected when adding a Force Account item to the contract and must be selected in 
order to generate the Force Account Approval Form.   

The appropriate Change Order Category (1, 2 or 3) must be selected in the CO Type field 
in order for the appropriate signatures to appear on the Change Order and Force Account 
Approval Form.  The CO Type “Time Adjustment Due to Quantity Increase” is used for 
special contract finalization processing and neither requires a signed Change Order (See 
Contract Finalization Section for details). 

The last 
one is only 
used at 
final 
estimate 
time.   
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The Change Order Header Window  

Figure 11-2 

 Exercise 11-2 
In the following exercise, you will create Change Order 001 for Contract CNB022K. 

User ID: jj05754 Group: OSTAFF  Contract: CNB022K 
1. On the Change Order Maintenance panel, double-click the Header 

icon.   
2. Click the Services menu and click Choose Keys.    
3. In the Contract ID list box, scroll to and double-click Contract 

CNB022K.   
4. In the Description field, type Water Utility Pipe Relocation.   
5. In the Reason Code drop-down list, click the expand arrow to the 

right of the current selection and click Utilities.   
6. In the CO Type drop-down list, click the expand arrow to the right of 

the current selection and click Category 2. 
7. Click the Time Adjustment check box (ON). 
8. Click the Save button. 
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Creating Change Order Time Adjustments 

The Time Adjustments window allows authorized Users to enter one or more 
time adjustments for a change order.  At least one adjustment must be recorded 
using this window if the Time Adjustment function is selected on the change 
order.  Time adjustments may be related to: 

• The Contract completion date 
• Milestone(s) on the Contract, or  
• Both the Contract completion date and milestone(s) associated with the 

Contract  

The Charge Type for the Contract or Milestone determines which timing 
components of the Contract and its associated milestones may be entered and 
modified.  The three types of Time Charges are: 

Completion Date Charge Type:  Has a specific fixed end date for the Contract or 
for milestones within the Contract.  Only the completion date field may be 
entered.  The system computes the number of days adjusted. 

Available Days Charge Type:  Only the number of days adjusted may be entered 
in the Time Adjustment Window.   

Calendar Days Charge Type:  Computes the end date for the Contract and for 
milestones based on the number of calendar days allocated for the work.  The 
number of days adjusted may be entered.  The system then computes the 
completion date. 

TDOT will primarily use Completion Date contracts and milestones.   

The Time Adjustments window has limits as follows: 

• Only one adjustment to the Contract completion date may be entered per 
change order. 

• Only one adjustment to each Milestone completion date or number of 
days may be entered per change order. (Time Adjustment Change Orders 
for Milestones are only needed to accommodate changes to SP108B, 
such as phased construction and mowing and litter cycles, because they 
are contractual milestones.  These would be Category 2 COs - 
modifications to Special Provisions.) 

• Text explaining reasons for the time adjustment may be entered. 
• The status of the associated change order determines whether the fields 

on this window are display only or may be modified by the user.  Time 
adjustments may only be entered while a change order is in Draft status.  
Changes orders in a Pending, Approved, or Denied status do not allow 
updates to these fields. 

Changing the 
target 
Milestone 
Completion 
date - not 
overrunning 
the time 
allowed. 
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The Change Order Time Adjustments Window  

Figure 11-3 

In TDOT, the Explanation in the Change Order Time Adjustments window 
should always be “See Change Order Explanations window.” 

 Exercise 11-3  
In the following exercise, you will navigate to the CO Time Adjustment window 
from the Header window and create a time adjustment on Change Order 001 for 
Contract CNB022K.  

User ID: jj05754 Group: OSTAFF  Contract: CNB022K 
1. On the Header window, click the Services menu and click CO Time 

Adjustments. 
2. Click the Adjustment Completion Date field and type 093005. 
3. In the Explanation field, type See Change Order Explanations window. 
4. Click the Save button. 
5. Click the New button. 
6. Click the For Milestone radio button. 
7. Select Milestone Number 01 from the drop-down list. 
8. Click the Adjustment Completion Date field and type 073005. 
9. In the Explanation field, type See Change Order Explanations window. 
10. Click the Save button. 
11. Click the Close button. 

 

Close here 
returns us 
back to the 
Header 
window. 
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Modify Existing Contract Items 

The Change Order Items window allows the User to: 

• Select an existing item on the Contract for inclusion in the change order 

• Add a new item to the Contract by including it in the change order 

• Select and modify an existing item in the Contract already associated 
with the change order 

• Delete an item from a change order 

Whenever the change order function is an overrun/underrun and/or extra work, 
the Change Order Items window must be used to make the corresponding entries 
and/or modifications to the change order items.  Extra work requires adding 
completely NEW Contract Item(s). Overrun/underrun requires modifying 
existing contract pay items. 

When modifying an existing Contract Item, select the Services menu “New CO 
Item” choice to bring up a list of existing contract items from which to select.  
The Quantity field may then be used to modify the item quantity.  

When adding a new item to the Contract, select the “New Contract Item” folder 
tab to define the item.  Then select the Change Order Item folder tab to define the 
item quantity in the Quantity field. 

 

The Change Order Item Folder Tab 

Figure 11-4 

This might 
be the 
hardest part 
of change 
orders 
because of 
the similar 
naming in 
SiteManager. 

Use ‘New CO 
Item’ for 
items new to 
the change 
order but 
already on 
the contract. 
For use with 
the Overrun/ 
Underrun 
function. 

Use ‘New 
Contract 
Item’ for 
items being 
added to the 
contract. For 
use with the 
Extra Work 
function. 
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 Exercise 11-4 
In the following exercise, you will Create a new Change Order to modify the quantity 
of an existing contract item for Change Order 002 for Contract CNB022K.  

User ID: jj05754 Group: OSTAFF  Contract: CNB022K 
First, let’s create a new Change Order. 

1. On the Header window, click the New button. 
2. In the Description field, type Substitution of a better material at 

the same unit price.   
3. In the Reason Code drop-down list, click the expand arrow to the 

right of the current selection and click Miscellaneous.   
4. In the CO Type drop-down list, click the expand arrow to the right 

of the current selection and click Category 3 
5. Click the Overrun/Underrun check box (ON). 
6. Click the Extra Work check box (ON). 
7. Click the Save button. 

Now, let’s add items to this change order. 
8. Click the Services menu and click CO Items. 
9. Click the Services menu and click New CO Item.   
10. In the Contract Items list box, scroll to and double-click for Project 

Nbr 55019-3220-94, Line Nbr 0100, Item Code 303-01, 
Description MINERAL AGGREGATE, TYPE A BASE, 
GRADING D.   

11. In the This Change Order quantity field, type –2888 (MINUS 
2888).   

12. Click the Save button.   
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Adding New Contract Items in a Change Order 

With the exception of TDOT Add-on items, new items may only be added to an 
active Contract through the change order process. When a new item is added to a 
Contract, the user must choose a project number, a category, and enter a Line 
Item Nbr, unit price, the Proposal Line Nbr, and a supplemental description of 
the item (if required) on the New Item tab of the Change Order Item window. 
The quantity must be entered on the Change Order Item folder tab.  

In TDOT, the New Contract Change Order Item function is used to add new 
items not covered by standard specifications or special provisions. 

In TDOT, Add-on items will be added by Headquarters Finance without a 
change order.  Add-on items are items covered by standard specifications or 
special provisions, as described in an earlier chapter of this training 
document.  To have an add-on item added to a contract, contact the 
Headquarters Finance Office. 

Tip:  When a new item is added to the contract through this process, the 
information about a new line item is not saved to the database until it is 
completed and saved on the Change Order Item tab.  The New Contract Item tab 
performs all edits and passes all new item data to the Change Order Item tab 
where both the new item and change order information are saved.  The contract 
item list is updated immediately with the new contract item, but the new contract 
item has a Pending status type. Upon approval of the change order, the new 
contract item has an Approved status type and is available to be included on 
Daily Work Reports. 

 
The New Contract Item Folder Tab 

Figure 11-5 

The contract item 
list is updated 
immediately with 
the new contract 
item, but the new 
contract item has 
a Pending status 
type.  

Upon approval of 
the change order, 
the new contract 
item has an 
Approved status 
type and is 
available to be 
included on Daily 
Work Reports. 
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In TDOT, the creator of the change order will use a starting number of 9500 for the 
Line item number of the first new contract item.  Each new contract item subsequently 
added to the contract is incremented by 1 from that starting point by the change order 
creator. This creator should enter the same number in the Proposal Line Nbr field as 
they entered in the Line Item Nbr Field.   

To determine the next available Line Item Number, look at the last Line Item Number 
used on the last Change Order (Change Order > Change Order Items). 

By default, the Major Item box is checked for all items being added. The creator should 
always uncheck this box because the Contract’s Major Items are determined during 
Contract activation. 

In TDOT, it is important to select the appropriate Category when adding items with a 
Change Order.  The table below defines the various Categories used by TDOT.  
Participating Categories are those paid by the normal funding source for the project.  
Non-Participating Categories are those paid by other funding sources than the normal 
funding source for the project.  Descriptions of the funding sources can be found in the 
Contract Funding window located at Main Panel > Contract Administration > Contract 
Records > Contract Funding.  Categories 1100 and greater (Alternate Bid Items) should 
not be used to add items to a contract for any reason, for these are only used in the bid 
letting.  If there are any questions concerning funding or if a Category needs to be 
added, please contact the Finance Office. 

 

Item Types Participating Categories Non-Participating 
Categories 

Roadway Items 0100 0110 - 0190 

Box Bridge Items 0300 0310 - 0390 

Bridge Items 0500 0510 - 0590 

Maintenance & Other Items 0700 0710 - 0790 

Utility Items 0900 0900 - 0990 

Alternate Bid Items >1100 
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 Exercise 11-5 

In the following exercise, you will add a New Item to the existing Change Order 
002 for Contract CNB022K. 

User ID: jj05754 Group: OSTAFF   Contract: CNB022K 
1. On the Change Order Item folder tab, click the New button. 
2. Click the New Contract Item folder tab. 
3. In the Project Nbr drop-down list, click the expand arrow to the right of the 

current selection and click 55019-3220-94. 
4. In the Category Nbr drop-down list, click the expand arrow to the right of the 

current selection and click 0100. 
5. In the Line Item Nbr field, type 9500. 
6. Using the right mouse button, click the Item Code field. 
7. In the object menu, click Search. 
8. In the Item Code list box, scroll to and click Item Code 303-01.09, Short 

Description MINERAL AGGREGATE, TYPE A BASE, GRADING D 
LIMESTONE. 

9. Click Ok. 
10. Click the Major Item check box to turn the indicator Off. 
11. In the Unit Price field, type 14.00. 
12. In the Proposal Line Nbr field, type 9500. 
13. Click the Change Order Item folder tab. 
14. In the This Change Order quantity field, type 2888. 
15. Click the Save button. 
16. Click the Close button. 
17. Click the Close button to close the Header window. 

 

The Line 
Item Nbr 
must be 
unique. 

Returns back 
to the Header 
window. 

The Proposal 
Line Nbr is 
the same as 
the Line Item 
Nbr. 
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Applying Explanations  

The Change Order Explanation window is used to document the reasons for 
contract changes. This window allows the author of the change order to record 
the reason for changes in the contract included in the change order.  It also allows 
reviewers and approvers to view the change order reasons.   

TDOT will use the Explanation type “General Change Order Explanations” 
for all of the explanations for a Change Order. 

When the CO is in Draft Status and the window is in new mode, the user may use 
the lower data window to 

• Display and search the list of standard explanations for this contract 
type, or  

• Type a non-standard explanation description in the multi-line text 
field. 

 
The Change Order Explanations Window 

Figure 11-6 
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In TDOT, Standard and Non-Standard Explanations are used together to 
form the body of the printed Change Order Report.  Before typing a Non-
Standard Explanation, the users should check to see if Standard 
Explanations exist for the Change Order.   

The Standard Explanation IDs have been named to help determine when 
and where to use them.  If the ID ends with a 1, it should be sequenced 
before the Non-Standard Explanations.  If the ID ends with a 2, it should be 
sequenced after the Non-Standard Explanations.   

The sequencing of the explanations is very important because this 
determines the order in which they are printed on the Change Order 
Report.   

The Standard Explanations should be used as follows: 

ITEM1 and ITEM2 – Used at the beginning and end of an explanation for a 
Change Order adding or modifying contract items.  Non-Standard 
Explanations are required between them. 

NOTIME – When there is no time extension on the Change Order the order 
should be "ITEM1, Non-Standard Explanation, NOTIME, ITEM2. 

TIME1 and TIME2 – Used at the beginning and end of an explanation for a 
Change Order modifying contract time.  Non-Standard Explanations are 
required between them. 

ITEMTIME1 and ITEMTIME2 – Used at the beginning and end of an 
explanation for a Change Order adding or modifying contract items and 
time.  Non-Standard Explanations are required between them. 
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  Exercise 11-6 

In the following exercise, you will add a standard explanation to Change Order 
002 for Contract CNB022K. 

User ID: jj05754 Group: OSTAFF  Contract: CNB022K 
1. On the Change Order Maintenance panel, double-click the 

Change Order Explanation icon. 
2. Click the New button to create a “General Explanation” 
3. Using the right mouse button, click the Pick Std Exp ID field. 
4. From the object menu, click the Search choice. 
5. In the Explanation list box, scroll to and click ITEM1. 
6. Click Ok.   
7. Click the Save button. 
8. Click the New button to create another “General Explanation.” 
9. In the lower text field, type “removed existing quantity of item 

303-01 and replaced with same quantity of item 303-01.09 due to 
changes in conditions at the project site.” 

10. Click the Save button. 
11. Click the New button to create another “General Explanation.” 
12. Using the right mouse button, click the Pick Std Exp ID field. 
13. From the object menu, click the Search choice. 
14. In the Explanation list box, scroll to and click ITEM2. 
15. Click Ok.   
16. Click the Save button. 
17. Click the Close button. 
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Calculating a Change Order 

After the full change order creation or maintenance activities are complete, 
including entries or updates to the change order items, time adjustments and 
explanations windows as desired, the user may re-calculate the display only 
values on the Change Order Header window. 

 

The Change Order Header Window 

Figure 11-7 

 Exercise 11-7 
In the following exercise, you will calculate Change Order 002 on Contract 
CNB022K.  

User ID: jj05754 Group: OSTAFF  Contract: CNB022K 
1. On the Change Order Maintenance panel, double-click the Header 

icon.   
2. Click the Services menu and click Calculate Change Order. 
3. Click the Save button. 
4. What is the CO Amount for this change order? __________________ 
5. Click the Close button. 

SiteManager 
calculates the 
total amount of 
the CO and 
displays the 
amount in the CO 
Amount field. 

$0.00 
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Review for Section 11 

Contract Change Orders may include: 

• Quantity adjustments for existing items 

• Adding new items of work to the contract 

• Extra Work 

• Time Extension on milestones or revisions to a 
contract completion date   

To access the Change Order Header window: 

1. On the Main panel, double-click the 
Change Order icon. 

2. On the Change Order panel, double-click 
the Change Order Maintenance icon. 

3. On the Change Order Maintenance panel, 
double-click the Header icon. 

4. In the Contract list box, scroll to and 
double-click the desired contract. 

5. In the Change Order list box, scroll to and 
click the desired change order. 

6. Click Ok.   

To modify a change order header: 

1. On the Main panel, double-click the 
Change Order icon. 

2. On the Change Order panel, double-click 
the Change Order Maintenance icon. 

3. On the Change Order Maintenance panel, 
double-click the Header icon. 

4. In the Contract list box, scroll to and 
double-click the desired contract. 

5. In the Change Order list box, scroll to and 
click the desired change order. 

6. Click Ok.   
7. Modify the desired fields as needed. 
8. Click the Save button. 

To navigate to other CO functions from the Header 
Window: 

1. Create a New Change Order Header or open 
an existing Change Order Header. 

2. Click the Services menu and click the CO 
Items, CO Time Adjustments, or Change 
Order Tracking choice. 

To modify an existing time adjustment to a contract or 
milestone: 

1. On the Change Order Maintenance panel, 
double-click the CO Time Adjustment icon. 

Or 
1. In the Header window with the correct 

Change Order open, click the Services 
menu and click the CO Time Adjustment 
choice. 

2. In the top data window, highlight the 
desired Contract or Milestone adjustment 
choice. 

3. If enabled, in the Time Adjustment Days 
field, type the modified number of days the 
contract or a milestone is adjusted. 

4. Press the Tab key. 
5. If enabled, in the Adjusted Completion 

Date field, type the modified completion 
date of the contract or a milestone. 

6. Press the Tab key. 
7. Click either the for Milestone or the or 

Contract Completion radio button (ON) to 
indicate whether this is a modification of a 
previous milestone or a contract adjustment 

8. Press the Tab key. 
9. Modify the Explanation for the new time 

adjustment if desired. 
10. Click the Save button. 

To modify an existing contract item: 

1. On the Change Order Maintenance panel, 
double-click the Change Order Items icon. 

Or 
1. In the Header window with the correct 

Change Order open, click the Services 
menu and click the Change Order Items 
choice. 

2. On the Change Order Item folder tab, 
click the Services menu and click the New 
CO Item choice.  

3. In the Contract Items list box, scroll to and 
click the desired Contract Item. 

4. Click Ok.   
5. In the Change Order Description field, 

type the description for the item change. 
6. Press the Tab key. 
7. In the Quantity field, type change order 

quantity. 
8. Click the Save button. 
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To add a new contract line item from the Item Master 
List: 

1. On the Main panel, double-click the 
Change Order icon. 

2. On the Change Order panel, double-click 
the Change Order Maintenance icon. 

3. On the Change Order Maintenance panel, 
double-click the Change Order Item icon.   

4. Click the New Contract Item folder tab. 
5. In Line Item Number field, type new 

number. 
6. In the Project Number drop-down list, 

click desired project. 
7. In the Category Nbr drop list, click desired 

category.  
8. Using the right mouse button, click the Item 

Code field. 
9. From the object menu, click the Search 

choice. 
10. In the list box, scroll to and click the new 

Item code. 
11. In the Unit Price field, type the unit price. 
12. In Proposal Number field, type the new 

number. 
13. Click the Change Order Item folder tab. 
14. In the This Change Order Quantity field, 

type desired quantity. 
15. Click the Save button. 

To apply a standard explanation to a change order: 

1. On the Main panel, double-click the 
Change Order icon. 

2. On the Change Order panel, double-click 
the Change Order Maintenance icon. 

3. On the Change Order Maintenance panel, 
double-click the Change Order 
Explanation icon. 

4. Click the Open button. 
5. In the Contract list box, scroll to and 

double-click the desired contract. 
6. In the Change Order list box, scroll to and 

click the desired change order. 
7. Click OK.   
8. Using the right mouse button, click the Pick 

Std Exp ID field. 
9. From the object menu, click Search. 
10. In the Explanation list box, scroll to and 

click the desired choice. 
11. Click OK.   
12. Click the Save button. 

To add a non-standard explanation: 

1. On the Main panel, double-click the 
Change Order icon. 

2. On the Change Order panel, double-click 
the Change Order Maintenance icon. 

3. On the Change Order Maintenance panel, 
double-click the Change Order 
Explanation icon. 

4. Click the Open button. 
5. In the Contract list box, scroll to and 

double-click the desired contract. 
6. In the Change Order list box, scroll to and 

click the desired change order. 
7. Click OK.   
8. Click the lower text field and type the 

explanation. 
9. Click the Save button. 

To calculate a Change Order: 

1. On the Main panel, double-click the 
Change Order icon. 

2. On the Change Order panel, double-click 
the Change Order Maintenance icon. 

3. On the Change Order Maintenance panel, 
double-click the Header icon. 

4. In the Contract list box, scroll to and 
double-click the desired contract. 

5. In the Change Order list box, scroll to and 
click the desired change order. 

6. Click Ok.   
7. Click the Services menu. 
8. Click the Calculate Change Order choice. 
9. Click the Save button.  
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Summary Exercise for Section 11 
In the following exercise, you will create a new Change Order for Contract CNB022J.  

User ID: jj05754 Group: OSTAFF Contract: CNB022J 

1. Navigate to the Header window. 

2. Create a new time adjustment Change Order for Contract CNB022J.  
• The description is Extended time due to relocation of water utility. 
• The Reason Code is Utilities. 
• The type of change order is a Category 1. 
• The function is Time Adjustment.  
• Navigate to the Time Adjustments window to indicate the new Contract Completion Date is 

10/10/05.  
3. Create a new Change Order that is both overrun/underrun and extra work for Contract 

CNB022J.  
• The description is Substitution of a better material at a lower unit price. 
• The Reason Code is Miscellaneous. 
• The type of change order is a Category 3. 

4. Click the Main Panel button to open a second window on top of the open CO Header window. 

5. Navigate to the Change Order Items window and change an existing item on the contract. 

• Project Number 55021-3214-94 
• Line Item Number: _____________________  
• Change Order quantity –1637 (minus 1637) 

6. Navigate to the New Contract Items folder tab and add a new item to the contract. 

• Project Number 55021-3214-94 
• Category Number 0100 
• Line Item Number _____________________  
• Item Code 303-01.09 
• Unit Price $13.90 
• Proposal Line Number 9501 
• Change Order quantity 1637 

7. Close the CO Items window. 

8. Calculate the Change Order on the Header window. 

9. Navigate to the Change Order Explanation window and apply Standard Explanation ITEM1, 
then a non-standard explanation of your choice (type it in), then the Standard Explanation 
ITEM2. 

10. Navigate to the Change Order Maintenance panel. 

0130 

9501 
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Learning Module 

 

 

 

 

 Section 12  Change Order Basics II 
for Office Documentation 

 

By the end of this module, you will be able to: 

• Forward a Change Order for Review 

• View the Custom Change Order  

• View the Change Order Report 

• Send a Change Order for Approval 

• Approve a Change Order 

• Track a Change Order 
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Review and Approval of Change Orders 

After it is created, a draft CO can be forwarded via in-box notification for 
parallel review. Parallel review is concurrent review by more than one reviewer 
at a time. The writer of the CO can also place the change order into Pending 
status and submit it for a hierarchical approval, skipping the review process. 

Reviewers/Approvers receive an In-Box message from the author requesting an 
action, review or approve the CO. The In-Box message specifies the contract and 
change order number. Users involved in reviewing a Draft CO or approving a 
pending CO can record their decisions about proposed changes to the contract 
on-line, using the Review/Approve window. 

Before a change order is finalized: 

• It may be subjected to an on-line parallel review by interested parties. 

• It must be approved by each of the Approval Levels and members of the 
User Group(s) defined in the Change Order Approval Rules. 

• It may require the prime contractor to sign a legal document regarding 
the modification. 

CO Review and Approval Sequence 

There are several SiteManager windows that facilitate this on-line review and 
approval process: 

• The Change Order for Review window accessed via the Services > 
Forward To function on the Change Order Header window 

• The Change Order for Approval window accessed via the Save button 
after the Status is changed to Pending on the Change Order Header 
window 

• The Change Order Review / Approval window 

• The Change Order Tracking window 
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The sequence of events in the change order review and approval process are as 
follows: 

1. When the change order is still in Draft status, the user may forward the 
draft change order for parallel review using the Forward To choice 
accessed via the Services menu. (This review may be eliminated and the 
Status changed immediately to Pending to begin an approval process.) 

2. Reviewers record their comments using the Change Order Review 
/Approval window. 

3. When the change order is changed to Pending status and saved, the user 
is prompted to submit the Change Order for approval using the Change 
Order Approval window. 

4. Approvers record their decisions using the Change Order Review / 
Approval window. 

5. At any time during the review and approval process, reviews and 
approvals may be viewed on-line using the Change Order Tracking 
window. 

6. If an approver selects “denied” in the review/approve window, the 
creator should change the status back to draft, make corrections, and 
change it to pending to submit it for approval again. 

7. If an approver selects “denied” in the review/approve window and 
provides a remark explaining why the Change Order will never be 
approved, the creator should change the status of the Change Order to 
Denied in the Header window.  BEWARE:  A Change Order in Denied 
Status may not be changed to Draft or Pending. 

Multiple Review and Approval Cycles 

If a change order is placed in a Draft status from a Pending status, updates are 
allowed to the change order, and any approvals secured while in Pending status 
are automatically deleted. In order for the change order to be approved, it must be 
placed in Pending status again and sent for approval. 

BEWARE:  A Change Order in Denied Status in the Header window may not be 
changed to Draft or Pending. 
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Forwarding a Change Order for Review 

During the life of the Contract Change order, the author is responsible for 
forwarding it to identified SiteManager users for review.  

The author of the Change Order may designate reviewers for the Change Order 
while it is still in a Draft status. The author has the option of using the existing 
reviewer list or updating/modifying the reviewer list each time the change order 
is submitted for review. The Change Order may be reviewed online by those 
designated by the author. It may be accessed and reviewed by multiple reviewers 
concurrently. Reviewers may provide their comments and recommendations to 
the author on-line. 

The Change Order for Review window is accessible to the author of the Change 
Order, and other users authorized to view the Change Order details. Also, 
Approvers have access to this window in order to select a replacement or proxy if 
they are unavailable. 

Note: When the CO is in Pending status the Forward to option on the Services 
menu is disabled.  

 

The Change Order Review Window  

Figure 12-1 
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 Exercise 12-1 
In the following exercise, you will forward Change Order 001 for Contract CNB022J 
for review.   

User ID: jj05754 Group: OSTAFF Contract: CNB022J 
1. On the Change Order Maintenance panel, double-click the Header icon. 
2. Click the Open button. 
3. In the Change Order list box, scroll to and click Change Order 001. 
4. Click the OK button. 
5. Click the Services menu. 
6. Click Forward To. 
7. On the Groups for Review window, click Departmental. 
8. In the lower window, click jj05751 Warren, Jackie. 
9. Click the Add button. 
10. Click the OK button. 
11. Click the Save button. 
12. SiteManager displays a message to inform you that mail has been sent. Click the 

OK button. 
13. To close the Header window, click the Close button. 
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Viewing the Custom Change Order  

The custom Change Order is a custom TDOT document. 

 
The Change Order Parameters Window  

Figure 12-2 

 
The Change Order Window  

Figure 12-3 
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In TDOT, the custom Change Order will be used to gather signatures on a 
Change Order.   

When an approver physically signs the custom Change Order the approver 
should also indicate their approval of the Change Order in SiteManager.  
The Headquarter Finance Office will indicate approval of the Change Order 
in SiteManager on behalf of all applicable Headquarter approvers. 
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Viewing the Change Order Report 

The Change Order Report window can be utilized as a source of information for 
the reviewer and/or approver of a change order.  This is a two-page report 
window that displays all the data included on a change order.  The second page 
displays only if there are Time Extensions associated with the change order 
selected for this report. 

 

The Change Order Report 

Figure 12-4 

The standard Change Order Report is available in Standalone mode. 
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 Exercise 12-2 

In the following exercise, you will access and view the Change Order Report for 
Change Order 002 for Contract CNB022J.    

User ID: jj05754 Group: OSTAFF  Contract: CNB022J 
1. Click the Change Orders folder tab. 
2. On the Change Orders panel, double-click the Reports icon. 
3. Double-click the Change Order Report icon. 
4. Using the right mouse button, click the Change Order field. 
5. In the Object menu, click Search. 
6. In the Change Order list box, scroll to and double-click Change Order 002. 
7. Click OK to generate the report. 
8. What is the description for this change order? 

           
9. What is the Total Value of Change Order 002?   _______ 
10. To close the Change Order Report window, click the Close button. 

 

Substitution of a better material at same unit price 
$0.00 
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Sending a Change Order for Approval 

In order for the change order to be approved, it must be placed in Pending status 
and sent for approval. 

 

The Change Order Approval Window 

Figure 12-5 

For TDOT, as each group is selected at the top, choose the user who should sign to 
approve the change order.  For the Contractor, select the Regional Construction 
secretary for your region to indicate when the contractor’s signature has been 
received. 

Change Orders of types Final Estimate and Time Adjustment Due to Quantity 
Increase are not changed to Pending status to begin the approval process.  These 
types of Change Orders are used in the final estimate process and are left in Draft 
Status by the Office Staff.   

The Office Staff should notify the Finance Office when these types of Draft 
Change Orders are complete.  The Finance Office will override the approval 
rules, change the Status to Pending, and approve the Change Order.  Neither of 
these types of change orders require a signed change order. 

If the Contract includes Federal Oversight, select the Headquarters Finance 
Office Representative as the approver for this group. 
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 Exercise 12-3 
In the following exercise, you will send Change Order 002 for Contract CNB022J for 
approval.   

User ID: jj05754 Group: OSTAFF Contract: CNB022J 
1. Click the Change Orders folder tab. 
2. On the Change Orders panel, double-click the Change Order Maintenance 

icon. 
3. On the Change Order Maintenance panel, double-click the Header icon. 
4. Click the Open button. 
5. In the Change Order list box, double-click change order 002. 
6. In the Status drop-down list, click the expand arrow to the right of the current 

selection and click the Pending choice. 
7. Click the Save button. 
8. Click Yes to the message confirming the status change to Pending. 

Now, add a group for approval. 
9. On the Change Order Approval window, in the Groups for Approval area, 

click Contractor.  
10. In the lower window, click the jj05765 Dady, Jude choice.  
11. Click the Add button. 

Now, add a second group for approval. 
12. In the Groups for Approval area, click Project Supervisor. 
13. In the lower window, click the jj05753 Johnson, Tracy choice. 
14. Click the Add button. 

Now, add a third group for approval. 
15. In the Groups for Approval area, click Regional Construction Supervisor.  
16. In the lower window, click the jj05760 Brown, Terry choice.  
17. Click the Add button.  

Now, add a fourth group for approval. 
18. In the Groups for Approval area, click Regional Director’s Representative.  
19. In the lower window, click the jj05756 Jacobs, Lindsey choice.  
20. Click the Add button.  

Now, add a fifth group for approval. 
21. In the Groups for Approval area, click Finance Staff.  
22. In the lower window, click the jj05755 Morris, L.D. choice.  
23. Click the Add button.  
24. Click OK. The system displays a message to inform you that mail has been sent. 
25. Click OK.  
26. Click the Save button. 
27. To exit SiteManager, click the Exit button. 

This is the 
Regional 
Construction 
Secretary. 
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Replacing Approvers 
To replace an approver after a change order has been sent for approval, follow these steps: 

1. In the Header window, open the desired change order. 

2. From the Services menu, select the Forward To choice. SiteManager displays the Change Order < > 
Approval window. 

3. In the Groups for Approval pane, select the group to be changed. 

4. Click the Remove button. 

5. In the available approver pane on the left, select the desired approver. 

6. Click the Add button.   

7. Repeat steps 3-6 as necessary. 

8. Click the OK button. SiteManager closes the Change Order < > Approval window and displays the 
Header window. 

9. On the toolbar, click the Save button. 
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Reviewing and Approving Change Orders 

The Change Order Review/Approve icon allows the user who receives an In-Box 
message to review a draft change order or to approve a pending change order. 

The Review/Approve window allows the user to: 

• Access the change order information 

• View the contract and change order information on-line 

• Document their recommendation to approve or deny the Draft or Pending 
Change Order 

• Record Remarks related to their recommendation. Remarks are optional. 

 
The Change Order Approval Window  

Figure 12-6 

 

In TDOT, when a change order is denied by a user in the approval process, 
that user must indicate the reason for the denial in the Remarks field.  

When an approver physically signs the custom Change Order document, 
that approver should also indicate their approval of the Change Order in 
SiteManager. 

The Regional Secretary will enter the electronic signature for the 
Contractor when the physical signature is received. 

Electronic approvals are not entered in SiteManager for the following 
groups who are responsible for physically signing the Custom Change 
Order Report: 

 Director of Construction 

 Assistant Chief Engineer of Operations 

 Commissioner 

 FHWA – unless Federal Oversight contract 
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 Exercise 12-4 
In the following exercise, you will approve Change Order 003 for Contract 
CNB022J.  

User ID: jj05765 Group: CONT   Contract: CNB022J 
1. Double-click the SiteManager Training program icon on your desktop. 
2. In the User ID field, type jj05765. 
3. In the Password field, type pass. 
4. Click the Logon button. 

Now, let’s open the Inbox and see if you’ve received a Pending Change Order to 
approve. 

5. On the Main Panel, double-click the Accessories icon. 
6. On the Accessories panel, double-click the In-Box icon. 
7. Note the message titled “Forward Change Order” Is there a request to 

approve Change Order 002 on Contract CNB022J? __________ 
8. To close the In-Box window, click the Close button. 
9. On the SiteManager Panel, click the Main Panel folder tab. 

Now, let’s open the Change Order Approval window. 
10. On the Main Panel, double-click the Change Orders icon. 
11. On the Change Orders panel, double-click the Change Order 

Maintenance icon. 
12. On the Change Order Maintenance panel, double-click the Change 

Order Review / Approve icon. SiteManager displays the Change Order 
Review/Approval window. 

13. In the Contract ID area, double-click contract CNB022J. 
14. In the Change Orders list box, double-click CO Nbr 002. 

Now, let’s review the details of the change order. 
15. Click the Services menu and click the Change Order option. 

SiteManager displays the Header window. 
16. Review the change order details. 
17. Click the Services menu and click the CO Items option. SiteManager 

displays the Select Change Order Item window. 
18. Double-click item 303-01 MINERAL AGGREGATE, TYPE A 

BASE, GRADING D. SiteManager displays the Change Order Items 
window.  

19. Review the item details. 
20. To close the Change Order Items window, click the Close button. 
21. To close the Header window, click the Close button. 

This is how the 
CO can be 
reviewed by an 
approver. 

Yes 
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Now, let’s approve the change order. 
22. On the Change Order Approval window, click the Approved radio 

button. 
23. Click the Save button. SiteManager displays a message that requests 

you to confirm the recommendation. 
24. In the message box, click the Yes button. SiteManager displays a 

message that requests you to save changes. 
25. In the message box, click the Ok button. 
26. To close the Change Order Approval window, click the Close button. 
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Tracking Change Orders 

The status of a Change Order in the review or approval cycle can be monitored 
by opening the Tracking window at any time. The Tracking window for a 
Change Order is a view-only window and displays the following information: 

• The date a request for recommendation was sent to a reviewer or approver 

• The reviewer or approver’s name 

• The action requested - review or approve 

• The date the reviewer or approver made a recommendation 

• Τhe recommendation - Approved or Denied 

• Any Remarks the reviewer or approver has made 

Authorized users may also view details about current and historic contract items 
on-line using the Item Summary window. 

 

The Change Order Tracking Window 

Figure 12-7 
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 Exercise 12-5 
In the following exercise, you will view the tracking window for Change Order 002 
for Contract CNB022J.   

User ID: jj05765 Group: CONT   Contract: CNB022J 
1. On the Change Order Maintenance panel, double-click the Tracking 

icon. SiteManager displays the Tracking window. 
2. On the Tracking window, click the CO Tracking List folder tab. 
3. Who is the next person to approve the change order?    
4. To close the Tracking window, click the Close button. 
5. To exit SiteManager, click the Exit button. 
 

Tracy Johnson 
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Review for Section 12 
To forward a Draft Change Order for review: 

1. On the Main Panel, double-click the 
Change Orders icon. 

2. On the Change Orders panel, double-click 
the Change Order Maintenance icon. 

3. On the Change Order Maintenance panel, 
double-click the Header icon. 

4. Open a draft change order. 
5. From the Services menu, click the Forward 

To choice. 
6. On the Change Order Review window, in 

the Groups for Review area, click a desired 
choice. 

7. In the User ID / User Name area, scroll to 
and highlight the desired User Name and 
User ID. 

8. Click the Add button. 
9. Click OK. 
10. Click the Save button. 

To access the Change Order Report: 

1. On the Main Panel, double-click the 
Change Orders icon. 

2. On the Change Orders panel, double-click 
the Change Order Reports icon. 

3. On the Change Order Reports panel, 
double-click the Change Order Report 
icon. 

4. Search and select the contract. 
5. Search and select the desired Change Order 
6. Generate the report on the user’s computer 

or select to generate and/or print off-line. 
7. Click OK. 

To send a Draft Change Order for approval: 

1. On the Main Panel, double-click the 
Change Orders icon. 

2. On the Change Orders panel, double-click 
the Change Order Maintenance icon. 

3. On the Change Order Maintenance panel, 
double-click the Header icon  

4. Open a draft change order. 
5. In the Status drop-down list, click the 

expand arrow to the right of the current 
selection and click the Pending choice. 

6. Click the Yes button. 
7. Click the Save button. 
8. On the Change Order for Approval 

window, in the Groups for Approval area, 
click a desired choice. 

9. In the User ID / User Name area, scroll to 
and highlight the desired User Name and 
User ID. 

10. Click the Add button. 
11. Click OK. 
12. Click OK. 
13. Click the Save button. 

To replace an approver after a change order has been 
sent for approval: 

1. In the Header window, open the desired 
change order. 

2. From the Services menu, select the Forward 
To choice. SiteManager displays the Change 
Order < > Approval window. 

3. In the Groups for Approval pane, select the 
group to be changed. 

4. Click the Remove button. 

5. In the available approver pane on the left, 
select the desired approver. 

6. Click the Add button.   

7. Repeat steps 3-6 as necessary. 

8. Click the OK button. SiteManager closes the 
Change Order < > Approval window and 
displays the Header window. 

9. On the toolbar, click the Save button. 
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To review or approve a Change Order: 

1. On the Main Panel, double-click the 
Change Orders icon. 

2. On the Change Orders panel, double-click 
the Change Order Maintenance icon. 

3. On the Change Order Maintenance panel, 
double-click the Change Order 
Review/Approve icon. 

4. Open a Draft Change Order that has been 
forwarded for review or a Pending Change 
Order that has been sent for approval. 

5. Click the Approved or Denied radio button.  
6. Click the Save button. 

 

 

To track the status of a change order: 
1. On the Main Panel, double-click the 

Change Orders icon. 
2. On the Change Orders panel, double-click 

the Change Order Maintenance icon. 
3. On the Change Order Maintenance panel, 

double-click the Tracking icon. 
4. Open a Change Order. 
5. When complete, click the Close button. 
 



Trns•port SiteManager® Learning Guide Summary Exercise for Section 12 
Section 12  Change Order Basics II Change Order Basics for Office Documentation 

 

 

352  

Summary Exercise for Section 12 
In the following exercise you will send a change order for approval and deny a change order request. 
Participants should log on using the jj05754 ID in the OSTAFF group.  

1. Log on to SiteManager.  User ID: jj05754; Password: pass. 

2. Navigate to the Header window. 

3. Open Change Order 001 for Contract CNB022J.  Send the Change Order for Approval by 
changing its status to Pending and save.  Send the change order for APPROVAL to the following 
personnel: 

• Contractor: jj05765 Dady, Jude. 
• Project Supervisor: jj05753 Johnson, Tracy. 
• Regional Construction Supervisor: jj05760 Brown, Terry. 
• Regional Director’s Representative: jj05756 Jacobs, Lindsey.  
• Finance Staff: jj05755 Morris, L.D. 

4. Navigate to the Change Order Maintenance panel, Tracking window.  Who is the next person 
responsible for approving Change Order 001, contract CNB022J?     

5. Navigate to the Reports panel.  Run the Change Order Report for Change Order 001 for 
contract CNB022J. 

• What is the Change Order Description?        

• Does this change order extend contract time or milestone time?     

6. Exit SiteManager. 

7. Log on to SiteManager. User ID: jj05765; Password: pass. 

8. Navigate to the Change Order Review/Approval window.  Approve Change Order 001 for 
contract CNB022J.  

9. Exit SiteManager. 

 

 

 

 

  

Water Utility Pipe Relocation 

Both Contract & Milestone Time 

jj05765 Dady, Jude 
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Learning Module 
 
 

 

 

 Section 13  Contract Finalization 
for Office Documentation 

 

By the end of this module, you will be able to: 

• Overview of the Contract Finalization Process 

• Update Key Dates 

• Create a Document Submission of the Final Estimate 

• Review and Resolve Estimate Discrepancies 

• View a Change Order 

• Generate the Final Estimate 

• Approve a Final Estimate 
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Overview of the Contract Finalization Process 
When a Final Estimate is paid, user’s may no longer record work against the 
contract in a Daily Work Report, although they may view these records.   

Supplemental estimates may be paid until the contract is placed into Complete 
status. 

Contracts appear in user’s pick lists as long as they are active (have an “active” 
status).  When the Contract’s status is Complete, Contracts no longer appear in 
users pick lists. 

 

In TDOT, Contracts will be placed in Complete status by the Finance Office 
approximately six months after the final estimate.   

 
Final Estimate Requirements 
Final estimates differ from other estimates in that: 

• There may only be one final estimate per contract. 
• Final estimate discrepancies cannot be overridden—they must be 

resolved before the final estimate may be approved.   
The user must resolve all final estimate discrepancies before the final 
estimate can be approved. Final estimate discrepancies may include the 
following: 

o Checklist Events incomplete 
o Item overruns 
o Contract Completion date missed 
o Milestone Completion date missed 

 

For final estimates, SiteManager performs the same edits, validations, and 
calculations as for progress estimates.  
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TDOT Final Estimate Workflow 
A.  Pre-Final Estimate Process – All discrepancies must be resolved prior to 
generating the FINAL estimate.  A temporary PROGRESS estimate will be 
generated to determine discrepancies to be resolved. Once all discrepancies have 
been resolved, the temporary PROGRESS estimate will be deleted and 
regenerated as a FINAL estimate. 

1. Review project records. As needed, correct quantities using the Quantity 
Correction plug-in, address any applicable change orders that need to be 
placed in “Denied” status and make sure that all stockpiled items have 
been depleted. 

2. Generate a PROGRESS estimate (this estimate will eventually be deleted 
and replaced with a FINAL estimate). 

3. Resolve all estimate discrepancies. (Note: Only time and item overrun 
discrepancies can be left unresolved in this step. These will be addressed 
in Sections B and C.) 

4. Run the Test Report and Price Adjustment plug-ins to add line item 
adjustments to the estimate. 

5. Enter any applicable Key Dates. 

6. Send the “Final Estimate Review” Document Submission to Final 
Records and Materials and Test for their approval. 

7. Modify item quantities as directed by Final Records and/or Material and 
Tests. 

8. Repeat steps 1-7 as needed until everyone approves the final quantities. 

9. View Estimates Discrepancies for the pending estimate. 

10. If there are no discrepancies for the pending estimate, skip Sections B and 
C and go to Section D. If there is a Time Discrepancy, proceed to Section 
B.  If there is an Item Overrun discrepancy, proceed to Section C. 
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B.  Resolving Time Overrun Discrepancy – This section only applies if the 
discrepancies for the pending estimate include “Exceeded Adj Compl Date”and 
“No Physical Work Complete Date.”  Headquarters Finance Office will remove 
the time overrun discrepancy at the end of this process. If this section does not 
apply, go to Section C.  

1. Run the Item Work Report to determine the Inspector Name & DWR 
Date of the DWRs that contain the calculations for assessment of LD. 

2. If the contractor is due extra days due to overrun of quantities, create a 
Time Adjustment Change Order (CO type “Time Adjustment Due to 
Quantity Increase”) to extend the time as calculated by the Liquidated 
Damage Template. List the Inspector Name and DWR Date of the 
Liquidated Damages DWR as the Change Order Explanation.  Leave the 
Change Order in “DRAFT” status and notify the Finance Office of the 
Change Order.  Finance Office will override approval and approve the 
Change Order. 

OR 

 If the contractor is not due extra days due to overrun of quantities 
 email Finance Office the Contract ID, Inspector Name, and DWR Date 
 of the Liquidated Damages DWR. 

3. Headquarter Finance Office will notify Office Staff that the discrepancy 
has been removed.  

C.  Resolving Item Overrun Discrepancy – If there is an Item Overrun 
Discrepancy, contract your Regional Support person. 

D.  Final Estimate Generation Process – All discrepancies will be resolved by 
the time the FINAL estimate is generated.  

1.  Generate the Final Estimate. 

2.  Run Test Report and Price Adjustment plug-ins to add line item 
adjustments. 

3.  Project Supervisor approve Final Estimate. 

4.  Notify Final Records via Document Submission that the Final Estimate is 
ready for Regional approval.  
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Updating Key Dates 
The Key Dates panel lists the Key Dates for the selected Contract in the top 
window. The data for the selected Key Date is displayed in the bottom window. 
The Key Date Types are pre-defined in the system code tables. SiteManager adds 
a set of default Key Dates automatically to each new Contract. The User creates 
the Key Date schedule and records the actual occurrence of Key Dates on this 
panel. The User can add, modify, and delete the Key Dates.  

The Key Dates Window 

Figure 13-1 
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Key Date Recipient Fed/ 
State 

Enters Date Comment 

Starting Notice Project 
Supervisor 

Both Office Staff Projected Date = Effective Date. Used to 
generate the Starting Notice report which 
notifies HQ Finance to fill in the Notice to 
Proceed and Work Begin Dates (from 
Critical Dates) 

Final Inspection 
Request 

Regional 
Construction 
Supervisor 

Both Office Staff Projected Date = Adjusted Completion Date 
(from Critical Dates). 
Contract ready for final inspection. 
Replaces Final Inspection Request form. 

Final Inspection Project 
Supervisor 

Both Office Staff Projected Date = Adjusted Completion Date 
(from Critical Dates). 
Final Inspection completed this date as 
inspected and Accepted Date. 

CC-3 Final 
Records 
Supervisor 

Fed Office Staff Projected Date = Adjusted Completion Date 
(from Critical Dates) 
All CC-3’s have been received. 

Notice of 
Termination 

Project 
Supervisor 

Both Office Staff Projected Date = Adjusted Completion Date 
(from Critical Dates). 
NOT form complete.  
Submit Field Office Completion Notice 
Report. 

Completion 
Notice (Date 
Time Stopped) 

Project 
Supervisor 

Both Office Staff Projected Date = Adjusted Completion Date 
(from Critical Dates) 
Time charges have been stopped.  The final 
inspection and all exceptions are complete.  

Final Records 
Submittal 

Project 
Supervisor 

Both Office Staff Projected Date = Adjusted Completion Date 
(from Critical Dates) 
Project Records have been submitted to 
Final Records.  

DT1696 
Materials and 
Tests 
Certification 

Project 
Supervisor 

Both Office Staff Projected Date = Adjusted Completion Date 
(from Critical Dates). 
DT1696 Materials and Tests certification 
submitted to Regional Materials and Tests. 

TDOT Default Key Dates 

Table 13-1 
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 Exercise 13-1 
In the following exercise, you will log in and enter Key Dates for contract 
CNB022U.  

User ID: jj05754 Group: OSTAFF Contract: CNB022U 
1. Double-click the SiteManager Training program icon on your desktop. 
2. In the User ID field, type jj05754.  
3. Press the Tab key. 
4. In the Password field, type pass. 
5. Press the Enter key. 
6. On the Main Panel, double-click the Contract Administration 

icon. 
7. On the Contract Administration panel, double-click the Contract 

Records icon. 
8. On the Contract Records panel, double-click the Key Dates icon. 
9. In the Contract Select list, scroll to and double click Contract ID 

CNB022U. 
10. In the Key Date Type list box, scroll to and click CC-3. 
11. In the Actual Date field, type 040105. 
12. Click the Save button. 
13. Where would you find the Adjusted Completion Date? 

______________________________________________________ 
14. Click the Close button. 

Contract window, Critical Dates folder tab
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Creating a Document Submission of the Final Estimate 
The Document Submission panel lets the user track documents that have been 
submitted for approval or resolution. Examples include drawings, catalog cuts, 
changes to traffic control plans, EEO reports, and complaints from the public. 
The user can enter or view the document type, the document category, the 
submission date, the submitter’s name, and a document description. The user can 
modify or delete a record only if there are no reviewers assigned to the 
document. 

To begin the document review process, the user selects one or more reviewers. 
The reviewer receives an In-Box notification that the document is ready for 
review. After reviewing the document, the reviewer records his recommendation 
on the Review Submitted Document panel. A recommendation can not be 
modified after it is saved, but a reviewer can add another recommendation. A 
new tracking record is created for every new recommendation. The user can track 
the document reviews in the bottom datawindow of the Document Submission 
panel. 

 
The Document Submission Panel 

Figure 13-2 
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In TDOT, the Document Submission window is used to notify Final 
Records and Materials & Tests to begin their review of the final 
Summary to Contractor Report.  If changes are needed, Final Records 
and/or M&T will deny the document submission and request changes be 
made by Office Staff. 

Final Records Staff will forward the Document Submission to Regional 
Construction Supervisor for approval and to Office Staff to kick off the 
final CO process when the Summary to Contractor Report is correct. 

The Finance Office will send the Office Staff a GroupWise message 
when an applicable final Change Order (Time Adjustments due to 
quantity increase) is approved and the final estimate may be generated. 
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 Exercise 13-2 
In the following exercise, you will add a document submission record and 
forward it for review for contract CNB022U.  

User ID: jj05754  Group: OSTAFF  Contract: CNB022U 
1. Click the Contract Administration folder tab. 
2. Double-click the Contractor Management icon. 
3. On the Contractor Management panel, double-click the Document 

Submission icon. 
4. In the Submitted By field, type Pat Smith. 
5. Press the Tab key. 
6. In the On field, type 042405. 
7. In the Document Type drop-down list, click Not Applicable. 
8. In the Document Category drop-down list, click Final Estimate 

Review. 
9. In the Description field, type Please Review the Summary to 

Contractor Report for the Final Estimate to indicate Installed 
Quantities. 

10. Click the Save button. 
Now, let’s forward this for review. 

11. Click the Services menu. 
12. Click the Forward to choice. 
13. In the Forward to Selected Users list box, scroll to and click Brady, 

Kim (jj05759). 
14. Click OK.  
15. Click the Save button. SiteManager displays a message to inform 

you that the mail has been sent.  
16. Click OK. Each reviewer is listed in the bottom datawindow with a 

‘Pending’ recommendation. 
17. Click the Exit button. 
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Adding Document Reviews   
The Document Submission Review panel lets the user enter recommendations for 
a submitted document. To access this panel, the user must be one of the 
reviewers assigned to review the document. When a submitted document is 
forwarded for review, the system notifies all reviewers by In-Box message that 
the document is ready for review.  

The top datawindow displays the document type, document category, submission 
date, name of the submitter, and document description. The reviewer adds a 
recommendation in the bottom datawindow. The three valid choices are 
Approved, Approved as Noted, and Denied. The reviewer can add comments in 
the Remarks field. A recommendation cannot be changed or deleted after it is 
saved, but the reviewer can add another recommendation. A new record is 
created for each new recommendation. 

 
The Review Submitted Document Panel 

Figure 13-3 

You can only access 
this window if a review 
is due from you.

The document to be 
reviewed can be either 
hard copy or soft copy. 
The document itself is 
not displayed on this 
panel. 
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 Exercise 13-3 
In the following exercise, you will add a review record for a submitted document 
for contract CNB022U.  

User ID: jj05759  Group: RM&TSUP  Contract: CNB022U 
1. Double-click the SiteManager Training program icon on your desktop. 
2. In the User ID field, type jj05759.  
3. Press the Tab key. 
4. In the Password field, type pass. 
5. Press the Enter key. SiteManager displays the Available Groups 

window. 
6. Click the RM&TSUP choice. 
7. Press the Enter key. 

Now, let’s view the documents submitted for review for contract CNB022U. 
8. On the Main Panel, double-click the Contract Administration 

icon. 
9. On the Contract Administration panel, double-click the 

Contractor Management icon. 
10. On the Contractor Management panel, double-click the Document 

Submission Review icon. 
11. In the Documents Submitted Select list box, scroll to and double-

click CNB022U. 
Now, let’s add a review record. 

12. In the Documents Submitted list box, scroll to and double-click 
Document Serial Number 1. 

13. In the Recommendation area, click the Approved radio button. 
14. In the Remarks field, type AOK. 
15. Click the Save button. 
16. Click the Close button. 
17. Double-click the Document Submission icon. 

Note the tracking of the Document Submission at the bottom of the screen. 
18. Click the Exit button. 

Shift-tab if user 
ID not 
highlighted. 

If the Document 
Submission window 
does not open, 
double-click 
Document Serial 
Number 1.  
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Reviewing and Resolving Estimate Discrepancies 
SiteManager identifies the discrepancies associated with an Estimate and displays 
them in the Estimate Discrepancy window. The discrepancies are of two levels: 
discrepancies at the Estimate level and discrepancies at the item level. For 
instance, if a Checklist Event Date is not met, the discrepancy is associated to the 
Estimate. If an item overrun is displayed, the discrepancy is associated with the 
specific line item.  

When the Recalculate Discrepancies function is selected from the Services menu, 
or if the Estimate is regenerated, the discrepancies are re-determined. 

 
The Estimate Discrepancies Window 

Figure 13-4 

 

 
The Navigate Button 

Figure 13-5 

 

 
All Discrepancies must be resolved prior to generating on the Final 
Estimate. Discrepancies on the Final Estimate may not be overridden. 
Headquarter Finance Office will remove the time overrun discrepancy upon 
review of the Liquidated Damages DWR Template. 

 

Only one option 
with Final Est 
discrepancies: 

• Resolve and 
recalculate 
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Exercise 13-4 
In the following exercise, you will review an Estimate Discrepancy on Estimate 
0002 for contract CNB022U.   

User ID: jj05754 Group: OSTAFF  Contract: CNB022U 
1. Double-click the SiteManager Training program icon on your desktop. 
2. In the User ID field, type jj05754.  
3. Press the Tab key. 
4. In the Password field, type pass. 
5. Press the Enter key. 
6. On the Main Panel, double-click the Contractor Payments icon.  
7. On the Contractor Payments panel, double-click the Estimates 

icon.  
8. On the Estimate panel, double-click the Estimate Discrepancy icon. 

SiteManager displays the Select Estimate window. 
9. In the Contract list box, scroll to and double-click Contract CNB022U. 
10. In the Estimate area, double-click Estimate Number 0002. SiteManager displays 

the Estimate Discrepancies window. 
11. Are there any discrepancies on this estimate? _______________ 
12. Click the Close button. 
13. Click the Main Panel folder tab. 

 

NO 
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Viewing the Change Order Header 
The Change Order Header window allows an authorized User to: 

• Create a new change order by entering new descriptive information for a 
change order, or  

• Maintain the current descriptive information about an existing change order 
as the status of the change order progresses from Draft through Pending to 
Approved or Denied.   
 

 
The Change Order Header Window  

Figure 13-6 

 

In TDOT, if time needs to be added due to quantity overruns, Office Staff 
will create a Time Adjustment Change Order of type “Time Adjustment Due 
to Quantity Increase.” 

Change Order of type “Time Adjustment Due to Quantity Increase” is not 
changed to Pending status to begin the approval process.  This type of 
Change Order is used in the final estimate process and is left in Draft status 
by the Office Staff. 

The Office Staff should notify the Finance Office when this type of Draft 
Change Order is complete.  The Finance Office will override the approval 
rules, change the status to Pending, and approve the Change Order.  This 
type of Change Order does not require a signed Change Order. 
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 Exercise 13-5 
In the following exercise, you will log in and view a Final Estimate Change Order.   

User ID: jj05754 Group: OSTAFF Contract: CNB022U 
1. On the Main Panel, double-click the Change Orders icon. 
2. On the Change Orders panel, double-click the Change Order Maintenance 

icon. 
3. On the Change Order Maintenance panel, double-click the Header icon. 

SiteManager displays the Header window. 
4. On the toolbar, click the Open button. 
5. Click the No button.  
6. In the Change Order list box, double-click change order 001. 
7. What type of Change Order is this? _______________________________ 
8. Click the Close button. 
9. Click the Main Panel folder tab.  

Final Estimate 
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Generating the Final Estimate 
To generate a final estimate, the user selects the Final radio button on the Generate 
Estimate panel. The estimate period start date defaults to the day after the end date 
of the previous progress estimate, and the estimate period end date defaults to the 
current date.  The estimate can be reviewed on the Estimate Summary panel.  

 
The Generate Estimates Panel 

Figure 13-7 

In TDOT, the end date for the Final Estimate period should be the 
defaulted current date in order for the Final Estimate to include all 
authorized DWRs.  The end date for the Final Estimate can be the same as 
the begin date.  
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 Exercise 13-6 
In the following exercise, you will generate a final estimate  

User ID: jj05754  Group: OSTAFF  Contract: CNB022U 

1. On the Main Panel, double-click the Contractor Payments icon. 
2. On the Contractor Payments panel, double-click the Estimate icon. 
3. On the Estimate panel, double-click the Generate Estimate icon. 

SiteManager displays the Contracts window. 
4. In the Contract list box, scroll to and double-click Contract 

CNB022U. 
Now, let’s generate the final estimate. 

5. In the Type area, click the Final radio button. 
6. On the toolbar, click the Generate Estimate button. SiteManager 

displays a message to confirm deletion of the existing estimate. 
7. In the message, click the Yes button. SiteManager displays a 

message to inform you that the process has been submitted. 
8. In the message, click the OK button. SiteManager displays a 

message to inform you that the profile for the process has been 
completed.  

9. In the message, click the OK button. 
10. To close the Generate Estimate window, click the Close button. 

 
Typically, you would now follow TDOT workflow to ensure the estimate 
quantities are correct, run the Test Reports Program, and run the Price 
Adjustments Program.  These skills are included in the Estimates chapter 
of this training guide.  

 

If you get an 
error message, 
do not 
reconnect to 
the Server. 
Click OK to 
Error 
messages. 
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Approving a Final Estimate   
SiteManager allows the user to approve final estimates if all discrepancies have 
been resolved. 

 
The Estimate Approval Panel 

Figure 13-8 

 

In TDOT, the Adjustments plug-in will apply the Estimate Approval for the 
Office Staff level on the Estimate.  The plug-in will also be used to return the 
Estimate to Pending status if the Estimate needs to be modified or deleted. 

Price Adjusment plug-
in provides first level 
Office Staff approval. 
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 Exercise 13-7 
In the following exercise, you approve the final estimate (Estimate 0002) for 
contract CNB022U.  You will then log on as the highest level reviewer and 
approve the final estimate (skipping the second reviewer).  

User ID: jj05754  Group: OSTAFF  Contract: CNB022U 
1. Double-click the Estimate Approval icon.  
2. In the list box, scroll to and click CNB022U. 
3. Click the Approved check box (ON). 
4. Click the Save button. 
5. Click the Exit button. 
6. Click OK. 

User ID: jj05757  Group: DIRCON  Contract: CNB022U 
7. Double-click the SiteManager icon. 
8. Click the User ID field and type jj05757. 
9. Press the Tab key. 
10. Type pass. 
11. Press the Enter key on your keyboard. 
12. In the Available Groups for jj05757 list, double-click DIRCON. 
13. Double-click the Contractor Payments icon. 
14. Double-click the Estimate icon. 
15. Double-click the Estimate Approval icon.  
16. In the list box, scroll to and double-click CNB022U. 
17. Click the Approved check box (ON) for the second level reviewer 

(Project Supervisor). 
18. Click the Approved check box (ON) for the third level reviewer 

(Regional Director Rep). 
19. Click the Approved check box (ON) for the fourth level reviewer 

(Finance Staff). 
20. Click the Approved check box (ON) for your level (Director of 

Construction). 
21. Click the Save button. 
22. Click OK. 
23. Click the Exit button. 

This exercise shows 
that the highest level 
reviewer can approve 
the estimate for lower 
level reviewers. 

If you get an 
error message, 
do not 
reconnect to 
the Server. 
Click OK to 
Error 
messages. 
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Review for Section 13 
To update Key Dates: 

1. On the Contract Records panel, double-
click the Key Dates icon. 

2. In the Key Date Type list 
3. In the Projected Date field, type the date 

the key date event is expected to be 
completed. 

4. In the Recipient field, perform a Search 
and select a User ID. 

5. In the Message field, type a short notice that 
will be sent to the Distribution List or 
Recipient when the Actual Date is entered. 

6. Click the Save button. 

To add a document submission record: 

1. On the Contractor Management panel, 
double-click the Document Submission 
icon. 

2. Click the Services menu and click the 
Choose Key choice. 

3. In the Contract ID list box, scroll to and 
click the desired choice.  

4. Click OK.  
5. In the Submitted By field, type the name of 

the person submitting the document. 
6. Press the Tab key. 
7. In the On field, type the date on which the 

document was submitted. 
8. In the Document Type drop-down list, click 

the expand arrow and click the document 
type. 

9. In the Document Category drop-down list, 
click the expand arrow and click the 
document Category. 

10. Press the Tab key. 
11. In the Description field, type a description 

of the document. 
12. Click the Save button. 

To assign a document reviewer: 

1. On the Contractor Management panel, 
double-click the Document Submission 
icon. 

2. Click the Open button. The Document 
Submitted Select panel opens. The Select 
Contract list is displayed.  

3. In the Select Contract list box, scroll to and 
double-click the Contract ID. 

4. In the Documents Submitted list box, scroll 
to and click the document. 

5. Click OK.  
6. Click the Services menu and click the 

Forward to choice. 
7. In the Forward to Selected Users list box, 

scroll to and click the reviewer. 
8. Click OK. A message says ‘Mail sent.’  
9. Click OK.  
10. To select another reviewer, repeat Steps 6 

through 9.  
11. Click the Save button. Each reviewer is 

listed in the bottom datawindow with a 
‘Pending’ recommendation. 

To review a submitted document: 

1. Receive notification by In-Box message that 
the document is ready for review. 

2. Review the document, which could be either 
hard copy or soft copy. 

3. On the Contractor Management panel, 
double-click the Document Submission 
Review icon. The Documents Submitted 
Select panel opens. 

4. In the Select Contract list box, scroll to and 
double-click the Contract ID. 

5. In the Submitted Document list box, scroll 
to and click the document. 

6. Click OK. The Document Submission 
Review panel displays information about the 
submitted document.  

7. In the Recommendation area, click the 
Approved, Approved As Noted, or Denied 
radio button. 

8. In the Remarks field, type comments to add 
to the review. 

9. Click the Save button. 
10. To add another review, click the New button 

and repeat Steps 7 through 9. 
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To create a Change Order Header: 

1. On the Main panel, double-click the 
Change Order icon. 

2. On the Change Order panel, double-click 
the Change Order Maintenance icon. 

3. On the Change Order Maintenance panel, 
double-click the Header icon. 

4. Select Choose Keys from the Services 
menu. 

5. In the Contract list box, scroll to and 
double-click the desired contract. 

6. Click Ok.   
7. In the Description field, type desired 

description.   
8. In the Reason Code drop-down list, click 

the expand arrow to the right of the current 
selection and click the desired choice.   

9. In the CO Type drop-down list, click the 
expand arrow to the right of the current 
selection and click the desired choice. 

10. Click the appropriate Functions check 
box(es) (ON). 

11. Click the Save button. 

To navigate to other CO functions from the Header 
Window: 

1. Create a New Change Order Header or open 
an existing Change Order Header. 

2. Click the Services menu and click the CO 
Items, CO Time Adjustments, or Change 
Order Tracking choice. 

To modify an existing contract item: 

1. On the Change Order Maintenance panel, 
double-click the Change Order Items icon. 

Or 
1. In the Header window with the correct 

Change Order open, click the Services 
menu and click the Change Order Items 
choice. 

2. On the Change Order Items folder tab, 
click the Services menu and click the New 
CO Item choice.  

3. In the Contract Items list box, scroll to and 
click the desired Contract Item. 

4. Click Ok.   
5. In the Change Order Description field, 

type the description for the item change. 
6. Press the Tab key. 
7. In the Quantity field, type change order 

quantity. 
8. Click the Save button. 

To apply a standard explanation to a change order: 

1. On the Main panel, double-click the 
Change Order icon. 

2. On the Change Order panel, double-click 
the Change Order Maintenance icon. 

3. On the Change Order Maintenance panel, 
double-click the Change Order 
Explanation icon. 

4. Click the Open button. 
5. In the Contract list box, scroll to and 

double-click the desired contract. 
6. In the Change Order list box, scroll to and 

click the desired change order. 
7. Click OK.   
8. Using the right mouse button, click the Pick 

Std Exp ID field. 
9. From the object menu, click Search. 
10. In the Explanation list box, scroll to and 

click the desired choice. 
11. Click OK.   
12. Click the Save button. 

To add a non-standard explanation: 

1. On the Main panel, double-click the 
Change Order icon. 

2. On the Change Order panel, double-click 
the Change Order Maintenance icon. 

3. On the Change Order Maintenance panel, 
double-click the Change Order 
Explanation icon. 

4. Click the Open button. 
5. In the Contract list box, scroll to and 

double-click the desired contract. 
6. In the Change Order list box, scroll to and 

click the desired change order. 
7. Click OK.   
8. Click the lower text field and type the 

explanation. 
9. Click the Save button. 
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To send a Draft Change Order for approval: 

1. On the Main Panel, double-click the 
Change Orders icon. 

2. On the Change Orders panel, double-click 
the Change Order Maintenance icon. 

3. On the Change Order Maintenance panel, 
double-click the Header icon  

4. Open a draft change order. 
5. In the Status drop-down list, click the 

expand arrow to the right of the current 
selection and click the Pending choice. 

6. Click the Yes button. 
7. Click the Save button. 
8. On the Change Order for Approval 

window, in the Groups for Approval area, 
click a desired choice. 

9. In the User ID / User Name area, scroll to 
and highlight the desired User Name and 
User ID. 

10. Click the Add button. 
11. Click OK. 
12. Click OK. 
13. Click the Save button. 

To generate a final Estimate: 

1. On the Estimate panel, double-click the 
Generate Estimate icon. 

2. Scroll to and click the desired Contract.  
3. Click Ok.  
4. Click the Final radio button. 
5. On the calendar, click the end date if 

desired. 
6. Click the Generate Estimate button. 
7. Click Ok.  

To view the Estimate discrepancies: 

1. On the Estimate panel, double-click the 
Estimate Discrepancy icon. 

2. On the Select Contract and Estimate 
window, in the list box, scroll to and 
double-click the desired Contract. 

3. In the list box, scroll to and click the desired 
Estimate. 

4. Click OK. SiteManager displays the 
Estimate Discrepancies window. 

To approve an Estimate: 

1. On the Estimate panel, double-click the 
Estimate Approval icon. 

2. In the list box, scroll to and double-click the 
desired Contract. 

3. In the list box, scroll to and click the desired 
Estimate. 

4. Click OK.  
5. Click the Approved check box (ON) for 

your level. 
6. Click OK.  
7. Click the Save button. 
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Summary Exercise for Section 13 
In the following exercise you will review the steps in the Contract Finalization Process 

User ID: jj05754 Group: OSTAFF Contract: CNB022U 

1. Log on to SiteManager.  User ID: jj05754, Password: pass. 

2. Navigate to the Key Dates window for Contract CNB022U. 

3. What is the actual date of the Final Inspection Request? _______________________________ 

4. Navigate to the Document Submission window. 

5. Create a Document Submission for Contract CNB022U.  Be creative in completing the fields. 

6. Navigate to the window that is used to generate a final estimate.  What is the name of this 
window? ______________________________________________________________________ 

7. In what ways do final estimates differ from regular progress estimates? 
______________________________________________________________________________ 

8. Navigate to the Estimate History window. 

9. What is the status of the final estimate for Contract CNB022U? 
______________________________________________________________________________ 

10. Navigate to the Main Panel. 

 

HAS NOT BEEN ENTERED 

GENERATE ESTIMATE 

ONLY ONE, NO DISCREPANCIES, NO MORE DWRS 

APPROVED (INAP IF LAST EXERCISE NOT COMPLETED) 



 

 

 377 

Learning Module 

 

 

 

 

Section 14  Supplemental Estimates 
for Office Documentation 

 

By the end of this module, you will be able to: 

• TDOT Supplemental Estimate Workflow 

• Create a Document Submission of the Supplemental Estimate 

• View Document Submission Recommendations 

• Generate a Supplemental Estimate 
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TDOT Supplemental Estimate Workflow 
1. Document need for additional payment in a Document Submission 

record. 
2. Forward the Document Submission Record to Final Records and 

Materials and Tests. 
3. Verify approval of the Document Submission by Final Records, 

Materials and Tests, and the Regional Construction Supervisor. 
4. Generate a Supplemental Estimate for the necessary lump sum 

payment amount. Supplemental Estimates can only be done AFTER 
a Final Estimate has been paid. 

 
In TDOT, after the Final Estimate has been paid, Supplemental Estimates 
may be generated to make lump sum payments for a specific amount.  There 
is no limit to the number of Supplemental Estimates that may be generated 
in SiteManager. 

Office Staff must document the reason for the Supplemental Estimate in the 
Description field of the Document Submission window, including how the 
amount was calculated (including item, project and category) and what the 
supplemental payment amount is.  The County should also be indicated in 
the Description field. Use the “Supplemental Estimate Review” as Document 
Category. 

The Document Submission feature is used to notify Final Records and 
Materials and Tests of the Supplemental Estimate and to get their approval 
for payment. Upon notification to review the estimate, Final Records and M 
& T will view the Description in the Document Submission Review and 
compare to the Final Estimate (check calculations and, if applicable, new 
quantities for test reports). 

After ensuring M&T's approval in Document Submission window, Final 
Records will enter the supplemental payment amount and the final total 
contract payment amount into the Remarks field of the Document 
Submission Review window and approve the document submission. 

Final Records will give their approval for payment in the Document 
Submission Review window.  The Document Submission is then forwarded 
to the Regional Construction Supervisor for approval prior to payment. 

After the Document Submission has the approval of Final Records, 
Materials and Tests, and the Regional Construction Supervisor, Final 
Records will notify the Field Office that the Supplemental Estimate may be 
approved by the Office Staff and continue through the Estimate Approval 
Process. 
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Creating a Document Submission of the Supplemental 
Estimate 

To begin the document submission review process, the user selects one or more 
reviewers. The reviewer receives an In-Box notification that the document is 
ready for review. After reviewing the document, the reviewer records his 
recommendation on the Review Submitted Document panel. A recommendation 
can not be modified after it is saved, but a reviewer can add another 
recommendation. A new tracking record is created for every new 
recommendation. The user can track the document reviews in the bottom 
datawindow of the Document Submission panel. 

 

The Document Submission Window 

Figure 14-1 

In TDOT, the Document Submission panel is used to submit Supplemental 
Estimates for review by Final Records, Material & Tests, and the Regional 
Construction Supervisor prior to starting the estimate approval process. 

A Document Submission with the category of Supplemental Estimate 
Review should be created before the supplemental estimate is generated.  
This Document Submission should be forwarded to Final Records and 
Materials & Tests.  

Final Records will forward to the Regional Construction Supervisor and 
after approval to the Office Staff. 

When the Office Staff receives this document submission notifying them of 
Final Records approval, they will generate and approve the Supplemental 
Estimate at the first level. 
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 Exercise 14-1 

In the following exercise, you will add a document submission record and 
forward it for review for contract CNB022U.  

User ID: jj05754  Group: OSTAFF  Contract: CNB022U 

1. On the Main Panel, double-click the Contract Administration 
icon. 

2. On the Contract Administration panel, double-click the 
Contractor Management icon. 

3. On the Contractor Management panel, double-click the Document 
Submission icon. 

4. In the Submitted By field, type Pat Smith. 
5. Press the Tab key. 
6. In the On field, type today’s date. 
7. In the Document Type drop-down list, click Not Applicable. 
8. In the Document Category drop-down list, click Supplemental 

Estimate Review. 
9. In the Description field, type Project Number 55019-3220-94, 

McNairy County, Item Code 203-01, Category 0100, 1000 CY x 
$2.00 = $2000.00. 

10. Click the Save button. 
Now, let’s forward this for review. 

11. Click the Services menu. 
12. Click the Forward to choice. 
13. In the Forward to Selected Users list box, scroll to and click Brady, 

Kim (someone from Materials and Tests). 
14. Click OK.  
15. Click the Save button. SiteManager displays a message to inform 

you that the mail has been sent.  
16. Click OK. Each reviewer is listed in the bottom datawindow with a 

‘Pending’ recommendation. 
17. Click the Services menu. 
18. Click the Forward to choice. 
19. In the Forward to Selected Users list box, scroll to and click Miller, 

Casey (someone from Final Records). 
20. Click OK.  
21. Click the Save button. SiteManager displays a message to inform 

you that the mail has been sent.  
22. Click OK. Each reviewer is listed in the bottom datawindow with a 

‘Pending’ recommendation. 
23. Click the Exit button. 

 

Ctrl-Click 
may also be 
used to select 
multiple 
reviewers at 
once. 
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Adding Document Reviews 

The Document Submission Review panel lets the user enter recommendations for 
a submitted document. To access this panel, the user must be one of the 
reviewers assigned to review the document. When a submitted document is 
forwarded for review, the system notifies all reviewers by In-Box message that 
the document is ready for review.  

The top datawindow displays the document type, document category, submission 
date, name of the submitter, and document description. The reviewer adds a 
recommendation in the bottom datawindow. The three valid choices are 
Approved, Approved as Noted, and Denied. The reviewer can add comments in 
the Remarks field. A recommendation cannot be changed or deleted after it is 
saved, but the reviewer can add another recommendation. A new record is 
created for each new recommendation. 

 

The Review Submitted Document Window 

Figure 14-2 

You can only access 
this window if a review 
is due from you.

The document to 
reviewed can be either 
hard copy or soft copy. 
The document itself is 
not displayed on this 
panel. 
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 Exercise 14-2 

In the following exercise, you will add a review record for a submitted document 
for contract CNB022U.  

User ID: jj05759  Group: RM&TSUP Contract: CNB022U 

First, let’s log in as someone in Materials and Tests. 
1. Double-click the SiteManager Training program icon on your 

desktop. 
2. In the User ID field, type jj05759.  
3. Press the Tab key. 
4. In the Password field, type pass. 
5. Press the Enter key. SiteManager displays the Available Groups 

window.  
6. Click the RM&TSUP choice. 
7. Press the Enter key. 

Now, let’s view the documents submitted for review for contract CNB022U. 
8. On the Main Panel, double-click the Contract Administration 

icon. 
9. On the Contract Administration panel, double-click the 

Contractor Management icon. 
10. On the Contractor Management panel, double-click the Document 

Submission Review icon. 
11. In the Documents Submitted Select list box, scroll to and double-

click CNB022U. 
Now, let’s add a review record. 

12. In the Documents Submitted list box, scroll to and double-click 
Document Serial Number 3. 

13. In the Recommendation area, click the Approved radio button. 
14. In the Remarks field, type ok. 
15. Click the Save button. 
16. Click the Exit button. 
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 Exercise 14-3 

In the following exercise, you will add a review record for a submitted document 
for contract CNB022U.  

User ID: jj05758  Group: FRECSTF Contract: CNB022U 

First, let’s log in as Final Records and add a review record. 
1. Double-click the SiteManager Training program icon on your 

desktop. 
2. In the User ID field, type jj05758.  
3. Press the Tab key. 
4. In the Password field, type pass. 
5. Press the Enter key. 
6. On the Main Panel, double-click the Contract Administration 

icon. 
7. On the Contract Administration panel, double-click the 

Contractor Management icon. 
8. On the Contractor Management panel, double-click the Document 

Submission Review icon. 
9. In the Documents Submitted Select list box, scroll to and double-

click CNB022U. 
Now, let’s add a review record. 

10. In the Documents Submitted list box, scroll to and double-click 
Document Serial Number 3. 

11. In the Recommendation area, click the Approved radio button. 
12. In the Remarks field, type Supplemental Payment Amount $2000, 

New Final Contract Price $752,585.75. 
13. Click the Save button. 
14. Click the Exit button. 
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Viewing Document Submission Recommendations 

The user can view and track document reviews in the bottom datawindow of the 
Document Submission panel. 

 

The Document Submission Window 

Figure 14-3 
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 Exercise 14-4 

In the following exercise, you will view the review records for a submitted 
document for contract CNB022U.  

User ID: jj05754  Group: OSTAFF Contract: CNB022U 

First, let’s log in as Final Records and add a review record. 
1. Double-click the SiteManager Training program icon on your 

desktop. 
2. In the User ID field, type jj05754.  
3. Press the Tab key. 
4. In the Password field, type pass. 
5. Press the Enter key. 
6. On the Main Panel, double-click the Contract Administration 

icon. 
7. On the Contract Administration panel, double-click the 

Contractor Management icon. 
8. On the Contractor Management panel, double-click the Document 

Submission icon. 
9. Click the Open button. 
10. In the Documents Submitted Select list box, scroll to and double-

click CNB022U. 
11. In the Documents Submitted list box, scroll to and double-click 

Document Serial Number 3. 
12. Have both Materials & Tests and Final Records approved the 

document submission? ___________________________________ 
13. Click the Close button. 
14. Click the Main Panel folder tab.  

Having acquired approval from Final Records, Materials and Tests, and 
Regional Construction, you may now generate and approve the 
Supplemental Estimate.   

YES 
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Generate a Supplemental Estimate 

After the final estimate, it may be necessary to pay an additional amount to the 
Contractor. To track this payment in SiteManager, it is necessary to generate a 
supplemental estimate. You can continue to generate an unlimited number of 
supplemental estimates as long as the Contract status remains active. 

 
The Generate Estimate Window 

Figure 14-4 
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 Exercise 14-5 

In the following exercise, you will generate a Supplemental estimate.  

User ID: jj05754 Group: OSTAFF  Contract: CNB022U 

1. On the Main Panel, double-click the Contractor Payments icon. 
2. On the Contractor Payments panel, double-click the Estimate icon. 
3. On the Estimate panel, double-click the Generate Estimate icon. 

SiteManager displays the Contracts window. 
4. In the Contract list box, scroll to and double-click Contract 

CNB022U. 
Now, let’s generate the Supplemental estimate. 

5. In the Type area, notice the Supplemental radio button is selected. 
6. In the Date area, in the End field, type 061605. (use the same date as 

begin date) 
7. In the Supplemental Amount field, type 2000.00. 
8. On the toolbar, click the Generate Estimate button. SiteManager 

displays a message to confirm deletion of the existing estimate. 
9. In the message, click the Yes button. SiteManager displays a 

message to inform you that the process has been submitted. 
10. In the message, click the OK button. SiteManager displays a 

message to inform you that the profile for the process has been 
completed.  

11. In the message, click the OK button. 
12. To close the Generate Estimate window, click the Close button. 
13. Click the Main Panel folder tab. 

All Estimate Approvals are entered in the SiteManager Estimate 
Approval window as described in the Progress Estimates and Contract 
Finalization section of this training manual. 

If the Final 
Estimate was not 
approved as per 
the last exercise in 
the previous 
chapter, 
Supplemental will 
not be an option. 

If you get an 
error message, 
do not 
reconnect to 
the Server. 
Click OK to 
Error 
messages. 
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Review for Section 14 
To add a document submission record: 

1. On the Contractor Management panel, 
double-click the Document Submission 
icon. 

2. Click the Services menu and click the 
Choose Key choice. 

3. In the Contract ID list box, scroll to and 
click the desired choice.  

4. Click OK.  
5. In the Submitted By field, type the name of 

the person submitting the document. 
6. Press the Tab key. 
7. In the On field, type the date on which the 

document was submitted. 
8. In the Document Type drop-down list, click 

the expand arrow and click the document 
type. 

9. In the Document Category drop-down list, 
click the expand arrow and click the 
document Category. 

10. Press the Tab key. 
11. In the Description field, type a description 

of the document. 
12. Click the Save button. 

To assign a document reviewer: 

1. On the Contractor Management panel, 
double-click the Document Submission 
icon. 

2. Click the Open button. The Document 
Submitted Select panel opens. The Select 
Contract list is displayed.  

3. In the Select Contract list box, scroll to and 
double-click the Contract ID. 

4. In the Documents Submitted list box, scroll 
to and click the document. 

5. Click OK. The Document Submission 
panel displays information about the 
submitted document.  

6. Click the Services menu and click the 
Forward to choice. 

7. In the Forward to Selected Users list box, 
scroll to and click the reviewer. 

8. Click OK. A message says ‘Mail sent.’  
9. Click OK.  
10. To select another reviewer, repeat Steps 6 

through 9.  
11. Click the Save button. Each reviewer is 

listed in the bottom datawindow with a 
‘Pending’ recommendation. 
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To review a submitted document: 

1. Receive notification by In-Box message that 
the document is ready for review. 

2. Review the document, which could be either 
hard copy or soft copy. 

3. On the Contractor Management panel, 
double-click the Document Submission 
Review icon. The Documents Submitted 
Select panel opens. 

4. In the Select Contract list box, scroll to and 
double-click the Contract ID. 

5. In the Submitted Document list box, scroll 
to and click the document. 

6. Click OK. The Document Submission 
Review panel displays information about the 
submitted document.  

7. In the Recommendation area, click the 
Approved, Approved As Noted, or Denied 
radio button. 

8. In the Remarks field, type comments to add 
to the review. 

9. Click the Save button. 
10. To add another review, click the New button 

and repeat Steps 7 through 9. 

To generate a supplemental estimate: 

1. On the Estimate panel, double-click the 
Generate Estimate icon. 

2. Scroll to and click the desired Contract.  
3. Click Ok.  
4. Click the Supplemental radio button. 
5. Type the supplementary amount. 
6. On the calendar, click the end date if 

desired. 
7. Click the Generate Estimate button. 
8. Click Ok.  

To approve a supplemental estimate: 

1. On the Estimate panel, Double-click the 
Estimate Approval icon. 

2. In the list box, scroll to and click the desired 
record. 

3. Click the Approved check box (ON) for 
your level. 

4. Click Ok.  
5. Click the Save button. 
6. When complete, click the Close button. 
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Summary Exercise for Section 14 
In the following exercise you will review the supplemental estimate process. 

User ID: jj05754  Group: OSTAFF Contract: CNB022U 

1. What is the first step in the Supplemental Estimate process?   
What window in SiteManager is used for this step?  ___________________________________ 
_____________________________________________________________________________ 

2. Create a new Document Submission record for a Supplemental Estimate. 

3. Forward the Document Submission record to Kim Brady and Casey Miller. 

4. Exit SiteManager. 

5. Log in as jj05758. 

6. Review the Document Submission created in step 2 above. 

7. Exit SiteManager. 

8. Log in as jj05754 

9. Review the Document Submission Recommendation created in step 6 above. 

10. Exit SiteManager. 

 

Document the need for additional payment – Document Submission window 

Congratulations! You have completed the course. 

Because of the 
way the data was 
staged, user IDs 
may not match 
the user names 
presented in this 
exercise. 
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